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Preface

The Sun Management Center 3.0 User’s Guide provides instructions on how to use the

Sun™ Management Center system management solution. These instructions are

designed for a system administrator with networking knowledge.

Note – In the Sun Management Center software, all alarm messages are displayed

in English.

Using UNIX Commands

This document may not contain information on basic UNIX® commands and

procedures such as shutting down the system, booting the system, and configuring

devices.

See one or more of the following for this information:

■ Solaris Handbook for Sun Peripherals

■ AnswerBook™ online documentation for the Solaris™ software environment

■ Other software documentation that you received with your system
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Typographic Conventions

Shell Prompts

TABLE P-1 Typographic Conventions

Typeface Meaning Examples

AaBbCc123 The names of commands, files,

and directories; on-screen

computer output

Edit your .login file.

Use ls -a to list all files.

% You have mail .

AaBbCc123 What you type, when

contrasted with on-screen

computer output

% su
Password:

AaBbCc123 Book titles, new words or terms,

words to be emphasized

Command-line variable; replace

with a real name or value

Read Chapter 6 in the User’s Guide.

These are called class options.

You must be superuser to do this.

To delete a file, type rm filename.

TABLE P-2 Shell Prompts

Shell Prompt

C shell machine_name%

C shell superuser machine_name#

Bourne shell and Korn shell $

Bourne shell and Korn shell superuser #

MS-DOS Microsoft Windows c:\
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Related Documentation

For a list of related documents, see the Sun Management Center 3.0 Software Release
Notes on the Sun Management Center website:

http://www.sun.com/sunmanagementcenter

Accessing Sun Documentation Online
The docs.sun.com sm web site enables you to access Sun technical documentation

on the Web. You can browse the docs.sun.com archive or search for a specific book

title or subject at:

http://docs.sun.com

Ordering Sun Documentation

Fatbrain.com, an Internet professional bookstore, stocks select product

documentation from Sun Microsystems, Inc.

For a list of documents and how to order them, visit the Sun Documentation Center

on Fatbrain.com at:

http://www.fatbrain.com/documentation/sun

Sun Welcomes Your Comments

We are interested in improving our documentation and welcome your comments

and suggestions. You can email your comments to us at:

docfeedback@sun.com

Please include the part number of your document in the subject line of your email.
Preface xlv



xlvi Sun Management Center 3.0 Software User’s Guide • November 2000



CHAPTER 1

Introduction

This chapter provides an overview of the Sun™ Management Center version 3.0

product, its component layers, and how they interact with one another.

This chapter includes the following topics:

■ Sun Management Center Overview

■ Sun Management Center Architecture

■ Sun Management Center Concepts

■ Sun Management Center Monitoring Features

■ Sun Management Center Software Environments

■ Installing Sun Management Center

■ Available Features

Sun Management Center Overview

Sun Management Center software is an open, extensible system monitoring and

management solution that uses Java™ software protocol and Simple Network

Management Protocol (SNMP) to provide an integrated and comprehensive

enterprise-wide management of Sun products and their subsystems, components,

and peripheral devices.
1



Sun Management Center technology provides a solution to extend and enhance the

management capability of Sun’s hardware and software solutions.

Sun Management Center Architecture

Sun Management Center software comprises three component layers: console,

server, and agent. It is based on the manager/agent architecture, in which:

■ The console is the user interface which interacts with you to initiate management

tasks.

■ The server (manager) executes management applications and sends requests to

agents in order to perform management tasks on your behalf.

■ The agents (that are executing on the managed nodes) access the management

information, monitor local resources, and respond to manager requests.

The three component layers are depicted in FIGURE 1-1.

TABLE 1-1 Sun Management Center Technology

Feature Description

System Management Monitors and manages the system at the hardware and operating

system levels. Monitored hardware includes boards, tapes, power

supplies, and disks.

Operating System

Management

Monitors and manages operating system parameters including load,

resource usage, disk space, and network statistics.

Application and

Business System

Management

Provides enabling technology to monitor business applications such

as trading systems, accounting systems, inventory systems, and

real-time control systems.

Scalability Provides an open, scalable, and flexible solution to configure and

manage multiple management administrative domains (consisting

of many systems) spanning across an enterprise. The software can

be configured and used in a centralized or distributed fashion by

multiple users.
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FIGURE 1-1 Sun Management Center Component Layers

The major Sun Management Center layers and their functionality are described

below.

Console Layer

You may have multiple consoles, serving multiple users, for the same Sun

Management Center server. The consoles provide you with:

■ Visual representations of the managed objects (for example, hosts and networks)

■ The ability to manipulate attributes and properties associated with the managed

objects (for example, create alarm thresholds)

■ The ability to initiate management tasks (for example, dynamic reconfiguration)

The Sun Management Center console layer is the interface between you and the

other component layers of Sun Management Center software.

Server Layer

The server layer accepts requests from you through the console and passes these

requests to the appropriate agent. It then relays the response from the agent back to

you.

Console Console

Server

Agent Agent Agent
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For example, if you want information on the number of users accessing a host, the

server layer receives this request from the console, and sends it to the agent on that

host. The agent finds the answer, sends it back to the server, which passes on the

information to you (through the console)

Similarly, if an error condition is created on one of the hosts, the agent on that host

sends notification of this error (an event) to the server, which forwards the

information to you (through the console) as an alarm.

In addition, this layer provides the console with a secure entry point to interface

with the agents.

The server layer includes five components (FIGURE 1-2):

■ Sun Management Center server

■ Topology manager

■ Trap handler

■ Configuration manager

■ Event manager

FIGURE 1-2 Sun Management Center Server Layer

Console

RMI

Configuration
manager

Topology
manager

Event
manager

Trap
handler

Remote
SNMP
agent

Local
SNMP
agent

SNMP SNMP

SNMP SNMP

SNMP SNMP

 Server

Sun Management Center
server layer
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The server component is the core of the server layer. It is based on Java technology

and is multi-threaded, and it handles multiple data requests from various Sun

Management Center users.

Sun Management Center Topology manager provides services including the

management of user administrative domains and the topology layout of managed

objects.

The Trap handler is a centralized SNMP trap receptor that performs logging and

forwarding of traps to interested components. It is this server layer component that

is responsible for receiving all alarm notifications.

The Sun Management Center Configuration manager provides security services to

the server and the agents.

The Sun Management Center Event manager sends and receives event information

from the agents. These events can trigger alarms, which are forwarded to the

console.

Agent Layer

The agent layer performs the actual information gathering, monitoring, and

management of objects on the nodes managed by the Sun Management Center

software. The server layer interacts with the agent layer to gain access to the

managed objects by using SNMP.

Sun Management Center agents are scalable, extensible, and SNMP-based. They

monitor and manage objects including hardware, operating systems, and

applications by loading modules that focus on a specific aspect of the system, as well

as application health and performance.

The agents use rules to determine the status of the managed objects. When the

conditions specified by a rule become true, the software automatically generates

alarms or performs actions as specified in the rules.

Server Context

A Sun Management Center server context is defined as the server layer and the

agent layers. When starting the console, you log into a particular server context. The

managed objects whose agents send information to that same server also belong to

the same server context.
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A managed object can belong to the same server context or a remote server context.

(A managed object in a remote server context sends information to a different server

while a managed object in the same server context sends information to the server

host that is connected to your console.)

By default, the Sun Management Center software manages an object in the same

server context but only monitors an object in a remote server context. For a precise

definition of manage and monitor, see the Glossary. For more information on the

server context, see Chapter 14.

FIGURE 1-3 Console Logs Into a Server Context

Sun Management Center Concepts

The following concepts are fundamental to understanding Sun Management Center

software:

■ Administrative domains

■ Modules

■ Alarms and Rules

Note – In this document, “domain” refers to a Sun Management Center

administrative domain, and should not be confused with uses of the term “domain”

related to other Sun products or documentation. See Chapter 2 for more information.

Console

 Server

Agent Agent Agent

Server

Server context 1 Server context 2
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Administrative Domains

An administrative domain is a hierarchical collection of resources that you want to

monitor and manage. The resources can include a complete campus, individual

buildings, hosts, networks, subnets, links, and so on. Each administrative domain

may consist of these resources, which can be combined with other resources to form

groups within a administrative domain. Each of these groups may contain additional

groups of resources, providing a multilevel, hierarchical administrative domain.

You should create administrative domains based on your business needs. You can

create one or more administrative domains. For example, you may create a lab

administrative domain that contains all the lab machines. Similarly, you may create

an accounting administrative domain that contains all the machines used for

accounting.

The Sun Management Center software displays the administrative domain and its

members in a visual representation (FIGURE 1-4).

In the following example, the host, Payroll2 , belongs to the Building B group,

which belongs to the Payroll Servers 1 administrative domain.

FIGURE 1-4 Sun Management Center Main Console Window Showing an Administrative
Domain and Its Members

Domain
members

Administrative
Domain
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Modules

Unlike most agents, the Management Information Base (MIB) provided by Sun

Management Center agents is not implemented in a monolithic code that contains a

wide variety of functionality in a single program. Instead, Sun Management Center

software uses several components, called modules, for each agent. Each module

implements its own MIB. Therefore, the Sun Management Center agent MIB is the

cumulative total of all the modules and their individual MIBs (FIGURE 1-5).

FIGURE 1-5 Sun Management Center Agent MIB

Sun Management Center modules monitor and manage the resources of systems,

applications, and network devices.

The modules serve two purposes:

■ To monitor and notify you (through alarms) when error conditions occur

■ To monitor and notify you (through alarms) when performance tuning is required

For more information on alarms, see“Alarms and Rules” on page 9.

Each module consists of one or more properties that can be monitored on your

system. For example, one of the default modules loaded during installation is the

Kernel Reader. This module monitors kernel properties. These properties include

user statistics, disk statistics, file system usage, and so on.

Note – You can add or remove modules dynamically. This feature enables you to

customize the modules loaded on each agent (object), based on your need.

Agent

Module
C

Module
B

Module
A

Module
C MIB

Module
B MIB

Module
A MIB

Cumulative
agent
MIB
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Alarms and Rules

Sun Management Center software enables you to monitor your system with alarms

of differing severities. The thresholds that generate these alarms are defined in the

modules. The software enables you to set the thresholds that trigger simple alarms.

For example, one of the properties of the Kernel Reader module is the number of

user sessions. The software enables you to set the threshold that generates the alarm.

For example, you may tell Sun Management Center software to generate a critical

alarm when there are seven or greater user sessions. Similarly, you may also tell the

software to generate only a cautionary alarm when there are five-to-six user

sessions.

Although the software is configured with default alarm conditions, you can set and

define your own alarm thresholds for simple alarms such as those based on the

simple rCompare (comparison) rule.

Complex rules also generate alarms. For example, one complex rule states that when

a disk is over 75 percent busy, the average queue length is over 10 entries and the

wait queue is increasing, then an alert alarm is generated. This rule combines three

conditions:

■ Percentage of the disk that is busy

■ Average queue length

■ Wait queue

Unlike simple rules, these complex rules are predefined and cannot be modified.

Consequently, you cannot set thresholds for complex alarms.

When an alarm is generated, the software notifies you through the main console

window, and with a message sent to a specified e-mail address. You can also write a

customized program that will notify you in other ways that an alarm condition has

occurred, such as sending a message to your pager.

For more information on alarms, see Chapter 12. For more information on rules, see

Appendix E.

Sun Management Center Monitoring
Features

Sun Management Center software includes the following monitoring features:

■ Autonomous Agents

■ Main Console Window

■ Hierarchy and Topology Views
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■ View Log

■ Applications

■ Hardware

■ Graph

■ Security

These are graphical user interface or GUI-based features, except for autonomous

agents. Security is both a GUI-based and command-line feature.

Autonomous Agents

Sun Management Center agents work autonomously by actively sampling key data

on host systems. These agents can be polled through SNMP get requests for the

current status of the monitored data.

When an agent gathers data for a monitored resource, it checks the data against the

alarm threshold set for the resource and determines whether the data values

constitute an alarm condition. If the monitored data meets the alarm threshold, the

agent performs the action associated with the alarm condition. Agents send

asynchronous messages (SNMP traps) to the server, which delivers notification of

the change in the status of the monitored data.

Main Console Window

Sun Management Center software provides a main console window to depict,

monitor, and interact with your system. You can monitor multiple administrative

domains, spanning different locations, through multiple console windows.

Hierarchy and Topology Views

Sun Management Center software offers both hierarchy and topology views (for

every administrative domain) and hierarchy and contents views (for every object).

The hierarchy enables you to navigate through the administrative domain or host to

find the object of interest. The topology view or contents view displays the members

of the object that is selected in the hierarchy.

For an administrative domain, the hierarchy and topology views are displayed in the

main console window. In addition, you may customize the administrative domain

topology view by adding a background or creating a connection between objects in

the administrative domain.
10 Sun Management Center 3.0 Software User’s Guide • November 2000



For an object, the hierarchy and contents views are displayed in the Details window.

The Details window consists of a series of tabs; the tabs are dependent on the type of

object. For example, a typical host object contains the following tabs: Info, Browser,

Alarms, View Log, Applications, and Hardware. The View Log, Applications View,

and Hardware tabs are described briefly below.

View Log

The view log tab button enables you to view informational messages, including error

messages, about your host.

Applications

This tab enables you to view and select detailed information about processes

running on the selected host or node. If you have any custom or third-party

applications installed, this tab also enables you to view detailed information about

processes running in the selected custom applications or third-party applications.

The displays are continually updated.

Hardware

The physical view available from the hardware tab provides you with photo-realistic

front, back, and side views of the host. With your mouse button, you can click on

individual components of the host and see detailed information about that

component. For example, you can click on a board in a server, and see detailed

information about that board, such as CPUs, memory, and board temperature.

Note – Physical views are only available for some hardware platforms.

Sun Management Center software also provides a logical view of the overall

hardware configuration of the host. Like the physical view, you can click on a single

component and obtain detailed information about that hardware component.

Note – Logical views are only available for some hardware platforms.
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Graph

Sun Management Center software enables you to create a two-dimensional graph of

any monitored data property that has a numerical value.

Security

The Sun Management Center security feature authenticates user login and access

control privileges for users and groups. It enables users to set security permissions at

the administrative domain, group, host, and module levels.

You can restrict access by setting different permissions. For example, one group of

users can see and modify properties on a host while a second group of users can

only see the host (with no modification privileges).

You can access Sun Management Center security features from the Attribute Editor

within the software.

Sun Management Center Software
Environments

Sun Management Center software may be deployed in two different environments:

■ production environment

■ developer environment

The production environment is an “active” or “real” environment in which you

manage and monitor your hardware, including subsystems, components, and

peripheral devices.

In contrast, the developer environment is a “test” or “demonstration” environment in

which developers can test customized modules designed to work with the Sun

Management Center software. While the developer environment may appear to be a

production environment, its sole purpose is to serve as a “demo” environment for

developers to create Sun Management Center modules. For more information on

developer environments, refer to the Sun Management Center 3.0 Developer
Environment Reference Manual.
12 Sun Management Center 3.0 Software User’s Guide • November 2000



Installing Sun Management Center

For information on installing Sun Management Center 3.0, see the Sun Management
Center 3.0 Software Installation Guide.

Getting Started With the Sun
Management Center Software

Note – For additional documentation describing new functionality, refer to the Sun
Management Center Software Release Notes, which is located on the Sun Management

Center web site: http://www.sun.com/sunmanagementcenter and on the Sun

Management Center 3.0 CD.

Sun Management Center supports multiple hardware platforms. Refer to the Sun
Management Center Configuration and Deployment Guide on the Sun Management

Center web site for more information on the supported hardware platforms: http:/
/www.sun.com/sunmanagementcenter .

This Sun Management Center 3.0 Software User’s Guide describes the software

functionality that is common to all the supported hardware platforms while

platform-specific information is included in the supplements. For example, Sun

Management Center functionality specific to the SPARCserver™ 1000 and 1000E, the

SPARCcenter™ 2000 and 2000E, and the Sun Enterprise™ 6x00/5x00/4x00/3x00 is

contained in the Sun Management Center 3.0 Supplement for Sun Enterprise Midrange
Servers. This supplement is located on the Sun Management Center web site: http:/
/www.sun.com/sunmanagementcenter and in the Sun Management Center 3.0

CD.

Note – For complete information on how you can use the Sun Management Center

software to manage and monitor your machines, read both this user’s guide and the

hardware supplement applicable to your machines.

After installing Sun Management Center software, spend some time navigating

through the various windows and testing their functionality. By exploring and

testing the software, you will have a better understanding of how you can customize

Sun Management Center software to aid in your system monitoring. See

Appendix A for more information.
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If you prefer to set up your monitoring environment now, see Chapter 14 for

information on security.

Available Features

This documentation includes a description of basic and advanced features available

in the Sun Management Center version 3.0 software product. The features available

in your installation of the product are highly dependent on the terms of your site

license. Your installation of the product may or may not include all features.
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CHAPTER 2

Using Sun Management Center
Administrative Domains

A Sun Management Center administrative domain is an arbitrary collection of

resources that can include a complete campus, individual buildings, hosts, networks,

subnets, links, and so on. The organization of an administrative domain collection is

in a hierarchy.

Note – In this document, “administrative domain” refers to a Sun Management

Center administrative domain, and should not be confused with other uses of the

term “domain” related to other Sun products or documentation.

This chapter describes the following topics:

■ To Set a Home Administrative Domain

■ To Select Domain Manager

■ To Create Administrative Domains

■ To Select an Administrative Domain

■ To Delete an Administrative Domain

■ To Set a Remote Administrative Domain

■ To Set Security for an Administrative Domain

Sun Management Center software can monitor a multitude of hosts. To enable you

to perform your monitoring tasks in an efficient manner, Sun Management Center

software organizes hosts into groups. The biggest (highest level) grouping is a

administrative domain. An administrative domain is an arbitrary grouping of hosts,

subnets, networks, buildings, and so on.

You can create one or multiple administrative domains, each with an unique name.

Each administrative domain consists of one or more members, arranged in a

hierarchy. For example, you may decide that an administrative domain consists of all

the hosts in one building. Or, you may decide that an administrative domain consists

of all the hosts in a campus.
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Note – Spend some time planning how you want to organize your hosts into

different administrative domains.

Decide if you need additional groups below the administrative domain to organize

your hosts. For example, if there are several hundred hosts, it is impractical to place

your hosts individually in one administrative domain.

You may decide to break the administrative domain into a set of smaller groups; for

example, campuses. The Headquarters administrative domain might consist of

several campus locations (FIGURE 1-4).

Each of these campus locations may be broken into smaller groups; for example,

buildings. Similarly, each building may be broken into smaller groups; for example,

networks, subnets, and groups. Finally, each group comprises individual hosts.

In this particular example, the hierarchical order, from highest level to lowest level,

is administrative domain, campus, building, network, subnet, group, and individual

host. For detailed information on creating administrative domains, see “To Create

Administrative Domains” on page 20.

Starting Sun Management Center
Software

When starting the software for the first time, a dialog is displayed that prompts you

to set a Sun Management Center home administrative domain. The home domain is

the administrative domain that is displayed whenever the console is started.

During installation, a default administrative domain (named after your server host)

is automatically created for you.

● Proceed with one of the following:

■ Select the default administrative domain and click on the Set Home button. Your

default administrative domain is set as your home administrative domain and is

displayed. For more information, see “To Set a Home Administrative Domain” on

page 17.

■ Select the default administrative domain and click on the Go To button. The main

console window is displayed with this default domain.

The default administrative domain consists of one object, your server host.

■ If you want to explore the main console window, see Chapter 5.

■ If you want to explore monitoring features, see Chapter 6.
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■ If you want to create additional administrative domains, see “To Create

Administrative Domains” on page 20.

■ If you want to create additional objects in your administrative domain, see

“Populating Administrative Domains” on page 20.

▼ To Set a Home Administrative Domain

1. Proceed with one of the following:

■ Click the Set Home button in the Set Home Domain dialog.

■ Select File ➤ Set Home Domain in the Sun Management Center main console

window.

The Set Home Domain dialog is displayed.

2. Select the administrative domain you want to set as your home administrative
domain.

The selected administrative domain is highlighted.

3. Click the Set Home button.

You see the following message at the bottom of the Set Home Domain dialog.

When the home administrative domain has been set, the message changes.

4. Click the Close button.

The main console window is updated and the home administrative domain is

displayed.

At this time, you may want to populate your administrative domain. See

“Populating Administrative Domains” on page 20 for more information.

Setting Home Domain...Please wait

Home domain successfully set.
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FIGURE 2-1 Home Domain

Creating Administrative Domains

The Sun Management Center software enables you to create Sun Management

Center administrative domains with the Domain Manager window.

▼ To Select Domain Manager

● In the main console window, select File ➤ Domain Manager.

The Domain Manager is displayed (FIGURE 2-2).
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FIGURE 2-2 Domain Manager

Note – In the Domain Manager, some of the buttons are grayed out until you select

an administrative domain.

TABLE 2-1 Domain Manager Buttons

Button Description

Add Displays the Create Domain dialog.

Security Displays the Attribute Editor with the security tab selected for the

highlighted administrative domain.

Delete Deletes the selected administrative domain and all its members.

Go To Updates the main console window to display the selected

administrative domain. You may also “go to” an administrative

domain by double-clicking on it.

Reference Inserts the selected administrative domain into the current

administrative domain.

Set Home Domain Sets the selected administrative domain as the administrative

domain that is always displayed whenever the console is started.

See “To Set a Home Administrative Domain” on page 17 for more

information.
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▼ To Create Administrative Domains

1. Select File ➤ Domain Manager from the main console window.

The Domain Manager is displayed (FIGURE 2-2).

2. In the Domain Manager, click the left mouse button on Add.

The Create Domain dialog is displayed (FIGURE 2-3).

FIGURE 2-3 Create Domain Dialog

3. Type in the name of the new administrative domain in the Domain Name field.

4. If you do not want your administrative domain populated now, be sure the
Populate Now check box is turned off.

The default choice is for Sun Management Center software to display a dialog

enabling you to start the Discovery Manager immediately after creating an

administrative domain. For more information about the Discovery Manager, see

Chapter 4.

5. Click the Create button.

6. Create additional administrative domains or populate your administrative domain
manually.

If you do not have the right security permissions to create an administrative domain,

an error message is displayed. See Chapter 14 for more information on security.

Populating Administrative Domains

Once you have created your administrative domain(s), you can begin to populate

these domains (and their subordinate groups).

Note – To populate an administrative domain, you must have esdomadm

privileges. See “Sun Management Center Groups” on page 235 in for more

information.
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There are three methods to add hosts and other resources to an administrative

domain collection:

■ Populate with the Discovery Manager—see Chapter 4. Discovery Manager

searches the network for resources. This is the default method for populating a

newly created administrative domain. The search can be time-consuming, but you

can shorten the search by setting limits.

■ Populate with the Discovery Manager at scheduled intervals by using the

Scheduling feature—see “Starting the Discovery Requests Window” on page 52.

You can set the search to occur hourly, daily, weekly, or monthly. This feature

enables you to search periodically for new managed objects on the network.

■ Manually populate with the Create an Object menu—see Chapter 3. This method

enables you to add objects one at a time and is useful for adding a small number

of known resources. For example, if you have installed a new host, you can use

Create an Object to add the host to the local administrative domain immediately.

Managing Administrative Domains

Once you have created Sun Management Center administrative domains, you can

manage them.

Selecting Administrative Domains

You can list administrative domains through the Domain Manager window

(FIGURE 2-2) or the Sun Management Center main console window.

▼ To Select an Administrative Domain

1. Proceed with one of the following:

■ Select File ➤ Domain Manager in the main console window.

■ In the main console window, click the left mouse button on the Sun Management

Center Administrative Domains pull-down menu (FIGURE 2-4).

The current list of administrative domains is displayed.
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FIGURE 2-4 Sun Management Center Main Console Window with a List of Current
Administrative Domains

2. Click the left mouse button on the administrative domain you want to view.

The main console window is updated and displays the selected administrative

domain. The Sun Management Center Administrative Domains button changes to

display the name of the administrative domain you have selected.

Deleting Administrative Domains

You must have the appropriate security permission to delete an administrative

domain. For more information on Sun Management Center security, see Chapter 14.

▼ To Delete an Administrative Domain

Caution – Deleting an administrative domain also deletes all the members of that

domain.

1. In the Domain Manager window, highlight the name of the administrative
domain you want to delete.

2. Click the Delete button.

The Confirm Domain Deletion dialog is displayed.
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Note – There are two versions of the Domain Deletion dialog box. One is for any

administrative domain. The other is for the administrative domain you are currently

viewing. The latter deletion dialog is shown below.

3. Click Delete.

The Confirm Domain Deletion dialog displays the following message.

When the administrative domain has been successfully deleted, the dialog is

removed and the Domain Manager updates the list of administrative domains.

4. Click the Close button in the Domain Manager.

Monitoring Remote Administrative
Domains

Remote administrative domains are Sun Management Center administrative

domains created in a different Sun Management Center server context. See

Chapter 14 for a description of server context.

If you are interested in an object in a different server context, you can still monitor
the remote resource by referencing the remote administrative domain in your local

administrative domain. However, you are not able to manage the remote resource

unless you log out of your current Sun Management Center server context and log

into the remote server context. You can manage monitored properties on a resource

only if the agent on that resource sends event management information to the server

to which your console is connected. By default, Sun Management Center security

gives you “read-only” privileges for remote administrative domains. For more

information on security, see Chapter 14.

Note – You can reference a remote administrative domain to monitor resources in

that administrative domain. You cannot manage monitored properties on a remote

resource.

For example, your current Sun Management Center server context may be based in

the Headquarters administrative domain. A second, remote Sun Management Center

server context may be based in Regional Office 1. When workers are absent from

Deleting domain...Please wait.
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Regional Office 1, system administrators in Headquarters can monitor the regional

office administrative domains by referencing these remote administrative domains

in the Headquarters server context. If an emergency occurs, administrators in

Headquarters can notify a Regional Office 1 administrator immediately.

Note – Remote administrative domains enable you to monitor critical resources

continuously.

Here is an example of how remote monitoring works. In the following figure,

administrative Domain A is monitoring objects 1 and 2 (which are assigned to

Domain A) as well as remotely monitoring objects 3 and 4, which are assigned to

Domain B. Note that administrative Domain A cannot monitor objects 3 or 4 without

going through remote administrative Domain B.

FIGURE 2-5 Remote Administrative Domain

Caution – Do not create an administrative domain with a circular reference (to

itself).

For example, do not create an administrative domain (Domain A) which references

another administrative domain (Domain B) which in turn, contains a reference to

Domain A.)

FIGURE 2-6 Remote Administrative Domain - Circular Domain Reference

Domain A Domain B

Object 1 Object 2 Object 3 Object 4

Object 1

Domain A Domain B

Object 2 Object 3 Object 4
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If it is necessary for the two administrative domains to monitor each other, to avoid

creating a circular administrative domain reference, create a domain member (for

example, a group) under Domains A and B as shown below.

FIGURE 2-7 Remote Administrative Domains - Setting Up for Successful Cross-
Monitoring

Now when making a remote reference, Domain A can reference Group 2 under

Domain B, while Domain B can reference Group 1 under Domain A.

▼ To Set a Remote Administrative Domain

1. In the main console window, select File ➤ Remote Domain Manager.

The Remote Domain Manager dialog is displayed.

2. Type the name of the remote server in the Host field. If applicable, also type the
appropriate number in the Port field.

By default, the Topology manager is installed on the server on port 164.

3. Click the List Domains button.

A list of administrative domains on the remote server is displayed.

4. Click the administrative domain you want to reference.

The selected administrative domain is highlighted.

5. Click the Reference button.

The selected administrative domain is created as a reference domain in the currently

selected administrative domain in the main console window.

Domain A Domain B

Object 1 Object 2 Object 3 Object 4

Group 1 Group 2
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Attribute Editor for an Administrative Domain

The administrative domain Attribute Editor provides additional information about

the selected administrative domain and the rules governing its behavior. Use the

Attribute Editor to edit security information for the administrative domain.

Note – Each Attribute Editor displays one or more tab buttons, depending on the

type of Attribute Editor. The Attribute Editor that is displayed is dependent on the

selected object.

▼ To Set Security for an Administrative Domain

1. Proceed with one of the following:

■ Open the Attribute Editor for an administrative domain by clicking the right

mouse button on the domain icon and highlight Attribute Editor from the pop-up

menu in the hierarchy view.

■ Select File ➤ Domain Manager in the main console window. Then select an

administrative domain and click the Security button.
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FIGURE 2-8 Attribute Editor for an Administrative Domain

2. If not already selected, click the Security tab (FIGURE 2-8).

3. Type the name(s) of user and administrator groups in the appropriate fields.

See Chapter 14 for more information.

4. Complete this procedure with one of the following actions:

■ Click OK to accept the changes you have made and close this window.

■ Click Apply to apply your changes without closing this window.

■ Click Reset to reset the Attribute Editor to the default parameters.

■ Click Cancel to cancel your request.
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CHAPTER 3

Objects

This chapter describes how to create and monitor objects.

This chapter discusses:

■ To Create a Node

■ To Create a Module Object

■ To Create a Group

■ To Create a Composite Object

■ To Create a Segment

■ To Connect Objects

■ To Copy an Object

■ To Copy a Group of Objects

■ To Modify an Object

■ To Cut and Paste Objects

■ To Delete Objects

Sun Management Center objects represent parts (or nodes) of a network and include

hardware and software components such as hosts (workstations and servers),

printers, routers, modules, and so on. A segment of the network itself can even be an

object.

Note – For additional information, refer to your supplement. The supplement

contains important hardware-specific information about creating an object.

To monitor or manage an object, you create a node to represent it in an

administrative domain or group. If the group does not yet exist, you must first create

the group.

You can create and monitor or manage one or more administrative domains

containing nodes for multiple objects (such as the workstations and other devices

connected to the server). For information about administrative domains, see

Chapter 2.
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Creating a Node

You create nodes through the Edit pull-down menu in the main console window.

▼ To Create a Node

Note – An administrative domain must exist before you can create a node. To create

an administrative domain, see “To Create Administrative Domains” on page 20.

1. In the hierarchy view of the main console window, select the administrative
domain in which you want to create the new object.

Select the lowest level group of the administrative domain where the new object

should be created.

For example, if you want to create a node in a building that is in one of the

campuses of a administrative domain, then select the building in the administrative

domain as the lowest level group.

2. In the main console window, select Edit ➤ Create an Object.

The Create Topology Object window is displayed. By default the tab is set to Node

(FIGURE 3-1).
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FIGURE 3-1 Create Topology Object Window—Node Tab
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3. In the upper half of the Create Topology Object menu, set up the new node:

a. Click the Monitor Via button to see the pull-down menu, then select the
software or agent to monitor the new node.

There are seven categories of agents and monitors (TABLE 3-1). If an agent is not

available for your selected object, SNMP Ping usually works. If you do not select

an available agent or ping command, the creation fails.

TABLE 3-1 Types of Sun Management Center Monitoring

Type Description Effect

Agent – Host Monitor and manage a host that has an

active agent that is installed and

running.

The status of the agent on the host can be

monitored. The Details window of the Sun

Management Center agent host contains tabs

such as Info, Browser, Alarms, and so forth. The

Entity Polling Type in the Info tab is ahost .

Agent –

Platform

For more information, see your

supplement.

Agent - Module Monitor and manage a module that has

an active Sun Management Center agent

that is installed and running.

The status of the Sun Management Center

Module on the agent host can be monitored. The

Details window contains Info and Browser tabs.

The Entity Polling Type in the Info tab is amod.

SNMP Proxy Monitor and manage the device through

a Sun Management Center agent that is

running a Sun Management Center

proxy module for that device. (The

proxy module must have been

previously loaded into the agent by

using the Load Module dialog. See

Chapter 11.) Communication between

the Sun Management Center Topology

manager and the agent is SNMPv2 usec.

Communication between the Sun

Management Center agent and the

remote device is SNMPv1 or SNMPv2,

depending on the proxy module.

The Proxy Monitoring module data can be seen.

The Details window contains the Info and

Browser tabs. The Entity Polling Type in the

Info tab is aprox .
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Note – For information about creating an object for your specific platform, see the

supplement.

b. If applicable, select a type from the pull-down menu in the Type field. The
Type field displays only if SNMP Ping, ICMP Ping, or Non-monitored is
selected in the Monitor Via field.

c. If applicable, scroll and select an object in the Create Topology Object window.

For some types of monitoring, the right side of the Create Topology Object

window displays the set of icons for the object you have selected. The icons are

displayed in the hierarchy and topology views in the main console window when

the node is created.

SNMP Ping Monitor the device by using SNMP ping
command. The Sun Management Center

Topology manager communicates with

the device using SNMPv1. (There are no

management capabilities provided for

devices monitored by the SNMP ping
command.)

The availability of the SNMP agent on the

device can be monitored. The Details window

contains only the Info tab. The Entity Polling

Type in the Info tab is snmp.

ICMP Ping Monitor the device by using the Internet

Control Message Protocol (ICMP) ping
command. (There are no management

capabilities provided for devices

monitored by the ICMP ping
command.)

The accessibility of the device can be monitored.

The Details window contains only the Info tab.

The Entity Polling Type in the Info tab is ping .

Non-Monitored Created node is for display only. Its

status is not monitored.

No aspects of the device are monitored. The

Details window contains only the Info tab. The

Entity Polling Type in the Info tab is dummy.

TABLE 3-2 Choices Available in the Type Pull-Down Menu

Monitor by
Agent -
Host

Agent -
Platform

Agent -
Module SNMP Proxy SNMP Ping ICMP Ping Non-monitored

Type Server

Workstation

PC

Router

Printer

Concentrator

Server

Workstation

PC

Router

Printer

Concentrator

Server

Workstation

PC

Router

Printer

Concentrator

TABLE 3-1 Types of Sun Management Center Monitoring (Continued)

Type Description Effect
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d. (Optional) Create a unique new name in the Node Label field.

The default label is the host name.

e. (Optional) Type a description of the node.

4. In the lower half of the Create Topology Object window, type the requested
information.

The questions in the lower half of the window vary with the agent or monitor that

you selected in Step 4a, above. The Non-Monitored selection does not require further

information, but most agent or monitor selections ask you to enter:

■ Node host name

■ Node IP address

You can enter either the host name, the IP address, or both. If there is a conflict

between the host name and the IP address, the host name takes precedence.

Other agent or monitor selections may also ask for one or more of the following:

■ Sun Management Center agent port number (the default is 161)

■ Proxy host name and IP address

■ Read/write SNMP communities

■ Module name

5. Complete this procedure with one of the following actions:

■ Click OK to accept the changes you have made and close this window.

■ Click Apply to apply your changes without closing this window.

■ Click Cancel to cancel your request.

This message is displayed at the bottom of the Create Topology Object window:

■ If the request is completed successfully, the main console window is updated and

the new node is displayed.

■ If the creation fails, an error message is displayed at the bottom of the Create

Topology Object window. The cause of the error may be that you do not have

permission to create this node, or that you must start a Sun Management Center

agent on the node.

Creating Node... Please Wait.
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Note – If you are connected to one Sun Management Center server context and

create a node on another Sun Management Center server context, ownership of the

new node on the second server context defaults to the espublic identity instead of

your login identity. This situation is normal. The espublic identity is imposed for

security of transactions between Sun Management Center server contexts. For more

information, see “Sun Management Center Remote Server Access” on page 239.

If you want to make any changes to the new node, see “Modifying Objects” on

page 47.

Creating a Monitored Module Object

If you want to monitor one or more module objects on a number of hosts, you may

find it useful to create module objects for each host and place all of the modules in a

common location (that is, in the same group or administrative domain). The

procedure for creating a module object is similar to that for creating a node.

▼ To Create a Module Object

1. In the hierarchy view of the main console window, select the administrative
domain in which you want to create the new object.

2. In the main console window, select Edit ➤ Create an Object.

3. Select the Node tab in the Create Topology Object window.

4. Select Sun Management Center Agent – Module in the Monitor Via field
(FIGURE 3-2).
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FIGURE 3-2 Create Topology Object Window for Sun Management Center Agent –
Module

5. (Optional) Type a node label.

6. (Optional) Type a description.

7. Type a host name or IP address.

You can enter either the host name, the IP address, or both. If there is a conflict

between the host name and the IP address, the host name takes precedence.

8. If necessary, change the port number.

9. Click the List Modules button to display a list of modules that are currently
loaded on the host.

If the module that you want to use is not loaded, see “To Load a Module” on

page 171. If the module that you want to use is not enabled, see “To Enable a

Module” on page 178.

The module list is displayed (FIGURE 3-3).
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FIGURE 3-3 Module List

10. Select the module that you want to monitor and click OK.

The module list closes.

11. Complete this procedure with one of the following actions:

■ Click OK to accept the changes you have made and close this window.

■ Click Apply to apply your changes without closing this window.

■ Click Cancel to cancel your request.

Creating Groups

You can create two types of groups, General and IP-based. General groups are based

on geography (campus or building). IP-based groups are based on networks or

subnets.

Note – To create a group, you must have esdomadm privileges. See “Sun

Management Center Groups” on page 235 in for more information.

▼ To Create a Group

1. In the hierarchy view of the main console window, click the administrative
domain in which you want the new group.

Select (by clicking) a location in the administrative domain where the new group

should be created.

For example, if you want to create a group in a building that is in one of the

campuses of an administrative domain, then click the building icon in the

administrative domain.
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2. In the main console window, select Edit ➤ Create an Object.

The Create Topology Object window is displayed.

FIGURE 3-4 Creating a Group in the Create Topology Object Window

3. In the Create Topology Object window:

a. Click the Group tab (FIGURE 3-4).

b. Change the Type field, if desired (General or IP-Based).

c. Select the object type (Building, Campus, or General).

The right side of the window is updated with an icon corresponding to the object

type.

d. Create a new group Label.

e. (Optional) Type a description in the optional Description field.

f. For an IP-based group, specify the IP address and the subnet mask.
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Note – The creation of an IP-based group results in the creation of an empty

network or subnet “container” which you can populate using the Create Topology

Object window.

4. Complete this procedure with one of the following actions:

■ Click OK to accept the changes you have made and close this window.

■ Click Apply to apply your changes without closing this window.

■ Click Cancel to cancel your request.

If you selected OK or Apply, this message is displayed at the bottom of the Create

Topology Object window:

If the request ends successfully, the main console window is updated and the group

is displayed.

If the request fails, an error message is displayed at the bottom of the Create

Topology Object window. The cause of the error may be that you do not have the

right permission to create this group.

If you want to make any changes to the new group, see “Modifying Objects” on

page 47.

5. Add components to your group:

■ Use the Create Topology Object window. See “To Create a Node” on page 30.

■ Copy and paste objects from other groups into the new group. See “Copying

Objects” on page 44.

Creating a Composite Object

A composite object is a group of related objects that you want to monitor together.

This term refers to hardware with multiple instances of the Solaris operating

environment running inside a single chassis.

You create composite objects through the Edit pull-down menu in the Create

Topology Object window.

Creating group... Please Wait.
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▼ To Create a Composite Object

1. In the hierarchy view of the main console window, select the Sun Management
Center administrative domain in which you want to create the new composite
object.

Select the lowest level group of the administrative domain where the new composite

object should be created.

2. In the main console window, select Edit ➤ Create an Object.

The Create Topology Object window is displayed. By default the tab is set to Node.

3. Click the Composite tab in the Create Topology Object window.

The window changes to display settings available for composite objects (FIGURE 3-5).

FIGURE 3-5 Create Topology Object Window—Composite Tab

4. Select an object in the Create Topology Object window.

For some types of monitoring, the right side of the Create Topology Object window

displays the set of icons for the object you have selected. The icons are displayed in

the hierarchy and topology views in the main console window when the composite

object is created.
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5. Create a unique new name in the Label field.

6. (Optional) Type a description of the node.

7. In the lower half of the Create Topology Object window, type the requested
information.

■ SSP Hostname

■ SSP IP Address

■ Sun Management Center agent port number (the default is 161)

You can enter either the host name, the IP address, or both. If there is a conflict

between the host name and the IP address, the host name takes precedence.

8. Complete this procedure with one of the following actions:

■ Click OK to accept the changes you have made and close this window.

■ Click Apply to apply your changes without closing this window.

■ Click Cancel to cancel your request.

This message is displayed at the bottom of the Create Topology Object window:

■ If the request is completed successfully, the main console window is updated and

the new composite object is displayed.

■ If the creation fails, an error message is displayed at the bottom of the Create

Topology Object window. The cause of the error may be that you do not have the

permission to create this object, or that you must start a Sun Management Center

agent on the object.

Note – If you are connected to one Sun Management Center server context and

create an object on another Sun Management Center server context, ownership of the

new object on the second server context defaults to the espublic identity instead of

your login identity. This situation is normal. The espublic identity is imposed for

security of transactions between Sun Management Center server contexts. For more

information, see “Sun Management Center Remote Server Access” on page 239.

If you want to make any changes to the new object, see “Modifying Objects” on

page 47.

Creating Composite Object... Please Wait.
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Creating Segments

To complete your view of an administrative domain, you can include segments of

the networks linking the nodes in the administrative domain. A segment object is a

line in the hierarchy of the topology view.

▼ To Create a Segment

1. In the main console window:

a. In the left window, select a location in the administrative domain where the
new segment should be created.

The segment is created at the selected (highlighted) level.

For example, if you want to create a segment in a building that is in one of the

campuses of an administrative domain, then select the building in the

administrative domain.

b. In the main console window, select Edit ➤ Create an Object.

The Create Topology Object window is displayed (FIGURE 3-1).

2. In the Create Topology Object window:

a. Click the Segment tab (FIGURE 3-6).
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FIGURE 3-6 Segment Tab in the Create Topology Object Window

b. Change the Type field, if desired (Bus or Ring).

c. Select the object type.

The list of choices (Ethernet or IPX) changes with your selection in the Type field.

At the right in the Create Topology Object window is a window that displays

large and small icons corresponding to the type of object you have selected. The

icons are displayed in the topology view in the main console window when the

segment is created.

d. Type a new segment label.

e. (Optional) Type a description in the Description field.

f. Type the IP address for this segment.

g. Type a subnet mask for this segment.

3. Complete this procedure with one of the following actions:

■ Click OK to accept the changes you have made and close this window.

■ Click Apply to apply your changes without closing this window.
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■ Click Cancel to cancel your request.

This message is displayed at the bottom of the Create Topology Object window:

If the request is completed successfully, the Create Topology Object window closes.

The main console window is updated and the view is displayed.

If the request fails, an error message is displayed in the Create Topology Object

window.

If you want to make any changes to the new segment, see “Modifying Objects” on

page 47.

Connecting Objects

You can connect objects in the topology view.

▼ To Connect Objects

1. Select two objects in the topology view.

To select two objects, select the first object in the topology view. Hold down the Shift

key and click the second object using the mouse button.

2. Select Edit ➤ Create a Connection.

A link is displayed between the objects.

Copying Objects

To move an object from one location in the topology view to another, use the Edit

commands, Cut and Paste . (Sun Management Center 3.0 software does not support

drag and release as an operation for moving objects.) To copy an object into other

topology views (leaving the original object in its current location), use Copy instead

of Cut .

For example, you can create an administrative domain that contains some of the

objects that already exist in another administrative domain. To do this, create a new

administrative domain (see Chapter 2), then copy existing objects into the new

administrative domain as described in the following procedure.

Creating segment... Please Wait
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You can also copy a group (an object that contains other objects). In this case, the

software does not create an independent, completely new group. Rather, it creates a

symbolic link to the existing group. Thus every copy is a different “view” of the same
group.

Note – You can select multiple objects by using the mouse button while holding

down the Shift key.

For more information on the main console window, see Chapter 5.

Note – The copy, cut, and paste functions are available in the topology view. The

copy and cut functions are also available in a pop-up window by clicking your right

mouse button on the object.

▼ To Copy an Object

This procedure is for a single object. To copy a group, see “To Copy a Group of

Objects” on page 46.

1. In the main console window, select the existing object in the topology view.

2. At the top of the main console window, select Edit ➤ Copy in the pull-down
menu.

This message is displayed at the bottom of the main console window:

3. Open the destination group or administrative domain.

The destination group is displayed in the topology view.

4. At the top of the main console window, select Edit ➤ Paste.

The pasted object is displayed in the destination group or administrative domain,

and this message is displayed at the bottom of the main console window:

Copy successful

Paste successful
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▼ To Copy a Group of Objects

To copy objects that are in one group and paste the copies into another group:

1. In the topology view, select the objects to be copied.

To copy all objects in the topology view, select Edit ➤ Select All in the main console

window menu bar.

To copy two or more objects selectively:

a. Click the first object to select it.

b. On the keyboard hold down the Shift key and click one or more additional
objects.

2. Select Edit ➤ Copy in the main console window menu bar.

When the objects are copied, this message is displayed at the bottom of the main

console window:

3. In the hierarchy view, select (highlight) the new group or administrative domain
where the group is to be copied.

4. Select Edit ➤ Paste Into in the main console window menu bar.

Alternatively, you can click with your right mouse button on the destination

administrative domain and select Paste Into from the pop-up menu.

Caution – If you select Edit ➤ Paste (instead of Edit ➤ Paste Into), the objects may

be pasted into the wrong group. If this occurs, highlight the duplicate objects and

select Edit ➤ Delete Object/Connection.

Caution – When you copy a group in the Sun Management Center software, the

new copy (a symbolic link) is labelled with italic font. The italic font is a reminder

that this is a link. If you add or remove objects from this group, the original group

and all copies of the group are affected.

Note – An object in the cut (pre-move) state remains visible—and selected with

dashed lines—until it has been successfully pasted. If you change your mind and no

longer want to paste the object, you can remove it from the cut state by clicking on it

a second time.

Copy Successful
46 Sun Management Center 3.0 Software User’s Guide • November 2000



Modifying Objects

Once you have created or copied an object, you can change the object through the

Modify Object window. The changes affect only the description of the object (in the

Sun Management Center server database) and do not modify the object itself.

▼ To Modify an Object

1. Select the object in the main console window.

2. Select Edit ➤ Modify in the main console window.

The Modify Object window is displayed (FIGURE 3-7). (The appearance of the

window varies widely, depending on whether the object is a group, node, composite

object, or segment.) The following example shows how to modify a node.

FIGURE 3-7 Modify Object Window—Example for a Node
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3. Edit the characteristics as needed.

If you are modifying a group object, the available characteristics are:

■ Type: General or IP-Based

■ Object: Building, Campus, or General

■ Group Label

■ Description

■ IP Address (for IP-Based only)

■ Subnet Mask (for IP-Based only)

For a node, the available characteristics are:

■ Monitor Via: Sun Management Center Agent - Host, Sun Management Center

Agent - Module, Sun Management Center Agent - Platform, SNMP Proxy, SNMP

Ping, ICMP Ping, or Non-Monitored

■ Node Label

■ Description

■ (Additional characteristics such as host name, IP address, or port may be listed,

depending on the type of node.)

For a segment, the available characteristics are:

■ Type: Bus or Ring

■ Object: Ethernet or IPX for bus type, or FDDI for ring type

■ Segment Label

■ Description

■ IP Address

■ Subnet Mask

For a composite object, the available characteristics are:

■ Object

■ Label

■ Description

■ SSP host name

■ SSP IP address

■ Port

See your supplement for more information.

4. Click OK to save your changes, or Cancel to leave the characteristics unchanged.

Note – If the object you are modifying is a host,
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Cutting and Pasting Objects

Objects can be cut (to be moved) or deleted (permanently) from the topology view in

the main console window. An object that is cut is temporarily saved in memory and

can be immediately pasted into one or more areas. (Sun Management Center 3.0

software does not support drag and release as an operation for moving objects.) An

object that is deleted cannot be recalled. For instructions on deleting objects, see

“Deleting Objects” on page 50. For more information about the main console

window, see Chapter 5.

Cut and paste functions work the same for all kinds of objects (hosts, modules, and

groups).

Caution – Do not use the cut function to delete objects. This function should only

be used to move objects. To delete an object, use Edit ➤ Delete in the main console

window. See “Deleting Objects” on page 50.

▼ To Cut and Paste Objects

1. Select an existing object in the topology view.

If you have not selected an object, the Cut and Delete functions are grayed out.

2. Select Edit ➤ Cut in the main console window.

A dashed line is displayed around the selected object. (The object does not

immediately disappear. This allows objects, such as processes which should not be

interrupted, to continue running until they are pasted into a new location.) The

object remains visible until it has been successfully pasted.

Note – You can cancel a Cut operation by clicking on the object a second time.

When the Cut operation succeeds, this message is displayed at the bottom of the

main console window:

3. Navigate to the destination location in the topology view.

4. Select Edit ➤ Paste. The object is displayed in this location and is removed from
the previous location.

Cut successful
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Deleting Objects

The Edit ➤ Delete command removes an object completely. To move an object to

another location, see “To Copy an Object” on page 45 or “To Cut and Paste Objects”

on page 49.

For more information on the main console window, see Chapter 5.

▼ To Delete Objects

Note – To delete an administrative domain, use the delete command in the Domain

Manager window; see “Deleting Administrative Domains” on page 22.

1. Select an existing object in the topology view.

If you have not selected an object, the Delete function is grayed out.

2. Select Edit ➤ Delete Object/Connection from the top of the main console window.

You are prompted to confirm or cancel the deletion.

If the Delete operation succeeds, the object is removed, and this message is

displayed at the bottom of the main console window:

Delete successful
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CHAPTER 4

Discovery Manager

You can use the Discovery Manager to populate administrative domains

automatically. For example, automatically populating administrative domains is

very useful if you have a large network. To add members manually with the Create

Topology Object window, see Chapter 3.

The following topics are described in this chapter:

■ To Start the Discovery Requests Window

■ To Initiate a Discovery Request

■ To Customize a Discovery Request

■ To Modify a Discovery Request

■ To Start, Stop, or Delete a Discovery Request

The Discovery Manager can find or “discover” hosts, routers, networks, and subnets

(see “Overview of IP Addressing” on page 509). The Discovery Manager also

discovers objects where a Sun Management Center agent is configured to a different

server context (see “Sun Management Center Server Context” on page 239).

The Discovery Manager can also find and group topology objects which are related;

either to a single hardware platform/chassis or a group of cooperating hardware

platform/chassis. This discovery and grouping allows convenient management of

the related objects and is described in the add-on supplement for those machine

architectures which have this grouping requirement.

Note – For additional information, refer to your supplement. The supplement

contains important platform-specific information about discovering objects.

You can create one or more discovery requests. Each request runs as a separate

process and populates the administrative domain with the objects that it has

discovered.

You can also schedule requests to run periodically and look for new hosts.
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Starting the Discovery Requests Window

To begin a Discovery Request, start the Discovery Requests Window.

▼ To Start the Discovery Requests Window

Start the Discovery Requests window in one of two ways:

■ When you create an administrative domain in the Create Domain dialog

(FIGURE 2-3) the Populate Now option is selected by default.

If you click Create in the Create Domain dialog while the Populate Now option is

selected, a dialog window enables you to start the discovery process immediately.

For more information on creating administrative domains, see Chapter 2.

■ Select the administrative domain in the Sun Management Center Administrative

Domains pull-down menu. then select Tools ➤ Discover in the main console

window (FIGURE 4-1).

FIGURE 4-1 Tools Pull-down Menu

The Discovery Requests window is displayed (FIGURE 4-2).
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FIGURE 4-2 Discovery Requests Window

The Discovery Requests window displays information containing the fields in

TABLE 4-1.

TABLE 4-1 Discovery Requests Window Fields

Field Description

Name A name which you create for the request. You can have multiple

requests with the same name.
Chapter 4 Discovery Manager 53



The Discovery Requests window has the buttons listed in TABLE 4-2.

Initiating a Discovery Request

You can discover hosts by using the ping command or by using routing tables.

Scheduled “Yes” if the request is scheduled, “No” if not scheduled

Status Reflects the current state of the discovery request. The states may

be:

1. New. A new request was added but has never been processed.

2. Queued. A request has been sent to the server but processing has

not yet started.

3. Running. The request is currently being processed.

4. Succeeded. The request has been successfully processed.

5. Failed. Processing of the request has failed.

6. Stopped. The user has stopped the process.

7. 0 Host found. The request did not find any hosts that passed the

filter limits.

TABLE 4-2 Discovery Requests Window Buttons

Button Description

Add Click this button to create a new Discovery Request through the

New Discovery Request window (FIGURE 4-2).

Modify Select a Discovery Request and click this button to make changes.

Duplicate Select a Discovery Request and click this button to create a copy of

the request.

Delete Select a Discovery Request and click this button to delete the

request.

Start Select a Discovery Request that is not running and is not scheduled

to run at a different time, and click this button to start the request.

Stop Select a Discovery Request that is running and click this button to

stop the request.

Log Select a Discovery Request and click this button to see a log of the

results generated from the selected discovery request runs.

TABLE 4-1 Discovery Requests Window Fields

Field Description
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Note – Currently the Discovery feature is supported only for administrative

domains and not for any subordinate groups. You can add requests only for an

administrative domain.

Note – Read Appendix C before initiating a discovery request using routing tables.

Appendix C explains the basic concepts of routing, network classes, and netmasks.

Note – For additional information, refer to your supplement. The supplement

contains important platform-specific information about discovering objects.

▼ To Initiate a Discovery Request

1. Click the Add button in the Discovery Requests window.

The New Discover Request window is displayed (FIGURE 4-3). The Discover tab is

highlighted by default.

Tip – You can copy an existing discovery request by highlighting the existing

request and clicking the Duplicate button. To edit the settings for the new discovery

request, see “Modifying a Discovery Request” on page 65.
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FIGURE 4-3 New Discover Request Window

2. (Optional) Type a new name for your discovery request in the Request Name
field.

Multiple requests are listed in the Discovery Requests window, enabling you to

select a request and edit the related search pattern.

3. In the Discover Using field, select the method that should be used for discovering
the network (Ping or Routing Table).

■ If you selected Ping, type the start and end IP addresses and netmask (FIGURE 4-3).

The discovery process uses the Ping command and searches for hosts and routers

in the specified IP address range. It then places the hosts in the appropriate

networks and subnets based on the netmask.

■ If you selected Routing Table, type the number of hops (the number of routers a

packet goes through before reaching its destination).

The discovery process starts from the Topology manager/ Sun Management

Center server host and goes through the specified number of hops to report

subnets and hosts n hops away. The number of hops limits the “distance” of

destination hosts from the host on which the Topology manager or Sun

Management Center server is running.
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Note – Routing Table discovery requests require that you run an SNMP agent at

port 161. This can be a Sun Management Center agent, snmpdx , or any SNMP agent

provided by your network management package.

For more information on routing tables, see Appendix C.

4. Click the OK button to start the discovery process, or go to the other tabs in this
window to customize your discovery request. See “Customizing Your Discovery
Request” on page 58.

When you start the discovery process:

■ The discovery process discovers all nodes that are running the Sun Management

Center agent. The discovery process includes agent nodes that belong to another

Sun Management Center server context. That is, nodes that are running Sun

Management Center agents in a remote Sun Management Center server context

are ignored.

■ Nodes that are not running a Sun Management Center agent are listed as ping

hosts.

■ The discover process discovers all nodes running an SNMP agent, where the

nodes are not connected to any Sun Management Center server. The information

gathered for SNMP agents is very limited.

Note – Each discovery request is assigned a Request ID. This ID is an unique Sun

Management Center internal identifier of the request. Therefore, the Request IDs are

not in sequential order. The Request ID displays in the Request Details portion of the

Discovery Requests Window.

Note – If a host is extremely busy, a discovery process that is gathering data for that

host may time out. If a timeout occurs for a host that is a Sun Management Center

agent, the host is reported as a ping host. If this happens, you may want to increase

the SNMP timeout period. See ““Customizing Your Discovery Request” on page 58”

for more information.

5. If a Sun Management Center server or agent is incorrectly reported to be a ping
host, create a new icon by re-running discovery with larger timeout and retry
values.
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Customizing Your Discovery Request

You can customize your new discovery request by clicking on one of the four tabs on

the New Discover Request window. The tabs are labeled Discover, Preferences,

Filters, and Scheduling. TABLE 4-3 summarizes the tabs and the options for these tabs.

(If you want to change an existing Discovery Request, see “Modifying a Discovery

Request” on page 65).

TABLE 4-3 Summary of Discovery Variables

Variable Definition

Discover

Request Name Descriptive name for this request, for example, “My Lab.” This name is

optional.

Discover Using Ping: Sweeps all addresses within the range specified by a Start IP

Address, an End IP Address, and netmask. Routing Table: Discovery

Manager consults the routing table of the Sun Management Center server

and determines its address, subnet address, and router(s). It proceeds from

there to discover more routers, networks, and subnets.

Start IP Address

End IP Address

These parameters apply to ping discovery requests. They specify the

address range within which the Discovery Manager tries to find hosts and

routers.

Netmask This parameter applies to ping discovery requests. It is used to segment

networks into subnets.

To find out if your network is subnetted and the value of the netmask,

check the /etc/netmasks file or the name service maps if you are using

NIS (network information service) or DNS (domain name service).

Port Port 161 is the default setting for Sun Management Center objects. The

Discovery Manager also tries an alternate port that you can specify in the

Also Check Port field. If neither port responds, the Discovery Manager

concludes that the object is not running a Sun Management Center agent.

Preferences

Logging

Log discover request progress? Setting this flag enables logging for that request. The discovery process

places the log files in the /var/opt/SUNWsymon/cfg/discover
directory. There is one log file per user-administrative domain. Currently,

this directory is used for debugging only.

Ping

Timeout (sec.) Amount of time (in seconds) that the Discovery Manager should wait for a

response to a ping request before timing out.
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Retries Number of times the Discovery Manager should send a ping request

before giving up.

SNMP

Timeout (sec.) Amount of time that the Discovery Manager should wait for a response to

a SNMP request before timing out.

Retries Number of times the Discovery Manager should attempt a SNMP request.

Community String One or more strings separated by the pipe (|) character. The default value

is public.

General

Maximum Hosts Maximum number of hosts that should be discovered.

Maximum Time (sec.) Maximum amount of time (in seconds) of the discovery process in real

time.

TABLE 4-3 Summary of Discovery Variables (Continued)

Variable Definition
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▼ To Customize a Discovery Request

You can specify limits for the New Discover Request window through the

Preferences and Filters tabs. You can also schedule the new discovery request to run

periodically through the Scheduling tab.

1. Click the Preferences tab.

The New Discover Request Preferences window is displayed (FIGURE 4-4).

Filters

Criteria

Select Filter Criteria

Host Name or Label

Operating System

Platform Type

Modules

Filter by host name, operating system, or platform type. Filtering uses the

grep command to search for the supplied value.

Filters This field remains blank until you select a filter criteria. The contents of

this field vary according to your selection(s). You can choose to include or

exclude values in the filtering process. For host names, you specify names

and wildcard characters. For operating systems and platform types, you

select from pull-down menus.

Scheduling

Discover new hosts periodically? If selected, then the specified discovery request is scheduled to run at the

specified start time and frequency.

Settings

Start Time (hh:mm) Specify the time (between 00:00 and 23:59) when discovery should be

started.

Frequency In the pull-down menu, select Hourly, Daily, Weekly, or Monthly.

Day of Week In the pull-down menu, select the day when discovery should run.

Day of Month (1..28) Specify the (numerical) day of the month when discovery should run. You

cannot enter a day unless you have selected Monthly as the frequency.

TABLE 4-3 Summary of Discovery Variables (Continued)

Variable Definition
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FIGURE 4-4 New Discover Request Preferences Window

2. Type your selections in the Logging, PING, SNMP, and General fields.

TABLE 4-3 lists the variables in the New Discover Request Preferences window.
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3. Click the Filters tab.

The New Discover Request window is displayed (FIGURE 4-5).

FIGURE 4-5 New Discover Request Window
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4. Click a checkbox to include host names, operating system, platform type, or
module in the filter process.

In TABLE 4-4, below, you will find a list of the buttons under the Filters tab.

By default, the options on this tab are greyed out. If the checkbox next to an option

is checked, the buttons become activated. For example, if you check Modules, you

can use the scrollable menu to highlight a loaded module. You can then choose

whether you want to include or exclude this module in the filter, and then add it to

the field next to the Add and Delete buttons.

5. Once you have defined the filter, click the OK button to confirm your selection.

You can now set filters in one of the following ways:

■ The Filters tab in the New Discovery Request window

■ Filter Manager under the Tools menu option in the console window

Note – If you use a filter, the discovery finds only hosts running the Sun

Management Center agent.

6. Click the Scheduling tab.

The New Discover Request Scheduling window is displayed (FIGURE 4-6).

TABLE 4-4 Buttons under Filters Tab

Button Description

Include Enables a feature be included in the filter process.

Exclude Enables a feature to be excluded during the filter process.

Add Enables a feature to be added to the filter process.

Delete Enables a feature to be deleted from the filter process.

OK Confirms your actions

Close Closes this window.
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FIGURE 4-6 New Discover Request Scheduling Window

7. If you want to schedule automatic discoveries, click the button for “Periodically
discover new hosts?” and customize the settings in the Settings area of the
window.

8. When you have finished your edits, click OK to save the new discovery request, or
click Cancel to cancel your changes.

If you click OK and you have not selected Periodically discover new hosts in the

Scheduling tab, a pop-up dialog is displayed, offering several choices for running

the new discovery request.

■ To save the discovery request and begin running it periodically at the scheduled

times, click Yes.

If your discovery request has already been scheduled, no confirmation dialog

window will appear.
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■ To save the discovery request, but not schedule it to run, click No.

■ To cancel the new discovery request without saving it, click Cancel.

9. Click Close to exit the window.

Modifying a Discovery Request

If you have previously created a periodic discovery request, you can change the

search patterns for that discovery request through the Discovery Requests window

(FIGURE 4-2).

▼ To Modify a Discovery Request

1. Select Tools ➤ Discover in the main console window (FIGURE 4-1).

The Discovery Requests window is displayed.

2. Find and select the name of the discovery request you want to modify.

3. Click the Modify button.

The Edit Discover Request window is displayed. As confirmation, the top bar of the

window displays the ID of the request and the Description field displays the name

of the request.

4. Select the Discover, Preferences, Filters, and Scheduling tabs and in turn, change
settings as needed.

5. Complete this procedure with one of the following actions:

■ Click OK to accept the changes you have made and close this window.

■ Click Cancel to cancel your request.

If you click OK, a pop-up dialog is displayed, offering several choices for running

the modified discovery request.

6. Exit from the window:

■ To start the discovery request and run it immediately, click Yes.

■ To schedule the discovery request, but not run it immediately, click No.

■ To cancel the running of the discovery request entirely, click Cancel.
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Starting, Stopping, or Deleting a
Discovery Request

If you have previously created a discovery request, you can start, stop, or delete it

through the Discovery Requests window (FIGURE 4-2).

▼ To Start, Stop, or Delete a Discovery Request

1. Select Tools ➤ Discover in the main console window (FIGURE 4-1).

The Discovery Requests window is displayed.

2. Select the name of the discovery request you want to modify.

3. Click the Start, Stop, or Delete button to start, stop, or delete a request,
respectively.
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CHAPTER 5

Sun Management Center Software
Main Console Window

The following topics are described in this chapter:

■ To Use the Main Console Window Menu Bar

■ To Search For a Name

■ To View the Current List of Administrative Domains

Main Console Window

The main console window (FIGURE 5-1) is the primary user interface. It provides:

■ Visual representations of the managed objects (for example, hosts and networks)

■ Ability to manipulate attributes and properties associated with the managed

objects (for example, create alarm threshold conditions).

The features shown in FIGURE 5-1 are described in this chapter.
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FIGURE 5-1 Main Console Window

Administrative Domain View

Once you have created an administrative domain and have populated it with objects

(groups and hosts, and so forth), you can see the administrative domain and its

objects in the hierarchy (tree) view and the topology (regional) view of this

administrative domain.

Menu Bar

Forward

Home
Up

Search

Hierarchy View Topology View

Domain Status

About Sun
Help

Back

Summary

Management
CenterTool Tip
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The administrative domain view enables you to build collections of objects that

support your monitoring and management tasks. You can group your host sets by

buildings, subnets, or other group objects. You can selectively view all objects (such

as hosts, routers, and servers) in the administrative domain, or selected objects (such

as the servers) that support a specific function that interests you.

The Domain view shows you the objects contained in an administrative domain; the

administrative domain itself, and any groups and hosts contained in that

administrative domain.

FIGURE 2-1 illustrates an example of an administrative domain. In this example,

Payroll Servers 1 represents an administrative domain that consists of all the host

machines in the Payroll office. The host machines are found in two geographic sites,

Campus A and Campus B. Campus B has one building (Building B), which contains

two host machines, Payroll 1 and Payroll 2.

You may choose to create a similar type of administrative domain, and you can

group your machines by subnet, rather than by building. You should create a

administrative domain and its subordinate groups in a hierarchy that best supports

your monitoring activities.

For more information on administrative domains, see Chapter 2.

The main console window displays two views of an administrative domain and its

members. The left side of the administrative domain view is the hierarchy (tree)

view and the right side is the topology view.

■ Hierarchy tree

The hierarchy tree view displays the relationship between a administrative

domain and its members. Some objects in the hierarchy view contain other objects

which can be a group of objects or a single object. Some objects are both.

In FIGURE 2-1, Building B is an object contained in the administrative domain

named Headquarters, but is also a group itself. Building B contains the network

194.150.151.52, the subnet mpk12-238-n, GroupA, and hosts machineA and

machineB.

For more information, see “Hierarchy View” on page 69.

■ Topology view

The topology view displays the member(s) of an object selected in the hierarchical

tree.

For more information, see “Topology View” on page 71.

Hierarchy View

Two types of windows contain hierarchy views:

■ Domain view in the main console window (FIGURE 5-1)
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■ Browser view in the Details window (FIGURE 13-1)

The administrative domain hierarchy view displays the administrative domain and

its members.

The Browser hierarchy view displays the host and its modules. This view is part of

the Browser Details window (Chapter 6).

Both the administrative domain hierarchy view and the Browser hierarchy view

behave in the same manner. In both windows, the hierarchy view is on the left side

of the window.

The mouse actions in the hierarchy view are summarized in TABLE 5-1.

▼ To Obtain Specific Information About the Hierarchy View

If an object has an expansion/compression next to it, there are additional levels of

information that are hidden. You can obtain more information about the object by

examining its subordinate objects. To obtain specific information about subordinate

objects, complete the step in one of the following methods.

Method 1

● Click on the expansion/compression icon next to the object to “unroll” the tree
branch.

The icon changes to a darker color, and the subordinate objects are displayed.

TABLE 5-1 Mouse Actions in the Hierarchy View

Mouse Action Result

Click with left or right mouse button on the

expansion/compression icon next to the object

“Expands” (opens) details or “collapses” (closes)

details of the selected object.

Double-click with the left mouse button on an object

icon

For a host object, starts the Details window or moves

the Details window to the foreground if it is already

open. For an administrative domain or group object,

unrolls or rolls details of the selected object. Also, the

topology view is updated with the members of the

selected object.

Click with the left mouse button on object icon Displays the members of the selected object in the

topology view. However, if the object icon is a host

(in the main console window), then the Details

window is displayed.

Click with the right mouse button and hold on the

object label

Pop-up menu is displayed. See “Pop-up Menu” on

page 72 for more information.
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Method 2

● Double-click with the left mouse button on the object icon or the label.

▼ To Obtain General Information About the Hierarchy View

If an object has a compression icon next to it, lower levels of the hierarchy are

currently displayed (in most cases). You can obtain information about the container

object by “rolling up” (hiding) the lower levels. To obtain general information about

a container object, complete the step in one of the following methods.

Method 1

● Click on the expansion/compression icon next to the object to “roll up” the tree
branch.

The group (container) object is displayed.

Method 2

● Double-click with the left mouse button on the object icon or the label.

Topology View

The topology view displays the members of the object selected in the hierarchy view.

There are two types of windows that contain topology views:

■ Domain view in the main console window (FIGURE 5-1).

■ Browser contents view in the Details window (Chapter 6).

Both the administrative domain and browser contents views behave in the same

manner.
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The mouse actions in the topology view are summarized in TABLE 5-2.

Tool Tip

As you move the mouse over various areas in the main console window, tool tips are

displayed momentarily. A tool tip is a description of the selected object or a

description of a property and value column of any data property table (Chapter 7).

Property tables provide information about the monitored property and are described

in Appendix D.

▼ To See a Tool Tip

● Place your mouse over an object.

After a brief delay, a tool tip is displayed that provides a short description of that

object (FIGURE 5-1).

Pop-up Menu

Pop-up menus are available for all objects in the hierarchy and topology views. The

contents of a menu vary according to the capability of the object selected.

▼ To Access a Pop-Up Menu

1. Click the right mouse button on the object.

The pop-up menu is displayed.

TABLE 5-2 Mouse Actions in the Topology View

Mouse Action Result

Double-click with the left mouse

button on the icon

Opens details about the selected object. However, if the object is a

host (in the main console window), then the Details window is

displayed.

Click with the left mouse button on the

icon

Selects icon.

Click with the right mouse button and

hold on the icon

Pop-up menu is displayed. See “Pop-up Menu” on page 72 for more

information.
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2. Click the left button to select a menu item (TABLE 5-3).

The following table lists common items in the approximate order in which they are

displayed in the pop-up menus. Some items are not displayed in all menus.

Note – Depending on the object you selected, all the pop-up menu items listed in

TABLE 5-3 may not be displayed.

Menu Bar

The menu bar is at the top of the main console window (FIGURE 5-1).

Select (highlight) an object by clicking it in the hierarchy or topology view, then click

a menu name (File, Edit, View, Go, or Tools). If a menu name is grayed out, that

option is not available for the object that you have selected.

TABLE 5-3 Common Pop-Up Menu Items

Menu Item Description

Cut Cuts the selected object. The cut object is enclosed in a dashed box

until it is pasted into a new location. To cancel the cut operation,

click on the object.

Copy Copies the selected object.

Rename Displays the Rename Object window.

Modify Displays the Modify Object window.

Attribute Editor Displays the Attribute Editor. For information about editing an

administrative domain, see Chapter 2. For information about

editing a host, see Chapter 9. For information about editing a

module, see Chapter 11. For information about editing security, see

Chapter 14.

Load Module Displays the Load Module dialog. For more information on the

Load Module dialog, see “To Load a Module” on page 171.

Details Displays the Details window. For more information on the Details

window, see Chapter 13.
Chapter 5 Sun Management Center Software Main Console Window 73



▼ To Use the Main Console Window Menu Bar

The menus are of the pull-down style.

1. Click an entry in the menu bar to display a pull-down menu.

2. Click an entry in the pull-down menu to initiate that action.

The menus in the menu bar are described below.
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File Menu Options

Edit Menu Options

TABLE 5-4 Options for the File Menu

Option Description

Domain Manager The Domain manager enables you to create your

administrative domain(s). For more information on Domain

Manager, see Chapter 2.

Remote Domain Manager For more information on Remote Domain Manager, see

Chapter 2.

Set Home Domain Sets your home administrative domain.

Sun Management Center-

Console Messages

Opens the Sun Management Center-Console Messages

window. The window displays messages generated by the

Sun Management Center application, but does not include

general UNIX messages.

Exit Exits the current console session and all related Sun

Management Center windows. A pop-up dialog asks you to

confirm the exit request.

TABLE 5-5 Options for the Edit Menu

Option Description

Create an Object Creates a group, a composite object, a node, or a network

segment in the administrative domain that is currently

highlighted in the console window. See Chapter 3.

Create a Connection Connects two objects in the topology view. You may choose the

type of connection to be General, RS-232, T1, or T3. The

connection is represented by a line between the objects.

Delete Object/Connection Deletes the highlighted object or connection. A dialog asks you

to confirm the deletion request.

Rename Enables you to rename the highlighted object. Displays a dialog

for you to enter the new name.

Modify Brings up the Modify Object menu. For more information on

the Modify Object menu, see “Modifying Objects” on page 47.

Cut Displays a dashed line around the selected object. The object is

not removed until you paste it into a new location.

Copy Copies the selected object into a temporary buffer.
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View Menu Options

Paste Pastes the cut or copied object into the administrative domain

or group that is currently displayed in the hierarchy or the

topology view.

Paste Into Pastes the cut or copied object into the selected administrative

domain or group.

Select All Selects all objects in the topology view.

TABLE 5-6 Options for View

Option Description

Topology Layouts Enables you to change the style of display in the topology view. The

styles are:

Network,

Grid (square grid pattern),

List (single vertical list),

Bus,

Star (equidistant lines connected to a center),

Spoked Ring (equidistant lines in a circle).

Set Topology

Background

Displays the Set Topology Background window. You can add a

background image to a topology view by selecting from a list of

graphics files. (The list may not be in alphabetical order.) You can

also use this window to remove a background image by clicking the

Unset button.

TABLE 5-5 Options for the Edit Menu (Continued)

Option Description
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Go Menu Options

Tools Menu Options

TABLE 5-7 Go Menu Items

Menu Item Action

Back Takes you to the previous console view. This option performs the

same function as the Back navigation button on the toolbar.

Forward Takes you to the next console view (if applicable). This option

performs the same function as the Forward navigation button on

the toolbar.

Home Takes you to the top of your home administrative domain in the

hierarchy view. This option performs the same function as the

Home navigation button on the toolbar.

Up Takes you up one level in the hierarchy view. This option performs

the same function as the Up navigation button on the toolbar.

History Lists recent locations that you have viewed in the current console

session. Select an entry to return to that location.

Search Opens the Topology Search window to search for the object label

that you specify. If one or more objects are found, the full path or

paths are displayed. This option performs the same function as the

Search navigation button on the toolbar.

TABLE 5-8 Tools Menu Items

Menu Item Action

Details Enables you to see detailed information (if available) for a selected

object. For more information about the Browser Details window, see

Chapter 6. For more information about the Details Alarm window,

see Chapter 12. For more information about the remaining

categories in the Details window, see Chapter 13.

Attribute Editor Displays the Attribute Editor. For information about editing an

administrative domain, see Chapter 2. For information about

editing a host, see Chapter 9. For information about editing a

module, see Chapter 11. For information about editing security, see

Chapter 14.

Graph Displays the Open Graph window. You can select from a list of

saved graphs. For information on the graphing function, see

Chapter 7.
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Navigation Buttons

As you move through different administrative domains and through different levels

within the administrative domains, the administrative domain views are stored in

memory. The navigation buttons (FIGURE 5-1) in the main console window help you

move back and forth between these views.

Note – The navigation buttons perform the same function as the Go menu items.

Discover Enables you to search for objects in a geographical location. For

information about the Discovery Requests window, see Chapter 4.

Load Module Enables you to load a Sun Management Center module for a

selected object. For information about the Load Module window,

see Chapter 11.

Dataview Manager Enables you to create customized data property tables and can be

created for one type of data from several different hosts or different

types of data from one host.

Group Operation Enables you to manage an object group, which is a named collection

of objects with an optional filter.

Topology Export Enables you to export data between different topology servers.

Topology Import Enables you to import data between different topology servers.

Telnet Enables you to launch Telnet. The Telnet application is displayed in

a separate window. The application has no further interaction with

the Sun Management Center software (except that you are able to

launch it from within the Sun Management Center software for

your convenience.)

TABLE 5-8 Tools Menu Items

Menu Item Action
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▼ To Search For a Name

1. On the console, click the Search icon (FIGURE 5-1).

The Search window is displayed (FIGURE 5-2).

TABLE 5-9 Navigation Buttons

Button Description

Back Button The back button is represented by an arrow facing left (FIGURE 5-1).

Clicking this button displays the previous screen.

Forward Button The forward button is represented by an arrow pointing right

(FIGURE 5-1). Clicking this button displays the next screen.

Home Button The home button is represented by a house (FIGURE 5-1). Clicking

on this button returns you to the highest level of the administrative

domain.

Up Button Clicking the up button enables you to navigate up one level in the

topology view.

Search Button The search button enables you to search for a text string in the

current domain.

Help Button Clicking the Help button (FIGURE 5-1) displays the online Sun

Management Center 3.0 Software User’s Guide.
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FIGURE 5-2 Search Window

2. Type the name or part of the name in the Object Label: field and click the Search
button.

A list of matching names is displayed in the Search Results section.

3. Highlight the appropriate name and click on the Go To button.

The topology view of the main console window is updated and the object with the

selected name is highlighted.

Sun Management Center Administrative
Domains Pull-Down Menu

The Sun Management Center Administrative Domains pull-down menu is shown in

FIGURE 2-6. This menu displays the current list of administrative domains and

enables you to switch from one administrative domain to another. Clicking on the

administrative domain updates and displays the selected administrative domain.

The default administrative domain is the administrative domain that is always

displayed whenever the main console is started.
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▼ To View the Current List of Administrative

Domains

1. In the main console window, click the Sun Management Center Administrative
Domains button.

The pull-down menu with the current list of administrative domains is displayed.

2. Click the administrative domain that you want to view.

The main console window is updated and displays the selected administrative

domain. The Sun Management Center Administrative Domains button changes to

display the name of the administrative domain you have selected.

Administrative Domain Status Summary

The administrative domain status summary displays the number of managed objects

that have unacknowledged open alarms, by level of severity, in the selected

Administrative Domain. (FIGURE 5-3).

Note – If a host has multiple alarms at several different severity levels, the host is

represented at only one severity level (the highest severity level for that host).

For more information on the administrative domain status summary, see “To Access

Alarms From the Main Console Window” on page 190.

FIGURE 5-3 Domain Status Summary
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CHAPTER 6

Browser

This chapter describes the following topics:

■ To Start the Details Window

■ To Exit the Details Window

■ To Enable the Alarms Filter

■ To Set Security for a Host or Module

Details View

The details view is a subset of the Domain view. The highest hierarchical object in a

details view is the host machine or module object. For more information on module

objects, see “To Create a Module Object” on page 35. Unlike the administrative

domain view, the details view enables you to see modules and the various

monitored properties and statistics contained in the modules.

Using the Details Window

You can start the Details window from the main console window.

The Details window provides you with detailed information about that individual

host. This window has several tab buttons, that may include the following:

■ Info

■ Browser

■ Alarms

■ View Log

■ Applications
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■ Hardware

Note – The tab buttons that are displayed in the Details window are dependent on

the type of object selected. In addition, the Hardware tab is missing if the

Config-Reader module is not supported on your system. For additional information

on the tabs for your specific hardware object, see your supplement.

Each tab button, as described in the following table, updates the window with a new

panel consisting of information represented by that tab button.

For more information on these buttons, see Chapter 13.

TABLE 6-1 Details Window—Common Tab Buttons

Tab Button Description

Info Provides general information about the host including host name,

IP address, polling type, and so on. This information is collected at

the time the object is created.

Browser Enables you to navigate through the hierarchy and contents views

of the host, set alarm thresholds, and view and graph monitored

data properties. This is the default view when the Details window

opens.

Alarms Displays the alarms for this host. Enables you to acknowledge or

delete alarms.

Modules Displays available modules, which modules are loaded, scheduled,

and enabled, and whether the modules are multi-instance modules.

Enables you to change the status of these module parameters.

View Log Displays informational messages, including error messages, about

your host. Enables you to search, monitor, and examine system, Sun

Management Center, and other log messages.

Applications Displays a list of applications. These applications include the

processes running on the host (if the Solaris Process Details module

is loaded) and other applications installed by the user. Depending

on your licensing agreement, this tab also provides access to the

Hardware Diagnostics Suite software. You can display the

Hardware Diagnostic Suite online help text by selecting the

Hardware Diagnostic Suite link, and then clicking the Help button.

Hardware Displays hardware configuration information about your host for

selected hardware platforms. Configuration information may

include the physical and logical view of your host. If the hardware

platform is not supported by the Config-Reader module, this tab

button is missing in the Details window.
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▼ To Start the Details Window

● Proceed with one of the following:

■ Click the right mouse button on the selected object and highlight Details from the

pop-up menu in the hierarchy view (FIGURE 6-1) or the topology view.

■ With your left mouse button, double-click on the selected host icon in the

hierarchy view or the topology view.

■ In the main console window, select the object then select Tools ➤ Details

(FIGURE 4-1).

Be sure to select a managed object, not a administrative domain, as the Details

window is not available for administrative domains.

The Details window (with the browser tab pre-selected) is displayed.

FIGURE 6-1 Opening the Details Window from the Pop-Up Menu

▼ To Exit the Details Window

● Click the Close button located at the bottom of the Details window.
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Browser Tab

The host contains four subordinate groups: hardware, operating system, local

applications, and remote systems. The Sun Management Center modules belong to

one of these four categories.

Note – Not all modules display in the hierarchy. For example, if you have the IPv6

monitoring module, it does not appear in the topology.

Sun Management Center software monitors hosts by using modules. Modules are

software components that monitor data pertaining to the health indicators and

resources of systems, applications, and network devices.

Note – Depending on your licensing agreement, you may not have access to all of

the modules described.

FIGURE 6-2 is an example of the host view. The left side of the host view is the

hierarchy (tree) view and the right side is the contents view. The host hierarchy view

displays the relationship between the host and its modules. In this example, the

loaded operating system modules are the MIB-II Instrumentation (Simple) and the

Kernel Reader (Simple) modules.

By using the Browser Details window, you can set alarm thresholds and view and

graph monitored data properties for your host.
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FIGURE 6-2 Browser Details Window

The Browser tab (FIGURE 6-2) contains the hierarchy and contents view for a host.

Tip – You may be able to see more information by holding the mouse pointer over

the object for several seconds. A pop-up balloon (tool tip) is displayed, showing

additional information about the object. These tool tips are also displayed for data

property table cells and are useful if information in a table cell is too long to display

completely.

Hierarchy view Contents view

Module icon

Options icon

Expansion

Compression
icon

icon
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8

Tip – The hierarchy can be expanded or compressed, depending on the position of

the expansion/compression icon (FIGURE 6-2). The icon is compressed when the

“handle” is pointing right. The icon is expanded when the “handle” is pointing

down.

Each host contains categories for Hardware, Operating System, Local Applications,

and Remote Systems. For more information on modules, see Appendix D.

Hardware
■ Config-Reader module

■ Sun StorEdge A5x00

■ Sun StorEdge T3

Note – The Config-Reader module monitors the host configuration, including

information and status for power supplies, keyswitch, fans, remote console, the

system in general, and so on. There are different Config-Reader modules for

different hardware platforms. If your system is supported by a Config-Reader

module, it is automatically loaded during installation. For more information on the

Config-Reader module for your hardware platform, refer to your platform

supplement and Appendix D.

Operating System

The Operating System category includes modules that monitor the operating

environment of the host:

■ Directory Size Monitoring

■ File Monitoring

■ Kernel Reader (Simple)

■ Kernel Reader

■ MIB-II Instrumentation

■ NFS File Systems

■ NFS Statistics

■ Simple MIB-II

■ Solaris Process Details
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Local Applications

The Local Applications category includes modules that monitor the local

applications on the host:

■ Agent Statistics

■ Data Logging Registry

■ Dynamic Reconfiguration

■ File Scanning

■ Health Monitor

■ Print Spooler

■ Process Monitoring

Remote Systems

The Remote Systems category includes modules that monitor remote systems:

■ MIB-II Proxy Monitoring module

■ HP JetDirect module (monitors HP printers equipped with a JetDirect card)

The next section is about some of the new browser table enhancements available in

Sun Management Center 3.0.

Browser Icons

The Browser Details window includes a row of icons at the top of the panel. The

Module and Options icons enable you to select one of several choices. The

Attributes, Graph, Probe, and Refresh Now icons serve a single purpose. The icons

and their functions are described in the following table.

TABLE 6-2 Browser Icons

Menu Item Definition

Module Available selections for the Module icon (FIGURE 6-2) are Load

Module, Edit Module, Enable Module, Disable Module, and Unload

Module, as described below.

Load Module Enables you to add a module to the host. The host must be selected

or this option is grayed out. For more information, see “To Load a

Module” on page 171.

Edit Module Enables you to edit module parameters. The module must be

selected or this option is grayed out. For more information, see “To

Edit Module Parameters” on page 176.
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Enable Module Enables you to enable a module. The module must be selected or

this option is grayed out. For more information, see “To Enable a

Module” on page 178.

Disable Module Enables you to disable a module. The module must be selected or

this option is grayed out. For more information, see “To Disable a

Module” on page 177.

Unload Module Enables you to unload a module from the host. The module must be

selected or this option is grayed out. For more information, see “To

Unload a Module” on page 179.

Options Available selections for the Options menu (FIGURE 6-3) are Copy,

Copy to Dataview Clipboard, Create Dataview, Copy to Graph

Clipboard, Alarms Filter Enabled, Add Row, Edit Row, Enable Row,

Disable Row, and Delete Row, as described below.

Copy Enables you to copy a module. You may paste the copied module in

the topology or hierarchy view of the main console. This enables

you to monitor the module properties without having the Details

window open. For more information, see “To Create a Module

Object” on page 35.

Copy to Dataview

Clipboard

Enables you to copy a data property to a clipboard, and then paste

into a dataview window.

Create Dataview Opens an automatically populated dataview window.

Copy To Graph

Clipboard

Enables you to add another data property (with the same units) to

an existing graph. Used with Add From Graph Clipboard menu

item in graphing window. See “To Graph Two Data Properties” on

page 120.

Alarms Filter

Enabled

Enables you to filter alarms on the Details window Alarms tab. See

Chapter 12 for more information.

Add Row Adds a row to a data property table. See “To Add a Row (for the

Directory Size Monitoring, File Monitoring, File Scanning, and

Process Monitoring Modules)” on page 106.

Edit Row Enables you to edit information for a row in a data property table.

Enable Row Enables a row (that has been disabled) in a data property table.

Disable Row Disables a row in a data property table.

Delete Row Deletes a row in a data property table.

Attribute Editor Displays the attribute editor for the selected object. The Attribute

Editor provides additional information about the selected object

and the rules governing its behavior. Use the Attribute Editor to

edit information about the object.

TABLE 6-2 Browser Icons

Menu Item Definition
90 Sun Management Center 3.0 Software User’s Guide • November 2000



Note – The browser buttons are grayed out when the command is not appropriate

for the selected object.

FIGURE 6-3 Options Menu Selections in Details Window

Alarms Filter

In Sun Management Center 3.0, you can now filter tables based on alarm states. For

example, if you want to only see rows that in a critical (red) state, there are two

items in the Options menu to support this view. These filter settings are per-browser

tab on a per-session basis and are not persistent across sessions.

The default state for the Alarms filter is that all boxes are unchecked and Alarms

Filter Enabled is set to Off.

Set Property Value Enables you to add property values to a multi-instance task.

Graph Graphs the selected monitored data property.

Dataview Displays the dataviews clipboard.

Probe Enables you to run selected commands on the monitored data

property.

Refresh Refreshes the information in the displayed data property table.

TABLE 6-2 Browser Icons

Menu Item Definition
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▼ To Enable the Alarms Filter

1. In the Details window, choose the Browser tab.

2. Under the Options pull-down menu, select Alarms Filter Enabled.

A check in the checkbox indicates that filters are enabled; no check indicates that

alarms are disabled.

Host Security

In the Details window, Sun Management Center software offers security at two

levels: the host itself and at the module level. You may also set security at the host

level only. In this case, anyone with the appropriate security can load modules, set

alarm thresholds, acknowledge alarms, and so on.

You may also set security permissions at the module level. In this case, only those

users with the appropriate module permissions can perform actions on the module.

Module security can be used as a “subset” of host security.

For example, at the host level, you can set security permissions so that users A, B,

and C can load modules and create alarm thresholds. User A loads the Health

Monitor module and creates customized alarm thresholds. However, users B and C

can change user A’s work unless security permissions have also been set at the

Health Monitor module level, enabling only user A to set alarm thresholds.

Note – In the case where security is set at both levels, the security permissions at

the module level take precedence over the security permissions at the host level.

Consequently, only user A can create alarm thresholds for the Health Monitor

module. For more information on security, see Chapter 14.

▼ To Set Security for a Host or Module

1. Open the Attribute Editor for a host or module by proceeding with one of the
following:

■ Click the right mouse button on the host or module and highlight Attribute

Editor from the pop-up menu.

■ Click the Attributes button.

2. Click the Security tab (FIGURE 2-8).
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3. Type the name(s) of user and administrator groups in the appropriate fields.

For more information on the security fields, see Chapter 14.

4. Complete this procedure with one of the following actions:

■ Click OK to accept the changes you have made and close this window.

■ Click Apply to apply your changes without closing this window.

■ Click Reset to reset the Attribute Editor to the default parameters.

■ Click Cancel to cancel your request and close the window.
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CHAPTER 7

Monitoring Data Properties

This chapter describes the following topics:

■ To Display a Data Property

■ To Confirm an Edit

■ To Choose an Option from a Combo Box

■ To Access The Column Header Context Menu

■ To Select a Row

■ To Select Multiple Contiguous Rows

■ To Select Multiple Row Ranges

■ To Define a Directory

■ To Add a Row (for the Directory Size Monitoring, File Monitoring, File Scanning,

and Process Monitoring Modules)

■ To Add a Printer

■ To Refresh Displayed Data

■ To Probe a Property

Monitoring Data Properties

Using your mouse, you can navigate through the hierarchy (tree) view in the Details

window to view the monitored properties. The lowest-level object in the host

hierarchy is the monitored property. The software provides both tabular and

graphical information about a monitored property.

Once the data has been displayed, you can refresh it. In addition, you can

simultaneously graph up to five data properties. These actions are described in the

following sections.
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▼ To Display a Data Property

Note – The following example uses the Kernel Reader module.

1. In the Browser Details window, double-click on the Operating System icon in the
hierarchy (tree) view.

The operating system modules are displayed in both the hierarchy and contents

views.

2. Double-click on the Kernel Reader icon in the contents view or single click in the
expansion/compression icon next to the Kernel Reader icon in the hierarchy view.

The Kernel Reader statistics are displayed.

3. Double-click on the System Load Statistics icon in either the hierarchy or the
contents view (FIGURE 7-1).

The monitored properties are displayed in a property table.
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FIGURE 7-1 System Load Statistics

Browser Table Operations

Sun Management Center property tables display information using a standard

format. The format includes:

■ A property table label

■ Column headings

■ Individual table cells organized into rows and columns

A row is a horizontal group of cells. A column is a vertical group of cells.
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FIGURE 7-2 Table Components

Sun Management Center tables contain two types of cells, editable and noneditable.

Information in an editable cell can be changed, and this cell has a white background

with black text.

Information in a non-editable cell is display-only. These cells have a colored

background with black text. The default background color for non-editable cells is

light gray (also called Secondary 3). However, Sun Management Center allows you

to customize colors for table cells, borders, and other aspects of the table.

The following Cell Color Specifications table describes the default colors and how

they are used:

TABLE 7-1 Cell Color Specifications

Color Name Use

White Enabled cell background

Black Enabled font color

Primary 1

(dark blue)

Active cell border

Primary 2

(medium blue)

Highlighted and selection for menu titles and menu items

Primary 3

(pale blue)

Highlighted rows and columns, noneditable highlighted cell, and

selected text
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Cell Operations

Two types of cells appear in Sun Management Center property tables. These are

editable cells, and noneditable cells.

Editable and Noneditable Cells

The key difference between editable and noneditable cells is the background. When

you click in an editable cell, there is a white background and in noneditable cells,

there is a gray background.

For example, in FIGURE 7-3 below, the cells in Pattern Description and Regexp Pattern

columns of the Scan table are white, indicating that they are editable. The remaining

cells in the Scan table as well as all of the cells in the File ID and File Stats tables are

gray, indicating that they are noneditable.

Secondary 1

(dark gray)

Table borders

Secondary 2

(medium gray)

Table shadows

Secondary 3

(pale gray)

Canvas or background table color

TABLE 7-1 Cell Color Specifications (Continued)

Color Name Use
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FIGURE 7-3 Editable and Noneditable Cells

▼ To Confirm an Edit

If you change data in an editable cell, you must confirm this change. When you edit

a cell, the Change Value Confirmation window displayed.

● In the Change Value Confirmation window, proceed with one of the following:

■ Click the OK button to confirm this change.

■ Click the Cancel button to cancel this change.
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Set Value Errors

If the value you used to set the value of a cell is invalid, an error window is

displayed. In this window, click the OK button to accept this error message.

Default Cell Editors
Editable cells will have one of the following types of default cell editors:

■ Text Cell Editor

This editor is invoked if the cell is a string type. Once the cell is selected, the text

cursor is activated at the end of the text string. If there is no text, the cursor will be

aligned left in the cell. To save the information in the cell, click the Return button.

■ Checkbox Cell Editor

A checkbox is a component with only two choices:

■ On

■ Off

As you can see in FIGURE 7-4, the state of the editor is indicated by a square that is

checked (on) or unchecked (off). Here, the checkbox is off.

FIGURE 7-4 Checkbox Cell Editor

■ Combo Box Cell Editor

This editor has a drop-down menu that displays an associated list of options. The

current choice appears in the combo box. As you move the cursor over the list, each

option is highlighted. The option you choose from the list replaces the current

selection.
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▼ To Choose an Option from a Combo Box

1. Click the drop-down arrow in the combo box.

2. Choose an item from the list.

3. Click anywhere outside the combo box.

The following three screenshots illustrate how to work with combo boxes. As you

can see, in FIGURE 7-5 below, the widget in the “Power On” cell tells you that there

are other text options available if the widget is clicked.

FIGURE 7-5 The Details Window Showing a Combo Box

Column Operations

This section discusses how the new enhancements affect the design of table columns.

▼ To Access The Column Header Context Menu

● In a table, click the right mouse button on a column header.

The column header context menu is displayed. For example, in FIGURE 7-6 below, you

can see the column header context menu is displayed with the following menu

options:

■ Attribute Editor

■ Set Property Value

■ Refresh
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FIGURE 7-6 Column Header Context Menu

Row Operations

This section discusses how the table operations affect the layout and design of table

rows.

▼ To Select a Row

● Place your cursor and click the right mouse button in the first cell of the row you
want to select.

This step enables you to highlight the entire row and the anchor cell has the focus.

The color of the cells in a row is determined by whether the cell is: editable or

noneditable. The maximum number of rows that can be shown in a table is equal to

the page size for tables.

▼ To Select Multiple Contiguous Rows

1. Click in the first target row to highlight the entire row.

2. Click the Shift button to either drag-click or click into any cell in the last row of
the desired group of rows.

All rows between the last and first anchor points will be selected.
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▼ To Select Multiple Row Ranges

1. Select the first range of a single or contiguous group of rows by completing the
procedure above.

2. Place the cursor in a row and proceed with the following:

■ Click the Control key

■ Click the right mouse button

This step adds a new range to the selection of rows between the existing range and

the new anchor point.

3. To extend the range of highlighted rows, proceed with the following:

■ Click the Shift button.

■ Click the right mouse button.

Row Context Menu

Use the context menu for a row or set of rows when these rows are highlighted and

a cell does not have focus. The context menu may be activated from anywhere in the

highlighted row(s) by clicking the right mouse button. For example, in FIGURE 7-7

below, the row context menu appears once you select a row and click the right

mouse button.

FIGURE 7-7 Row Context Menu
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For selected modules, the software enables you to add, delete, enable, or disable

rows for the data property tables (TABLE 7-2). When these modules are initially

loaded, the data property tables are empty (except the Directory Size Monitoring

and Print Spooler modules). For the File Monitoring, File Scanning, and Directory

Size Monitoring modules, you must add a row to monitor the data property.

For more information on the directory size monitoring and file monitoring modules,

on the file scanning, print spooler, and process monitoring modules, see

Appendix D.

▼ To Define a Directory

The following example procedure uses the Directory Size Monitoring module. If this

module is not loaded, see “To Load a Module” on page 171.

1. In the Browser Details window, double-click on the Operating System icon in the
hierarchy (tree) view.

The operating system modules are displayed in both the hierarchy and contents

views.

2. Double-click on the Directory Size Monitoring icon in the contents view or single
click in the expansion/compression icon next to the Directory Size Monitoring
icon in the hierarchy view.

The Directory Size Monitoring Status folder is displayed.

3. Double-click on the Directory Size Monitoring Status folder in either the
hierarchy or the contents view.

The Directory Monitoring property table is displayed.

TABLE 7-2 Sun Management Center Modules That Enable You to Add Rows

Module Name Description

Directory Size

Monitoring

Each added row enables you to define another directory for

monitoring.

File Monitoring Each added row defines the monitored “file”.

File Scanning Each added row defines the “pattern” that must be matched within

the monitored file.

Print Spooler Each added row enables you to define another printer for spooler

monitoring.

Directory Size

Monitoring

Each added row defines the “pattern” that must be matched from

all the processes that are running on the agent object.
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FIGURE 7-8 Directory Size Monitoring Table

4. Proceed with one of the following:

■ Click the right mouse button in the table row and select the Add Row command

from the pop-up menu.

■ In the Details window, click in the table to select it. The options icon turns white

(instead of gray) when the table is selected. Then select Options ➤ Add Row.

The Row Adder window is displayed.

5. Type the appropriate information in the text fields.

6. Complete this procedure with one of the following actions:

■ Click OK to accept the changes you have made and close this window.

■ Click Apply to apply your changes without closing this window.

■ Click Reset to reset the window to the default parameters.

■ Click Cancel to cancel your request.

The added row is displayed in the contents view.

▼ To Add a Row (for the Directory Size

Monitoring, File Monitoring, File Scanning, and

Process Monitoring Modules)

The following example procedure uses the File Monitoring module. If this module is

not loaded, see “To Load a Module” on page 171.

1. In the Browser Details window, double-click on the Operating System icon in the
hierarchy (tree) view.

The operating system modules are displayed in both the hierarchy and contents

views.

2. Double-click on the File Monitoring icon in the contents view or single click in
the expansion/compression icon next to the File Monitoring icon in the hierarchy
view.

The File Monitoring Status folder is displayed.
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3. Double-click on the File Monitoring Status folder in either the hierarchy or the
contents view.

An empty property table is displayed.

FIGURE 7-9 File Monitoring Table

4. Proceed with one of the following:

■ Click the right mouse button in the table row and select the Add Row command

from the pop-up menu (FIGURE 7-9).

■ In the Details window, select Options ➤ Add Row.

The Row Adder window is displayed (FIGURE 7-10).

5. Type the appropriate information in the text fields.
Chapter 7 Monitoring Data Properties 107



FIGURE 7-10 Row Adder Window for the File Monitoring Module

6. Complete this procedure with one of the following actions:

■ Click OK to accept the changes you have made and close this window.

■ Click Apply to apply your changes without closing this window.

■ Click Reset to reset the window to the default parameters.

■ Click Cancel to cancel your request.

The added row is displayed in the contents view (FIGURE 7-11).

FIGURE 7-11 Updated File Monitoring Table
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Note – The Row Adder window that is displayed is dependent on the selected

module. FIGURE 7-12, FIGURE 7-13, and FIGURE 7-14 illustrate examples of the Row

Adder window for the Directory Size Monitoring, File Scanning and Process

Monitoring modules, respectively.

FIGURE 7-12 Row Adder Window for the Directory Size Monitoring Module
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FIGURE 7-13 Row Adder Window for the File Scanning Module
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FIGURE 7-14 Row Adder Window for Process Monitoring Module

Other Operations

Sorting

Sorting is supported on all columns, and the following data properties are

recognized:

■ String

■ Numeric

■ Date

In the column, you will notice that the:

■ Label is flush left

■ Text is bold & black

■ Sort widget for ascending or descending is flush right

The widget appears as a triangle that points up or down. By double-clicking on the

header of the sorted column, you can toggle between a descending and ascending

sort.
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As you can see in FIGURE 7-15 below, the sorting widget is visible next to CPU

Number. Since this widget is pointing down, you can perform a descending sort.

FIGURE 7-15 Sorting

Working with Large Data Property Tables

In large data property tables, you can see only one page of rows at a time. Icons are

displayed above the table (FIGURE 7-16)that enable you to scroll through these tables.

The icons enable you to:

■ Return to the first page

■ Return to the previous page

■ Go to the next page

■ Go to the final page

Sorting widget
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FIGURE 7-16 Scrolling Through Large Tables

Next to these icons is a pull-down menu that enables you to go to a specific page.

For example, in the File Monitoring Table (FIGURE 7-16), there are two pages. You can

click on the pull-down menu, choose 2 and proceed to page 2.

▼ To Add a Printer

The following example procedure uses the Print Spooler module. If this module is

not loaded, see “To Load a Module” on page 171.

1. In the Browser Details window, double-click on the Print Spooler icon in the
hierarchy (tree) view.

The operating system modules are displayed in both the hierarchy and contents

views.

2. Double-click on the Print Spooler icon in the contents view or single click in the
expansion/compression icon next to the Print Spooler icon in the hierarchy view.

The Print Spooler folder is displayed.

3. Double-click on the Print Spooler folder in either the hierarchy or the contents
view.

Three property tables are displayed; these are Lpsched Status, Printer Devices Table,

and Printer Queues Table.

Pull-down Menu

Last
Next

Previous
First
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FIGURE 7-17 Print Spooler Property Tables

4. Proceed with one of the following:

■ Click the right mouse button in the Printer Devices table row and select the Add

Row command from the pop-up menu.

■ In the Details window, select Options ➤ Add Row.

The Row Adder window is displayed (FIGURE 7-18).

5. Type the appropriate information in the text fields.
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FIGURE 7-18 Row Adder Window for the Print Spooler Module

6. Complete this procedure with one of the following actions:

■ Click OK to accept the changes you have made and close this window.

■ Click Apply to apply your changes without closing this window.

■ Click Reset to reset the window to the default parameters.

■ Click Cancel to cancel your request.

The added row is displayed in the contents view.

▼ To Refresh Displayed Data

● Proceed with one of the following:

■ Click the right mouse button in the data property table row and select Refresh

from the pop-up menu (FIGURE 7-19).

■ Click the Refresh Now button.

In this example, the System Load Statistics table is updated with the latest

information.
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Note – You may also set up a refresh interval and the Sun Management Center

software automatically updates your monitored data at your designated time

interval. For information on accomplishing this task, see “Refresh Tab in the

Attribute Editor” on page 144.

FIGURE 7-19 Monitored Data Property Pop-up Menu

Probing Properties

On selected module properties, the software enables you to use pre-determined

UNIX commands including list files, the vmstat command, and so on. The Probe

button is not grayed out when probe commands are applicable for the selected

property.

Note – The Find All Recent Files probe commands for the Filesystem Usage

properties (Kernel Reader module) find only files that were created or modified less

than 24 hours ago. The Find All Files probe commands find all files regardless of the

date/time they were created or modified.

For more information on the Filesystem Usage, see “Filesystem Usage Table” on

page 560.

The following example procedure explains how to probe a property in the Directory

Size Monitoring module. If you have not done so already, load this module by

following the procedure “To Load a Module” on page 171.
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▼ To Probe a Property

1. In the Browser Details window, double-click on the Operating System icon in the
hierarchy (tree) view.

The operating system modules are displayed in both the hierarchy and contents

views.

2. Double-click on the Directory Size Monitoring icon in the contents view or single
click in the expansion/compression icon next to the Directory Size Monitoring
icon in the hierarchy view.

The Directory Monitoring Status folder is displayed.

3. Double-click on the Directory Monitoring Status folder icon in either the
hierarchy or the contents view.

The monitored data properties are displayed in a property table.

4. Proceed with one of the following:

■ Click the right mouse button in the Directory Monitoring table row and select the

List Files or Recursively List Files command from the pop-up menu (FIGURE 7-20).

■ Click the Probe icon, select the appropriate command from the Probe Select dialog

(FIGURE 7-21), and click the OK or Cancel button.

FIGURE 7-20 Probe Commands in the Pop-up Menu
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FIGURE 7-21 Probe Select Dialog
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CHAPTER 8

Graphing Data Properties

This chapter describes the following topics.

■ To Graph A Monitored Data Property

■ To Graph Two Data Properties

■ To Save Graphing Parameters

■ To Open a Graph

■ To Apply a Graph Template

Graphing Properties

Sun Management Center software enables you to graph most monitored data

properties.

▼ To Graph A Monitored Data Property

● Proceed with one of the following:

■ Click the right mouse button in any table cell containing a data property you

want to graph, and select Graph from the pop-up menu (FIGURE 7-19).

■ Select (highlight) the desired data property, and then click the Graph button at the

top of the Details window.

The graphing window is opened and the values of the property are plotted as a

function of time. The plotting is dynamic and continues even if the graphing

window is iconified on the desktop. Plotting stops, however, if the window is closed.

Note – Placing your cursor and clicking with the right mouse button in a property

row or column displays the pop-up menu for that property.
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FIGURE 8-1 Graph of System Load Statistics Average Over the Last Five Minutes

▼ To Graph Two Data Properties

1. Click the right mouse button in the data property table cell.

In this example, the Load Averages Over the Last 1 Minute table cell is selected.

2. Proceed with one of the following:

■ Click the right mouse button in the table cell and select the Copy to Graph

Clipboard command from the pop-up menu (FIGURE 8-2).

■ In the Details window, select Options ➤ Copy to Graph Clipboard.

Note – The Copy to Graph Clipboard command works only when the units of the

data item are the same. Also, Copy to Graph Clipboard places the data on a

clipboard. The data is not actually placed on the graph until you complete the

following step.

3. Go to the graphing window in which you want the additional property to be
plotted. Select Graph ➤ Add From Graph Clipboard (FIGURE 8-3).

The second data property is added (FIGURE 8-4).
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FIGURE 8-2 Copying Load Averages Over the Last One Minute to the Graph

Note – You may graph up to 5 datasets at one time on a single graph.

FIGURE 8-3 Adding Load Averages Over the Last One Minute to the Graph
Chapter 8 Graphing Data Properties 121



FIGURE 8-4 Load Averages Over the Last One and Five Minutes

▼ To Save Graphing Parameters

1. Select Graph ➤ Save Graph Request As or Select Graph ➤ Save Template in the
Graphing window.

The Save Graph Request function enables you to save the host name and the data

property or properties that have been graphed. Once saved, a graph of this property

on this host can be pulled up quickly from inside the graphing window (as shown

here) or from the main console window under the Tools menu. A newly opened

graph starts plotting fresh data.

The Save Template function enables you to save any custom features you have

added to your graph including axis labeling, headers, footers, legend, and so on.

(For more information see “Graphing Menus” on page 123.)

2. Type the name in the Enter Graph Name or Enter Template Name fields.

3. Click the Save button to save your graph request (template) or click the Cancel
button to cancel your request.

▼ To Open a Graph

1. Select Graph ➤ Open Saved Graph in the Graphing window.

The Open Graph dialog is displayed.

2. Select (highlight) a saved graph from the list.
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3. Click the OK button to open the graph or the Cancel button to cancel your
request.

▼ To Apply a Graph Template

1. Select Graph ➤ Apply Template in the Graphing window.

The Apply Template dialog is displayed. This dialog enables you to apply saved

custom features to the current graph.

2. Select (highlight) a saved template from the list.

3. Click the OK button to apply the template to the current graph or the Cancel
button to cancel your request.

Graphing Menus

There are five Graphing window menu items:

■ Graph

■ Edit

■ View

■ Tools

■ Help

Graph Menu Items

TABLE 8-1 Graph Menu Items

Menu Item Description

Save Graph Request

as

Saves the host name and data property (properties) that are plotted.

Open Saved Graph Opens a previously saved graph.

Delete Deletes a previously saved graph.

Save Template Saves any custom changes you make on the graph.

Apply Template Applies a saved template to the current graph.
Chapter 8 Graphing Data Properties 123



The graph utility enables you to customize the look and feel of your graphs through

the edit menu items (TABLE 8-2).

Note – Header, Footer, Axes, and Legend changes are not visible unless the view

option corresponding to that part of the graph is toggled on (TABLE 8-4).

Delete Template Deletes a previously saved graph template.

Add From Graph

Clipboard

Adds an additional dataset to an existing graph. Choose this menu

item after selecting a property to “copy to graph clipboard.”

Close Closes the graphing window.

TABLE 8-1 Graph Menu Items

Menu Item Description
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Edit Menu Items

FIGURE 8-5 Edit Menu Items

Note – Editing axes requires some care in choosing the correct values. If you should

choose values for Min and Max that are impossible to plot, the dialog, in most cases,

gives you an error message describing the problem. However, if you simply choose

values that are possible, but result in the plotted points no longer being visible, you

are not warned with an error message.

TABLE 8-2 Edit Menu Items

Menu Item Description

Chart Type Changes graph type to line, area, or bar graph.

Main Titles Changes the text, font, font style, point size, and orientation of the

header, footer, legend, x-axis or y-axis title. In addition, this dialog

enables you to select and customize the border around the title.

Axes Edits the range and the spacing of the x- and y-axes. This menu

item is suggested for advanced users only (FIGURE 8-6 and

FIGURE 8-8).

Border Determines the border type (including a no border option).
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FIGURE 8-6 and FIGURE 8-8 show the axes dialog for the x-axis and y-axis.

X-axis Title Dialog

FIGURE 8-6 X-axis Editing Dialog

Sun Management Center software chooses default x-axis values. You can change the

values in the fields on this screen. These fields and the possible range of values are

described in the following table.

TABLE 8-3 Fields on the X-axis Title Dialog Box

Field Name Description

Text Enter the label for the x-axis of your graph.

Style Select plain, bold, or italic font style for the x-axis label.

Name Select serif, sans serif, or monospaced font for the x-axis label.

Size Select a font size for the label, ranging from 6-point to 26-point font.

Placement This field indicates that the label is always below the graph. This

value cannot be changed.

Orientation Select one of four types of orientation for the axis label. Examples

are shown in FIGURE 8-7.

Border Type Select no border for the label, or select a type of border.

Border Width Set the border width for the label. This field does nothing if the

border type you select is “None.”
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FIGURE 8-7 Examples of X-axis Label Orientation

Y-axis Title Dialog

FIGURE 8-8 Y-axis Editing Dialog

VerticalHorizontal

Upside Down Vertical Flip
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Sun Management Center software chooses default y-axis values. You can change the

values in the fields on this screen. See TABLE 8-3 for a description of the fields on the

y-axis screen. They are the same as those described for the x-axis label, except that in

the Placement field, the default value is “West,” which indicates that the label is

always left of the graph. This value cannot be changed.

View Menu Items

TABLE 8-4 View Menu Items

Menu Item Description

Live Data Displays the monitored property (properties) data points.

Show Header Displays the header text.

Show Footer Displays the footer text.

Show Axis Titles Displays the x-and y-axes titles.

Show Axes Displays the x-and y-axes.

Show Grids Displays a grid pattern in the graphing window.

Show Legend Displays the legend text.

Rotate Graph Rotates the graph by 90, 180, or 270 degrees.

Flip Flips the graph over (x-axis flips the x-axis, y-axis flips the y-axis).

Reset View Resets rotate and flip options to the default (graph upright) setting.
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FIGURE 8-9 View Menu Items
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Tools Menu Items

Help Menu Items

TABLE 8-5 Tools Menu Items

Menu Item Description

Zoom Toggle to turn on the zoom option, which focuses on a selected area

of the graph. Hold down the Shift key while dragging out a

rectangle with the mouse.

Translate Toggle to turn on the translate option, which moves the graphing

window side to side or back and forth. Hold down the Control key

while moving the mouse left-right or up-down.

Restore Removes the effects of the zoom and translate options; undo option.

TABLE 8-6 Help Menu Items

Menu Item Description

Help Access the Help documentation.
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CHAPTER 9

Attribute Editor

This chapter describes the following topics:

■ To Open the Attribute Editor

■ To Create an Alarm

■ To Register an Alarm Action

■ To Modify Alarm Actions

■ To Send an Email

■ To Define Your Own Alarm Action Script

■ To Set a Refresh Interval

■ To Set a History Interval

Attribute Editor for a Data Property

The Attribute Editor for a data property provides additional information about the

property and enables you to customize various monitoring criteria. You can use the

Attribute Editor to set:

■ Alarm thresholds

■ Actions when alarm conditions occur

■ The refresh interval

■ A logging schedule for historical data points

The Attribute Editor has one or more tabs at the top of the window that enable you

to switch between different panels. The tabs for the System Load Statistics data

property are:

■ Info

■ Alarms

■ Actions

■ Refresh

■ History
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Note – Each Attribute Editor displays one or more of these tabs, depending on the

type of Attribute Editor. The Attribute Editor that is displayed depends on the

selected object.

▼ To Open the Attribute Editor

1. Click the right mouse button and select a data property table cell (FIGURE 8-2).

2. Proceed with one of the following:

■ Click the right mouse button in a table row and select Attribute Editor from the

pop-up menu.

■ Click the Attributes icon.
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Information Tab in the Attribute Editor

The Information panel (FIGURE 9-1) provides you with additional information about

the selected object.

FIGURE 9-1 Attribute Editor Info Tab for a Monitored Property
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Alarms Tab in the Attribute Editor

The Alarms panel (FIGURE 9-2) enables you to set alarm thresholds (TABLE 9-1) for

simple alarms only.

Simple alarms are based on thresholds. A monitored data property is greater than,

less than, not equal to, or equal to a single threshold value. By contrast, complex

alarms are based on a set of conditions becoming true. For more information on

alarm rules, see Appendix E.

FIGURE 9-2 Attribute Editor Alarms Tab for a Monitored Property
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TABLE 9-1 shows common simple alarm limits for monitored properties. The alarm

limits are also displayed in the Parameter Description field (FIGURE 9-2). You may set

thresholds for one or more of these alarm limits for selected data properties.

The software offers you the following flexibility in setting your alarms:

■ Determine the thresholds that trigger an alarm of a particular severity

■ Determine when alarms are sounded (for example, only on weekdays)

Note – You need the appropriate security permission to set an alarm threshold. See

Chapter 14 for more information.

TABLE 9-1 Common Simple Alarm Limits in Sun Management Center Software

Alarm Limit Description

Critical Threshold (>) Critical (red) alarm occurs if value exceeds limit entered in this field.

Alert Threshold (>) Alert (yellow) alarm occurs if value exceeds limit entered in this field.

Caution Threshold (>) Caution (blue) alarm occurs if value exceeds limit entered in this field.

Critical Threshold (<) Critical (red) alarm occurs if value is below the limit entered in this field.

Alert Threshold (<) Alert (yellow) alarm occurs if value is below the limit entered in this

field.

Caution Threshold (<) Caution (blue) alarm occurs if value is below the limit entered in this

field.

Alarm Window Alarm occurs only during this time period. For example, if you type

day_of_week=fri , an alarm occurs only if the alarm condition exists on

a Friday. If an alarm condition exists on Tuesday, no alarm is registered.
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▼ To Create an Alarm

The following example illustrates how to create a simple alarm. This example creates

an alarm threshold in the Kernel Reader module.

1. Click the Browser tab button in the Details window.

2. Click the expansion/compression icon next to the Operating System icon in the
hierarchy tree view.

The Operating System modules are displayed.

3. Click the expansion/compression icon next to the Kernel Reader icon.

The Kernel Reader properties are displayed.

4. Double-click on the System Load Statistics icon.

The System Load Statistics properties table is displayed in the contents view.

5. Click with your left mouse button and select the table cell for Load Averages Over
the Last 5 Minutes.

6. Click the Attributes button.

The Attribute Editor window is displayed.

7. Click on the Alarms tab button.

The alarm rows are displayed.

8. Type a value in the Critical Threshold (>) field which is less than the current value
(FIGURE 9-2).

Entering this value enables you to create a critical alarm.

9. Complete one of the following actions:

■ Click OK to accept the changes you have made and close this window.

■ Click Apply to apply your changes without closing this window.

■ Click Reset to reset the Attribute Editor to the default parameters.

■ Click Cancel to cancel your request.

After some time, the Load Average Over the Last 1 Minute data field in the table

turns red. In addition, red alarm icons are displayed on the following folders and

icons: Operating System, Kernel Reader, and System Load Statistics (unless your

system has an open, unacknowledged severity 1 black alarm).

10. Click the Alarms tab button in the Details window.

The alarm you created should be reflected in the alarms table. See Chapter 12 for

more information on this subject.

11. Acknowledge this alarm.
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12. Create additional alarm thresholds and familiarize yourself with their operation.

Once you have created these alarms, you can set up security permissions so that

another Sun Management Center software user cannot change your alarm

thresholds. For more information on security, see Chapter 14.

Note – You do not need to fill in alarm information for all alarm thresholds. For

example, you may choose to create only a critical alarm threshold.

The preceding example illustrates creating a situation where an alarm is registered if

a value exceeds the alarm limit. TABLE 9-1 lists other common alarm limits in the

software.

Actions Tab in the Attribute Editor

The Actions panel (FIGURE 9-3) enables you to instruct the software to perform a

predetermined action if an alarm occurs.

Note – Acceptable actions include scripts that are stored in the /var/opt/
SUNWsymon/bin directory. These scripts execute with root permissions.

For example, you can enter the name of a script in the critical action field so that an

email is sent to a system administrator whenever a critical alarm is generated for the

Load Average Over the Last Five Minutes data property.

As shown in FIGURE 9-3, you can set separate actions for different alarm conditions or

one for any alarm condition (action on any change). The conditions are:

TABLE 9-2 Alarm Conditions

Condition Action specified in this field allows you to:

Critical Notify a user that a critical alarm has occurred, or specify a script or

application to invoke in response to the critical alarm.

Alert Notify a user that a alert alarm has occurred, or specify a script or

application to invoke in response to the alert alarm.

Caution Notify a user that a caution alarm has occurred, or specify a script

or application to invoke in response to the caution alarm.
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Note – The check boxes shown to the right of the Action buttons enable you to

specify automatic or manual execution of a specific alarm action. By default, all

actions are set for manual execution. Only manual actions can be modified.

FIGURE 9-3 Attribute Editor Actions Panel for a Monitored Property

Indeterminate Action Notify a user that a indeterminate event (not associated with an

alarm) has occurred, or specify a script or application to invoke in

response to the event.

Close Action Notify a user that an alarm has been closed, or specify a script or

application to invoke in response to alarm closing.

Action on Any

Change

Notify a user that any of the previous conditions in this table has

occurred, or specify a script or application to invoke in response to

any one of these previous conditions.

TABLE 9-2 Alarm Conditions

Condition Action specified in this field allows you to:
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When you activate the check box and click the Actions button, the Action Dialog

Selection window is displayed (FIGURE 12-8). This window enables you to modify the

registered alarm actions. Two buttons in the dialog (Email and Other) allow you to

choose one of two options for an alarm action.

TABLE 9-3 lists these buttons and their functions.

▼ To Register an Alarm Action

1. Click on the Attribute Editor Actions tab.

The Attribute Editor Actions dialog is displayed.

2. Press the Actions... button next to the action to be registered.

The Action Selection dialog is displayed.

3. Select the type of alarm action you want to register (E-mail or Other).

4. Make your entries in the fields of the selected action.

5. Click OK to accept the entries and close the Alarm Action dialog.

The entry is displayed in the corresponding Action field of the Actions dialog.

▼ To Modify Alarm Actions

1. Click the Action button for the alarm action you want to modify.

The Action Selection dialog is displayed.

2. Select the type of alarm action you want to modify (E-mail or Other).

3. Make your changes in the fields of the selected action.

4. Click OK to accept the changes and close the Alarm Action dialog.

The change is displayed in the corresponding Action field of the Actions dialog.

TABLE 9-3 Alarm Actions Modification Dialog Buttons

Tab Function

Email Allows you to specify an address and message to be sent as email.

Other Allows you to select generic shell scripts installed on the managed

node.
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▼ To Send an Email

The following describes an example of how to send an email to a user when a critical

alarm occurs.

1. Click the Browser tab button in the Details window.

2. Click the expansion/compression icon next to the Operating System icon in the
hierarchy tree view.

The Operating System modules are displayed.

3. Click the expansion/compression icon next to the Kernel Reader icon.

The Kernel Reader properties are displayed.

4. Double-click on the System Load Statistics icon.

The System Load Statistics properties table is displayed in the contents view.

5. Click with your left mouse button and select the table cell for Load Averages Over
the Last 5 Minutes.

6. Click the Attributes button.

The Attribute Editor window is displayed.

7. Click the Actions tab.

The Action Selection screen displays.

8. Click Email to activate the To and Message fields.

9. Type username in the To field and the message in the Message field.

10. Complete this procedure with one of the following actions:

■ Click OK to accept the changes you have made and close this window.

■ Click Cancel to cancel your request.

The following email is sent to the user whenever an alert alarm occurs.

Date: Wed, 30 Jun 2000 15:25:39 -0800
From: root@MachineB (0000-Admin(0000))
Subject: Sun Management Center - Alert Alarm Action
Mime-Version: 1.0

Sun Management Center alarm action notification ... {Alert:
machineB Kernel Reader Load Average Over The Last 5 Minutes >
0.01Jobs}
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▼ To Define Your Own Alarm Action Script

The following procedure describes how to customize an alarm action (other than an

email message as described previously) to notify a user when an alarm condition

occurs.

1. Create your custom alarm action script, using the following optional arguments:

2. At the command-line level, become superuser.

3. Install the script in the home Sun Management Center directory. The default is
the /var/opt/SUNWsymon/bin/ directory. For example:

Note – The script filename should not have a .sh extension.

4. Click the Browser tab button in the Details window.

5. Set the alarm threshold.

For more information, see “To Create an Alarm” on page 136.

6. Click the expansion/compression icon next to the Operating System icon in the
hierarchy tree view.

The Operating System modules are displayed.

7. Click the expansion/compression icon next to the Kernel Reader icon.

The Kernel Reader properties are displayed.

8. Double-click on the System Load Statistics icon.

The System Load Statistics properties table is displayed in the contents view.

TABLE 9-4 Arguments for Custom Alarm Action Script

Argument Definition

%statusfmt The alarm severity, such as Warning, Critical, and so on.

%statusstringfmt The complete alarm string, including severity. (For example:

Critical: Machine A Kernel Reader Number of User Sessions > 10)

# su

# cp custom_alarm_script /var/opt/SUNWsymon/bin/
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9. Click the left mouse button to select the table cell for Load Averages Over the Last
5 Minutes.

10. Click the right mouse button.

The selection menu is displayed.

11. Click the Attribute Editor... item.

The Attribute Editor window is displayed.

12. Click the Actions tab.

The action rows are displayed.

13. Type custom_alarm_script %statusstringfmt in the Critical Action field of the
Actions panel (FIGURE 9-4).

14. Click the box next to the Critical Action field to remove the check mark.

Your script will be executed automatically.

15. Complete this procedure with one of the following actions:

■ Click OK to accept the changes you have made and close this window.

■ Click Apply to apply your changes without closing this window.

■ Click Reset to reset the Attribute Editor to the default parameters.

■ Click Cancel to cancel your request.
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Note – If the script is not valid, the message “Failed to save attribute information.”

is displayed at the bottom of the Attribute Editor window.

FIGURE 9-4 Specifying a Custom Script for an Alarm Action
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Refresh Tab in the Attribute Editor

The Refresh panel (FIGURE 9-5) enables you to set the refresh interval for this object.

The refresh interval is the interval between the times when the Sun Management

Center agent samples the monitored property.

FIGURE 9-5 Attribute Editor Refresh Tab for a Monitored Property
144 Sun Management Center 3.0 Software User’s Guide • November 2000



▼ To Set a Refresh Interval

The following example illustrates how to set a refresh interval in the System Load

Statistics module.

1. Click the Browser tab button in the Details window.

2. Click the expansion/compression icon next to the Operating System icon in the
hierarchy tree view.

The Operating System modules are displayed.

3. Click the expansion/compression icon next to the Kernel Reader icon.

The Kernel Reader properties are displayed.

4. Double-click on the System Load Statistics icon.

The System Load Statistics properties table is displayed.

5. Click with your left mouse button and select the table cell for Load Averages Over
the Last 5 Minutes.

6. Click the Attributes button.

The Attribute Editor window is displayed.

7. Click the Refresh tab button.

The refresh panel is displayed.

8. Type a value (in seconds) in the Refresh Interval field or click the Advanced
button.

In this example, type 300 in the entry field. The refresh interval is five minutes. For

more information on the Advanced button, see “Using the Time Editor” on page 149.

9. Complete this procedure with one of the following actions:

■ Click OK to accept the changes you have made and close this window.

■ Click Apply to apply your changes without closing this window.

■ Click Reset to reset the Attribute Editor to the default parameters.

■ Click Cancel to cancel your request.

Whenever the System Load Statistics table is displayed, the values in the table are

refreshed every five minutes.

Note – By increasing the refresh interval to a larger interval, then the agent uses less

CPU cycles.
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History Tab in the Attribute Editor

The History panel enables you to save older data for a monitored property. In

FIGURE 9-6, a history of data points is recorded every 120 seconds (sample interval).

This information can be stored in a disk file or in the memory cache.There are two

types of disk files: circular (maximum of 1000 lines) and text. These files are located

in the /var/opt/SUNWsymon/log directory. If you select memory cache, you must

also indicate how many data points should be saved in the Max Size (sample) field.

Note – You can view this data in a graph by opening the graph for this monitored

property. If you have selected memory cache, the graph is displayed with the

historical data.

FIGURE 9-6 Attribute Editor History Tab for a Monitored Property
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▼ To Set a History Interval

1. Click the Browser tab button in the Details window.

2. Click the expansion/compression icon next to the Operating System icon in the
hierarchy tree view.

The Operating System modules are displayed.

3. Click the expansion/compression icon next to the Kernel Reader icon.

The Kernel Reader properties are displayed.

4. Double-click the System Load Statistics icon.

The System Load Statistics properties table is displayed.

5. Click with your left mouse button and select the table cell for Load Averages Over
the Last 5 Minutes.

6. Click the Attributes button.

The Attribute Editor window is displayed.

7. Click the History tab button.

The history panel is displayed.

8. Type a value (in seconds) in the Sample Interval field or click on the Advanced
button.

In this example, type 120 in the entry field. A history data point is collected every

two minutes. For more information on the Advanced button, see “Using the Time

Editor” on page 149.

9. Click in the check box next to Save History as Disk File or Save History in
Memory Cache.

10. If you decided to save history as a disk file, determine the file type (circular or
text) and type the file name in the Text File Name field (text file only).

A circular disk file is automatically saved under the name history.log . If you do

not choose a file name for your text file, it is automatically saved under the name

agent_default.history .

11. If you decided to save history in memory cache, type the number of history data
points in the Max Size (sample) field.

For example, if you set this field to 1000, only the most current 1000 data points are

stored in the memory cache. Any older data points are discarded. These data points

may be graphed. See “To Graph A Monitored Data Property” on page 119 for more

information.

12. Complete this procedure with one of the following actions:

■ Click OK to accept the changes you have made and close this window.
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■ Click Apply to apply your changes without closing this window.

■ Click Reset to reset the Attribute Editor to the default parameters.

■ Click Cancel to cancel your request.
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CHAPTER 10

Time Editor

This chapter describes the following topics:

■ To Create a Time Expression Using the Cyclic and Comparison Tabs

■ To Create a Time Expression Using the Absolute and Cron Tabs

■ To Create an Alarm Schedule Using the Comparison Tab

Using the Time Editor

Use the Time Editor (FIGURE 10-1) to schedule monitoring activities. For example, you

may want a particular module to be operational only during business hours. Or you

may want to record the history of a monitored property only during peak activity.

You can use the Time Editor to set the schedule for a module, for alarms, for a

refresh interval, and for history data collection.

Note – The schedule (set by the Time Editor) for a module overrides the schedule

for alarms, refresh intervals, and history. If the module is not “on,” the data

properties are not monitored and the alarms, refresh, and history schedules are

meaningless.
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FIGURE 10-1 Time Editor

There are four basic types of Time Expressions:

■ Cyclic – Periodic events

■ Absolute – Starting at a particular time

■ Comparison – Allowing events at specific times

■ Cron – Allowing events at specified times using cron input format

These Time Expressions can be used separately or in combination.

Note – All four Time Expressions are valid for history sample and refresh intervals.

However, only the comparison tab is valid for alarm and module schedules.

Combining Time Expressions

The following examples illustrate combining Time Expressions to set a history

interval.

Note – Sampling for the history interval does not occur unless the module is also on

(according to the module schedule).
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▼ To Create a Time Expression Using the Cyclic

and Comparison Tabs

Note – This procedure is also valid for a refresh interval.

1. Click on the Advanced button in the History tab of the Attribute Editor for a data
property.

See “To Set a History Interval” on page 147 for more information.

The Time Editor is displayed (FIGURE 10-1).

2. If any value is in the Time Expression field, highlight the value and delete it by
clicking the Delete button.

3. Click the Insert button.

The Time window is displayed with the Cyclic tab selected.

4. Determine the frequency for the history interval (FIGURE 10-2).

In this example, the history interval is set for every hour. That is, the software checks

the System Load Average Over the Last 5 Minutes every hour.

a. Highlight the number field and click the up or down arrows until the number 1
is displayed.

b. Highlight the units field and click the up or down arrows until hours is
displayed.
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FIGURE 10-2 Setting a Cyclic Time of One Hour

5. Click the Apply button.

■ Cycle(1 hours) is displayed in the Time Editor (FIGURE 10-3).

FIGURE 10-3 Time Editor With Cyclic Time of One Hour

6. Click the Insert button.

The Time window is displayed with the Cyclic tab selected.

7. Click the Comparison tab.

The Time window is displayed with the Comparison tab selected.
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8. Determine the start of the Time Range (Monday).

The time range determines the time period when the software checks the system

load average every hour. The software does not check the system load average

outside the time period specified by this window. In this example, the time range is

from Monday to Friday, inclusive.

a. Select Day of week from the left pull-down menu.

b. Select >= from the middle pull-down menu.

c. Select Monday from the right pull-down menu.

The time expression is displayed in the Current Time Expression field

(FIGURE 10-4).

FIGURE 10-4 Setting the Start Range to Monday

9. Click the Apply button.

The Time Editor is updated. The Current Time Expression now reads

Day_of_week>=Monday. However, the Time Editor also enables you to select the Or

expression (FIGURE 10-5).
Chapter 10 Time Editor 153



FIGURE 10-5 Time Editor Is Updated With a Start Range of Monday

10. Determine the end of the Time Range by clicking the Insert button.

11. Click on the Comparison tab of the Time window.

The Time window is displayed with the Comparison tab selected.

12. Determine the end of the Time Range (Friday).

a. Select Day of week from the left pull-down menu.

b. Select <= from the middle pull-down menu.

c. Select Friday from the right pull-down menu.

The Time expression is displayed in the Current Time Expression field

(FIGURE 10-6).
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FIGURE 10-6 Setting the End Range to Friday

13. Click the Apply button.

The Time Editor is updated. The Time Expression fields now read Cycle(1 hours)

and Day_of_week>=Monday and Day_of_week<=Friday (FIGURE 10-7).

FIGURE 10-7 Time Editor Showing a Cycle Time of One Hour From Monday to Friday

14. Click the Apply button.

The Sample Interval field in the Attribute Editor is updated. The software will check

the system load average (over five minutes) at every hour, from 12:00 AM Monday

to 12:00 AM Saturday morning.
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FIGURE 10-8 Updated History Attribute Editor Showing a Cycle Time of One Hour From
Monday to Friday
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▼ To Create a Time Expression Using the Absolute

and Cron Tabs

Note – This procedure is also valid for a refresh interval.

1. Click on the Advanced button in the History tab of the Attribute Editor for a data
property.

See “To Set a History Interval” on page 147 for more information.

The Time Editor is displayed (FIGURE 10-1).

2. If any value is in the Time Expression field, highlight the value and delete it by
clicking the Delete button.

3. Click the Insert button.

The Time window is displayed with the Cyclic tab selected.

4. Click the Absolute tab.

The Time window is displayed with the Absolute tab selected.

5. Determine the starting time and date (FIGURE 10-9).

a. Highlight the hour, minute, and if desired, the seconds fields and click the up
or down arrow until the correct time is displayed.

b. Highlight the month, date, and year fields and click the up or down arrow until
the correct date is displayed.

The starting date and time are displayed in the Current Time Expression field.

Note – Time is displayed using the 24-hour clock.
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FIGURE 10-9 Starting Time of 12:00:00 PM on August 20, 1999

6. Click the Apply button.

The starting date and time are displayed in the Time Editor (FIGURE 10-10).

FIGURE 10-10 Time Editor With Starting Time of 12:00:00 PM August 20, 1999

7. Click the Insert button.

8. Click the Cron tab.

The Time window is displayed with the Cron tab selected.
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9. Select the time when the history interval is active.

The software does not check the system load average outside the time specified by

this window. In this example, the condition is at 3:00 AM every Monday through

Friday.

a. Select 0 from the Minute pull-down menu.

b. Select 3rd from the hour pull-down menu.

These first two pull-down menus set the time at 3:00 AM.

c. Select Every from the Day of month pull-down menu.

d. Select Every from the Month pull-down menu.

These two pull-down menus set the date for every day.

e. Select Monday from the final pull-down menu.

The Current Time Expression field reads Cron(03**1). This expression states that

the history window is only active at 3:00 AM every Monday (FIGURE 10-11).

FIGURE 10-11 Cron Tab Selected With 3:00 AM Every Monday

10. Click the Apply button.

The Time Editor is updated. The Time Expression now states Cron(03**1)

(FIGURE 10-12).
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FIGURE 10-12 Time Editor Selected With Starting Date/Time 12:00:00 PM, August 20, 1999,
and History Interval Start Time of 3:00 AM Every Monday

11. Place the cursor in the Cron field on the Time Editor screen. Backspace using the
left arrow key until the cursor is between the ending parenthesis and the number
1. Type -5, so that the value in this field now reads Cron(03**1-5).

This expression states that the history interval is only active at 3:00 AM every

Monday through Friday (FIGURE 10-13).

FIGURE 10-13 Time Editor With Starting Date/Time of 12:00:00 PM, August 20, 1999 and
History Interval of 3:00 AM Every Monday Through Friday

12. Click the Apply button.

The Time Editor is updated. In this example, the history window is active at 3:00 AM

every Monday through Friday after the starting date and time of 12:00 PM August

20, 1999 (FIGURE 10-14).

Edit this field to
select a range of
days for the
refresh interval
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FIGURE 10-14 History Interval With Starting Time of 12:00 PM August 20, 1999 and 3:00
AM Every Monday Through Friday
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▼ To Create an Alarm Schedule Using the

Comparison Tab

Note – This procedure is also valid for a module schedule.

1. Click on the Advanced button in the Alarms tab of the Attribute Editor for a data
property.

See “To Create an Alarm” on page 136 for more information.

The Time Editor is displayed (FIGURE 10-1).

2. If any value is in the Time Expression field, highlight the value and delete it by
clicking the Delete button.

3. Click the Insert button.

The Time window is displayed with the Comparison tab selected.

4. Determine the start of the Time Range (9:00 AM).

The time range determines the time period when the software checks the system

load average. The software does not check the system load average outside the time

period specified by this window. In this example, the time range is from 9:00 AM to

5:00 PM every day.

a. Select Hour from the left pull-down menu.

b. Select >= from the middle pull-down menu.

c. Select 9 from the right pull-down menu.

The Time expression Hour>=9 is displayed in the Current Time Expression field

(FIGURE 10-15).
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FIGURE 10-15 Comparison Tab With Greater Than or Equal to 9:00 AM

5. Click the Apply button.

The Time Editor is updated. The Current Time Expression now reads Hour>=9. In

this example, both conditions should occur in the alarm window time range.

However, the Time Editor also enables you to select the Or expression (FIGURE 10-16).

FIGURE 10-16 Time Editor With Greater Than or Equal to 9:00 AM

6. Determine the end of the Time Range by clicking the Insert button.

The Time window is displayed with the Comparison tab selected.

7. Determine the end of the Time Range (Friday).

a. Select Hour from the left pull-down menu.
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b. Select <= from the middle pull-down menu.

c. Select 17 from the right pull-down menu.

The Time expression Hour<=17 is displayed in the Current Time Expression field

(FIGURE 10-17).

FIGURE 10-17 Comparison Tab With Less Than or Equal to 5:00 PM

8. Click the Apply button.

The Time Editor is updated. The Time expression now reads Hour>=9 And

Hour<=17 (FIGURE 10-18).

FIGURE 10-18 Time Editor With Time Interval Between 9:00 AM and 5:00 PM
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9. Click the Apply button.

The alarm window field in the Attribute Editor is updated. The software will check

the system load average (over five minutes) from 9:00 AM Monday to 5:00 PM

Friday (FIGURE 10-19).

FIGURE 10-19 Alarms Attribute Editor With Alarm Window From 9:00 AM to 5:00 PM
Every Day
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CHAPTER 11

Managing Modules

This chapter describes the following topics:

■ To Load a Module

■ To Edit Module Parameters

■ To Disable a Module

■ To Enable a Module

■ To Unload a Module

■ To Set a Module Schedule

■ To Set Security Permissions for a Module

Sun Management Center Modules

Sun Management Center modules are responsible for collecting data from specific

monitored resources. These modules can be dynamically loaded, enabled, disabled,

and unloaded into a Sun Management Center agent.

■ Loading a module adds the module icon to the Browser Details window, defines

the managed object and data properties, and starts data acquisition. The data

properties for the managed object are displayed in the Details window. The data

display is periodically refreshed.

■ Enabling a module restarts data acquisition if the module has been previously

disabled. The data display for the managed object is periodically refreshed in the

Details window.

■ Disabling a module temporarily stops data acquisition for the managed object

until the module is enabled. While a module is disabled, the data is not refreshed.

Also, it also does not trigger an alarm (even if you do a manual refresh). Alarms

are not triggered until the module is re-enabled.

■ Unloading a module stops data acquisition for the managed object. The managed

object and data properties are undefined and the module icon is removed from

the Browser Details window.
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Default Modules

Some or all of the following modules are loaded by default when you install the

software.

■ Agent Statistics

■ File Scanning

■ Kernel Reader

■ Config-Reader (for supported hardware platforms)

■ Simple MIB-II

Module List

TABLE 11-1 lists generic modules that you can load and use. The list of modules that

is displayed for your system is dependent on the type of platform you have. See

your supplement for more information on platform-specific modules, including the

Config-Reader and Dynamic Reconfiguration module. For information on the other

Sun Management Center modules, see Appendix D.

TABLE 11-1 Sun Management Center Modules

Module
Module Version
Number Description

Agent Statistics 2.0 Provides information about the health of the agent

installed on a host by monitoring the objects,

processes and execution of processes by the agent.

Config-Reader 1.0 Provides the hardware configuration of the host.

Both the physical view and the logical view require

that this module be loaded.

Data Logging

Registry

2.0 Provides information about data logging in agents

including log destination, module name, logging

interval, and buffer length. Multiple copies of this

module can be loaded.

Directory Size

Monitoring

2.0 Enables you to isolate and monitor the size of any

directory and its subdirectories on a host where a

Sun Management Center agent is installed.

Multiple copies of this module can be loaded, or

you can add additional directories for monitoring

by adding a row in the properties table.

Dynamic

Reconfiguration

2.0 Enables Sun Management Center software users to

perform dynamic reconfiguration operations on

DR-enabled monitored hosts.
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File Monitoring 2.0 Monitors selected files on a host. Monitored

parameters include file size and timestamps.

Multiple copies of this module can be loaded. This

module requires you to add rows in the data

property table. For more information, see “To Add

a Row (for the Directory Size Monitoring, File

Monitoring, File Scanning, and Process Monitoring

Modules)” on page 106.

File Scanning 2.0 Scans files on a host for specified patterns. Multiple

copies of this module can be loaded. This module

requires you to add rows in the data property table.

For more information, see “To Add a Row (for the

Directory Size Monitoring, File Monitoring, File

Scanning, and Process Monitoring Modules)” on

page 106.

HP JetDirect 2.0 Monitors the status of HP printers equipped with a

JetDirect card. Multiple copies of this module can

be loaded.

Health Monitor 2.0 Enables you to monitor various resources usage in

your host such as CPU, disk, NFS, and SNMP.

Kernel Reader 2.0 Provides kernel statistics, such as CPU details,

system call, faults, streams, disk information, and

page information.

Kernel Reader

Simple

1.0 Provides kernel statistics, such as load statistics,

swap statistics, and streams statistics. Also

provides software rules information.

Logview ACL 1.0 This module supports viewing and monitoring of

the system log, Sun Management Center log, and

other log files, using the Modules tab on the Details

window.

MIB-II

Instrumentation

1.0 Provides the system, interfaces, IP, ICMP (internet

control message protocol), TCP (transmission

control protocol), and UDP (user datagram

protocol) MIB-II (management information base)

group information of the monitored host.

MIB-II Proxy

Monitoring

2.0 Provides proxy management of hosts that are

running non-Sun Management Center MIB-II

SNMP agents. Multiple copies of this module can

be loaded.

TABLE 11-1 Sun Management Center Modules (Continued)

Module
Module Version
Number Description
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For more information on modules, see Appendix D.

NFS File Systems 2.0 Provides information about the NFS file systems on

monitored hosts by monitoring the amount of disk

space occupied by mounted or unmounted file

systems and the amount of used and available

space as well as the file system’s remaining total

capacity.

NFS Statistics 2.0 Monitors the number of NFS calls and RPC (remote

procedure calls) received by the server as well as

the status of the transaction activity on the

monitored host. Multiple copies of this module can

be loaded.

Print Spooler 3.0 Monitors the status of the printer daemon and print

queue on the monitored host as well as the printer

devices installed on it.

Process

Monitoring

2.0 Monitors one or more processes on the host.

Specifies monitored processes by matching

patterns. Multiple copies of this module can be

loaded. This module requires you to add rows in

the data property table. For more information, see

“To Add a Row (for the Directory Size Monitoring,

File Monitoring, File Scanning, and Process

Monitoring Modules)” on page 106.

Simple MIB-II 1.0 Provides the system Group, interfaces Group, IP

Forwarding, IP Route Table information of the

standard MIB-II (Management Information Base)

group information of the monitored host. This is a

scaled-down version of the MIB-II Instrumentation

module.

Solaris Process

Details

2.0 Displays detailed information of Solaris processes

running on a host where the Sun Management

Center agent has been installed. The Process Details

window requires that this module be loaded.

Storage A5x00 1.0 Enables you to monitor the state of A5000, 5100,

and 5200 storage devices, and manage alarms on

these devices.

Sun StorEdge T3 1.0 Enables you to monitor the state of T3 storage

devices, and manage alarms on these devices.

TABLE 11-1 Sun Management Center Modules (Continued)

Module
Module Version
Number Description
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Note – The Config-Reader and Dynamic Reconfiguration modules are supported

only on specific hardware platforms. For more information, refer to your

supplement.

Note – Depending on your system hardware, additional modules may be

supported. For more information, refer to the Sun Management Center web site:

http://www.sun.com/sunmanagementcenter .

Loading Modules

To load a module, follow these steps.

▼ To Load a Module

1. Select the host machine on which the module will be loaded by clicking on the
host machine icon.

Note – If you haven’t selected a host before attempting to load a module, the Load

Module option in the Tools pull-down menu is gray and cannot be used.

2. Open the Load Module dialog by doing one of the following:

■ Click the right mouse button on the selected host icon and highlight Load Module

from the pop-up menu in the hierarchy view or the topology view (FIGURE 11-1).

■ In the main console window, select Tools ➤ Load Module.

■ In the Details window, select host name and then Module ➤ Load Module.

■ In the Details window, select the Modules tab to display the Module status screen.

Note – See Chapter 16 for more information on managing modules, using the

Module status screen.
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FIGURE 11-1 Load Module Pop-Up Menu in Topology View

The Load Module dialog is displayed (FIGURE 11-2).
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FIGURE 11-2 Load Module Dialog

The Load Module dialog lists Sun Management Center modules. If a number

appears next to the module name, for example as shown above for the File Scanning

Module, the number indicates the number of existing instances of that module on

your host. An instance is a single word or alpha-character string that is used

internally within the Sun Management Center agent to identify uniquely a particular

module or a row within a module.

Note – Some modules can have multiple instances loaded on a host.

Note – You must specify a unique name for each instance when multiple instances

of the same module are loaded.

3. Click the name of the module you want to load.
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4. Click the OK button.

The Module Loader dialog is displayed. The contents of the dialog varies with the

module that is selected. FIGURE 11-3 and FIGURE 11-4 show possible examples of the

dialog.

FIGURE 11-3 Module Loader Dialog For Directory Size Monitoring
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FIGURE 11-4 Module Loader Dialog for Process Monitoring

5. If necessary, type the relevant information into any editable name fields.

For example, the Directory Size Monitoring module requires you to enter the name

of the instance and a description. (An instance is a single word or alpha-character

string that is used internally within the Sun Management Center agent to identify

uniquely a particular module or a row within a module.)

If you do not type in information for a necessary field, the software responds with

an error message and the module is not loaded.

6. Complete this procedure with one of the following actions:

■ Click OK to accept the changes you have made and close this dialog.

■ Click Reset to undo your changes.

■ Click Cancel to cancel your request.

Note – You can also double-click a module name in the Load Module dialog to load

that module.
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Editing Modules

The Sun Management Center software enables you to edit modules by changing

module parameters and enabling or disabling modules.

▼ To Edit Module Parameters

1. Select the module for editing.

2. In the Details window, select Module ➤ Edit Module (FIGURE 11-5).

FIGURE 11-5 Module Menu in Details Window

3. Edit Module Menu in Details Window

The Module Parameters Editor is displayed.

4. Type the relevant information into the editable fields.

FIGURE 11-6 shows an example. The actual display varies with the module that is

selected.
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FIGURE 11-6 Module Parameter Editor

5. Complete this procedure with one of the following actions:

■ Click OK to accept the changes you have made and close this window.

■ Click Reset to reset the module to the default parameters.

■ Click Cancel to cancel your request.

▼ To Disable a Module

● Click the right mouse button on the selected module and highlight Disable
Module from the pop-up menu in the hierarchy or contents view.

OR
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● In the Details window, select Module ➤ Disable Module (FIGURE 11-5).

When the module has been disabled (turned off), the following message is displayed

at the bottom of the Details window (FIGURE 11-7).

FIGURE 11-7 MIB-II Instrumentation Module Is Disabled

If the disabled module is the Solaris Process Details module, the following message

is displayed at the bottom of the Details window.

Caution – Because data is not being refreshed for a disabled module, the data will

not trigger an alarm until you re-enable the module (even if you manually refresh

the data).

▼ To Enable a Module

● Click the right mouse button on the selected module and highlight Enable
Module from the pop-up menu in the hierarchy or contents view.

OR

Module successfully disabled.

Solaris Process Details module disabled. Process data may not be
current.

This icon indicates the module is disabled
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● In the Details window, select Module ➤ Enable Module (FIGURE 11-5).

When the module has been enabled (turned on), the following message is displayed

at the bottom of the Details window.

▼ To Unload a Module

1. Proceed with one of the following:

■ Click the right mouse button on the selected module and select Unload Module

from the pop-up menu in the hierarchy view or the contents view.

■ In the Details window, select Module ➤ Unload Module (FIGURE 11-5).

The Confirm Module Unload dialog is displayed.

2. Click the Unload button to remove the module or the Cancel button to cancel this
request.

Monitoring Modules

Tip – If you want to monitor one type of module on a number of hosts, you can

create module objects for each host and place all of the objects in a common location

(that is, in the same group or administrative domain). To create a module object, see

“To Create a Module Object” on page 35.

Attribute Editor for a Module

The Attribute Editor for a module provides additional information about the module

and enables you to customize various monitoring criteria. You can use the module

Attribute Editor to set:

■ Module schedules

■ Security permissions

Module successfully enabled.
Chapter 11 Managing Modules 179



Note – The Attribute Editor consists of a series of one or more tab buttons at the top

of the window that enables you to switch between different panels. The buttons that

are displayed are dependent on the selected object.

Setting a Module Schedule

You may determine when a module should be active and when it should be inactive

by setting a schedule. For example, you can schedule a module to run between

8:00 AM and 5:00 PM every day. At all other times, the module is inactive, whether

or not an alarm condition exists.

▼ To Set a Module Schedule

1. Open the Attribute Editor for a module by proceeding with one of the following:

■ Click the right mouse button on the selected module icon and highlight Attribute

Editor from the pop-up menu in the hierarchy view (FIGURE 11-1) or the topology

view (FIGURE 11-1).

■ In the Details window, click the Attributes button.

2. Click the Schedule tab (FIGURE 11-8).

3. Click the Advanced button and set the module schedule.

See “To Create an Alarm Schedule Using the Comparison Tab” on page 162 for

details.

4. Complete this procedure with one of the following actions:

■ Click OK to accept the changes you have made and close this window.

■ Click Apply to apply your changes without closing this window.

■ Click Reset to reset the Attribute Editor to the default parameters.

■ Click Cancel to cancel your request.
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FIGURE 11-8 Setting a Module Schedule
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Setting Security Permissions for a Module

You can set security permissions for an individual module.

The security permissions for a module override the default security permissions for

its parent object or host. For example, if a user has administrator privileges for a

module, but only general privileges for the host, the user still retains administrator

privileges for the module. For further information on privileges, see Chapter 14.

▼ To Set Security Permissions for a Module

1. Open the Attribute Editor for a module by proceeding with one of the following:

■ Click the right mouse button on the selected host icon and highlight Attribute

Editor from the pop-up menu in the hierarchy view (FIGURE 11-1) or the topology

view (FIGURE 11-1).

■ In the Details window, click the Attributes button.

2. Click the Security tab (FIGURE 11-9).

3. Type the name(s) of user and administrator groups in the appropriate fields.

4. Complete this procedure with one of the following actions:

■ Click OK to accept the changes you have made and close this window.

■ Click Apply to apply your changes without closing this window.

■ Click Reset to reset the Attribute Editor to the default parameters.

■ Click Cancel to cancel your request.
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FIGURE 11-9 Setting Module Security in the Attribute Editor
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CHAPTER 12

Alarm Manager

The Alarm Manager software monitors your hardware and software and notifies

you, through alarms, when abnormal conditions occur. These alarms are triggered

by conditions outside of preset range or by Sun Management Center rules. Default

alarm conditions and rules are included in the modules. You can also set up your

own alarm thresholds. For a list of Sun Management Center rules, see Appendix E.

The Sun Management Center 3.0 Alarm Manager enables you to:

■ View alarms in pages from a database

■ Manually run the currently registered action after an alarm has been triggered

■ Set and change the currently registered action from a list of all installed actions

■ Sort alarms

■ Read the factory default suggested fix for a rule

■ Create a new user-default suggested fix for a rule

■ Keep a running record of user notes for an alarm instance

This chapter describes the following topics:

■ To Access Alarms From the Main Console Window

■ To Access Alarms From the Alarms Tab in the Details Window

■ To Acknowledge New Alarms

■ To Filter the Alarms Table

■ To Delete Alarms

■ To Enter an Alarm Note

■ To View and Add Suggested Fixes

■ To Modify Currently Registered Actions

Note – The messages displayed in the Alarms page of the Details window are

always in English. They are not translated in other languages. However, the text in

all dialog windows and in suggested fixes is internationalized.
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Alarm Information

The Alarms Manager software displays alarm information for managed objects. You

can view object alarm information in an administrative domain in the Main Console

and Details Alarm windows.

Tip – Pointing your cursor at the alarm icons in these windows displays an object

status description.

Note – The Sun Management Center agent is configured so that only one server

receives alarm information from that agent.

You can acknowledge, delete, and manage the object alarms by using the Alarms

Details window. For more information, see “To Access Alarms From the Main

Console Window” and “To Access Alarms From the Alarms Tab in the Details

Window.”

Domain Status Summary

A managed object status summary is displayed in the Main Console window

(FIGURE 5-1) in the Domain Status Summary. These colored icons (FIGURE 5-3)

designate the severity of the alarms.

Tip – Pointing your cursor at the alarm icons in this summary displays the icon

definitions.

Numbers next to the alarm icons in the Domain Status Summary (FIGURE 5-3)

indicate the number of managed objects for which the highest severity open,

unacknowledged alarm is represented. For example, a number 1 next to the yellow

alarm icon (center) indicates that there is one managed object for which the highest

severity alarm is yellow (alert).

The Domain Status Summary displays the number of managed objects in the

administrative domain that have at least one unacknowledged open alarm of a specific

severity.
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Note – If two or more types of alarms exist in the host, the color of the more severe

unacknowledged open alarm is displayed in the Domain Status Summary.

If the most severe alarm on one host is critical (red) and the most severe alarm on

another host is alert (yellow), you see the number 1 next to both the red alarm icon

and the yellow alarm icon.

Down Alarms

A down alarm (the black alarm icon with a down arrow in FIGURE 12-2) indicates that

a service-affecting condition has occurred and an immediate corrective action is

required. An example of this condition is when a resource defined by a managed

object has gone out of service and that resource is required; for example, a module

has gone down (exited).

Critical Alarms

A critical alarm (the red alarm icon with the vertical bar in) indicates that a service-

affecting condition has developed and an urgent corrective action is required. An

example of this condition is when a severe degradation in the capability of an object

has occurred and the object needs to be restored to full capability.

Alert Alarms

An alert alarm (the yellow alarm icon with the slanted bar in FIGURE 12-2) indicates

that a non-service-affecting condition has developed and a corrective action should

be taken in order to prevent a more serious fault.

Caution Alarms

A caution alarm (the blue alarm icon with the horizontal bar in FIGURE 12-2) indicates

the detection of a potential or an impending service-affecting fault, before any

significant effects have occurred. Action should be taken to diagnose further (if

necessary) and correct the problem in order to prevent it from becoming a more

serious service-affecting fault.
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Off/Disabled Alarms

A disabled alarm (the white alarm icon with a black X in FIGURE 12-1) indicates that

a resource for a managed object is disabled; for example, a module is disabled.

Note – Objects with black star icons that may look like a “splat” on your screen, are

objects with indeterminate states, not to be confused with alarms. A black star or

splat icon in the Main Console window means that a data acquisition failure

occurred in that object. The failure is not the result of a rule infraction, so no alarm is

associated with it. FIGURE 12-1 contains and example of the splat icons in the Browser

Details window.

FIGURE 12-1 Objects With Indeterminate States Identified by Black Star or “Splat” Icon

Note – When you view the data property table for an object, a pink row is another

indication of an indeterminate object state.

Alarm Icon Colors

The Alarm Manager software alerts you to an unacknowledged open alarm condition

that exists using several different methods:

■ Colored icons in the Domain Status Summary on the main console

■ Colored icons in the hierarchy (tree) view

Black splat
icons
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■ Colored icons in the contents view

■ Colored relevant row or column in the property table (contents view)

The type and color of alarm icon identify the severity of the alarm. For example, a

red alarm icon indicates a critical condition has developed and corrective action is

required immediately. By contrast, a blue alarm icon indicates a potential or an

impending service-affecting fault.

FIGURE 12-2 shows an unacknowledged, open critical alarm in the Swap Statistics

properties table Used KB row. The row is red, which indicates a critical alarm.

FIGURE 12-2 Browser Details Window Swap Statistics Alarm

The alarm icons are propagated up the hierarchy tree view, from the individual

module up to the host. For example, FIGURE 12-2, shows an unacknowledged, open

error condition (critical alarm) in the Swap Statistics icon. You see this same red

alarm icon on the Swap Statistics icon, on the Kernel Reader icon module, on the

Operating System icon, and the host icon.

In addition, you also see a red alarm icon on the corresponding host, group (if any),

or administrative domain in the main console window unless an unacknowledged

open black alarm (of higher severity) exists.
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Note – Unacknowledged alarms take precedence over acknowledged alarms. If the

hierarchy has two or more types of alarms, the color of the more severe

unacknowledged alarm is propagated up the tree. For example, if there is a yellow

unacknowledged alarm in CPU usage, and a red unacknowledged alarm in Disk

Statistics, only the red alarm icon is propagated. However, if there is a yellow

unacknowledged alarm in CPU usage, and a red acknowledged alarm in Disk Statistics,

only the yellow alarm icon is propagated.

▼ To Access Alarms From the Main Console

Window

1. Click one of the buttons in the Domain Status Summary (FIGURE 5-1) in the Main
Console window.

A list of objects that have at least one open, unacknowledged alarm, the highest

severity of which is that of the icon on the button, is displayed in the Domain Status

Details window.

For example, if you click on the button with the yellow alarm icon (alert alarms), the

Domain Status Details window displays a list of objects for which the highest

severity, unacknowledged, open alarms are yellow (alert). The number of objects

displayed is equal to the number on the button within approximately a five second

delay period).

2. Complete this procedure with one of the following actions:

■ Double-click on the desired row in the table.

■ Single-click on the desired row to select it, and then click the Details... button.

The Alarms Details window (FIGURE 12-3) is displayed.

▼ To Access Alarms From the Alarms Tab in the

Details Window

1. With your right mouse button, click the selected host icon in the Main Console
window and click Details in the pop-up menu.

The Browser Details window is displayed.

2. Click the Alarms tab.

The Alarms Details window is displayed (FIGURE 12-3).
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Note – A bold header and a down or up arrow indicate which column the table is

sorted on and the sort order. The alarms table shown in FIGURE 12-3 is sorted in

descending order (down arrow in Start time column) by start date and time, newest

to oldest alarm. This is the default sort order for the table.

FIGURE 12-3 Alarms Details Window

Alarms Table

The alarms table contains a statistical summary of all alarm data for the managed

object that you select.
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Note – If the object is a platform, see your platform supplement for more

information.

This table can be filtered and sorted to display only the information you currently

want to see in the order that you want to see it. Alarms can be filtered and sorted

from the alarms table. For additional details, see To Filter the Alarms Table” and “To

Sort the Alarms Table.”

Database Paging

The length of the alarms table, that is the maximum number of alarms that can be

displayed on a page, is 50. The current page number and total number of alarms for

the selected object in the database are displayed at the top of the table.

When new alarms occur, the currently displayed alarms table does not change,

whether or not these alarms affect the current page. Instead, the Refresh button

displays a two state icon. This icon indicates that new alarms have arrived and you

should update (Refresh) the table to include the new alarms as soon as it is

convenient.

When you delete alarms, the table is updated immediately; the deleted alarms no

longer appear in the table. When alarms are deleted by another user, you may see

blank rows in the alarms table. A Refresh request recomputes the pages and updates

the table to remove the deleted alarms. Only one page of alarms is displayed per

request. Additional pages can be seen by using the Page Navigation buttons above

the alarms table.
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Page Navigation

TABLE 12-1 lists the Page Navigation information and buttons in the Alarms Details

window. Informational messages inform you when the first and last pages of the

table are displayed. A scroll bar enables you to scroll through each page of the table.

Alarm Categories

The alarms table presents different categories of detailed alarm information. Some of

this information (TABLE 12-2) is always displayed in the alarms table.

TABLE 12-1 Alarm Table Page Navigation Information and Buttons

Item Function

Current Page Indicates the number of the page currently being displayed. Any

page can be selected by using the down arrow or typing in the

desired page number.

First Displays the first page of the alarms table

Previous Displays the previous first page of the alarms table

Next Displays the next page of the alarms table

Last Displays the last page of the alarms table

Total Alarms for

Object

Displays the total number of alarms currently registered for the

selected object

TABLE 12-2 Alarm Categories Displayed in Alarms Table

Category Description

Severity Indicates the severity of the alarm; black is most severe and grey is

least severe. A green check mark in this column indicates that the

alarm was acknowledged.

Start time Date and time the alarm occurred

State Indicates the state of the alarm: open (“ringing” bell icon) or closed

(“silent” bell icon)

Action Indicates the action taken by the user or the program in response to

the alarm condition.

Message Abbreviated message that indicates the type of alarm
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Additional information (TABLE 12-3) is displayed on the bottom of the page when an

alarm row is selected. This information is only displayed for closed and/or

acknowledged alarms.

Selecting an alarm row displays any available additional information associated

with that alarm. The additional information consists of the end time of the alarm, the

acknowledgment date and time, and the user ID of the user who acknowledged the

alarm.

Alarm States

A bell icon in the State column of the alarms table indicates the state of each alarm.

Each alarm has two states: open and closed.

An open alarm is one in which the condition that caused the alarm still exists. A

closed alarm means the condition no longer exists. Open alarm icons are “ringing”;

closed alarm icons are “silent.”

Alarm Action Status

Each alarm can have one of three action conditions: no action, pending or executed.

No action means that an action has not been registered for that alarm. Pending

action means that the action is manual and must be executed using the Run button.

Executed means that the action is automatic and has already been done by the

Alarms Manager software.

A three-state icon in the Action column of the alarms table indicates the status of

each alarm.

TABLE 12-3 Additional Alarm Information

Item Description

Alarm Ended On Date and time the alarm condition was fixed

Alarm Acknowledged

On

Date and time the alarm was acknowledged and the user ID of the

person who acknowledged it.
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Sorting the Alarms Table
Table sorting is done in the database. Double-clicking a column header sorts the

entire table in descending order according to the contents of that column. Double-

clicking again reverses the sort order (ascending) and so on.

The column headers have an down or up arrow to the right of the header. These

arrows indicate the order in which the table is sorted, descending (down arrow) or

ascending (up arrow). The arrow indicator and the selected column header are

boldface to identify current sort order. TABLE 12-4 lists the default sort order for each

header.

▼ To Sort the Alarms Table

● Double-click any column header in the table.

The alarms table is redisplayed immediately in descending order. To change the

order to ascending, double-click the header again. There may be a time delay for

large numbers of alarms.

TABLE 12-4 Alarm Sorting Order

Table heading Sorting Order

Severity Alarms are sorted from highest severity to lowest severity.

Start Time Alarms are sorted from newest to oldest.

Action Alarms are sorted as follows: alarms with completed (executed)

actions first, pending actions second, and no actions third.

State Alarms are sorted from open to closed.

Message Alarms are sorted alphabetically.
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Managing and Controlling Alarms

You can manage and control the alarms displayed in the alarms table by using the

buttons and menu above the table: Acknowledge, Run, Refresh and the Options.

TABLE 12-5 lists these items and describes their functions.

Acknowledging New Alarms

New alarms must be acknowledged so you can track the status of newer alarms

more easily. Unacknowledged alarms continue to be displayed in the Domain Status

Summary, hierarchy (tree) view, contents view, topology view and the relevant row

or column in the property table (contents view).

▼ To Acknowledge New Alarms

1. Select the alarm(s) you want to acknowledge by clicking the alarm row(s) with
your left mouse button.

The selected row is highlighted.

TABLE 12-5 Alarm Management and Control Buttons

Button Functions

Acknowledge Enables you to acknowledge the existence of a new alarm. A green

check mark is displayed in the severity column after you

acknowledge an alarm.

Run Enables you to execute the registered action to be taken for a

specific alarm. Only pending manual actions can be executed using

this button.

Refresh Updates the currently displayed alarms table. The date and time of

the last refresh are displayed above the alarms table in the Last

Refresh field.

Options Displays a pull-down menu of alarm controls and actions.
FIGURE 12-4 shows the Options Menu. TABLE 12-6 describes the

optional controls and actions.
196 Sun Management Center 3.0 Software User’s Guide • November 2000



Note – You can select several rows at once by holding down your left mouse button

and dragging the cursor over the selected rows. If, after you select several rows, you

want to skip a few rows and select other rows, hold down the Control key and select

the additional rows by clicking each row. All selected rows are highlighted.

2. Click Acknowledge.
The user ID and date and time of acknowledgment are registered and displayed; a

green check mark is displayed next to the alarm icon in the Severity column

▼ To Run a Registered Alarm Action

● Select one or more alarms with pending actions in the alarms table and click Run.

The currently registered alarm action(s) for the managed node are invoked; the

action state in the alarms table changes from pending to executed. For additional

details, see “To Run a Registered Alarm Action” on page 197 and “To Modify

Currently Registered Actions” on page 203.

Refreshing the Alarms Table

As new alarms are entered into the database the currently displayed alarms table

does not change, regardless of whether these alarms affect the currently displayed

page. Instead, a two-state icon is displayed by the Refresh button at the top of the

Alarms Details window. This icon indicates that new alarms have arrived and you

should update the display soon as it is convenient. As existing alarms are deleted,

the alarms table is updated automatically. For additional details, see “Database

Paging” on page 192.

▼ To Refresh the Alarms Table

● Click the Refresh button.

The alarms table is updated to reflect the new alarms. The program recomputes the

division of pages to add the new alarms. The date and time of refresh are displayed

in the Last Refresh field.
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Using the Options Menu

FIGURE 12-4 shows the Options menu. TABLE 12-6 describes the alarm controls and

actions in this menu.

FIGURE 12-4 Alarm Control and Actions Options Menu

TABLE 12-6 Alarm Control and Actions Options

Option Function

View Alarms Enables you to filter the alarms table by severity, open or closed

alarms, and/or acknowledged or unacknowledged alarms.

FIGURE 12-5 shows the View Specific Alarms dialog.

Delete Alarms Deletes all of the selected alarms from the table. The deleted

alarm(s) are saved in an archive file on the server for 24 hours. A

confirmation message is displayed before the alarm is deleted.

Delete All Closed

Alarms

Deletes all the closed alarms from the table. The deleted alarm(s)

are saved in an archive file on the server for 24 hours. A

confirmation message is displayed before the alarm is deleted.

Modify Action... Modifies the registered alarm action. FIGURE 12-8 shows the Action

Selection dialog.

Add Note Enables you to keep a set of historical notes related to a specific

alarm instance to track the actions taken to correct a specific alarm

condition and by whom.

View Suggested Fix Displays the suggested fixes (Sun Management Center and user-

suggested) for the selected alarm.
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Filtering the Alarms Table

You can filter the alarms table by using the View Specific Alarms dialog

(FIGURE 12-5). This dialog enables you to select the severity, state, and

acknowledgement status of the alarms displayed in the table.

FIGURE 12-5 View Specific Alarms Dialog

▼ To Filter the Alarms Table

1. Select Options ➤ View Alarms in the Details Alarms window.

The View Specific Alarms dialog (FIGURE 12-5) is displayed.

2. Select the items to include in the alarms table by clicking the box(es) next to the
item(s).

A check mark is displayed in each box you select.

3. Complete this procedure with one of the following actions:

■ Click Apply to accept your selections and continue to display the View Specific

Alarms dialog.

■ Click OK to accept your selections and close the View Specific Alarms dialog.

The alarms table is filtered and redisplayed to reflect your selections.
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Deleting Alarms

Closed alarms should be deleted to conserve space and keep the alarms database

current. Open alarms should only be deleted if they are orphaned. You can delete

open alarms, but the potential exists for alarm information in the Alarms windows

to differ from alarm information in the hierarchy and topology views. That is, the

alarms are removed from the view in the alarms table, but the alarm condition may
still exist. An example of when this action may be required would be in the case of

an unloaded module. If the module has triggered alarms that were not closed before

it was unloaded, the alarms are orphaned. Orphaned alarms may remain in view

and may need to be deleted manually (forced deletion).

Caution – You should only delete open alarms when there is no other way to

remove these alarms.

▼ To Delete Alarms

1. Select the alarm(s) you want to delete by clicking the selected row(s) in the alarms
table.

A confirmation alert is displayed.

Note – You can select several rows at once by holding down your left mouse button

and dragging the cursor over the selected rows. If, after you select several rows, you

want to skip a few rows and select other rows, hold down the Control key and select

the additional rows by clicking each row. All selected rows are highlighted.

2. Select Options ➤ Delete All Closed Alarms or Delete Alarms.
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Entering Alarm Notes

This is an expanding list of notes for a specific alarm. You can enter notes over the

life of the alarm to track its history. FIGURE 12-6 shows the Add Alarm Note dialog.

FIGURE 12-6 Add Alarm Note Dialog

▼ To Enter an Alarm Note

1. Click Options ➤ Add Note.

The Add Alarm Note dialog is displayed.

2. Enter your comments in the text field of this dialog.

3. Click OK to accept your changes and close the Add Alarm Note dialog.
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Viewing Suggested Fixes
A factory default suggested fix can be displayed for each alarm when a specific

alarm is selected from the alarms table. FIGURE 12-7 shows the View Suggested Fix

dialog. The top half of this dialog displays the Sun Management Center suggested

fix. If you find that this fix is not adequate, you can create your own suggested fix.

FIGURE 12-7 View Suggested Fix Dialog

▼ To View and Add Suggested Fixes

1. Select an alarm from the alarms table.

2. Click Options View ➤ View Suggested Fix.

The View Suggested Fix dialog is displayed.

3. Enter your text in User Suggested Fix: field of this dialog.

The length of the suggested fix text is limited by the database to 512 bytes.

4. Click OK to accept your changes and close the View Suggested Fix dialog.

The specified Sun Management Center suggested fix remains at the top of the dialog.
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Registering and Modifying Alarm Actions

Some alarm actions can be initiated manually by you after an alarm occurs. Others

are done automatically by the Alarms Manager software after you register them.

Typically, you should register the actions to be taken before the alarm occurs.

For alarms with no registered actions, “no action” icon is displayed in the Actions

column of the alarms table. For alarms with a manual action, the “pending” icon is

displayed until the action is Run by the user. Then, the “executed” icon is displayed.

For alarms with an automatic action, the “executed” icon is always displayed.

You can register alarm actions for each object module before the alarm occurs by

using the Attribute Editor Actions tab, which displays the Alarms Actions and, in

turn, the Action Selection dialog (FIGURE 12-8). For additional details, see Chapter 9.

FIGURE 12-8 Action Selection Dialog

▼ To Modify Currently Registered Actions

1. Select an action pending alarm in the table and click Options ➤ Modify Action...
with your left mouse button.

The Action Selection dialog is displayed. Only alarms that are pending manual

action can be modified.

2. Select the action that you want to modify (Email or Other) and make the necessary
changes. For details, see Chapter 9.
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3. Click OK to accept your changes and close the Action Selection dialog.
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CHAPTER 13

Details

The Sun Management Center Details window provides detailed information about a

selected object. The following are described in this chapter:

■ To Start the Details Window

■ To Close the Details Window

■ To Display Online Documentation

■ To View the System Log File Messages

■ To View the SunMC Log File Messages

■ To View Other Log File Messages

■ To View a Hardware Configuration

The Details window displays several tab buttons. The commonly seen buttons are

shown in TABLE 13-1.

Clicking a tab button updates the window with the panel for that tab.
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Note – The tabs that are displayed in the Details window are dependent on the type

of object selected. For example, the Hardware tab is missing if the Config-Reader

module is not supported on your system. For additional information on the tabs for

your specific hardware object, see your supplement.

TABLE 13-1 Details Window Tabs

Tab Button Description

Info Provides general information such as host name, IP address, and

polling type.

Browser Enables you to navigate through the hierarchy and contents views

of the hardware, operating system, local applications, and remote

systems (for navigation purposes). This view is the default view.

(The Browser is covered separately in Chapter 6.)

Alarms Displays alarm status messages and the alarm controls for the host

or node. Enables you to acknowledge or delete alarms. (Alarms are

covered separately in Chapter 12.)

Modules Displays module status - which modules are currently installed,

whether they are enabled, and so on. Also displays which modules

are available, but not currently installed.

View Log Displays entries from host log files (such as system message logs).

Applications View Processes - Displays information about processes running in

the host. This is the default selected for the Applications tab.

Other applications - If you have installed custom or third-party

applications, the entries for the application(s) display below the

View Processes entry. Select an application and the application is

displayed in the right side of the window.

Depending on your licensing agreement, this tab also provides

access to the Hardware Diagnostics Suite software. You can display

the Hardware Diagnostic Suite online help text by selecting the

Hardware Diagnostic Suite link, and then clicking the Help button.

Hardware Displays configuration information (resources, physical view,

logical view, and dynamic reconfiguration status and controls), if

available, for a host.
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Navigating the Details Window

▼ To Start the Details Window

1. Double click the left mouse button on an object icon in either the hierarchy view
or the topology view.

Be sure to select an object, not a administrative domain, as the Details window is not

available for administrative domains.

The Details window is displayed (FIGURE 13-1).

FIGURE 13-1 Details Window for a Selected Object

From left to right, the icons are:
Attribute Editor
Set Property Value
Graph
Dataview
Probe
Refresh Now
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2. Click a tab to view detailed information for that category.

Tip – Some tabs have the ability to display many levels of detail. Double-click icons

in the Details window to see additional levels of information. A category may have

many subcategories.

Tip – If information in a table cell is too long to be displayed in full, you may be

able to see more information by holding the mouse pointer in the cell for several

seconds. A pop-up balloon (tool tip) is displayed, showing the complete text

contained in that cell.

Tip – The hierarchy can be expanded or compressed, depending on the position of

the expansion/compression icon (FIGURE 6-2). The icon is compressed when the

“handle” is pointing right. The icon is expanded when the “handle” is pointing

down.

Click the compression icon to expand the hierarchy view (“unroll” and display more

levels of detail).

▼ To Close the Details Window

● Click the Close button located at the bottom of the window.

▼ To Display Online Documentation

● Click the Help button located at the bottom of the window.
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Info Tab

Clicking the Info tab displays the Properties table. The general properties are listed

in the following table.

Browser Tab

The Browser tab displays hierarchy and contents views of the hardware, operating

system, local applications, and remote systems.

TABLE 13-2 General Properties in the Info Tab of the Details Window

Property Description

Entity Desc Label that you selected when you created the node.

Entity Full Desc Optional description you entered when you created the node.

Hostname Machine name 1

1. If you change the host name on the host device, the host name shown in this property table remains the old
name. To update the information, either modify the host object (see “To Modify an Object” on page 47 for more
information), or delete the host object with the old name, and recreate it with the new name.

IP Address IP address 2

2. When a Sun Management Center entity is added to the topology, the Topology Agent queries the entity for the
IP address and port of the Trap Handler and Event Manager components, as configured for the entity. But this
is the only time information is retrieved from the entity, so the information stored in the topology will be incor-
rect if the entity is ever reconfigured to correct a misconfiguration or change the server-context of the entity. If
the information shown here for the Trap Handler and Event Manager is compared with the expected configu-
ration of the entity and does not match, remove the entity from the topology and reenter it.

Netmask Netmask associated with the host.

Operating System Operating system type and version.

Entity Family Hardware architecture.

Entity Trap Destination Host IP address of Sun Management Center server which

receives this host’s trap information.

Entity Event Destination Host IP address of Sun Management Center server which

receives this host’s events information.

Entity Polling Type Agent or SNMP.

Target Hostname Host name of the target.

Target IP Address IP address of the target.
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See Chapter 6 for detailed information on using the Browser tab.

Alarms Tab

The Alarms Details window displays the alarms for the host. For detailed

information on using the Sun Management Center Alarm Manager, see Chapter 12.

Modules Tab

The Modules tab displays currently loaded modules, as well as those modules that

are available to your system but aren’t currently scheduled. This screen also allows

you to:

■ unload a module

■ load a module

■ edit module parameters

■ enable a module

■ disable a module

■ display module rules

■ schedule a module for loading at a later time

For detailed information on using the Modules tab, see Chapter 16.

View Log Tab

The View Log tab (FIGURE 13-2) enables you to view several types of messages:

■ System log messages stored in the /var/adm directory

■ Sun Management Center error messages

■ Other messages

File names in the /var/adm directory start with the word “messages”.

If you select the SunMC Log option on the Log File pulldown menu, a list of log file

choices is displayed. An example is shown in FIGURE 13-5.
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This window has two scrollable panes: Messages for and Monitored Messages. The

Messages for area contains the filtered, messages that you select using the Filter...

button. You can locate specific messages in this area by using the Find message

feature.

The Monitored Messages area contains the messages you select using the Monitor...

button. New messages in this field are highlighted.

FIGURE 13-2 View Log Screen

Note – If no messages match the Filter criteria, the message “no matches found for

this log file.” is displayed at the bottom of the View Log window.
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▼ To View the System Log File Messages

● Select Log File ➤ System Log.

Click the Log File field and highlight Syslog. The System Log messages are

displayed.

Note – Clicking the Reload button refreshes the display and adds the latest log

messages.

Filtering Your Messages

You can apply a filter to display only those messages that match the date range and

text pattern that you specify. The size of the search can be limited by specifying the

maximum number of matches to report.

▼ To Filter Your Log Request

1. Click the Filter... button (FIGURE 13-2).

The Message Filter Options dialog is displayed (FIGURE 13-3).

FIGURE 13-3 Message Filter Options Dialog
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2. Using the down arrows, select the starting date.

Highlight the month, day, and year for the first log message you want to view.

3. Select the starting time by using the down arrows.

Highlight the hour and minute for the first log message you want to view.

4. Select the ending date.

Highlight the month, day, and year for the last log message you want to view.

5. Select the ending time.

Highlight the hour and minute for the last log message you want to view.

6. Type the text pattern to be matched in the Text pattern to match field.

Note – Select a text pattern that is unique to the type of message in which you are

interested.

7. Click Forward or Backward to specify the direction of the message search through
the log file.

Note – To begin searching from the end of the log file, select Backward; from the

beginning, select Forward.

8. (Optional) Type the maximum number of log messages that should be matched in
the Maximum matches to report field.

If you enter zero (0),all matching messages are reported, up to a maximum of 100

messages.

9. Complete this procedure with one of the following actions:

■ Click OK to filter and reload your log messages and close this window.

■ Click Apply to filter and reload your log messages without closing this window.

■ Click Cancel to cancel your request.

Reload Button

Click the Reload button to refresh and reload the currentlyfiltered set of log

messages.
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Monitor Button

Monitoring enables you to view new log messages as they occur. Each new message

that arrives is highlighted.

▼ To Monitor Log Messages

1. Click the Monitor button on the View Log screen (FIGURE 13-2).

The Monitor Filter Options dialog is displayed (FIGURE 13-4).

FIGURE 13-4 Monitor Filter Messages Dialog

2. Click the check box next to Enable log file monitoring to enable or disable log file
monitoring.

A check mark in the box indicates log file monitoring is enabled. A blank box

indicates that log file monitoring is disabled.

3. To display only currently monitored log messages, click the check box next to
Clear old monitored messages.

A check mark is displayed in the box.

4. Type the text pattern to be matched in the Text Pattern to Match field.

You can use a UNIX regular expression. For information about regular expressions,

refer to the regex(1F) man page.

Note – Select a text pattern that is unique to the type of message in which you are

interested.

5. Complete this procedure with one of the following actions:

■ Click OK to monitor your log messages and close this window.

■ Click Apply to monitor your log messages without closing this window.

■ Click Cancel to cancel your request.
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Finding Specific Log Messages

You can search for a specific character sequence within that set of messages by using

the Find field. This field enables you to search for a specific text pattern after the

selected set of log messages has been loaded and displayed in the Messages for area.

Note – Wildcard searches using an asterisk (* ) character, are not supported in the

View Log find feature.

To search for a message that contains the asterisk character, precede the character

with a backslash (\), for example, \*.

After typing in the desired text pattern, the up/down arrow buttons find the next

occurrence of the pattern and highlight it.

▼ To Find a Log Message

1. Type the specific character sequence (part of the log message) in the Find field
(FIGURE 13-2).

2. Click Return or the down or up arrow to search the log messages for that
sequence.

The first matching message is highlighted.

3. Click the down or up arrow to continue your search and find additional
occurrences of the matching sequence.
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▼ To View the SunMC Log File Messages

1. Click the Log File field and highlight System Log. The SunMC Log File Menu
displays (FIGURE 13-5).

FIGURE 13-5 SunMC Log File Menu

2. Highlight the Sun Management Center log file you want to view.

The messages for the selected log file are displayed.

3. If you want to apply filters to the information, click the Filter button and enter the
filter parameters on the Message Filter Options dialog box.

The information id redisplayed, using the filter you selected.

▼ To View Other Log File Messages

1. Click the down arrow under the Log File field and highlight Other Log.

Note – The Logview ACL module (Local Applications) must be loaded, or this

option appears grayed out on the Module Status screen.
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2. If you want to filters the information, click the Filter button and enter the filter
parameters on the Message Filter Options dialog box.

The information is redisplayed using the filter you selected.

Applications Tab

This tab enables you to view and select detailed information about processes

running on the selected host or node. If you have any custom or third-party

applications installed, this tab also enables you to view detailed information about

processes running in the selected custom applications or third-party applications.

The displays are continually updated.

● Click on the application listed in the Applications list.

The right side of the window is updated with the selected application.

Note – The View Processes application is displayed by default whenever the

Applications tab is selected.

View Processes

The View Processes application (FIGURE 13-6) enables you to view and select detailed

information about processes running on the selected host or node.

Note – The Solaris Process Details module must be loaded to use the Process

Viewer. For instructions, see “To Load a Module” on page 171.

Note – If the Solaris Process Details module is not loaded when you first click the

Applications tab, then you must load the module, close the Details Window, and

then reopen the Details window to see the processes. Thereafter, the Solaris Process

Details module is unloaded or loaded dynamically. That is, you no longer need to

close and reopen the Details window to see the processes whenever this module is

unloaded or loaded.
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FIGURE 13-6 Process Viewer

Configuring the Process Display

▼ Selecting Columns for Viewing

1. Click the View Columns button above the Process table to display the View
Columns pull-down menu.

A pull-down menu is displayed (FIGURE 13-7) that enables you to add or remove

columns from the table.
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FIGURE 13-7 View Columns Menu

2. Highlight one or more process properties that you want to display.

The check box next to each selected property is displayed with a check mark

(FIGURE 13-7) and the right side of the Process Viewer window is updated. The new

column or columns are added to the display, to the right of the existing columns.

The total number of processes displayed is listed in the Process Summary field at the

bottom of the Details window.

TABLE 13-3 lists the properties that are available for the Processes view.

TABLE 13-3 Process Viewer Properties

Property Description

PID Process Identifier.

PPID Process ID of the parent.

UID Effective user ID number.

User Effective user login name.

EUser Effective user ID.

Group ID Group ID of the user.

EGroup Effective group ID of the user.
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Sorting Columns

You can sort the processes (rows) by the properties (column headers) in ascending or

descending order. For example, you can sort the CPU% column starting with either

the smallest or the largest value first.

▼ To Sort Columns in Ascending Order

● Click the property (table column header).

The processes (rows) are updated in ascending order for that property.

Session ID Process ID of the session leader.

PGroup Process ID of the process group leader.

Tty Controlling terminal for the process. A question mark (?) is printed

when there is no controlling terminal.

Start time Starting time of the process, in hours, minutes, and seconds. (The

start time for a process that is more than 24 hours old is given in

months and days.)

Time Cumulative execution time for the process.

State State of the process.

Wait Channel Address of an event for which the process is sleeping. If blank, the

process is running.

Class Scheduling class of the process.

Address Memory address of the process.

Size Size (in pages) in main memory for the image of the swappable

process.

Priority Priority of the process.

Nice Decimal value of the system scheduling priority of the process.

CPU% Ratio of CPU time used recently to CPU time available in the same

period, expressed as a percentage.

Memory% Ratio of the process’s resident set size to the physical memory on

the machine, expressed as a percentage.

Command Command name.

CommandLine Full command name and its arguments, up to a limit of 80

characters.

TABLE 13-3 Process Viewer Properties (Continued)

Property Description
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▼ To Sort Columns in Descending Order

● Click the property (table column header) while holding down the Shift key.

The processes (rows) are updated in descending order for that property.

Moving Columns

You can rearrange the order of columns.

▼ To Reorder Columns in the Table

1. Select a column by clicking and holding down the mouse button on the table
column header.

2. Drag the column to the desired position.

Process Statistics Window

The Output For Process ID window displays statistics for your choice of either

pmap, pstack, pfiles, or pldd for any highlighted process in the Process View

window.

Process Summary Field

The Process Summary field lists statistics for all processes, active or inactive.

TABLE 13-4 Process Statistics

Statistic Description

pmap Prints the address space map of each process.

pstack Prints a stack trace for each lightweight process (lwp) in each

process.

pfiles Reports fstat(2) and fcntl(2) information for all open files in

each process.

pldd Prints dynamic libraries for the process.
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Custom or Third-Party Applications

Note – To develop custom applications, you will need the Sun Management Center

Developer Environment and documentation. See your Sun authorized sales

representative for more information.

Custom or third-party applications, if you have any installed on your system,

display below Applications - View Processes in the left side of the Applications

Details window. Select the application if you do not want to view process detail

information for a host or node.

After you select an application, the selected properties for the application are

displayed in the right side of the Applications Details window. The properties

shown depend on the application selected.

Hardware Tab

Note – The Hardware tab is missing if this feature is not supported on your system.

The Hardware Details window (FIGURE 13-8) provides three choices for system

information:

■ Hardware Summary

■ Physical View

■ Logical View

Note – For additional information on the Hardware tab for your specific hardware

object, see your supplement.
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FIGURE 13-8 Hardware Details Window

To view the choices, pull down the Views Menu.

▼ To View a Hardware Configuration

Note – If you load or unload the Config-Reader or Dynamic Reconfiguration

modules while the Details window is open you must close, and then reopen the

Details window to see the results.

● Click once to highlight the configuration in which you are interested.

The window is updated and the selected feature is displayed.
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Hardware Summary

The Sun Management Center software displays a table of hardware resources of the

selected host. Here are some typical values displayed in the Hardware Summary

table.

Your table may appear different. The resources vary, depending on the type of object

displayed in the detail view.

Note – The Total Disks field only displays the number of internal disks. This number

does not include the disks that are part of enclosures.

Close/Help

Click Close to close the Details window and return to the main console. Click Help

to view online help text for the Details window.

Physical View

When you select the Physical view - system option, the software displays a

photo-realistic picture of the selected host (FIGURE 13-9), if available. Pictures are not

available for some system types.

Note – This feature is usable only if the host is monitored by a Sun Management

Center agent.

TABLE 13-5 Hardware Summary

Resource Description

Total Disks Total number of disks connected to the host

Total Memory Total amount of memory connected to the host

Total Processors Total number of processors connected to the host

Total Tape Devices Total number of tape devices connected to the host
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FIGURE 13-9 Hardware Configuration Physical View

As you move the mouse pointer over the picture of the system being viewed, some

of the components are highlighted. The detailed component information displays in

the right section of the viewing window, and the path name of the component is

displayed in the Component field at the bottom of the window.
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FIGURE 13-10 Hardware Configuration Physical View with Component Details (Property/
Value View)

Rotate Current View

For some systems, you can select alternate front, rear, and side views by selecting

entries in the Rotate Current View pull-down menu. Pictures are not available for

some system types.

For some systems, pictures of components such as CPU boards and I/O boards may

also be available. As you move the mouse pointer over various parts of the system

picture, the mouse pointer changes from an arrow to a hand icon when a detailed

picture is available for an individual component.
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Click a highlighted component to display the detailed picture of the component.

When you are finished viewing component details, click Up to return to the parent

system view.

Physical View When a Sun StorEdge Device is Connected

If a Sun StorEdge™ A5000, A5100, or A5200 is connected to the clicked component,

the Views pull-down menu lists the devices that are connected, under the system to

which they are connected. The Sun StorEdge A5000-series devices are displayed on

this menu as sena(0), sena(1), and so on

You can select and view any of these storage devices from the Views menu.

History

The History pull-down menu allows you to revisit a view you had selected

previously.

Refresh Details

Click Refresh Details to update the Property/Value information (in the right side of

the viewing window) for a highlighted physical component in the topology.

Otherwise, the information does not change from when you first opened the

physical view.

Dynamic Reconfiguration

The Dynamic Reconfiguration button is displayed in the physical and logical views

only for certain platforms. Refer to your hardware supplement for more information.

▼ To Reconfigure the System

1. Open the Details window for the selected system.

2. Select the Modules tab in the Details window and verify that the Dynamic
Reconfiguration (dr) module is loaded. Load the module if necessary.

3. Select the Hardware tab in the Details window.

4. Pull down the Views Menu and select “system” in either the Physical View or the
Logical View category.

The view changes, and a Reconfiguration button appears at top of the display.
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5. Click the Reconfiguration button.

If the Reconfiguration module is not loaded, a pop-up window displays an error

message.

If the Reconfiguration module is loaded, the Dynamic Reconfiguration pop-up

window appears (FIGURE 13-11). The example shows the display for a Sun Enterprise

4500 Server.

FIGURE 13-11 Dynamic Reconfiguration Pop-up Window

6. Select a board slot or memory bank.

The Dynamic Reconfiguration function buttons are highlighted for operations that

are permitted for the selected board or memory. Buttons are grayed out for functions

that are not permitted.

7. Click the desired function button for that memory or board.

TABLE 13-6 Dynamic Reconfiguration Functions

Function Action

Configure Adds the selected board or memory to the system configuration.

Turns on power to the board, if the board was not previously in the

Connected state.

Unconfigure Removes the selected board or memory from the system

configuration. Electrical power to the board is maintained.
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Logical View

The software displays a logical view configuration of a host (FIGURE 13-12) if the host

is monitored by a Sun Management Center agent. (Logical views are not available

for ping hosts.)

Connect Turns on electrical power to the board. Basic tests of the board are

run, but the board is not automatically added to the system

configuration. (Note: The Configure function includes this step.)

Disconnect Turns off power to the board. The board is ready to remove when

the yellow Service LED is lit, and the Power and Cycling LEDs are

off.

Test Memory Tests the selected memory. Note that memory tests can be time-

consuming and may take an hour or more for large-capacity

DIMMs.

TABLE 13-6 Dynamic Reconfiguration Functions

Function Action
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FIGURE 13-12 Hardware Configuration Logical View

Search

Clicking the Search button displays the Search window. Use the Search window to

search for components in the Logical View topology (the left side of the viewing

window).

Tip – The Search function is case-sensitive. The error message “Node not found” is

displayed at the bottom of the Details window if the search does not locate the

component in your system.
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Tip – The Search function stops at the first instance found. For example, if you enter

the word board , Search always stops at board(0) . To find board #2, enter enough

of the board name. For example, board(2) or just ard(2) are sufficient to identify

the specific target uniquely.

When the Search feature has located the component, it is highlighted in the topology

view. The name of the component displays in the Component field in the bottom

right section of the screen.

Expand All

Clicking the Expand All/Recover Default button decompresses and recompresses all

the component icons in the topology area (left side) of the window. For example,

here is the compressed view:

FIGURE 13-13 Compressed Topology of Components in Logical View

After you press Expand All, here is the expanded topology view:
Chapter 13 Details 231



FIGURE 13-14 Expanded Topology of Components in Logical View

The button label toggles to “Recover Default.” When you press Recover Default, the

topology recompresses all the component icons in the topology area of the window.

Refresh Details

Click Refresh Details to update the Property/Value information (in the right side of

the viewing window) for a highlighted logical component in the topology.

Otherwise, the information does not change from when you first opened the logical

view.

Dynamic Reconfiguration

The Dynamic Reconfiguration feature in the Logical View is the same as is described

in the previous section, “Physical View” on page 224.
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CHAPTER 14

Sun Management Center Security

Security in Sun Management Center software is based on Java™ security classes and

SNMPv2 usec (SNMP version 2, user-based security model) security standards. This

chapter discusses security features, users and groups, and their privileges.

The software offers the following layers of security:

■ Only valid Sun Management Center users can operate the software.

■ The software enables you to set security permissions or access control (ACL)

categories and provides control at the administrative domain, group, host, and

module levels.

■ It authenticates user login and access control for individual managed properties.

This chapter describes the following:

■ To Add Sun Management Center Users

■ To Access ACL on a Module

■ To Add a User-Defined Group to an ACL

■ To Grant a User esadm, esops, or esdomadm Privileges

■ To Delete Sun Management Center Users

■ To Override Default Privileges

Access Control Categories

The software offers the following ACL categories:

■ Admin, like the superuser (root ) in UNIX

■ Operator, as an operator who runs and monitors the system

■ General, like guest access with read-only viewing privileges

To understand ACL categories, you first need to understand Sun Management

Center software users and groups. The following sections explain users and groups.
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Sun Management Center Users

Sun Management Center users are valid UNIX users on the server host. As such, the

system administrator has to add valid users into the following file;

/var/opt/SUNWsymon/cfg/esusers.

If a user’s name is not in this file, that user cannot log into the Sun Management

Center software unless the user logs in as espublic or esmaster since these two

user names are part of this file. (See the following section for more information.)

Public and Private Users

During the Sun Management Center server setup, the file /var/opt/SUNWsymon/
cfg/esusers is created and the following users are added to the file automatically:

■ espublic
espublic is comparable to logging into a UNIX system as guest . It enables

users to have “general” privileges. For example, when a user tries to access

information from a session running in a different Sun Management Center server

from their own, they are given access as espublic and are able to view the

information as a guest only.

■ esmaster
esmaster is comparable to being superuser in UNIX. It automatically gives

“admin” access privileges to users logging into the software.

The administrator has to add the additional list of user IDs for all other users who

need to log into Sun Management Center software. All users in this file have

“general” access privileges, by default, unless they are given additional privileges

using the procedures described in “Using Access Control” on page 241.

Note – The user names espublic and esmaster are not configurable during

installation. They must specifically be defined as espublic and esmaster .

General Users

Any user who is part of the esusers file is known as a “general” user. Sun

Management Center general users can, by default, perform the following functions:

■ Log into the software

■ View the administrative domains, hosts, and modules that are created

■ View the events

■ Trigger manual refreshes

■ Run ad hoc commands

■ Graph data
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Sun Management Center Superuser

Implicitly, the Sun Management Center superuser belongs to all the groups

described in the following sections. Sun Management Center superuser has “admin”

privileges as described in “Sun Management Center Administrators or esadm” on

page 236.

Sun Management Center Groups

The following groups are created by default on the server host during the Sun

Management Center server setup:

■ esops
■ esadm
■ esdomadm

In addition, all the Sun Management Center users belong to a hypothetical group,

called ANYGROUP.

The above groups must be defined on the machine where the Sun Management

Center Configuration manager is running. They do not need to be defined on other

machines. These groups are described in greater detail in the sections that follow.

Note – The preceding groups are defined in the /etc/group file. Note that

although Sun Management Center esmaster and espublic users are configured as

members of the preceding groups, they are not explicitly mentioned in the

/etc/group file.

Sun Management Center Operators or esops

Sun Management Center software users belonging to the group esops are usually

referred to as operator users who run, monitor, and to some extent, configure some

parameters on the managed systems. As you can see in the following list, esops can

perform operations, including some that are allowed for general users:

■ Disable or enable modules

■ Set module active time window

■ Set alarm limits

■ Set rule parameters

■ Run alarm actions

■ Run adhoc commands

■ Set refresh interval

■ Acknowledge, delete, or fix events

■ Enable or disable history logging
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■ Set logging history parameters

Sun Management Center Administrators or esadm

Software users belonging to the group esadm can perform “admin” operations,

which are a superset of the operations that can be performed by operator users as

described in “Sun Management Center Operators or esops” on page 235. In addition

to all the operations that “operator” users (esops ) can perform, these “admin” users

(esadms) can perform the following operations:

■ Load or unload modules

■ Set ACL users and groups

■ View administrative domains, hosts, or modules

Sun Management Center Domain Administrators or
esdomadm

The users belonging to the group esdomadm can perform the following “domain

administrator” operations:

■ Create administrative domains

■ Create groups within administrative domains

■ Add objects to groups or administrative domains

■ View administrative domains, hosts, or modules

Note – Other than the privileges listed above, a user belonging to “esdomadm” is

just a “general” user, unless configured otherwise.
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Admin, Operator, and General Functions

TABLE 14-1 contains the different types of functions users can do by default.

This table is general in nature and applies to all modules. Individual modules may

also have specific restrictions, which are under the control of the module.

TABLE 14-1 Domain Admin, Admin, Operator, and General Functions

Function Domain Admin Admin Operator General

Load modules x

Unload modules x

Create administrative domains x

Create groups within

administrative domains

x x

Add objects to groups or

administrative domains

x x

View administrative domains,

hosts or modules

x x x x

Set ACL users or groups x

Disable or enable modules x x

Set module active time

window

x x

Set alarm limits x x

Set rule parameters x x

Run alarm actions x x

Run adhoc commands x x

Set refresh interval x x

Manually trigger a refresh x x x

Enable or disable history

logging

x x

Set logging history parameters x x

Acknowledge, delete, or fix

events

x x

View events x x x
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In Sun Management Center software, the above categories maintain inclusive
relationships or privileges. This means that, by default, a user who has esadm
privileges can do anything that a user who has esops privileges can. But an

administrator has the option to change the default permissions so that a user who

has esops privileges can do more than a esadm user. Inclusive relationships means

that these three groups, esops , esadm, and esdomadm, do not have any code

enforcement behind them which makes one group more powerful than the other.

For more information on how to override default privileges, see “Overriding the

Default Privileges” on page 247.

Specifying Access Control

The administrators (esadm group) can specify ACL features for users and groups for

the following:

■ Administrative domains

■ Groups within administrative domains

■ Hosts

■ Modules

Admin, Operator, and General Access

An ACL specification consists of establishing or defining one or more of the

following:

■ Administrator users and administrator groups

A list of users and groups who can perform administrator operations. By default,

they are esadm or esdomadm, wherever applicable.

■ Operator users and operator groups

A list of users and groups who can perform operator operations. By default, they

are esops .

■ General users and general groups

A list of users and groups who can perform general operations. By default, this is

a hypothetical group called ANYGROUP.

■ Communities for administrators (SNMP)

A list of SNMP communities that can perform admin operations using SNMP

protocol.

■ Communities for operators (SNMP)

A list of SNMP communities that can perform operator operations using SNMP

protocol.
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■ Communities for general (SNMP)

A list of SNMP communities that can perform general operations using SNMP

protocol.

Sun Management Center Remote Server Access

Users can access and view data from sessions running on remote Sun Management

Center servers. When a user tries to gain access to such information, that user is

provided access as espublic (guest) with read-only privileges. The behavior of Sun

Management Center sessions running on different servers is defined in terms of each

session’s server context. See “Sun Management Center Server Context” on page 239

for more information.

As a user, you can access and set up a different server context for a variety of

reasons:

■ To provide for separate security access privileges so that each server context

could have different users and administrators and yet be accessible to each other

■ To allow for physical separation between elements, as in the context of a wide

area network (WAN)

■ To increase performance since this would allow many hosts to be handled by one

set of central components

By linking to a different server context, you can view the top level status of the

objects in the other server context.

Sun Management Center Server Context

A server context is defined as agents running on many hosts, all sharing a single set

of the following central components:

■ Sun Management Center server

■ Topology manager

■ Event manager

■ Trap handler

■ Configuration manager

A server context is defined as a collection of Sun Management Center agents and the

particular server layer to which the console is connected. Agents within the same

server context can talk to each other. Agents in remote server contexts can talk using

read-only privileges.

Every Sun Management Center component or agent is configured at installation to

know the location of its Trap handlers and Event managers. Sun Management

Center software identifies the Trap handlers and the Event managers by their IP or
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port addresses. This means that if you want to determine if you are within your

server context or are accessing information from another server context, you need to

know the respective IP or port addresses of the servers that you access. Different

server contexts have different port numbers.

A remote server context refers to a collection of agents and a particular server layer

with which the remote agents are associated.

FIGURE 14-1 Remote Server Context

An agent gets its security configuration from the server layer. For example:

■ Agents within the same server context can talk to each other.

■ Agents in remote server contexts can talk remotely using read-only privileges.

■ Requests to agents in remote servers are performed as the Sun Management

Center espublic user. This allows successful requests across servers, as long as

Sun Management Center sessions on both servers have the same password for

user espublic .

■ Each Sun Management Center server maintains a list of agent IP or port address,

to distinguish objects in its own context from objects on a different Sun

Management Center server.

Limitations While Crossing Servers

Some security restrictions apply when a user tries to communicate across server

contexts.

Console

 Server

Agent Agent Agent

Server

Server context 1 Server context 2
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In the current Sun Management Center environment, you can access information

from another server with a few limitations:

■ If you try to access a different or remote server context, the server give you access

with espublic user privileges. Thus you can access data but cannot modify or

use the objects within the different server. You are restricted only to viewing the

remote server objects. Therefore, the following consequences apply:

■ You can access other server contexts as long as the espublic user password is

the same in all contexts.

■ You can view data in another context as user espublic , but you cannot

perform control actions, such as setting alarm thresholds, and other similar

functions.

■ Edit functions work differently in a remote server. For example, you can copy and
paste between contexts but cannot cut and paste between contexts.

Note – From a graphical user interface perspective, it is important to note that it

may not be obvious that you are accessing a different server context. To identify if

you are accessing a different server, check the server’s IP port number or address in

the Info tab of the Details window.

Using Access Control

The following sections describe how to perform the following key ACL functions:

■ To Add Sun Management Center Users

■ To Access ACL on a Module

■ To Add a User-Defined Group to an ACL

■ To Grant a User esadm, esops, or esdomadm Privileges

■ To Delete Sun Management Center Users

▼ To Add Sun Management Center Users

1. Become superuser (on the Sun Management Center server host).

2. Edit the file /var/opt/SUNWsymon/cfg/esusers . Make sure that the user name
is that of a valid UNIX user.

3. Add the user name on a new line.

4. Save the file and exit the editor.
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Note – By adding a user to the users list, the user has default privileges. See

“Default Privileges” on page 246 and “Overriding the Default Privileges” on

page 247 for more information.

▼ To Access ACL on a Module

1. Proceed with one of the following:

■ Click the right mouse button on the selected object and highlight Attribute Editor

from the pop-up menu.

■ Select Tools ➤ Attribute Editor in the main console window.

The Attribute Editor is displayed. The buttons at the bottom of the window are

grayed out, with the exception of the Cancel and Help buttons. The remaining

buttons become active if you modify any field in the window.

2. Select the Security tab within the Attribute Editor window (FIGURE 14-2).

3. Change the values as required.

For example, you may enter data as follows:
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FIGURE 14-2 Example of Security Fields in the Attribute Editor

Note – Use spaces or commas between multiple entries as illustrated in the entries

for “Operator” under “Users.”

The preceding example of the Attribute Editor with the Security tab selected

contains the following field entries:

TABLE 14-2 Security Attributes

Attribute Description

Administrator Users A list of users. jim is a user who can perform administrator

operations

Operator Users A list of operators. john and others are users who can perform

operator operations. Note that their entries are separated by one or

more spaces

General Users A list of general users. Here, nick and richie are users who can

perform general operations
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Note – For more information on security privileges, see “Access Control Categories”

on page 233.

▼ To Add a User-Defined Group to an ACL

1. Become superuser.

2. Create a group:

3. Add users to the newly created group:

a. Edit the /etc/group file.

b. Add users to the group.

c. Save the file and exit the editor.

4. Add the new group to the ACL of interest.

See “To Access ACL on a Module” on page 242 for more information.

Administrator

Groups

All the users belonging to esadm and administrators can perform

administrator operations. By default, they are esadm or esdomadm,

as applicable

Operator Groups All users belonging to esops can perform operator operations

General User Groups ANYGROUPis a hypothetical group that can perform general

operations. All Sun Management Center users belong to this

hypothetical group

Communities for

Administrators

This field is empty denoting that there is no SNMP community that

can perform admin operations using the SNMP protocol

Communities for

Operators

This field is empty denoting that there is no SNMP community that

can perform operator operations using the SNMP protocol

Communities for

General Users

public is an SNMP community that can perform general

operations using the SNMP protocol

# /usr/sbin/groupadd groupname

TABLE 14-2 Security Attributes

Attribute Description
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▼ To Grant a User esadm, esops , or esdomadm
Privileges

1. Become superuser.

2. Make sure that the user is a valid Sun Management Center user.

You may do this by adding the user to the /var/opt/SUNWsymon/cfg/esusers
file.

3. Edit the /etc/group file.

4. Add the user to one of the following lines as applicable: esadm, esops , or
esdomadm.

5. Save the file and exit the editor.

▼ To Delete Sun Management Center Users

1. Become superuser on the Sun Management Center server host.

2. Edit the file /var/opt/SUNWsymon/cfg/esusers .

3. Delete the line corresponding to the user name you want to delete.

4. Save the file and exit the editor.

5. Delete the user names from additional groups.

After a user is deleted from the list of Sun Management Center users, the user can

no longer log into the Sun Management Center server. Make sure to delete that user

from all the ACLs.
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Default Privileges

Administrative domains are manipulated by the Topology manager. This section

illustrates the default privileges for the Topology manager and for other agents and

modules.

Topology Manager Default Privileges

The default privileges for Topology manager (where administrative domains are

maintained) are listed in the following table.

TABLE 14-3 Default Privileges for Topology Manager

Topology Manager Default Privileges

List of Admin Users

List of Operator Users

List of General Users

List of Admin SNMP Communities

List of Operator SNMP Communities

List of General SNMP Communities public

List of Admin Groups esdomadm

List of Operator Groups esops

List of General Groups ANYGROUP
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Other Sun Management Center Component and

Module Default Privileges

The default privileges for all other components and modules are listed in the

following table.

The keyword ANYGROUPis not a true UNIX group, but is a special keyword that

means that “any user who can log into Sun Management Center software is given general
access to the objects.”

Overriding the Default Privileges

In Sun Management Center software, only administrators can override default

privileges using the Attribute Editor to modify the ACL lists for that particular

object.

The following section illustrates how to override default list privileges.

TABLE 14-4 Sun Management Center Component and Module Default Privileges

Components/Modules Default Privileges

List of Admin Users

List of Operator Users

List of General Users

List of Admin Groups esadm

List of Operator Groups esops

List of General Groups ANYGROUP

List of Admin SNMP Communities

List of Operator SNMP Communities

List of General SNMP Communities public
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▼ To Override Default Privileges

● Create the following override files in the /var/opt/SUNWsymon/cfg directory:

■ agent-acls-d.dat

■ topology-acls-d.dat

■ event-acls-d.dat

■ cfgserver-acls-d.dat

■ trap-acls-d.dat

The following example creates an admin group wheel for the agent instead of the

esadm. By default, it makes user 1, margot, and user 2, helen , admin users for

that agent.

Note that the lists of names are separated by spaces, such as, helen and margot .

The lines beginning with a pound sign (#) are comment lines and you may ignore

them. They are presented here for reference purposes only.

Note – Remember to create similar files for each component or machine.

For platform-specific information about security, see your supplement.

#   File:    agent-acls-d.dat
#   Version: %I% %E% %U%
#
#   Copyright (c) 1993-1997 Halcyon Inc.
#
#   e.g.
#       adminUsers =
#       operatorUsers =
#       generalUsers =
#       adminCommunities =
#       operatorCommunities =
#       generalCommunities =
#       adminGroups =
#       operatorGroups =
#       generalGroups =
#
       adminUsers = helen margot
       adminGroups = wheel
       operatorGroups = esops
       generalGroups = ANYGROUP
       generalCommunities = public
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CHAPTER 15

Grouping Operations

Note – This feature may or may not be available on your system, depending on

your licensing agreement.

A group operation is a task instance that is applied to an object group and is

(optionally) scheduled for execution. The key feature in this functionality is the

Group Operations window (FIGURE 15-2). This window enables you to create and edit

group operations. The main components of these group operations are:

■ An object group with an optional filter

■ A task, which could be one of the following types:

■ Module

■ Data Property

■ MCP Parcel (Module Configuration Propagation)

From the Group Operations window, you can create, modify, delete, and save these

components.

As you scroll down and highlight each existing group operation, a summary of each

main component is displayed under the Group, Filter, and Task Summary sections.

The following are described in this chapter:

■ To Create an Object Group

■ To Create a Task

■ To Create an Object Group

■ To Edit an Object Group

■ To Delete an Object Group

■ To Create a Filter

■ To Edit a Filter

■ To Delete a Filter

■ To Create a Task

■ To Create a Module Task

■ To Edit a Module Task

■ To Create a Data Property Task
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■ To Edit Data Property Tables

■ To Delete a Task

■ To Create an MCP Parcel

■ To Delete an MCP Parcel

■ To Create an MCP Task

■ To Edit an MCP Task

■ To Delete an MCP Task

Start by selecting Group Operation from the console Tools menu (FIGURE 15-1).

FIGURE 15-1 Console Window With The New Tools Menu

The main Group Operations window (FIGURE 15-2) is displayed by choosing Tools ➤

Group Operation in the Sun Management Center console window (FIGURE 15-1).
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FIGURE 15-2 Main Group Operations Window

The Group Operations Window

This table at the top (FIGURE 15-2) displays:

■ The group operation name

■ A pull-down menu that lists existing groups (with optional filters)

■ A pull-down menu that lists existing tasks

■ Schedule information

■ State (of the group operation)

Create/Edit
Filters

Create/Edit
Groups

Create MCP ParcelsCreate/Edit
Tasks
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Under the optional Description field, there are two read-only areas, Group Summary

and Task Summary. To display the information in these two sections, select a group

operation at the top of this window. For example, you can see the platform type, the

operating system, and the modules that comprise a group operation.

The following tables describe the submenu options that are found under the

following options on the menu bar:

■ File

■ Edit

■ View

■ Help

TABLE 15-1 File Menu Options

Menu Item Description

New Enables you to create a new group, filter, task, or MCP parcel.

Suspend Enables you to suspend the execution of a group operation.

Resume Enables you to resume the execution of a group operation.

Save Enables you to save this group operation to the server, with or

without a schedule.

Close Enables you to close the Group Operations window.

TABLE 15-2 Edit Menu Options

Menu Item Description

Delete Is enabled only when one or more completed group operations is

selected.

Can only delete a group operation if the group operation:

• is inactive

• has been suspended

When an operation is deleted, a confirmation window is displayed.

Modify Group Enables you to modify an existing group operation.

Modify Filter Enables you to modify an existing filter.

Modify Task Enables you to modify an existing task.
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To create a group operation, you must first create a:

■ Group with an optional filter

■ Task

General Procedures

▼ To Create an Object Group

1. In the main Group Operations window (FIGURE 15-2), click in the row under the
Name column, that reads, “Click to enter name...”

2. Enter a group operations name.

3. Press the Return button or click in the next cell.

Your cursor will now be in the blank cell under the Group column.

4. Click on the pull-down menu and choose from the list of existing groups.

If the pull-down menu is empty or you do not see a group name that you want to

use, you must create a new object group.

5. To create a new object group, proceed with one of the following:

■ Choose File ➤ New ➤ Group.

■ Click the Create/Edit Group button from the toolbar.

The Create/Edit Groups window is displayed (FIGURE 15-4). For additional

information on creating and editing groups, see “To Create an Object Group” and

“To Edit an Object Group.” For additional information on creating and editing

filters, see “To Create a Filter” and “To Edit a Filter.”

TABLE 15-3 View Menu Option

Menu Item Description

View Log Enables you to see the View Log window.

TABLE 15-4 Help Menu Options

Menu Item Description

Help Enables you to display the help documentation.
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▼ To Create a Task

1. In the main Group Operations window (FIGURE 15-2), click in the empty row under
the Task column.

2. Click on the pull-down menu and choose from the list of existing tasks.

If the pull-down menu is empty or you do not see a task name that you want to use,

you must create a new task.

3. To create a new task, proceed with one of the following:

■ Choose File ➤ New ➤ Task.

■ Click the Create/Edit Task button from the toolbar.

The Create/Edit Groups Task window is displayed (FIGURE 15-6). For additional

information on creating and editing tasks, see “To Create a Task.”

▼ To Set a Schedule

1. Click in the empty cell under the Schedule column.

2. Use the pull-down menu to select one of the following:

■ Activate Upon Save

■ Set Schedule

If you select Activate Upon Save, the group operation will be activated once you

click File ➤ Save in the main Group Operations window. If you select Set Schedule,

the Set Schedule window (FIGURE 15-3) is displayed.

FIGURE 15-3 Set Schedule window

3. From the Set Schedule window, you can use the various pull-down menus to set
the date, time, and frequency of occurrence for your group operation.
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▼ To Set the State of the Operation

Note – This column is read-only, so you cannot set anything.

1. Click in the empty cell under the State Column.

2. Use the pull-down to select one of the following group operation states:

■ Queued

■ Running

■ Suspended

■ Failed

■ Succeeded

■ Active

■ Inactive

■ Missed Schedule

■ Run & Failure

■ Failure & Suspended

■ Success & Suspended

Detailed Procedures

▼ To Create an Object Group

1. In the Create/Edit Groups window, under the Group column, click in the cell that
says, “Click to enter name...”

For additional information on the buttons and columns in this window, see

TABLE 15-5 and TABLE 15-6.
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FIGURE 15-4 Create/Edit Groups Window

2. Enter a group name.

3. Select one of the following buttons and click the Update button.

■ “All Objects in Domain”

This means the object group refers to the entire domain.

■ “Select Objects in Domain”

The objects that are preselected in the main console topology area will be displayed

in the list after the Update button is clicked. This list comprises objects that do not

have a filter applied to them. To see the list of objects after a filters has been applied

to them, click the Preview button.

Note – You cannot choose domains, because it is a read-only field. The Domain field

will be automatically filled in with the current domain name.
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4. Click in an empty cell under the Filter column and use the pull-down menu to
choose a filter name.

If this menu is empty or there is no filter you want to use, create a new filter. For

additional information on creating and editing a filter, see “To Create a Filter” and

“To Edit a Filter.”

5. Enter an optional description in the Description field.

6. Click the OK button to save this group.

▼ To Edit an Object Group

1. In the Create/Edit Group window, highlight a group.

2. Make all necessary changes.

TABLE 15-5 Buttons on the Create/Edit Group Window

Button Description

Delete Located at the top of the Create/Edit Group window, this button

enables you to delete a row, which consists of the entire group

object, the domain, and the filter.

Delete Located next to the field that contains the list of objects in the

Domain, this button enables you to delete specific objects from your

list of selected objects.

Update Enables the selections made in the main topology area to be added

to your group and entered into this window.

Preview Applies the optional filter to the current object group. The contents

of the above list are shown in a new dialog with changes to reflect

the filtering operation.

OK Enables you to save the newly created group.

Cancel Enables you to cancel the current operation.

Help Enables you to display the online help documentation.

TABLE 15-6 Columns on the Create/Edit Group Window

Column Name Description

Name Enables you to click into this cell and add a new object group name.

Domain Automatically populated by the current domain name (read-only).

Filter Enables you to use the pull-down menu, which displays a list of

existing filters.
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3. Click the OK button.

▼ To Delete an Object Group

1. Highlight the group you would like to delete.

2. Click the Delete button located near the top of the Create/Edit Groups window.

3. Click the OK button.

▼ To Create a Filter

1. In the Create/Edit Filters window (FIGURE 15-5), under the Name column, click in
the cell that says, “Click to enter name...”

FIGURE 15-5 Create/Edit Filter Window
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2. Click your left mouse button and enter your filter name.

3. Enter an optional description in the Description field.

4. Set filters by activating any, or all, of the following options:

To activate these options, click in the checkbox and use the pull-down menu to select

an item from the displayed list.

■ Host or Object Label

■ Platform Types (Include/Exclude)

This pull-down menu has all possible platform types. This criterion selects only

hosts which have at least one of the specified platform types.

■ Operating Systems (Include/Exclude)

This pull-down menu lists all possible operating systems. This criterion selects

only hosts which have at least one of the specified operating systems.

■ Modules (Include/Exclude)

This pull-down menu has all possible modules. This criterion selects only objects

which have at least one of the specified modules loaded.

■ IP Addresses (Include/Exclude)

The fields next to this option enable you to enter a range of IP addresses. This

criterion selects only hosts which have an IP address in the specified range.

5. Click the Save button.

▼ To Edit a Filter

1. In the Create/Edit Filters window, highlight the filter you want to modify from the
list.

TABLE 15-7 Buttons on the Create/Edit Filters Window

Button Description

Include/Exclude • The Include button specifies that the host must match one of the

items in the list.

• The Exclude button means the host cannot match any item in the

list.

Delete Enables you to delete an included item from the list.

OK Enables you to save the newly created filter.

Cancel Enables you to close the current operation.

Help Enables you to display the online help documentation.
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2. Modify the filter.

3. Click the OK/Save button to save your changes.

▼ To Delete a Filter

1. In the Create/Edit Filters window, highlight the filter you want to delete.

2. Click the Delete button located next to the Name field.

A deletion confirmation window is displayed, which reminds you that deleting the

task is a permanent action.

3. Click the OK button to confirm the deletion.

Tasks

There are three types of tasks that will be described in this section:

■ Module task

■ Data Property task

■ MCP Parcel Task

▼ To Create a Task

1. In the Create/Edit Task window, under the Name column, click in the cell that
says, “Click to enter name...”

2. Enter your task name.
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FIGURE 15-6 Create/Edit Tasks Window

3. Under the Type column use the pull-down menu to choose whether the task type
will be a module, a data property, or MCP.
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Module Task

FIGURE 15-7 Create/Edit Module Task Window

If you choose Module, the information in TABLE 15-8 will be displayed under the

Create/Edit section:

TABLE 15-8 Module Properties Task - Table Columns

Column Description

Action The pull-down menu displays the type of action to be applied to the

module. The following options are provided:

• None

• Load

• Unload

• Disable

• Enable

• Set Schedule

Security Enables you to set any security values for the module.
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▼ To Create a Module Task

1. In the Create/Edit Task window, use the pull-down menu under the Type column,
and choose Module.

After choosing Module, notice that the Create/Edit Task table at the bottom of the

window (FIGURE 15-8) will contain the items found in TABLE 15-8.

FIGURE 15-8 Create/Edit Task Window - Module Task Option

2. In the Module column, choose a module from the pull-down list.

3. In the Action column, chose the type of module action from the pull-down menu.
If you select Set Schedule For..., the Attribute Editor window is displayed with the

Schedule tab activated. For additional information on the Attribute Editor, see

Chapter 9.

4. Click in the Security column to display the Attribute Editor window with the
Security tab activated.

Settings that are made here will be reflected as a checkmark in the Security column.

Make your changes in the Attribute Editor window and click the OK button. For

additional information on the Attribute Editor, see Chapter 9.
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5. In the Create/Edit Task window, click the OK button to save your changes.

▼ To Edit a Module Task

1. In the Create/Edit Tasks window, highlight the task you want to modify.

2. Make the necessary changes.

3. Click the OK button to save your changes.

Data Property Tasks

▼ To Create a Data Property Task

1. In the Create/Edit Tasks window, use the pull-down menu under the Type
column, and choose Data Property (FIGURE 15-9).

FIGURE 15-9 Create/Tasks Window - Data Property Option
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TABLE 15-9 Data Properties Task - Table Columns

After choosing Data Property, the Create/Edit Task table at the bottom of the

window will contain the items found in TABLE 15-9. If you click in any of the four

right cells, the Attribute Editor window is displayed with that item’s tab activated.

For additional information on the Attribute Editor, see Chapter 9.

2. Click in the first empty cell under the Data Property column.

A Data Property Chooser window is displayed (FIGURE 15-10).

3. Under the Additional Specifiers section, enter a module instance name in the
Module Instance field.

4. Click the OK or Apply button to save your changes.

This newly created data property task will appear in the table in the lower portion of

the Create/Edit Tasks window (FIGURE 15-9).

Column Description

Name When you click in this row, the Data Property Selection window

(FIGURE 15-10) is displayed. To display a data property table in the

right pane of the split pane, navigate down in the hierarchy tree and

click the mouse button on a managed object name.

Alarm Enables you to display the Attribute Editor window, with the Alarm

tab activated.

Action Enables you to display the Attribute Editor window, with the

Action tab activated.

Refresh Enables you to display the Attribute Editor window, with the

Refresh tab activated.

History Enables you to display the Attribute Editor window, with the

History tab activated.
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The Data Property Selection Window

FIGURE 15-10 Data Property Selection Window

The use of this window is similar to the Host Details window. To navigate through

this window, click on the expansion/compression icons in the hierarchy until you

find a specific managed object. When you double-click on this managed object, the

table will be displayed in the right frame. There are three types of data property

tables that will be displayed:

■ Simple, scalar tables (read-only values) (FIGURE 15-11)

■ Simple, scalar tables with editable values (FIGURE 15-12)

■ Vector tables (FIGURE 15-13)

Additional
Specifiers
area
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▼ To Edit Data Property Tables

Simple Scalar, Noneditable Table

1. In the Create/Edit Tasks window (FIGURE 15-9), under the Name column in the
lower part of this window, click on a managed object.

The Update Data Property window will be displayed (FIGURE 15-11).

FIGURE 15-11 Update Data Property Window for a Simple, Scalar Data Property Table

2. Since this table is a scalar, noneditable table, click the OK button.

This type of managed object is noneditable, so the field under Name is grey.

Simple, Scalar Table With Editable Values

1. In the Create/Edit Tasks window (FIGURE 15-9), under the Name column in the
lower part of this window, click on a managed object.

The Update Data Property window will be displayed (FIGURE 15-12).

FIGURE 15-12 Update Data Property Window for a Simple, Scalar Data Property Table With
Editable Values

2. Enter a value or edit an existing value.

3. Click either the OK button to save your changes.
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Vector Tables

FIGURE 15-13 Update Data Property Window for a Vector Data Property Table

1. In the Create/Edit Tasks window (FIGURE 15-9), under the Name column in the
lower part of this window, click on a managed object.

The Update Data Property window is displayed (FIGURE 15-13).

2. Modify the data property.

In the Data Property Chooser window (FIGURE 15-10), under the Additional Specifier

section, use the following options for vector tables:

■ Module Instance Name

■ Scope

■ Row Action

Module Instance Name

In this data property table type, you have to enter additional information. For

example, if you have chosen a multi-instance module, you must provide a name for

this instance. The Module Instance field is located at the bottom of the Data Property

Selection window under the Additional Specifiers section.

Scope

Here, the scope of the task (FIGURE 15-10) on this data property must be specified as

either a column or a cell. For example, in the CPU Utilization module, if the Column

button is chosen, the task will apply to all CPUs. But, if the Cell button is selected,

you will be required to enter an index value, such as a CPU number. To alert you

that a field is for required values, the text accompanying this field will be displayed

in red.
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In a vector data property table, you can modify the following:

■ Editable values

■ Required values

■ Module instance name

■ Scope

Row Action

FIGURE 15-14 Update Row Action Window

If the module allows the addition of rows, you can the select the Row Action button

(FIGURE 15-10), and use the pull-down menu to choose one of the following options:

■ Add row

■ Modify row

■ Delete row

For example, if you selected Add Row, the Update Row Action window

(FIGURE 15-14) is display will list the required field and the values that you would

enter (as you would find in the Add Row window). For additional information on

adding rows, see Chapter 7.

3. Click the OK button to save your changes.

You will be returned to the Create/Edit Task window. Since you have completed

your selections from the Data Property Chooser window, there will now be

checkmarks under the corresponding columns.

▼ To Delete a Task

1. In the Create/Edit Task window, highlight the task you want to delete.
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2. Click the Delete button, which is located next to the Name and Type columns.

The Delete confirmation window is displayed, which reminds you that deleting the

task is a permanent action.

3. Click the OK button to confirm the deletion.

Module Configuration Propagation Tasks

▼ To Create an MCP Parcel

1. Proceed with one of the following:

■ In the main Group Operations window, choose File ➤ New ➤ MCP Parcel.

■ In the toolbar of the main Group Operations window, click the MCP Parcel icon.

The Create MCP Parcel window is displayed (FIGURE 15-15).

In this window, click your left mouse button in the first cell under the Name column,

which says, “Click to enter new parcel name....”

For information on the buttons in the Create MCP Parcel window, see TABLE 15-10.

2. Enter the parcel name.

FIGURE 15-15 Create MCP Parcels Window
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TABLE 15-10 Buttons on the Create MCP Parcel Window

3. Click in the first empty cell under the Host column and enter a host name.

This is the host whose configuration files will be used to propagate out to the target

hosts in your group.

4. Click in the first empty cell under the Port column and enter a port number.

This is the port number that the agent is running for the reference host.

5. Click in the first empty cell under the Module column.

The Specify Modules in Parcel window (FIGURE 15-16) is displayed.

Button Description

Delete Enables you to delete an existing parcel.

Synchronize Enables you to copy any changes in the configuration files (changes

that have been made since the last propagation) of the reference

host out to all the target hosts. Ensures that the target hosts are in

sync with the reference host.

OK Enables you to save the parcel.

Apply Enables you to save the current parcel and continue with another.

Cancel Enables you to cancel the current operation.

Help Enables you to access the online help documentation.

TABLE 15-11 Fields on the Create MCP Parcel Window

Field Description

Name Enables you to enter the name of your MCP Parcel.

Host Enables you to enter your reference host name.

Port Number Enables you to enter the port number of the reference host.

Module Enables you to select modules for the parcel. (A checkmark appears

in the cell if the parcel is complete.)

Modules in Parcel Lists all the modules contained in a parcel.
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FIGURE 15-16 Specify Modules in Parcel Window

6. Under the Available Modules column, select a module name and click the Add
button.

The module name you chose will now appear under the Modules in Parcel column.

You can add as many modules as you wish. To delete a module from the Modules in

Parcel list, highlight the module’s name and click the Delete button.

7. Click the OK button.

In the Create MCP Parcel window (FIGURE 15-15), a checkmark is displayed in the cell

under the Module column to indicate that a complete parcel has been created. Once

this parcel is complete, the color of this row will change from white to light grey,

which indicates that this is row is selectable but not editable.

Caution – MCP Parcels cannot be edited. You must delete the existing parcel and

create a new one.

To see a list of all the modules in a parcel, highlight a row under the Parcels section.

8. Enter an optional description in the Description field.

9. Click the OK or Apply button to save this parcel.

▼ To Delete an MCP Parcel

1. In the Create MCP Parcels window, click the Delete button.

A deletion confirmation window is displayed, which reminds you that deleting the

parcel is a permanent action.

2. Click the OK button to confirm the deletion.
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▼ To Create an MCP Task

1. In the Create/Edit Task window, use the pull-down menu under the Type column,
and choose MCP Task (FIGURE 15-6).

The Create/Edit Tasks window is displayed (FIGURE 15-17). In the bottom of this

window, under the Create/Edit Task: MCP section, there is a pull-down menu that

lists all previously created parcels.

FIGURE 15-17 The Create/Edit Tasks window

2. Click this pull-down menu and select a parcel.

3. Click the OK/Apply button to save your changes.

▼ To Edit an MCP Task

● In the Create/Edit Task window, click on the pull-down menu under the Create/
Edit Task: MCP section and choose a different parcel.
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▼ To Delete an MCP Task

● In the Create/Edit Task window, under the Task section, highlight the task you
want to delete and click the Delete button.
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CHAPTER 16

Module Management

Note – This feature may or may not be available on your system, depending on

your licensing agreement.

This chapter describes the following topics:

■ To Load a Module

■ To Load a Scheduled Module

■ To Unload a Module

■ To Edit Module Parameters

■ To Enable a Module

■ To Disable a Module

■ To Display Module Rules

These features are available on the Details window, using the Modules tab.

Modules Status Screen

When you click the Modules tab button in the Details window, the Modules status

screen (FIGURE 16-1) is displayed. This screen has two main sections:

■ Selected Modules with Load Status

■ Available Unscheduled Modules

Note – Your system may not have all of the modules that are shown in the

following examples, depending on the terms of your licensing agreement.
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FIGURE 16-1 Modules Status Screen in the Details Window

Under “Selected Modules with Load Status,” information is segmented as shown in

in TABLE 16-1.

TABLE 16-1 Columns in “Selected Modules with Load Status”

Column Name Description

Module Name Name of the module.

Loaded Indicates whether the module is loaded.

Scheduled Indicates whether the module is scheduled.

Enabled Indicates whether the module is enabled.
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The “Available Unscheduled Modules” section of the screen contains a list of

modules that are available, but are not currently loaded.

Note – If the module is a multi-instance module, a special icon is displayed next to

it (for example, the File Scanning Module in FIGURE 16-1).

For information on the buttons in this screen, see the following table.

▼ To Load a Module

1. In the Details window, select the Modules tab.

2. Under the Modules tab, in the Available Unscheduled Modules section of the
Modules status screen, select a module and click the Load button.

The Module Loader window is displayed (FIGURE 16-2). There are two tabs on this

screen:

■ Module Parameters (default tab)

■ Schedule

TABLE 16-2 Modules Window Buttons

Button Description

Unload Unloads the selected module.

Load Now Loads any modules that are scheduled but not currently loaded.

Edit Allows you to edit module parameters.

Enable Enables the selected module.

Disable Disables the selected module.

Rules Displays the Threshold Summary window.

Load Loads a module that is highlighted in the Available Unschedule

Modules section of the Modules status window.

Close Closes the current screen

Help Opens the Help documentation.
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FIGURE 16-2 Module Loader Screen With Module Parameters Tab Active

3. If the module being loaded is a multi-instance module, as shown in FIGURE 16-2,
enter the instance name and description in the appropriate fields.

Note – Some modules do not have an editable fields on this screen, except the

Module Description field. You can change the module description, but it is not

recommended.

4. Click OK to load the module now and return to the Modules status screen.

5. To load the module at a specific time, click the Schedule Module tab.

The Module Loader screen is displayed with the Schedule tab active (FIGURE 16-3).
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FIGURE 16-3 Module Loader Screen with Schedule Tab Active

6. Click the Advanced button.

The Time Editor screen is displayed (FIGURE 16-4).

FIGURE 16-4 Time Editor Screen
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7. Click Insert.

The Time screen is displayed (FIGURE 16-5).

FIGURE 16-5 Time Screen

8. Select the time for the module to be loaded, and click Apply.

The Time screen closes, and you are returned to the Time Editor screen.

9. On the Time Editor screen, the time selected on the previous screen is displayed
in the Time Expression field. Click Apply.

The Time Editor screen closes, and you are returned to the Module Loader screen.

10. On the Module Loader screen, click OK.

The Module Loader screen closes and you are returned to the Modules status screen.

After a few seconds, the module name moves from the “Available Unscheduled

Modules” section to the “Selected Modules with Load Status" section of the Modules

status screen. The module status in the Scheduled column is Yes.
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▼ To Load a Scheduled Module

1. In the “Selected Modules with Load Status” section, highlight a module that is
currently scheduled not loaded (has a No in the Loaded column and a Yes in the
Scheduled column). Click the Load Now button.

The Load Now dialog box (FIGURE 16-6) is displayed.

FIGURE 16-6 Load Now Dialog Box

2. To load the module at the time previously selected, click Preserve Schedule. Then
click OK.

The module loads at the scheduled time. To cancel this screen, click Cancel. To

display online help for this feature, click Help.

Note – To clear previous scheduling, click Clear Schedule, and click OK. the module

status in the Loaded column remains No, and the status in the Scheduled column

changes to No also.

▼ To Unload a Module

1. In the “Selected Modules with Load Status” section, select a module and click the
Unload button.

The Confirm Module Unload window is displayed (FIGURE 16-7).

FIGURE 16-7 Confirm Module Unload Window
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2. In the Confirm Module Unload window, click the Unload button to confirm that
you want the module unloaded or the Cancel button to cancel the operation.

Once you click the Unload button, the module moves from the “Selected Modules

with Load Status” to the “Available Unscheduled Modules” section and is now

unloaded.

▼ To Edit Module Parameters

1. On the Modules status screen, click Edit.

The Module Parameter Editor screen is displayed.

FIGURE 16-8 Module Parameter Editor Screen

2. The screen is displayed with the default tab, Module Parameters selected.

Edit the module parameters. For some modules, the only information that can be

changed on this screen is the module description.

The Schedule tab (FIGURE 16-3) is used to load or unload a module. See “To Load a

Module” for more information.
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3. When you are finished, click Cancel to close the Module Parameter Editor and
return to the Modules status screen.

▼ To Enable a Module

1. Highlight a module listed in the “Selected Modules with Load Status” section of
the screen.

Note – The module must have an “Disabled” status in the Enabled column.

2. Click Enabled.

The module status in the Enabled column changes to “Enabled.” A message

“Succeed in enabling module” is displayed in the lower left corner of the Modules

status screen.

▼ To Disable a Module

1. Highlight a module listed in the “Selected Modules with Load Status” section of
the screen.

Note – The module must have an “Enabled” status in the Enabled column.

2. Click Disabled.

The module status in the Enabled column changes to “Disabled.” A message

“Succeed in disabling module” is displayed in the lower left corner of the Modules

status screen.

▼ To Display Module Rules

1. On the Module Status screen, highlight the module of interest and click Rules.

The Threshold Summary of Module: screen is displayed, containing the name of the

selected module after the colon (:). In this example, the kernel reader (simple)

module is shown.
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FIGURE 16-9 Threshold Summary of Module Screen

This window contains the sections listed in TABLE 16-3.

TABLE 16-3 Threshold Summary Window Fields

Table Description

Attribute Name Lists the data property.

Rule Name Shows the rule name. If the rule is simple, it shows the threshold

value. If the rule is complex, a “-” is listed, and these values, when

selected, are listed in the Threshold list located at the bottom of the

window.

Critical The most severe alarm state.

Alert The mid-point alarm state.

Caution The least severe alarm state.
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2. After you view the information, click Close to return to the Module status screen.

Rule Description Displays a rule description for the selected attribute.

Thresholds Displays threshold values for the selected attribute.

Parameter

Description

Displays a description of the parameters shown in the Thresholds

field.

TABLE 16-4 Threshold Summary Window Buttons

Button Description

Close Closes the Threshold Summary window.

Help Accesses the Help documentation.

TABLE 16-3 Threshold Summary Window Fields

Table Description
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CHAPTER 17

Dataviews

Note – This feature may or may not be available on your system, depending on

your licensing agreement.

Dataviews are customized data property tables and can be created for one type of

data from several different hosts, or different types of data from one host. An

example of the first concept is a dataview that monitors CPU usage in group of

hosts; an example of the second concept is a dataview that monitors disk space and

CPU usage on one host.

Dataview Tables

The data required to create these tables is copied from different sources, including:

■ Tables

■ Modules

■ Hosts

Dataviews are an excellent way of monitoring your group operations. Since these

views are presented in a table, a variety of data can be easily compared. Also, these

tables are created once and are automatically refreshed. Dataviews have all the

features of module tables, except that cells are noneditable. Also, alarm status is

correctly propagated. That is, cells that have triggered a critical alarm appear in red.
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FIGURE 17-1 Tools Menu in the Console Window

FIGURE 17-2 Dataviews Manager Window
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▼ To Open an Empty Dataview Window

1. In the console window, choose Tools ➤ Dataview Manager (FIGURE 17-1).

The Dataviews Manager Window is displayed (FIGURE 17-2).

2. Click the Create Button.

An empty Dataviews window is displayed.

▼ To Create a Dataview

From the Details and Console windows, there are two options to create a dataview:

■ Create a Dataview

■ Copy to the Dataview Clipboard

Create a Dataview Option

From the Context Pop-up Menu

1. In the browser view, click the expansion/compression icon next to the items in the
hierarchy (FIGURE 17-3) down to the desired data property.

2. On the data property, highlight a row or a cell and click the right mouse button.

3. Select Create Dataview (cell or row) from the context menu (FIGURE 17-3).

An automatically populated dataview window is displayed.

From the Options Menu

1. On the data property, highlight a row or a cell.

2. From the Options menu, select Create Dataview (cell or row).

An automatically populated dataview window is displayed.
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Copy to Dataview Clipboard Option

There are two locations from which you can create a dataview with this menu

option:

■ Details Window

■ Console Window

Details Window

1. Highlight a row or cell in a data property table.

2. Click the right mouse button and select Copy to Dataview Clipboard (cell or
rows).

3. In the Details window, click on the Dataview icon.

An empty Dataview window is displayed.

4. Choose Edit ➤ Paste from Clipboard.

Console Window

1. Highlight a row or cell in a data property table.

2. Click the right mouse button and select Copy to Dataview Clipboard (cell or
rows).

3. In the Console window, choose Tools ➤ Dataview Manager.

A Dataview Manager window is displayed (FIGURE 17-2).

4. Click the Create button.

5. Choose Edit ➤ Paste from Clipboard.
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FIGURE 17-3 Row-Context Menu in the Details Window
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▼ To Open an Existing Dataview

FIGURE 17-4 Open Dataview Window

● From the Dataview Manager window (FIGURE 17-2), highlight the name of the
dataview you want to open and click the Open button.

A populated dataview window is displayed (FIGURE 17-4).

Navigating Through a Dataview Window

● The dataview window (FIGURE 17-4) contains the following main menu items:

■ File

■ Edit

■ Tools

■ Help
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For additional information on these menu items, see TABLE 17-2, TABLE 17-3, and

TABLE 17-4.

▼ To Delete a Dataview

● From the Dataview Manager window (FIGURE 17-2), highlight the name of the
dataview you want to delete and click the Delete button.

TABLE 17-1 File Menu Items

Menu Item Description

Save Displays the Save window, which enables you to name and save the

current dataview.

Close Enables you to close the current dataview window.

TABLE 17-2 Dataview Edit Menu Items

Menu Item Description

Paste From

Clipboard

Is active only when the clipboard is not empty. If a table is open,

this item adds the data property at the end of this table. If no table

is open, a new one is created and the data property is pasted into it.

Delete Row(s) Deletes the selected row from the table. Is active only when the row

is selected.

TABLE 17-3 Dataview Tools Menu Items

Menu Item Description

Attribute Editor Brings up the Attribute Editor on the selected cell.

TABLE 17-4 Dataview Help Menu Item

Menu Item Description

Help Brings up the Help documentation.
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Note – Once you click the Delete button, a warning popup window (FIGURE 17-5) is

displayed. This window reminds you that deleting a dataview is permanent and

asks whether you want to continue.

FIGURE 17-5 Warning Window

▼ To Save A Dataview

1. In the Dataview window, choose File ➤ Save.

The Save Dataview window is displayed. You may enter an optional description in

the Description field.

2. Click the Save Dataview button.

FIGURE 17-6 Save Dataview Window

Note – If the name you have chosen for this dataview exists, a Warning window

(FIGURE 17-7) is displayed.
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FIGURE 17-7 Save Warning Window

Types of Dataview Tables

There are two types of Dataview tables:

■ Scalar

■ Vector

Scalar Table

This table is created from scalar data items, which are single cells from scalar or

vector tables and includes the following three columns:

■ Host name

■ Data Property Name

■ Value

Note – The Data Property Name column contains the name of the property for the

data item in the following format: module/object/property

▼ To Create a Scalar Dataview Table

1. In the Details window, click on the Operating System icon in the hierarchy (tree)
view.

2. Double-click on the Kernel Reader icon in the Contents View window or single-
click the Expansion/Compression icon next to the CPU Statistics icon.

The CPU Statistics folder is displayed.

3. Click on the CPU Utilization folder in either the hierarchy or the contents view.

The CPU Utilization Table is displayed.
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4. Select a cell from this table.

5. To copy the cell to the dataview clipboard, proceed with one of the following:

■ From the Options menu, choose Copy to Dataview Clipboard ➤ Cell(s) or

Create Dataview ➤ Cell(s).

■ In the Details window, click the right mouse on the table and select Copy to

Dataview Clipboard ➤ Cell(s).

For additional information on the Copy to Dataview Clipboard option, see “Copy to

Dataview Clipboard Option” on page 290, and for additional information on the

Create Dataview option, see “Create a Dataview Option” on page 289.

FIGURE 17-8 CPU Utilization Table
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Vector Table

This table contains one or more rows from a vector module table. From this table,

you can simultaneously select one row or multiple rows. If you select multiple rows,

they do not have to be contiguous. For example, you can select row number 3 and

row number 4 and not rows number 5 and then select number 6 and number 7

(FIGURE 17-9).

Note – When selecting rows, however, you cannot select partial rows; the entire row

must be selected.

FIGURE 17-9 Contiguous Row Selection

Caution – Do not paste rows from vector and scalar tables into the same dataview

window (though they can be from different hosts).

▼ To Create a Vector Dataview Table

1. In the Browser Details window, click on the Operating System icon in the
hierarchy view (FIGURE 17-10).
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2. Double-click on the Kernel Reader icon in the contents view or single-click the
expansion/compression icon next to the CPU Statistics icon.

The CPU Statistics folder is displayed (FIGURE 17-10).

3. Click on the CPU Utilization folder in the hierarchy view.

The CPU Utilization table is displayed (FIGURE 17-10).

FIGURE 17-10 CPU Utilization Table

4. Select a row from this table.

5. To copy the cell to the dataview clipboard, proceed with one of the following:

■ From the Options menu, choose Copy to Dataview Clipboard ➤ Cell(s) or

Create Dataview ➤ Cell(s).

■ In the Details window, click the right mouse on the table and select Copy to

Dataview Clipboard ➤ Cell(s).
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For additional information on the Copy to Dataview Clipboard option, see “Copy to

Dataview Clipboard Option” on page 290, and for additional information on the

Create Dataview option, see “Create a Dataview Option” on page 289.

Note – You can only paste compatible data types. If you try to paste an

incompatible data type, an error dialog box (FIGURE 17-11) is displayed.

FIGURE 17-11 Mixing Data Warning Window
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CHAPTER 18

Sun Management Center Web
Interface

Note – This feature may or may not be available on your system, depending on

your licensing agreement.

This chapter covers the following topics:

■ To Start the Sun Management Center Web Interface

■ Main Console

■ Host Details Browser Page

■ To Display the Host Details Browser Page

■ Info Tab

■ Browser Tab

■ Alarms Tab

■ To Filter the Alarms Table

■ Log Tab

■ Attribute Editor

The Sun Management Center Web Interface is a web-based management interface

for the Sun Management Center platform. It is a host management system that uses

HTTP protocol to provide easy access to Sun Management Center management

information. Sun Management Center users can access the Web Interface across the

firewall to monitor and manage Sun Management Center information from any

location using widely-available web browers, such as Netscape Navigator and

Internet Explorer.

The Sun Management Center Web Interface provides most of functions of the Sun

Management Center Java Console for host management. It allows users to monitor

and manage alarms and modules, and rapidly navigate the managed objects.
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Web Interface

TABLE 18-1 lists the functions that are provided by the Web Interface and the chapters

in which the corresponding Java-based functions are described. This chapter

describes the Web-based functions and use.

The Sun Management Center Web Interface is an optional Sun Management Center

component. It depends on the Sun Management Center Server for retrieving and

manipulating managed objects.

▼ To Start the Sun Management Center Web

Interface

1. Start your web browser.

Note – You do not have to be superuser to run the Sun Management Center from

your web browser.

TABLE 18-1 Web Interface Functions

Function Location

Main Console “Main Console Window” on page 67

Host Details Page “Navigating the Details Window” on page 207

Info tab “Info Tab” on page 307

Browser tab “Browser Tab” on page 86

Alarms tab “Alarms Tab” on page 309

Modules tab “Modules Tab” on page 311

View Log tab “Log Tab” on page 314

Attribute Editor Chapter 9

Info tab “Information Tab in the Attribute Editor” on page 133

Alarms tab “Alarms Tab in the Attribute Editor” on page 134

Actions tab “Actions Tab in the Attribute Editor” on page 137

Refresh tab “Refresh Tab in the Attribute Editor” on page 144

History tab “History Tab in the Attribute Editor” on page 146
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2. Enter the Sun Management Center web location URL:

3. The Sun Management Center Login page (FIGURE 18-1) is displayed.

This Login Page is for entering your user ID and password. The Sun Management

Center server and web server are on the same host.

FIGURE 18-1 Sun Management Center Web Login Page

4. Log in using a valid UNIX account.

This account must be listed in the /var/opt/SUNWsymon/cfg/esusers file on

the Sun Management Center server.

After you log in successfully, the Main Console (FIGURE 18-2) is displayed.

http:// server_name
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FIGURE 18-2 Main Console, Default Domain Selected

Main Console

All available domains are displayed in a drop-down Domain options menu. You can

select one domain at a time to monitor or manage objects that are under the selected

domain.

When you select a domain (FIGURE 18-2), the object hierarchy tree is displayed. Each

tree node represents a topology object. If the there are child objects under the node,

the tree node can expand or collapse. All tree nodes are displayed along with their

associated icons, such as topology type icon, alarm icon, and expandable (or

collapsible) icons for group objects.

A domain alarm state status icon for the selected domain is displayed next to the

domain icon. A time stamp display above the domain name shows when the current

page was loaded from the server.

Selecting a domain splits the page in two. The contents view (right side) of the

screen displays the details about the selected host, including the state of the machine

and a time stamp. A hyper-link enables you to display the Host Details page, which

provides additional object/module monitoring information and management

capabilities. Only host objects can be selected.
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FIGURE 18-3 Main Console, Example Host (Shanghai) in Default Domain Selected

TABLE 18-2 lists the Main Console and Host Details buttons and describes their

functions.
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Tip – Clicking the web browser Reload button reloads the entire page, including all

frames.

Host Details Browser Page

▼ To Display the Host Details Browser Page

1. Select a domain from the Domain menu, for example Default Domain

2. Click on a leaf (host) tree node, for example, shanghai.

3. Click on “Go to host details.”

The Host Details Browser page (FIGURE 18-5) is displayed, replacing the Main

Console page.

At the top of the Host Details page, some or all of the of the following tabs are

displayed, depending on the type of host: Info, Browser, Alarms, Modules and View

Log. These tabs have the same basic functions as the Details window described in

Chapter 6.

TABLE 18-2 Main Console and Host Details Buttons

Button Function

Auto Refresh Disables and enables the auto refresh feature. The Auto Refresh

enable menu contains:

1 Minute

2 Minutes

3 Minutes

5 Minutes

10 Minutes

Automatically refreshes the display according to the item selected.

These options can be configured on the server through a

configuration file.

Refresh Refreshes the screen display immediately.

Main Page Redisplays the Main Page.

Logout Enables users to close the Sun Management Center. After logging

out, the Login page (FIGURE 18-1) is displayed.

Help Displays the online help for this panel in another browser window.
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Info Tab

The Info page displays the general information about the object. This window is the

same as the Details Info tab window described in Chapter 6.

FIGURE 18-4 Host Details Info Page

Browser Tab

When the Browser tab is selected, the center of the page splits into two vertical

frames (FIGURE 18-5) in the same manner as the Browser Window described in

Chapter 6, and functions similarly.

This window has Auto Refresh, Refresh, Main Page, Logout and Help buttons,

which are described in TABLE 18-2.

For additional details, see Chapter 6.
Chapter 18 Sun Management Center Web Interface 307



FIGURE 18-5 Host Details Browser Page with Expanded Tree
308 Sun Management Center 3.0 Software User’s Guide • November 2000



FIGURE 18-6 Host Details Browser Page with Module Properties Table

Alarms Tab

The Web Interface Alarms Manager is almost identical to the Sun Management

Center 3.0 Alarms Manager described in Chapter 12. For Web Interface Alarm

Manager details, see Chapter 19. When Auto refresh is enabled, all operation buttons

and the selection column (column one) are disabled.
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FIGURE 18-7 Hosts Details Alarms Page

The Alarms page is similar to the Sun Management Center 3.0 Alarms Details

window. Auto Refresh Disable enables all of the operation buttons, except the Filter

button, and disables the selection column (column one).

View Alarms in the Options menu enables you to filter the alarms table by severity,

open or closed alarms, and/or acknowledged or unacknowledged alarms.

FIGURE 18-8 shows the View Specific Alarms dialog. For details, see Chapter 19.
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FIGURE 18-8 View Specific Alarms Dialog

▼ To Filter the Alarms Table

1. Click the box(es) next to the item(s) to select (or deselect) the item.

A check mark is displayed in each box you select.

2. Click OK to accept the changes and close the dialog.

The alarms table is filtered and redisplayed to reflect your selections.

Modules Tab

The Modules page displays all available modules and their status (that is, whether

they loaded or unloaded, and for the loaded modules, whether they are enabled or

disabled). Modules can be loaded, unloaded, enabled, and disabled by an authorized

user only.
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FIGURE 18-9 Host Details Modules Page

Note – To load or unload and enable or disable a module you must have the

appropriate security permission. For more information, see Chapter 14.

The Host Details Modules page is similar to the Module Loader window described

in Chapter 6. In some cases editing can be done on the Host Details Modules Page.

TABLE 18-3 lists the Host Details Modules page hyperlinks.

TABLE 18-3 Host Details Modules Page Hyperlinks

Action Function

Load Loads the selected module. This action displays the Module Loader

dialog (FIGURE 18-10).

Unload Unloads the selected module.

Enabled Enables module.

Disabled Disables module.

(Is this picture up-to-date?)
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This window also has Auto Refresh, Refresh, Main Page, Logout and Help buttons,

which are described in TABLE 18-2.

Module Loader Dialog

The Module Loader dialog enables you to Load any of the modules listed in the

Modules Available for Loading table on the Host Details Modules page.

FIGURE 18-10 Module Loader Dialog

This page also enables you to schedule the modules.
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▼ To Display the Module Loader Dialog

1. Click the Load link in the Action column of the Modules Available for Loading
table for the module you want to load.

The Module Loader dialog is displayed.

2. Click OK to load the selected module.

Log Tab

The Log tab displays system log information. It has an option menu for log file types

and a text area for log file content. The filtered messages are displayed. The Log tab

page also has a Filtered Messages dialog that enables you to filter the messages

displayed in the text area by Starting and Ending date and time, and so on.

FIGURE 18-11 Log Page System Log
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FIGURE 18-12 Log Page Event Log

FIGURE 18-13 shows the Message Filter Option dialog.
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FIGURE 18-13 Message Filter Option Dialog

Attribute Editor
The Attribute Editor is displayed after a property value is selected in a properties

table. Selecting one of the property values displays the Attribute Editor Info page in

another browser window, which allows you to do limited editing for the property. If

there is no value, a “__” is displayed for the hyperlink

The Attribute Editor has some or all of the following tabs: Info, Alarms, Actions,

Refresh and History. This Attribute Editor, is similar to the Java-based Attribute

Editor, which is described in Chapter 9.

Advanced editing, such as time editing, is not provided in this release. Otherwise,

the Attribute Editor functions the same as described in Chapter 20.
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FIGURE 18-14 Attribute Editor Info Page

Configuring the Sun Management
Center Web Console to Use the Secure
Socket Layer (SSL).

1. Log in as UNIX root account and stop the Web Console by using the
es-stop -w command.

% /opt/SUNWsymon/sbin/es-stop -w
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2. Change current path to /opt/SUNWsymon/netscape/https-admserv , and start
the Netscape fasttrack admin server.

3. Bring up the Web Browser and enter http://[machine]:8888 in the URL text
field.

4. Log in as admin (account name and password both are “admin”).

5. Select localhost from the Server Option menu and click the manage button to
go to the localhost Server Manager page.

6. Click the Security tab, and select Create Database.

7. Enter the password in the Database Password field and click OK to create a Trust
Database.

8. After you have successfully created a Trust Database, click the Request a
Certificate tab and follow the instructions to request a certificate from the CA
(Certification Authority).

9. Click on the Install Certificate tab to install the certificate from the CA.

10. Switch back to the Preference tab, click the Encryption tab, and turn on
Encryption.

11. Click the On/Off tab to turn on your Web Server.

You can now access the Sun Management Web Console through a secure http
connection. The URL for the Sun Management Web Console starts with https://.

For more detailed information about web server administration, refer to the

FastTrack Online Help.

Note – The Web Console runs under your Web Browser. Thus, you can change the

font size. If you select a very large font, some pop-up windows may be too small to

display all contents correctly. You can enlarge the windows to display them properly.

All pop-up windows sizes are based on a 12-pixel font, so we suggest using this size

font for the Web Console.

% cd /opt/SUNWsymon/netscape/https-admserv
% ./start
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CHAPTER 19

Web Interface Alarms Manager

Note – This feature may or may not be available on your system, depending on

your licensing agreement.

The Web Interface Alarms Manager functions in the same manner as the Alarms

Manager software, which is described in Chapter 12. However, some functions are

different. This chapter describes these differences and provides additional

instructions for using the Web Interface Alarms Manager. Some advanced functions,

such as alarm table sorting, are not available. For additional details, see Chapter 12.

This chapter cover the following topics:

■ Notifying Users That a Host or Agent is Down

■ To Set Up User Notification for Down Host or Agent

■ Status Summary Panel

■ To View the Status Summary Panel

■ Viewing Alarm Information

■ To View Alarm Information

■ Alarm Categories

■ To View Additional Alarm Information

■ Alarms Table Page Navigation

■ Alarm Actions
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Notifying Users That a Host or Agent is
Down

You can configure the Sun Management Center software to send an email

notification if a host or agent is down. You can notify:

■ Yourself only

■ Several people

■ All email recipients linked to the group to which the host or agent belongs

▼ To Set Up User Notification for Down Host or

Agent

1. In the Main Console window, select the host or group of hosts about which you
want to receive notification if the host or agent is down.

The host information is displayed in the Contents View of the Main Console

window.

2. Click Go to Host Details.

The Host Details Browser page is displayed.

3. Click the Alarms tab.

The Host Details Alarms page is displayed.

4. Select Options ➤ Modify Actions from the Options menu on the Host Details
Alarms page.

The Alarm Actions Attribute Editor dialog is displayed (FIGURE 19-1).
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FIGURE 19-1 Attribute Editor Actions Dialog

5. Click the Action button next to the Critical Action field or enter the email address
directly in the field.
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FIGURE 19-2 Attribute Editor Alarm Actions

6. If the Alarm Actions dialog is displayed, click the email button.

7. Enter the email address and username to be notified of the host down and agent
down condition in the To: field.

To notify more than one person, use the format email username1, username2,
and so on.

8. Enter the appropriate text in the Subject and Message fields.

9. Click OK to close the Attribute Editor Alarm Actions dialog.

The email address(es) are displayed in the Critical Action field of the Attribute

Editor Actions dialog.

10. Click OK to accept your changes.
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Status Summary Panel

The Status Summary panel on the Main Console page displays the number of

managed objects in the selected domain that have at least one unacknowledged open
alarm of a specific severity. This panel is similar to the Domain Status Summary

described in Chapter 12, except that the icons are not buttons so they do not display

the Domain Status window.

FIGURE 19-3 Main Console Default Domain with Status Summary Panel

▼ To View the Status Summary Panel

1. Go to the Sun Management Center Login Page from your Web Browser.

2. Log into the Sun Management Center 3.0.

The Sun Management Center 3.0 Main Console Default Domain is displayed.

Note – Select Domain domainname if you want to see a Status Summary for another

domain.

Status Summary panel
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Viewing Alarm Information

Alarms information is displayed in the alarms table (FIGURE 19-6) on the Host Details

Alarms page. For additional details, see Chapter 12.

▼ To View Alarm Information

1. With the left mouse button, click on a host icon in the Main Console window.

The Host Description and Status are displayed in the Contents View of the Main

Console page.

FIGURE 19-4 Main Console Contents View With “Go to Host Details” Hyperlink
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2. Click on “Go to Host Details.”

The Host Details Browser page is displayed.

FIGURE 19-5 Host Details Browser Page
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3. Click on the Host Details Alarms tab.

The Host Details Alarms page (FIGURE 19-6) is displayed.

FIGURE 19-6 Host Details Alarms Page
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Alarm Categories

The Host Detail Alarms page presents a table of different categories of detailed

alarm information. Except for the first column (TABLE 19-1), the categories and

information are the same as those described in TABLE 12-2 and TABLE 12-3.

FIGURE 19-7 Host Details Alarms Page Additional Alarm Information

TABLE 19-1 Alarm Selection Column

Category Description

- Selects the alarm row. You can select multiple alarm rows by

holding down the Control key and clicking in this column. a check

mark indicates that the column is selected.
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Some of this information is always displayed in the alarms table (FIGURE 19-6).

Additional information (FIGURE 19-7) is displayed on the bottom of the page when an

alarm row is selected. This information is only displayed for closed and/or

acknowledged alarms.

▼ To View Additional Alarm Information

Note – Only one alarm can be viewed at aa time.

1. Click the first column of the alarm you want to view.

A check mark is displayed in the first column,

2. Select Options ➤ View Additional Information on the Host Details Alarms page.

The information about the acknowledged and closed alarm is displayed at the

bottom of the page.

Alarms Table Page Navigation

The alarms table navigation information and buttons are the same as those described

in TABLE 12-1.

Alarm Actions

An additional button on the Host Details Alarms page, Auto Refresh, allows you to

refresh the alarms table automatically, or turn off (disable) the automatic refresh

capability to allow you to edit the alarms. When Auto Refresh is enabled, all

operation buttons and the selection column are disabled.

The alarms table cannot be sorted by double-clicking on the headers. Otherwise, all

Alarm actions on the Host Details Alarms page function the same as those on the

Alarms Details page described in Chapter 12. A confirmation request is displayed

when you delete an alarm or alarms.
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FIGURE 19-8 Alarm Deletion Confirmation Request
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CHAPTER 20

Web Interface Attribute Editor

Note – This feature may or may not be available on your system, depending on

your licensing agreement.

This chapter explains the following topics:

■ To Display the Attribute Editor

■ To Modify Alarm Actions

■ To Send an Email for a Critical Alarm

■ To Define an Alarm Action Script

■ To Set a Refresh Interval

■ To Set a History Interval

Module Data Properties

The module data properties provide additional information about the modules. The

Attribute Editor enables you to customize the monitoring criteria for these

properties. You can use the Web Interface Attribute Editor to set:

■ Alarm thresholds

■ Actions when alarm conditions occur

■ Refresh intervals

■ Logging schedule for historical data points

The Web Interface Attribute Editor has a series of tabs that enable you to switch

between different pages. Each Attribute Editor displays one or more of these tabs,

depending on the type of object selected. For example, the tabs for the data

properties Attribute Editor for the System Load Statistics module are:

■ Info

■ Alarms
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■ Actions

■ Refresh

■ History

▼ To Display the Attribute Editor

1. Click the Host Details Browser tab.

The Host Details Browser page is displayed.

2. Click the expansion/compression icon next to the Operating System icon in the
hierarchy tree view.

The Operating System modules are displayed.

3. Click the expansion/compression icon next to the Kernel Reader icon.

The Kernel Reader modules are displayed.

FIGURE 20-1 Host Details Browser Kernel Modules

4. Double-click on the System Load Statistics icon.

The System Load Statistics module properties table is displayed in the contents view.
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FIGURE 20-2 Kernel Reader System Load Statistics Module Properties Table

5. Select one of the Load Averages in the Value column and click with your left
mouse button.

The Attribute Editor Info page is displayed.
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Info Tab

The Attribute Editor Info page (FIGURE 20-3) provides additional information about

the selected object.

FIGURE 20-3 Attribute Editor Info page for a Monitored Data Property (System Load
Statistics)

Alarms Tab

The Attribute Editor Alarms page (FIGURE 20-4) enables you to set alarm thresholds

(TABLE 20-1) for simple alarms only.

The alarms software offers you the following flexibility in setting your alarms:

■ Determine the thresholds that trigger an alarm of a particular severity

■ Determine when alarms are sounded (for example, only on weekdays)
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Note – To set an alarm threshold you must have the appropriate security

permission. For more information, see Chapter 14.

Simple alarms are based on thresholds. A monitored data property is greater than,

less than, not equal to, or equal to a single threshold value. By contrast, complex

alarms are based on a set of conditions being true. For more information on alarm

rules, see Appendix E.

FIGURE 20-4 Attribute Editor Alarms Page for a Monitored Property
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TABLE 20-1 lists common simple alarm limits for monitored properties. The alarm

limits are also displayed in the Parameter Description field (FIGURE 20-4). You can set

thresholds for one or more of these alarm limits for selected data properties.

▼ To Create an Alarm

The following example procedure shows how to create a simple alarm. This example

creates an alarm threshold in the Kernel Reader module.

1. Select a data property (System Load Statistics) (FIGURE 20-3) from the Host Details
Browser page.

2. Click on the Alarms tab.

The Alarms page (FIGURE 20-4) is displayed.

3. In the Critical Threshold (>) field, type a value that is less than the current value.

Entering this value creates a critical alarm.

4. Complete one of the following actions on the Alarms tab page:
■ Click OK to apply your changes and close this page.

■ Click Reset to reset the Attribute Editor to the default parameters.

TABLE 20-1 Common Simple Alarm Limits in Sun Management Center Software

Alarm Limit Description

Critical Threshold (>) Critical (red) alarm occurs if value exceeds limit entered in this field.

Alert Threshold (>) Alert (yellow) alarm occurs if value exceeds limit entered in this field.

Caution Threshold (>) Caution (blue) alarm occurs if value exceeds limit entered in this field.

Critical Threshold (<) Critical (red) alarm occurs if value is below the limit entered in this field.

Alert Threshold (<) Alert (yellow) alarm occurs if value is below the limit entered in this

field.

Caution Threshold (<) Caution (blue) alarm occurs if value is below the limit entered in this

field.

Alarm Window Alarm occurs only during a specified time period. For example, if you

type day_of_week=fri , an alarm occurs only if the alarm condition

exists on a Friday. If an alarm condition exists on Tuesday, no alarm is

registered.
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In a few moments, the Load Average Over the Last One Minute data field in the

System Load Statistics data properties table turns red. In addition, red alarm icons

are displayed on the following folders and icons: Operating System, Kernel Reader,

and System Load Statistics (unless your system has an open, unacknowledged

severity one (1) black alarm).

5. Click the Host Details Alarms tab.

The alarm you created is reflected in the alarms table when it is refreshed. For more

information on this subject, see Chapter 19.

6. Acknowledge this alarm.

7. Create additional alarm thresholds and familiarize yourself with their operation.

Once you have created these alarms, you can set up security permissions so that

another Sun Management Center software user cannot change your alarm

thresholds. For more information on security, see Chapter 14.

Note – You do not need to fill in alarm information for all alarm thresholds. For

example, you can choose to create only a critical alarm threshold.

The preceding example procedure creates an alarm is that is registered if a value

exceeds the specified alarm limit. TABLE 20-1 lists other common alarm limits.

Actions Tab

The Attribute Editor Actions page (FIGURE 20-5) enables you to instruct the software

to perform a predetermined action if an alarm occurs.

Note – Acceptable actions include scripts that are stored in the /var/opt/
SUNWsymon/bin directory. These scripts execute with root permissions.

For example, you can enter the name of a script in the critical action field so that an

email is sent to a system administrator whenever a critical alarm is generated for the

Load Average Over the Last Five Minutes data property.

Separate actions can be set for different alarm conditions or one action can be set for

any alarm condition (action occurs on any change) using the Action button next to

each Action field on the Actions page. These buttons enable you to display the

Alarm Action Modification dialog (FIGURE 20-6).
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FIGURE 20-5 Attribute Editor Actions Page for a Monitored Property (System Load
Statistics)

Note – The check boxes shown to the right of the Action buttons enable you to

specify automatic or manual execution of a specific alarm action. By default, all

actions are set for manual execution. Only manual actions can be modified.

Automatic
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FIGURE 20-6 Alarm Action Modification Dialog

The Alarm Action Modification dialog enables you to modify the registered alarm

actions. Two buttons in the dialog (Email and Generic) allow you to choose one of

two options for an alarm action.

TABLE 20-2 lists these buttons and their functions.

▼ To Modify Alarm Actions

1. Click the Action button for the alarm action you want to modify.

The Alarm Actions modification dialog is displayed.

2. Select the type of alarm action you want to modify (Email or Generic).

3. Make your changes in the fields of the selected action.

TABLE 20-2 Alarm Actions Modification Dialog Buttons

Tab Function

Email Allows you to specify an address, subject, and message to be sent as

email.

Generic Allows you to select generic shell scripts installed on the managed

node.
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4. Click OK to accept the changes and close the page.

The change is displayed in the corresponding Action field of the Actions page.

▼ To Send an Email for a Critical Alarm

The following example procedure describes how to send an email to a user when a

critical alarm occurs.

1. Select a data property (System Load Statistics) (FIGURE 20-3) from the Host Details
Browser page.

2. Select Load Averages Over the Last Five Minutes in the Value column and click
with the left mouse button.

The Attribute Editor Info page is displayed.

3. Click the Actions tab.

The Actions page is displayed (FIGURE 20-5).

4. Type email username in the Critical Action field.

Note – You can also use the Alarm Actions Modification dialog (FIGURE 20-6) to

enter the username.

5. Complete this procedure with one of the following actions:
■ Click OK to apply your changes and close this page.

■ Click Reset to reset the Attribute Editor to the default parameters.

The following email is sent to the user whenever an alert alarm occurs.

▼ To Define an Alarm Action Script

The following procedure describes how to customize an alarm action to

automatically notify a user when an alarm condition occurs.

Date: Wed, 30 Jun 1999 15:25:39 -0800
From: root@MachineB (0000-Admin(0000))
Subject: Sun Management Center - Alert Alarm Action
Mime-Version: 1.0

Sun Management Center alarm action notification ... {Alert:
machineB Kernel Reader Load Average Over The Last 5 Minutes >
0.01Jobs}
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1. Create the script using the following arguments:

2. At the command-line level, become superuser.

3. Install the script in the home Sun Management Center directory. The default is
the /var/opt/SUNWsymon/bin/ directory. For example:

Note – The script filename should not have a .sh extension.

4. Click the Host Details Browser tab.

5. Set the alarm threshold.

For more information, see “To Create an Alarm” on page 420.

6. Click on the System Load Statistics icon.

The System Load Statistics properties table is displayed in the contents view of the

Host Details Browser page (FIGURE 20-2).

7. Select Load Averages Over the Last Five Minutes in the Value column and click
with the left mouse button.

The Attribute Editor Info page is displayed.

8. Click the Attribute Editor Actions tab.

The Actions page is displayed (FIGURE 20-5).

9. Click on Action button for the Critical Actions field to display the Alarm Action
Modification dialog (FIGURE 20-6).

10. Click the Generic Actions button.

11. Type custom_alarm_script %statusstringfmt in the Available Scripts field.

TABLE 20-3 Arguments for Custom Alarm Action Script

Argument Definition

%statusfmt The alarm severity, such as Warning, Critical, and so on.

%statusstringfmt The complete alarm string, including severity. (For example:

Critical: Machine A Kernel Reader Number of User Sessions > 10)

# su

# cp custom_alarm_script /var/opt/SUNWsymon/bin/
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12. Complete this procedure with one of the following actions:
■ Click OK to apply your changes and close this page.

■ Click Reset to reset the Attribute Editor to the default parameters.

The script file name is displayed in the Critical Action field on the Actions page.

Refresh Tab

The Attribute Editor Refresh page (FIGURE 20-7) enables you to set the refresh

interval for this object. The refresh interval is the interval between the times when

the Sun Management Center agent samples the monitored property.

FIGURE 20-7 Attribute Editor Refresh Tab for a Monitored Property

▼ To Set a Refresh Interval

The following example shows how to set a refresh interval in the System Load

Statistics module.
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1. Select a data property (System Load Statistics) (FIGURE 20-1) on the Host Details
Browser page.

2. Select Load Averages Over the Last Five Minutes in the Value column and click
with the left mouse button.

The Attribute Editor Info page is displayed.

3. Click the Refresh tab.

The Refresh page is displayed.

4. Type a value (in seconds) in the Refresh Interval field.

In this example, 300 was typed in the entry field. The refresh interval is five

minutes.

5. Complete this procedure with one of the following actions:
■ Click OK to apply your changes and close this page

■ Click Reset to reset the Attribute Editor to the default parameters.

When the System Load Statistics properties table is displayed, the values in the table

are refreshed every five minutes.

Note – By increasing the refresh interval to a larger interval, the agent uses less CPU

cycles.
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History Tab

The Attribute Editor History page enables you to save older data for a monitored

property. In FIGURE 20-8, a history of data points is recorded every 120 seconds

(sample interval). This information can be stored in a disk file or the memory cache.

FIGURE 20-8 Attribute Editor History Tab for a Monitored Property

The two types of disk files are: circular (maximum of 1000 lines) and text. These files

are located in the /var/opt/SUNWsymon/log directory in the file specified in the

Text File Name field.

If you select memory cache, you must indicate in the Max Size (sample) field the

number of data points to save.

A circular disk file is automatically saved under the name history.log . If you do

not choose a file name for your text file, it is automatically saved under the name

agent_default.history .
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For example, if you set this field to 1000, only the most current 1000 data points are

stored in the memory cache. Any older data points are discarded. These data points

can be graphed. See “To Graph A Monitored Data Property” on page 119 for more

information.

Note – You can view this data in a graph by opening the graph for this monitored

property. If you have selected memory cache, the graph is displayed with historical

data.

▼ To Set a History Interval

1. Select a data property (System Load Statistics) (FIGURE 20-3) from the Host Details
Browser page.

The Attribute Editor Info page is displayed.

2. Click the History tab.

The History page is displayed.

3. Type a value (in seconds) in the Sample Interval field.

In this example, 120 was typed in the entry field. A history data point is collected

every two minutes. For more information on the Advanced button, see “Using the

Time Editor” on page 149.

4. Complete this procedure with one of the following actions:
■ Click OK to apply your changes and close this page.

■ Click Reset to reset the Attribute Editor to the default parameters.
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CHAPTER 21

Topology Import/Export Utility

Note – This feature may or may not be available on your system, depending on

your licensing agreement.

This chapter explains the following topics:

■ Database Requirements

■ Main Console GUI

■ Topology Export Utility

■ Topology Import Utility

■ Import/Export CLI Interface

■ Import/Export File Contents

The Topology Import/Export Utilities enable Sun Management Center users to

import or export the topology database from or to an ASCII file. The import utility is

used to read data from a file and update the topology database and the data of the

topology agent object. The export utility reverses this operation.

The Topology Import/Export Utility is used to:

■ Dump the topology data as backup regularly.

■ Transfer data between different topology servers.

■ Restore the data from backup if the topology data is damaged.

■ Convert the data into the another file format and load it into another management

system in a third party management platform.

This utility can be invoked from the Sun Management Center console main window

and the CLI. Users must specify the objects (the complete topology data and

specified domains) to be imported or exported. The tool supports several methods of

data handling, including overwrite and append.

■ The import/export utility supports domain level operation. You can specify one

domain to export or the whole topology hierarchy.

■ The import utility allows you to retain backup data.

■ You can import objects of any domain to one domain.

■ The export utility allows you to back up the existing data.
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■ You can export data in incremental mode.

Database Requirements

The Topology Import/Export Utility communicates with the Sun Management

Center server via client APIs. The operation on XML format file is based on xml.jar

(Java X project). FIGURE 21-1 shows the import/export software structure.

FIGURE 21-1 Software Structure

For export, two modes are provided: Append and Overwrite. In Overwrite mode,

the dumped data will overwrite the file whether or not the file already exists. In

Append mode, the dumped data is added to the end of the file.

For import, two modes are provided to process the domain information contained in

the dumped file. The first mode is to ignore the domain information; all objects are

created in the specified or home domain. The second mode is to import domain

information together with all other objects. In this case, new domains can be created

and all nondomain objects are created in the corresponding domain.

Client APIs xml.jar

import/export tool

Sun Management Center Server

RMI

SNMP

Topology Agent

Server Side

Console Side

Database

import/
export
file
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Main Console GUI

The Main Console GUI has an individual menu item in the Tools menu for each

operation: Topology Import and Topology Export. The export operation is only

available when the current topology hierarchy contains data. Thus, the Topology

Export item is gray (inactive) when the topology hierarchy is empty.

FIGURE 21-2 Tools Menu on the Sun Management Center Main Console
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Topology Export Utility

You can start the Topology Export Utility from the main console window or the CLI,

which is described in the “Import/Export CLI Interface” on page 438.

▼ To Start the Export Utility

● Select Tools ➤ Topology Export from the Main Console GUI.

After you select Topology Export menu from the Tools menu, a dialog is displayed

to ask you to input a file as the target file. A list shows all domains managed by the

topology agent. Users can select one domain to export. To export multiple domains,

you can repeat the preceding operation to export another domain in the append

mode.

FIGURE 21-3 Export Domain Selection Dialog
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Users can select one of the following export policies: Append (incremental) and

Overwrite (Overwrite is the default). Append mode is to append the data at the end

of the file and Overwrite mode overwrites the file. When Append mode is used in

the export, a more restrictive check is performed on the file; the file must be a valid

import/export data file. A valid import/export data file is a well-formed XML file

with correct import/export file document type declaration (DTD).

Valid Time in the preceding figure is an editable combo box. You can input the

number of days of validity time or select a predefined value. The predefined values

can be 7 days (1week), 30 days (1 month), 90 days (1 quarter).

To export a file you must have permission to write to the file (if the file exists) or to

create the file (if the file does not exist). Otherwise, an error dialog is displayed and

the operation exits.

FIGURE 21-4 Warning Message for Nonexistent File

TABLE 21-1 Export Domain Selection Dialog

Item Description

Export Domain

Name

Allows you to specify the name of the domain to export.

Export to File Allows you to specify the name of the file to export to.

File Name Allows you to specify the name of the file you want to export.

Browse Allows you to select a file from a file selection dialog.

Mode Append - appends the data at the end of the file.

Overwrite - overwrites the file.

Valid for day(s) Permits you to specify the amount of time the dumped data is valid,

The default valid time is “unlimited.”

Comments Allows users to input comments in the text area.
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Topology Import Utility

▼ To Start the Import Utility

● Select Tools ➤ Topology Import from the Main Console GUI.

After you select Topology Import menu from Tools menu, a dialog is displayed for

you to input a file name as the data source. A list shows all domains managed by the

topology agent.

FIGURE 21-5 Domain Selection Dialog (Import)

Users are provided two policies to deal with the domain information: Follow and

Ignore. Follow mode imports not only the groups, but also domain information (new

domains can be created). Ignore mode ignores the domain information and only

imports groups and entities to the target domain that the user specified. All data is

TABLE 21-2 Export Domain Selection Dialog

Item Description

Import to File Allows you to specify the name of the file to import.

Browse Allows you to select a file from a file selection dialog.

Import Domain

Name

Allows you to specify the name of the domain to import.

Mode Follow - imports groups and domain information (new domains can

be created).

Ignore - ignores the domain information and only imports groups

and entities to the target domain that you specify.
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imported into the home domain by default. Users can specify the location in the

topology hierarchy to which the data will be imported by selecting from the domain

name selection box. The location selection is only available in the Ignore mode. In

the Follow mode, the groups and entities are created in the domain contained in the

file.

Because the import utility updates the topology database, a warning dialog lets you

confirm the operation before the operation is executed.

FIGURE 21-6 Warning Dialog

The warning dialog also tells you when and by whom the input file was generated,

helping you to ensure that the correct data file is being used.

Exported data files have an item about the validity time of the file. If you are trying

to import an out-of-date file, importation stops and you are notified.

The import utility checks the accessibility of the file. If the file does not exist or is

unreadable, you receive an error message, and the operation exits.

For the import utility to analyze the import file, the file format must be correct. If the

file is formatted incorrectly, the import utility generates an error message.

If the entity exists in the current topology hierarchy, the user gets a warning dialog

asking whether or not the entity should be replaced. Five options are provided:

Replace, Replace All, Ignore, Ignore All and Cancel Import.

TABLE 21-3 Warning Dialog Buttons

Button Description

Replace Replaces the conflicting data with new values.

Replace All Replaces all conflicting data. The dialog is not displayed when the

data conflict occurs again, and the old value is replaced.

Ignore Do not update the conflicting data.

Ignore All The dialog is not displayed when a data conflict occurs; all conflicts

are ignored and left unchanged.

Cancel Import Stops the operation.
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Import/Export CLI Interface

The import/export utilities are invoked from CLI with the following commands:

The import/export utilities follow the unified command format:

Topology Import Utility

Command Parameters

TABLE 21-4 lists the import utility command parameters. The parameter format

follows the CLI general parameter template.

All parameters can be passed through to command line, or obtained from a

parameter file. For example, the import utility can be run with command line:

# SunMC -s <server> -p <port> -u <user> CLI_operation
password: *******
SunMC CLI> export [parameter]
SunMC CLI> import [parameter]

SunMC > operation [<options>] [-f <input file>] [-o <outputfile>]\
[-pf <parameter file>] [-p <parameter specifications>]

TABLE 21-4 Import Utility Command Parameters

Parameter Description

file = <xml file name> Specifies the import data source.

list = on | off Lists all entities (domains, groups and hosts) contained in the

file. Users must know what objects will be imported before the

operation is started.

mode = follow | ignore Specifies the import mode.

target = <domain> Specifies the target domain.

SunMC > import -p mode=follow target=domain1 <return>
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Users can put all parameters into a parameter file (for example, /home/user/
param_file ).

The file /home/user/param_file will look like:

The file /home/user/param_file will look like:

The explicit assignment in the command line overrides the same assignment in the

parameter file. For example, mode=ignore is assigned in command line and

mode=follow is assigned in parameter file. The final parameter is mode=ignore .

Confirmation Messages

The import utility prompts the user to answer the following items before the

operation is done or when the data conflicts:

Warning message for confirmation

Enter ‘y’ for Yes or ‘n’ for No.

SunMC > import -pf /home/user/param_file <return>

% cat /home/user/param_file <return>
mode = follow
target = domain1
%

The data being used is exported by <user name> on <mm/dd/yyyy>.
The import operation will modify your topology database, are you
sure you want  to do this? [Yes/No]
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Data conflicts

Enter:

r for Replace - Replaces the conflicting data with new values.

a for Replace All - Replaces all conflicting data.

i for Ignore - Do not update the conflicting data.

g for Ignore All - All conflicts are ignored and left unchanged.

s for Stop - Stops the operation.

Output Messages

TABLE 21-5 lists the results of the import command and the corresponding messages.

The entity <entity name> already exists in your topology hierarchy,
do you want to replace it?
[Replace(r)/replace All(a)/Ignore(i)/iGnore all(g)/Stop(s)]

TABLE 21-5 Import Utility Output Messages

Message Reason Description

import: Done. Succeed The operation is done

successfully.

<filename>: No such
file.

File does not exist The file specified does not

exist. Two files may be used by

command line: data file (as

import data source) and

parameter file (as parameter

list).

import: Cannot open
<filename>.

Permission denied The file cannot be opened for

reading.

import: File format is
not supported.

Format wrong The source file is not a valid

database export data file.

import: File out-of-
date (xx days).

Data out-of-date You are using out-of-date data.
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Topology Export Utility

Command Special Parameters

Export has command special parameters. The parameter format follows the CLI

general parameter template.

Comments

import: Authentication
failed.

Authentication failed The current user has no

authority to create objects in

the topology hierarchy.

import: Wrong parameter
file.

Parameter file error The parameter file should be a

list of name = value pairs. If not,

application generates an error

message and stops.

import: illegal
parameter - <para>.
Use -h option to get
usage.

Illegal parameter An illegal parameter is passed

to the import operation.

TABLE 21-6 Export Parameter Comments

Parameter Comments

domain = domain | ALL Specifies which domain or domains will be exported. By

default, all domains are exported.

file = xml file name Specifies the name of the target file in which to store the

export data.

mode = append | overwrite Specifies export mode: append or overwrite. If not

specified, the default mode is append. When append mode

is used, the current user is the same as the last export

operation.

validate = xx | unlimited Specifies the validation time of the export data in days.

TABLE 21-5 Import Utility Output Messages (Continued)

Message Reason Description
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After invoking the export command, you are asked to enter comments. The prompt

is >. You can press Return anywhere to break the line. The input is ended with

pressing Return twice. For example:

Output Messages

TABLE 21-7 lists the results of the export command and the corresponding messages.

SunMC CLI> export -p domain=ALL mode=append <return>
Please enter comments for the export:
> Comment text line 1 <return>
> Comment text line 2 <return>
> <return>
<
State = OK
message = Done.
SunMC CLI>

TABLE 21-7 Export Utility Output Messages

Message Reason Description

export: Done. Succeed The operation is done successfully.

export: Can not open file. File does not exist. The parameter file does exist.

filename: Permission denied. File error The file cannot be created or

opened for writing.

export: File format not

supported.

Format wrong The error occurs when appending

the export data to a file and the

file is not a valid export data file.

export: The domain <...> not

exist

Object error The domain that the user wants to

export does not exist.

export: Wrong parameter file. Parameter file error The parameter file shall be a list of

<name = value> pairs. If not, the

application will notify the user

that the parameter file format is

error and stop.
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Import/Export File Contents

TABLE 21-8 lists the topology data that the import/export utilities process.

export: The current user is

different from the last one.

User conflict The error occurs when you try

overwrite or append the data to

an existing data file created by

others. You cannot modify or

overwrite other’s export data.

export: Data is out-of-date. Data is too old. You are using an out-of-date

export file. It only occurs when

you export data in append mode.

export: illegal parameter -

<para>.

Please use -h option to get

usage.

Illegal parameter An illegal parameter is passed to

the export operation.

TABLE 21-8 Import/Export File Contents

Item Description

Entity information The record information about every domain, group and host.

Adornment

information

The adornment information about domains and groups. The

adornment information only contains the layout and background

index instead of the background content. That is, the information

about background only contains the GIF file name, but not the GIF

file.

Relationship

information:

The relationship information describes the topology hierarchy,

entity background and layout.

TABLE 21-7 Export Utility Output Messages (Continued)

Message Reason Description
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File Format Description

The Import/Export file describes the import/export data. Users can edit it with a

text editor. The file includes the information about every entity in the topology

hierarchy. Because the append export mode can append more object information to

the file, the format is easy to extend and analyze. XML format is used to save the

exported data.

File Format Design

The file is separated into four parts:

■ Magic

■ DTD (Document Type Declaration)

■ Head Information

■ Data Blocks

Magic

The magic information identifies that the file is an XML format file. It is <? XML

version = 1.0 ?> typically.
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DTD (Document Type Declaration)

The DTD information defines the structure of the document. The DTD of an export

file is defined as:

<? XML version = 1.0 RMD = INTERNAL ?>
<!DOCTYPE DOCUMENT [
<!ELEMENT DOCUMENT (HEAD, COMMENTS ?, DOMAIN*)>

<!ELEMENT HEAD (USER, DATE, VALIDATE?, PRODUCT, VERSION)>
<!ELEMENT USER (#PCDATA)> /* creator’s user name */
<!ELEMENT DATE (#PCDATA)> /* the latest export date. */

<!ELEMENT VALIDATE(#PCDATA)> /* validity information: 7/30/90 days or
unlimited. The field is not mandatory. */

<!ELEMENT PRODUCT (#PCDATA)> /* SunMC or Sun Management Center, which
only specifies the XML is a SunMC export
file. It is very useful to check the file
validity when importing. */

<!ELEMENT VERSION(#PCDATA)> /* 3.0 */
<!ELEMENT COMMENT(#PCDATA)> /* Comments. */
<!ELEMENT DOMAIN (ENTITY* ADORNMENT*)>

/* The element describes a domain. A domain
can contain groups and adornment
information. */

<!ATTLIST DOMAIN /* Domain attributes  */
disc CDATA
field-test CDATA
family_type CDATA
hostname CDATA
ip CDATA
architecture CDATA
netmask CDATA
flag CDATA>
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Head Information

The head information is used to record the general information, including user, data,

version, platform, product, and so forth.

Data Blocks

Data blocks contain the topology hierarchy architecture and entities.

<!ELEMENT ENTITY (ENTITY* ADORNMENT*)>
/* Entity element describes a entity. If it is a group, it may contain groups
and adornment.

<!ATTLIST ENTITY /* Entity attributes */
desc CDATA
full_desc CDATA
hostname CDATA
ip CDATA
netmask CDATA
architecture CDATA
family CDATA
polling_type CDATA
url CDATA
x_coord CDATA
y_coord CDATA
topology_type CDATA
event_dest CDATA
trap_dest CDATA
target_host CDATA
target_ip CDATA
read_info CDATA
write_info CDATA>

<!ELEMENT ADORNMENT>
<!ATTLIST ADORNMENT

x_coord CDATA
y_coord CDATA
type CDATA
configuration CDATA>

]>
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Example

Here is the topology for the domain called “my new.”

FIGURE 21-7 New Topology Example

Here is an example of the export file. The data contained in the file describes the

“my new” domain:
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<?xml version="1.0" encoding="UTF-8"?>
<DOCUMENT>

<HEAD>
<USER>jkang</USER>
<DATE>1/7/1999</DATE>
<VALIDITY>7 days</VALIDITY>
<PRODUCT>SunMC</PRODUCT>
<VERSION>3.0</VERSION>
<COMMENTS>This is an example.</COMMENTS>

</HEAD>
<DOMAIN name="my new">

<ENTITY arch="SunOS 5.8" config="" desc="wizard" entityId="e-1"
family="sun4u-Sun-Ultra-30" fulldesc="wizard" hostname="wizard"
ipAddr="129.158.168.63" isPoll="false" isSoftGroupLink="false"
netMask="255.255.255.255" pollType="ahost" readInfo="" targetHost=""
targetIp="" targetUrl="snmp://129.158.168.63:1100/sym//base/mibman/modules"
type="" writeInfo="" xCoord="23" yCoord="39" />

<ENTITY arch="SunOS 5.8" config="" desc="atom" entityId="e-2"
family="sun4u-Sun-Ultra-30" fulldesc="" hostname="u30-1"
ipAddr="129.158.168.113" isPoll="false" isSoftGroupLink="false"
netMask="255.255.255.255" pollType="ahost" readInfo="" targetHost=""
targetIp="" targetUrl="snmp://129.158.168.113:161/sym//base/mibman/modules"
type="" writeInfo="" xCoord="75" yCoord="39" />

<ENTITY arch="" config="" desc="campus" entityId="e-3"
family="campus-view" fulldesc="" hostname="" ipAddr="" isPoll="true"
isSoftGroupLink="false" netMask="" pollType="aview" readInfo="espublic"
targetHost="" targetIp="" targetUrl="snmp://129.158.168.63:164/mod/
topology+view-101" type="" writeInfo="" xCoord="27" yCoord="111">

<ENTITY arch="" config="" desc="building" entityId="e-1"
family="building-view" fulldesc="" hostname="" ipAddr="" isPoll="true"
isSoftGroupLink="false" netMask="" pollType="aview" readInfo="espublic"
targetHost="" targetIp="" targetUrl="snmp://129.158.168.63:164/mod/
topology+view-102" type="" writeInfo="" xCoord="" yCoord="">
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<ENTITY arch="SunOS 5.8" config="" desc="Wizard" entityId="e-1"
family="sun4u-Sun-Ultra-30" fulldesc="" hostname="wizard"
ipAddr="129.158.168.63" isPoll="false" isSoftGroupLink="false"
netMask="255.255.255.255" pollType="ahost" readInfo="" targetHost=""
targetIp="" targetUrl="snmp://129.158.168.63:1100/sym//base/mibman/modules"
type="" writeInfo="" xCoord="" yCoord="" />

<ENTITY arch="SunOS 5.8" config="" desc="aaa" entityId="e-2"
family="sun4u-Sun-Ultra-30" fulldesc="" hostname="wizard"
ipAddr="129.158.168.63" isPoll="false" isSoftGroupLink="false"
netMask="255.255.255.255" pollType="ahost" readInfo="" targetHost=""
targetIp="" targetUrl="snmp://129.158.168.63:1100/sym//base/mibman/modules"
type="" writeInfo="" xCoord="" yCoord="" />

<ENTITY arch="SunOS 5.8" config="" desc="atom" entityId="e-3"
family="sun4u-Sun-Ultra-30" fulldesc="" hostname="u30-1"
ipAddr="129.158.168.113" isPoll="false" isSoftGroupLink="false"
netMask="255.255.255.255" pollType="ahost" readInfo="" targetHost=""
targetIp="" targetUrl="snmp://129.158.168.113:161/sym//base/mibman/modules"
type="" writeInfo="" xCoord="" yCoord="" />

</ENTITY>
</ENTITY>

<ENTITY arch="" config="" desc="129.158.0.0" entityId="e-4"
family="network-view" fulldesc="129.158.0.0" hostname="129.158.0.0"
ipAddr="129.158.0.0" isPoll="true" isSoftGroupLink="false"
netMask="255.255.255.0" pollType="aview" readInfo="espublic"
targetHost="129.158.0.0" targetIp="129.158.0.0" targetUrl="snmp://
129.158.168.63:164/mod/topology+view-103" type="" writeInfo="" xCoord="38"
yCoord="181">

<ENTITY arch="" config="" desc="129.158.168.0" entityId="e-1"
family="subnetwork-view" fulldesc="129.158.168.0" hostname="129.158.168.0"
ipAddr="129.158.168.0" isPoll="true" isSoftGroupLink="false"
netMask="255.255.255.0" pollType="aview" readInfo="espublic"
targetHost="129.158.168.0" targetIp="129.158.168.0" targetUrl="snmp://
129.158.168.63:164/mod/topology+view-104" type="" writeInfo="" xCoord=""
yCoord="">

<ENTITY arch="SunOS 5.8" config="" desc="wizard" entityId="e-1"
family="sun4u-Sun-Ultra-30" fulldesc="SUNW,Ultra-30" hostname="wizard"
ipAddr="129.158.168.63" isPoll="false" isSoftGroupLink="false"
netMask="255.255.255.0" pollType="ahost" readInfo="public" targetHost=""
targetIp="" targetUrl="snmp://129.158.168.63:1100/sym//base/mibman/modules"
type="" writeInfo="" xCoord="" yCoord="" />
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</ENTITY>
</ENTITY>
<ENTITY arch="" config="" desc="myworkstation" entityId="e-5"

family="nonagent-sun4u-Sun-Ultra30" fulldesc="" hostname="wizard"
ipAddr="129.158.168.63" isPoll="false" isSoftGroupLink="false" netMask=""
pollType="snmp" readInfo="public" targetHost="" targetIp="" targetUrl="snmp:/
/wizard:1100/oid//1.3.6.1.2.1.1.7.0" type="" writeInfo="private" xCoord="52"
yCoord="253" />

<ENTITY arch="SunOS 5.8" config="" desc="System Group" entityId="e-
6" family="base-agent" fulldesc="MIB tree branch" hostname="wizard"
ipAddr="129.158.168.63" isPoll="false" isSoftGroupLink="false"
netMask="255.255.255.255" pollType="amod" readInfo="" targetHost="wizard"
targetIp="129.158.168.63" targetUrl="snmp://129.158.168.63:1100/mod/mib2-
simple/system" type="" writeInfo="" xCoord="52" yCoord="329" />

<ADORNMENT Config="bus" Id="adorn-7" Type="layout" XCoord="0"
YCoord="0" />

</DOMAIN>
</DOCUMENT>
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CHAPTER 22

Command Line Interface

Note – This feature may or may not be available on your system, depending on

your licensing agreement.

The Sun Management Center Command Line Interface (CLI) provides an alternative

method to the graphical user interface for monitoring and managing your system.

The CLI also enables you to use the Sun Management Center server remotely.

The following topics are discussed in this chapter:

■ Overview of the Sun Management Center CLI

■ CLI User Interface

■ CLI Interaction Modes

■ Logging in to Sun Management Center Software

■ CLI Command Parameters

■ CLI Commands

■ Format of CLI Output

■ CLI Log File

■ Internationalization and the CLI

Overview of the Sun Management
Center CLI

CLI functionality is similar to that provided in the GUI and provides many of the

functions available through the GUI.

You can use the CLI to:

■ Retrieve topology information (domain/group/entity).

■ Create topology objects (domain/group/entity).
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■ Retrieve/manipulate managed object properties/attributes.

■ Load/unload module(s) on one or a set of Sun Management Center agents.

■ Enable/disable module(s) on one or a set of Sun Management Center agents.

■ Retrieve alarm information on one or a set of Sun Management Center agents.

■ Acknowledge or delete alarms on one or a set of Sun Management Center agents.

■ Set and run alarm actions on one or a set of Sun Management Center agents.

The CLI can be accessed from a user terminal session, using one of the following:

■ UNIX workstation, running Solaris 2.6 and higher

■ PC, running Windows98 or Windows NT

Relationship of the CLI to the System Structure

FIGURE 22-1 presents the Sun Management Center structure and the relationship of

the CLI within the structure.

FIGURE 22-1 CLI in Sun Management Center System Structure

Console Layer

Server Layer

Agent Layer
Agent (s)

Server

GUI Console(s) CLI Console(s)

Config Server

Topology Agent

Event Manager

Trap Handler
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CLI Software Structure

FIGURE 22-2 describes the software structure of the CLI. It contains four basic

components:

■ The Command IO component is used to parse the command line arguments and

present the operational results, including errors, warnings, and exit status.

■ The Session Handler is used to set up a connection and maintain a session during

the interaction.

■ The Operation Implementation layer implements the CLI operation functionality.

■ The Client API is used to implement all supported CLI operations.

FIGURE 22-2 CLI Software Structure

Constraints

CLI output is available only in text format. Features that require a GUI, such as

physical view and graphing, are not available through the CLI.

Also, creation and viewing of groups and tasks are not supported in the CLI.

Assumptions and Dependencies
■ Functions supported in the CLI are a subset of the functions available in the GUI

console.

■ The CLI provides comparable information to the output retrieved using the

associated GUI functionality, but the information is formatted differently.

■ High-level operations can be performed by a single CLI command.

Command IO

Operation
Implementation

Client API

Session
Handler
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CLI User Interface

The following table describes characteristics of the CLI user environment.

User Authorization

Two levels of user authorization are available:

■ General end users can retrieve monitored object properties.

■ Administrative users have the same privileges as general users, and can also set up

or modify the managed system.

TABLE 22-1 Characteristics of the CLI User Environment

Characteristic Description

Secured user access You specify the host and port number on which the server is

running, and provide a Sun Management Center login ID on the

Sun Management Center server. You will be prompted to enter your

password.

Independency Commands in the CLI are independent. This means that no

command’s execution is required as a condition for execution of any

other command.

Help The CLI provides a help system that tells you the available

commands, and explains how to use the commands.

Input The CLI allows users to specify which operation is going to apply

and where (scope and condition) to apply it. These specifications

can be entered through the command line as parameters, or through

an input file. Operations can be spread over several input lines,

with a backslash at the end of a line signifying continuation on the

following line.

Output The CLI reports results as well as errors in a readable format.

Results can be output to a specified file, and should be formatted in

such a way that it can be used as input to subsequent CLI

commands. In batch mode, the CLI produces an exit status on

termination that is indicative of the success of the operation.
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CLI Interaction Modes

The CLI is designed to support two interaction modes:

■ Batch mode: The CLI connects to the server, executes commands one at a time, and

closes the connection.

■ Multiple-command or Session mode: The CLI establishes a connection with the

server, then accepts all operations until it receives an explicit closing request. The

session can include multiple operations.

Batch Mode

The parameter -b enables batch mode with a file option. Once the CLI is started, it

will automatically execute the login command and prompt the user for login

information. If the login is successful, the commands in the file will be executed one

at a time. See “To Access the CLI in Solaris Environments” on page 456.

Multiple-command (or Session) Mode

Multiple-command or session mode is similar to the Sun Management Center GUI

mode, in that it establishes a connection with the server before it is ready to provide

service. Once a session is established, it can accept many service requests.

Session mode is more efficient in the networked environment when you apply

multiple requests to a remote server. Session mode commences whenever the CLI is

invoked without providing a specific operation on the command line. The exit status

of the process indicates the success of the connection and authentication of the

session, but does not attempt to indicate the success of individual operations.

Note – The Sun Management Center CLI can consider batch mode as one extreme

case of session mode, in which there is only one command in the session. In this

case, the exit status of the CLI indicates the success or failure of the operation

performed.
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Logging in to Sun Management Center
Software

▼ To Access the CLI in Solaris Environments

You can access the CLI in batch mode by typing the following command from

/opt/SUNWsymon/sbin :

Note – The -b parameter indicates batch mode.

For multiple-command (or session) mode, type the following:

Go to Step 1.

▼ To Access the CLI in Microsoft Windows

Environments

After you have already installed the Sun Management Center console layer, double-

click on es-cli in the CLI folder. A screen displays for CLI login.

./es-cli -b file

./es-cli parameters
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1. Type the login command. The login requires you to specify the host name and
your login name.

In the following example, seattle is the serverHost name, and joannm is the

login name:

Your login name and password are the same as the name and password you enter on

the Sun Management Center Login screen when using the Sun Management Center

software GUI.

2. After the session is established, you can enter the desired commands:

The CLI commands are described in detail later in this chapter.

> login serverHost=seattle
Login: joannm
Password:
>

> command
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CLI Command Parameters

The CLI uses a set of reserved or predefined parameters in combination with the CLI

commands to help you target the information you need. These parameters and

corresponding values are listed in the following table:

TABLE 22-2 CLI Predefined Parameters and Values

Parameter Value Optional Notes or Description

-b This parameter is used to start the CLI in batch

mode. It is ignored in session mode.

-h When used as a parameter to a command, the

help for the command is displayed. This

parameter takes precedence over all other

parameters. When -h is set, other parameters are

ignored.

-l This parameter has no effect on basic commands.

This parameter is only used in extended

commands to feed the result of the last extended

command as an input to the current one. If this

parameter is set, all other parameters will be

ignored, and the parser will automatically feed

the last extended output (including all parameters

and results, if any) to the current extended

command. Use this parameter sparingly in

circumstances that warrant its necessity.

a agent|agentList agent=agentHost[:agentPort]
agentList=agent[,agent] +

append output file The append parameter is used to append the

results of a command to a file. If the file does not

exist, it will be created. Use this parameter in

conjunction with a command. Alternatively, set

this parameter globally to append all subsequent

output to a file. If the append and o parameters

are both set, append takes precedence over o.

Only results will be recorded. The command itself

is not recorded. Use the log parameter to record

command information.
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columns This parameter is used in extended commands to

print only column(s) that correspond to the

column name(s) specified in the value of this

parameter. Multiple column names are delimited

by a comma (“,”). for example:

columns=”Alarm Id,Node URL,Target
Host,Severity”
The values of this parameter are case-sensitive.

f plain|xml|html Sets the output format to plain text, XML, or

HTML. See “Format of CLI Output” on page 472

for more information.

serverHost server host This parameter sets the server host for login. It is

a global parameter that cannot be set after a login

session is established.

height number of lines Number of lines displayed on a screen.

i input file This parameter is used to read an input file that

contains various parameter settings into the

current session. Each parameter setting should

reside on a separate line. For example, an input

file with three parameter settings would look as

follows:

more=off
serverHost=myserver
a=myagent:161

log log file This parameter is used to activate the recording of

all CLI commands (including the time each

command is entered) onto the specified log file.

Once the parameter is set, all subsequent

commands will be appended to the file. If the file

does not exist, it will be created. Because the file is

not overwritten, be sure a new file is created if

you want a new set of records.

m module|moduleLis
t

module=moduleName[+moduleInstance]
moduleList=module[,module] +

more on|off If it is set to on , all subsequent outputs on the

terminal will be displayed one screen at a time,

which is defined by the height and width

parameters. The default is off for batch mode

and on for session mode.

TABLE 22-2 CLI Predefined Parameters and Values (Continued)

Parameter Value Optional Notes or Description
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Operation and Parameter Format

CLI operations support retrieval of information and manipulation of object

attributes for topologies, modules, and alarms. The general format is:

Parameters are a series of name-value pairs.

o output file This parameter is used to write the results of a

command to a file. If the file exists, it will be

overwritten. Use this parameter in conjunction

with the a command. Alternatively, set this

parameter globally to write all subsequent output

to a file. If append and o are both set, append
takes precedence over o. Only results will be

recorded. The command itself is not recorded. Use

the log parameter to record command

information.

serverPort server port This parameter is the server port for login. It is a

global parameter that cannot be set after a login

session is established. If it is not set, the default

port of 2099 will be used.

t topoObject The topology object is the object managed in the

topology agent. It can be a domain, a view group,

or an entity. It is specified in the fully qualified

name started from the domain, for example,

/domain/group/host .

width number of characters Number of characters in one line displayed on a

screen.

> command [name=value]*

TABLE 22-2 CLI Predefined Parameters and Values (Continued)

Parameter Value Optional Notes or Description
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▼ To Override Parameters

Parameters passed on the command line are available throughout a session. The set
command can be used to overwrite or store new parameters. For example:

The original values from the command line can be stored by entering reset . For

example:

The unset command can be used to remove a parameter from the current session.

For example:

Specifying a parameter as part of an operation overrides the session parameter for

the duration of that operation. When an explicit name value parameter is specified

along with i=inputFile , the explicit name value overrides the value from the file.

For example, if the file x contains:

and you type:

./es-cli a=b
> set
a=b
> set a=c
> set x=y
> set
a=c
x=y

> reset
a=b

> set
a=b
c=d
> unset a
> set
c=d

a=b
c=d

> doSomething c=f i=x
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then the doSomething command will see the value of c as f , and not d.

This applies also on the command line. For example:

bob will override the value of of the host in the serverFile .

Command-Specific Parameters

The CLI uses parameter lists to define all required parameters for a specific

command. A parameter list is a list of name=value pairs, with values encapsulated

in quotes (if they contain white space), with pairs separated by whitespace, and with

no whitespace between the parameter name, the equals sign and the quoted value.

The following is an example of a parameter list:

If a parameter has a list of values, they are separated by a comma (“,”) with no

whitespace between each value. For example:

The following name-value pairs are acceptable:

The following name-value pairs are not acceptable:

./es-cli serverHost=bob i=serverFile

m=kernel-reader moduleDesc="My Kernel Reader"

severity=DIS,DWN,ERR

test1=”This is just a test”
test2=hello
test3=hello,hi,aloha
test4=”hello,hi,aloha”

test1=”How are you?”,”Who are you?”
test2=”Testing”,1,2,3
test3=”Hello
test4=Hello”
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Parameters can be entered during a session or read from a file. This file will contain

key=value pairs separated by new lines. Values must be enclosed in quotes if they

contain spaces. Use the i=fileName parameter to specify the location of the file.

CLI Commands

This section describes the commands supported in the CLI. There are two types of

commands:

■ Basic

■ Extended

Basic commands run in the foreground. You cannot run subsequent commands until

you stop running a basic command.

Extended commands run in the background by default (unless the foreground

parameter is set to on). Only one command can run in the background at any one

time. Commands that run in the background do not produce any output to the

screen to indicate its success or failure, errors encountered (if any), its progress, and

so on. Use the print command to send output to the screen.

Note – When a command is running in the background, the login and logout

commands are not allowed to run. These commands can interfere with the command

that is running in the background.

Basic CLI Commands

The following table describes the basic CLI commands:

TABLE 22-3 Basic Commands for the CLI

Command name Description

alias Lists all available pseudonyms or shorthand terms for

commands.

clear Removes all parameters from the current session.

exit Logs out from the server and exits the CLI.
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help Lists all available CLI commands in alphabetical order

with a brief description of each. Basic commands are

listed first, followed by extended commands. (Also see

the more command below.)

kill Kills the command that is running in the background.

login Logs in to a Sun Management Center server. This

command prompts you for your user name and

password. You must log in before performing commands

with the Sun Management Center server or agents. Once

you log in to a session, no other login will be allowed

until you run the logout command.

logout Terminates your connection to the Sun Management

Center server.

more Displays help on a specified command, including

parameters, defaults, and procedures.

print Prints the results of the last extended command in the

specified format to the specified destination. If the

parameter o is set, the printout is directed to a file and is

not shown on the screen.

Note: This command is not saved in the command

history.

quit Logs out from the server and exits the session (same as

the exit command).

reset Resets all parameters to what was set from the command

line. Any parameter that is set after the command line is

left unchanged.

set Store or display parameters in the current session. The

parameter is available to all commands.

status Shows the status of the command that is running in the

background.

unalias Removes a pseudonym or shorthand term for a

command.

unset Removes parameter settings from the current session.

Note: This command is not saved in the command

history.

TABLE 22-3 Basic Commands for the CLI (Continued)

Command name Description
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Extended CLI Commands

There are four types of extended commands available in the CLI:

■ Module commands

■ Object attribute commands

■ Alarm commands

■ Topology commands

Module Extended Commands

There are seven extended commands for managing modules.

Examples for Using the Module Extended CLI Commands

If you want to find out which modules are loaded on a particular host, the command

format is getLoadedModules a=agent . In this example, the agentHost name is

seattle . You would type the following:

TABLE 22-4 Module Extended Commands in the CLI

Command name Reserved Parameters Description

disableModule a=agent|agentList
m=module|moduleList

Disable a module or modules in

an agent or agents.

enableModule a=agent|agentList
m=module|moduleList

Enable a module or modules in an

agent or agents.

getLoadedModules a=agent|agentList Get a list of loaded modules in an

agent or agents.

getModule a=agent|agentList
m=module

Get information for a particular

module.

getModules a=agent|agentList Get a list of modules in an agent.

loadModule a=agent|agentList
m=module|moduleList
moduleName=name
moduleDesc=description

Load a module in an agent or

agents.

unloadModule a=agent|agentList
m=module|moduleList

Unload one or more modules in

an agent or agents.

> getLoadedModules a=seattle
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Next, suppose you wanted to load a module that is not currently loaded. The

command format is loadModule a=agentHost :agentPort m=module . In this

example, the agentHost name is still seattle and the agentPort is the default, 161 .

The module is the kernel reader module. You would type the following:

Object Attribute Extended Commands

There are four extended commands for managing object attributes.

> loadModule a=seattle:161 m=kernel-reader

TABLE 22-5 Object Attribute Extended Commands in the CLI

Command name Reserved Parameters Description

addRow a=agent[,agent]+
m=module
mgtObj=managed_object
property=property
propInst=property_instance
rowValues="name=value[,name=value]+"

Add a row in a table.

delRow a=agent[,agent]+
m=module
mgtObj=managed_object
property=property
propInst=property_instance
rowValues="name=value[,name=value]+"

Delete a row in a table.

getAttributes a=agent[,agent]+
m=module
mgtObj=managed_object
property=property
propInst=property_instance

Get certain attributes in an agent

or a list of agents.

setAttributes a=agent[,agent]+
m=module
mgtObj=managed_object
property=property
propInst=property_instance
attributes=""
values=""

Set certain attributes in an agent

or a list of agents.
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Examples for Using the Object Attribute Extended CLI Commands

In the following example to retrieve attributes, the agentHost name is haiku and the

agentPort is 1161 . The module is agent-stats , the managed object is

totalstats , and the property is defined as size :

The following shows example parameters for deleting a row from a table (as

specified in rowValues ):

> getAttributes a=haiku:1161 m=agent-stats mgtObj=totalstats \
property=size

> delRow a=haiku:1161 \
m=filemon mgtObj=filemonstats/filemonTable/filemonEntry \
rowValues=”name=test,desc=this,filename=/etc/passwd”
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Alarms Extended Commands

There are five extended commands for managing alarms.

TABLE 22-6 Alarms Extended Commands in the CLI

Command name Reserved Parameters Description

ackAlarms a=agent|agentList
note=reason
m=module[+moduleInstance]
managed_object=managed_object
property=property
property_instance=property_instance
qualifier=qualifier
severity=ERR|WRN|INF|IRR|DWN|DIS|OFF
state=O|C|F
ack=A|N

Acknowledge alarms with an

optional note (or reason) in an

agent or a list of agents.

delAlarms a=agent|agentList
note=reason
m=module[+moduleInstance]
managed_object=managed_object
property=property
property_instance=property_instance
qualifier=qualifier
severity=ERR|WRN|INF|IRR|DWN|DIS|OFF
state=O|C|F
ack=A|N

Delete alarms with an optional note

(or reason) in an agent or a list of

agents.

getAlarms a=agent|agentList
m=module[+moduleInstance]
managed_object=managed_object
property=property
property_instance=property_instance
qualifier=qualifier
severity=ERR|WRN|INF|IRR|DWN|DIS|OFF
state=O|C|F
ack=A|N

Get alarm information of an agent

or a set of agents.

runAlarmAction a=agent|agentList Run an alarm action manually in an

agent or a list of agents.

setAlarmAction a=agent|agentList
command=command

Set an alarm action (manual or

delay) in an agent or a list of agents.
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Examples for Using the Alarms Extended CLI Commands

In the following example to retrieve alarms, the agentHost name is haiku and the

alarms requested to be returned are specified as either ERRor DWN. The command

getAlarms with no parameters would return all alarm information:

The following is an example parameter for deleting alarms with a specified notation:

Supported Parameter Lists for Topology Commands

Topology commands support the following parameter lists.

topoEntity_desc_list: specify a managed object information. It contains
the following keywords:
fullDesc=text
family=text
topoType=text
topoCfg=text
isPolled=true|false
pollType=dummy|ping|snmp|ahost|amod|aprox
readInfo=text
writeInfo=text
targetHost=text
targetIp=text
agentPort=port

where agentPort is optional and is only used if url is not specified and the user does

not want to use the default port.

topoEntity_filter_list: classify a group of managed objects under a
certain condition
pollType=text
arch=text
family=text

> getAlarms a=haiku severity=ERR,DWN

> delAlarms note=”by sysadm only”
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topoGroup_desc_list: specify a managed view group. It contains the
following keywords:
fullDesc=text
family=text

a=agent is a reserved parameter, where agent=agentHost[:agentPort].

Topology Extended Commands

There are seven extended commands for managing the topology.

TABLE 22-7 Topology Extended Commands in the CLI

Command name Reserved Parameters Description

createEntity t=topoObject
topoEntity_desc_list

Create a managed entity. The

topoEntity_desc_list is used to specify the

entity properties. If the url or the agentPort is

not specified, the default port of 161 is not used.

createGroup t=topoObject,
topoGroup_desc_list

Create a topology domain or group. If it is a

domain, topoGroup_desc_list is ignored. If it

is a topology group, topoGroup_desc_list
must be provided.

delTopoObjects t=topoObject Delete a managed topology object in the managed

topology hierarchy. All objects under the specified

topology object are deleted as well.

getAgentPort a=agent,t=topoObject Return a port number that the Sun Management

Center agent is running on the specified host in a

topology domain. If there are multiple agents, a

list of port numbers is returned. If t is not

specified, the default domain is used.

getAllTopoObjects t=topoObject,
topoEntity_filter_list

Get a list of all managed objects in the managed

topology hierarchy that satisfy a certain condition

as specified in the entity_filter_list .

getDomains Get information for all managed domains.

getTopoObject t=topoObject,
topoEntity_filter_list

Get managed topology objects. If the topology

object is a domain or a group, it returns all

group/entity objects directly under this domain

or group. These objects satisfy a certain condition

specified in the topoEntity_filter_list .
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Examples for Using the Topology Extended CLI Commands

In the following example, the command retrieves a list of managed topology objects

under the default domain headquarters . The command would return a list of all

groups and subgroups under the headquarters hierarchy:

In the following example, the command creates a group under an existing domain

named headquarters_test .

> getTopoObject t=/headquarters

> createGroup t=/headquarters_test/build19 \
fullDesc=”test headquarters domain” family=building-location
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Format of CLI Output

The output of a basic command is available only in plain text. The output of an

extended command is available in three formats:

■ Plain text

■ XML

■ HTML

Use the f parameter to set the output to the intended format. Regardless of the

format, an output will consist of a set of results. Each result contains a list of

name=value pairs, with each pair occupying one row. Thus, each result may span

multiple rows.

For retrieval commands, the name in the list of name=value pairs is the target

attribute, or a managed object.

For set commands, each result will have the following format:

where state tells whether the command is successful, and message provides the

details.

When an error is encountered, it should be generated in the following format:

where message contains an error message.

state=OK|Fail
message=””

state=Fail
message=””
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Plain Text

When the f parameter is set to plain , the output format is set to plain text. To

clearly delineate different results, each result begins and ends with a separator. The

following example shows an output in plain text:

XML

When the f parameter is set to xml , the output format is set to XML. In this format,

each result is delineated by a Row tag. A set of results contains a list of Row tags.

Each Rowcontains a set of Property tags, which is a list of name=value pairs. Each

Rowhas a Type attribute with either Data or Error as its value.

Data indicates that the set of Properties is information that has been retrieved,

whereas Error indicates that the set of Properties is related to an error that has

occurred. The following is an example of XML output:

== <commandName>: Results 1/2 =======================
attribute1=value1
attribute2=value2
== <commandName>: Results 2/2 =======================
attribute1=value3
attribute2=value4
====================================================

<?xml version=”1.0”?>
<Table Command=”<commandName>”>
<Row Type=”Data”>
<Property Name=”attribute1”>value1</Property>
<Property Name=”attribute2”>value2</Property>
</Row>
<Row Type=”Data”>
<Property Name=”attribute1”>value3</Property>
<Property Name=”attribute2”>value4</Property>
</Row>
</Table>
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HTML

When the f parameter is set to htm or html , the output format is set to HTML. In

this format, the set of results is enclosed in a table. Each result takes up one row,

with the top row comprising the column headings, that is, the name of each

name=value pair.

The first column heading is Row, and lists the row number for each row. Subsequent

rows have columns that contain values.

Each column in a subsequent row contains the value of a name=value pair in the

corresponding result. Each result that is related to an error will be displayed in

another table. If a column has no data, it is grayed out.

The following example shows an incomplete excerpt of HTML output:

CLI Log File

CLI commands (including the time a command is entered) are recorded in a log file.

The log file has the following format:

For example:

<TABLE BORDER=1 CELLPADDING=5 CELLSPACING=0 BGCOLOR=”#FFFFCC”>
<TR VALIGN=TOP>
<TD ALIGN=CENTER BGCOLOR=0><FONT COLOR=WHITE><B>Row</B></FONT></TD>
<TD ALIGN=CENTER BGCOLOR=0><FONT COLOR=WHITE><B>attribute1</B></FONT></TD>
<TD ALIGN=CENTER BGCOLOR=0><FONT COLOR=WHITE><B>attribute2</B></FONT></TD>
</TR>
<TR VALIGN=TOP>
<TD ALIGN=CENTER>1</TD>
<TD>value1</TD>
<TD>value2</TD>
</TR>
<TR VALIGN=TOP>
<TD ALIGN=CENTER>2</TD>
<TD>value3</TD>
<TD>value4</TD>
</TR>
</TABLE>

DATE & TIME;duration or message;command and parameters

Wed Jan 26 10:18:20 EST 2000;== START OF THREAD ==;getAlarms
Wed Jan 26 10:18:27 EST 2000;7 seconds;getAlarms
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▼ To Record CLI Commands in a Log File

1. Set the log parameter to a file name. For example:

Once the parameter is set, all subsequent commands are appended to the file. If the

file does not exist, it will be created.

The file will not be overwritten, so make sure a new file is created if you want a new

set of records.

2. To stop recording, unset the log parameter. For example:

Internationalization and the CLI

All commands and log files are available only in English. Command descriptions

and help text, however, follow the Java internationalization guidelines for the

following additional languages:

■ French

■ German

■ Italian

■ Japanese

■ Korean

■ Simplified Chinese

■ Spanish

■ Traditional Chinese

set log=/var/opt/SUNWsymon/history.log

unset log
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APPENDIX A

Getting Started With Sun
Management Center Software

TABLE A-1 is an example of how you can use the Sun Management Center software.

This table includes a summary of some typical tasks and the order in which they

should be done. Each task is referenced to a section in the manual, which provides

detailed, step-by-step directions.

The tasks and the order in which they are included in this table is based on the

assumption that you will explore and learn the software before setting up your

actual monitoring environment.

TABLE A-1 Example Use of Sun Management Center Software

Task For More Information, Go to

Create an administrative domain. “To Create Administrative Domains” on

page 20

Populate the administrative domain by creating objects. Chapter 3

Populate the administrative domain with the Discovery

manager.

Chapter 4

Familiarize yourself with the Console window. Chapter 5

Navigate through Sun Management Center software using the

hierarchy (tree) view.

“Hierarchy View” on page 69

Navigate through Sun Management Center software using the

topology view.

“Topology View” on page 71

Open the Details window. “To Start the Details Window” on page 85

Load other modules. “To Load a Module” on page 171

Disable some modules. “To Disable a Module” on page 177

Unload some modules. “To Unload a Module” on page 179
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Note – For additional information specific to your hardware, see your supplement.

Monitor your system using the modules. Appendix D

Explore the different modules. “Browser Tab” on page 86

Explore the processes view. “View Processes” on page 217

Explore the view log function. “View Log Tab” on page 210

Explore the physical view. “Hardware Tab” on page 222

Explore the logical view. “Hardware Tab” on page 222

View a property table. “Monitoring Data Properties” on page 95

View a graph of a property table. “To Graph A Monitored Data Property” on

page 119

Create an alarm. “To Create an Alarm” on page 136

Watch the alarm go up the hierarchy (tree) view. “To Create an Alarm” on page 136

View the alarm through the Details window. “The Alarm Manager software alerts you to

an unacknowledged open alarm condition

that exists using several different methods:”

on page 188

View the alarm through the administrative domain status

summary.

“To Access Alarms From the Main Console

Window” on page 190

Sort the alarms and become familiar with the Alarms window. “Alarm Information” on page 186

Acknowledge the alarm. “Acknowledging New Alarms” on page 196

Delete the alarm. “Deleting Alarms” on page 200

Create alarm conditions. “To Create an Alarm” on page 136

Set the refresh interval. “Refresh Tab in the Attribute Editor” on

page 144

Set security. Chapter 14

TABLE A-1 Example Use of Sun Management Center Software (Continued)

Task For More Information, Go to
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APPENDIX B

Miscellaneous Sun Management
Center Procedures

This appendix documents the following procedures:

■ To Regenerate the Security Keys

■ To Configure a Legacy SNMP Agent as a Subagent of a Sun Management Center

Agent

■ To Increase Agent Memory Size

■ To Determine If a Port Is Used

■ To Reconfigure Sun Management Center Software to Use Nondefault Port

Addresses

■ To Reconfigure Sun Management Center SNMP Port Addresses

■ To Reconfigure Sun Management Center RMI Port Address

■ To Create a Server Component as a Monitored Object

■ To Increase the Critical Threshold for the Virtual Size Data Property.

■ To Change the Default Values for Smart Delete in the Event Manager

■ To Use ccat to Read Sun Management Center Log Files

■ To Use ctail to Read Sun Management Center Log Files

■ To Resolve a Hanging Main Console Window

■ To Customize the Tools Menu

■ How to Use the Sun Management Center SNMP MIBs in a Third Party

Management Station

■ How to Access the Modules With Multiple Instances

■ Database Backup and Recovery

Regenerating Security Keys

The Sun Management Center setup generates the security keys for Sun Management

Center components using the following default settings:

■ Valid Sun Management Center users are espublic and esmaster
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■ Sun Management Center superuser is esmaster

Note – The software uses an eight-character string as a seed to make the generated

key unique. During setup, you have the option to use the default Sun Management

Center seed or to use one that you create. The same seed must be used for all server

and agent setups in a given server context. For more information on server context,

see Chapter 14.

Sun Management Center setup does not create UNIX accounts for the special users

espublic and esmaster . You should not need to log into the Sun Management

Center console using these user IDs because they are reserved for internal

communication between processes. However, some troubleshooting activities may

require you to log in using one of these user IDs. If so, you have to create it and

assign a password using the usual UNIX commands useradd and passwd .

The esmaster user ID bypasses normal permission checks, so use it with care. For

normal operation, use an existing login account. Setup provides an opportunity to

specify an existing user as a Sun Management Center administrator. This user ID is

added to the esadm and esdomadm groups as well as the esusers file. For more

information on security and the Sun Management Center superuser, see Chapter 14.

The security keys for the components need to be regenerated if one or more of the

following is true:

■ UDP ports of any of the Sun Management Center agents are changed.

■ Host names or IP addresses of the Sun Management Center agent host change.

Note – Changing the host name or the IP address of the Sun Management Center

server is not supported.
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▼ To Regenerate the Security Keys

Note – In these examples, shared_secret stands for a secret string of up to 8

characters that is common to all machines in a server context. It is required as an

argument to the script base-usm-seed.sh . A default (maplesyr ) is provided by

the software, but you can specify your own password if desired. This secret string or

password is used to generate keys for communication between processes.

-u public is needed to respond to external SNMP requests with public
communities.

1. Log in as superuser.

2. Depending on your installation, type one of the following.

■ If you installed only the agent layer, type:

■ If you installed only the server layer, type:

■ If you installed both the agent and server layers on one host, type:

3. Restart the Sun Management Center server.

For more information, see the Sun Management Center 3.0 Software Installation Guide.

# /opt/SUNWsymon/sbin/es_run base-usm-seed.sh -s shared_secret -c agent -u public

# /opt/SUNWsymon/sbin/es_run base-usm-seed.sh -s shared_secret -c topology -u public
# /opt/SUNWsymon/sbin/es_run base-usm-seed.sh -s shared_secret -c trap event
cfgserver servers

# /opt/SUNWsymon/sbin/es_run base-usm-seed.sh -s shared_secret -u public
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Configuring a Legacy SNMP Agent as a
Subagent of a Sun Management Center
Agent

A legacy SNMP agent is a SNMP agent that is not part of the Sun Management

Center agent framework. In real world situations, you may need to configure one or

more legacy agents as subagents of a Sun Management Center agent.

Any legacy SNMP agent can be configured as a subagent of a Sun Management

Center Agent provided that:

■ The legacy agent can run on a port other than 161.

■ The legacy agent configuration supports running that agent as a non-daemon

process.

■ You have the legacy agent MIB definition file.

▼ To Configure a Legacy SNMP Agent as a

Subagent of a Sun Management Center Agent

1. Log in as superuser.

2. If the file /var/opt/SUNWsymon/cfg/subagent-registry-d.x does not exist,
copy it from the /opt/SUNWsymon/base/cfg directory:

3. In the file /var/opt/SUNWsymon/cfg/subagent-registry-d.x , find the block
that is similar to the following:

# cp /opt/SUNWsymon/base/cfg/subagent-registry-d.x /var/opt/SUNWsymon/cfg/
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4. Remove the comment symbol at the beginning of the line (#) so that the code now
looks like the following.

5. Modify the lines as follows:

■ Change sa2 to the unique subagent name for the agent.

■ type is legacy .

■ persist is false if the subagent is stopped when the Sun Management Center

agent exits. If this value is true , then the Sun Management Center agent does not

stop the subagent when the Sun Management Center agent exits.

■ snmpPort is the UDP port number on which you want to run the subagent.

# sa2 = {
#    type             = legacy
#    persist          = false
#    snmpPort         = "20001"
#    errorAction      = restart
#    startCommand     = "/usr/lib/snmp/mibiisa -p %port"
#    stopCommand      = "kill -9 %pid"
#    pollInterval     = 60
#    pollHoldoff      = 60
#    oidTrees         = 1.3.6.1.2.1
#    snmpVersion      = SNMPv1
#    securityLevel    = noauth
#    securityName     = espublic
# }

sa2 = {
    type             = legacy
    persist          = false
    snmpPort         = "20001"
    errorAction      = restart
    startCommand     = "/usr/lib/snmp/mibiisa -p %port"
    stopCommand      = "kill -9 %pid"
    pollInterval     = 60
    pollHoldoff      = 60
    managedTrees     = "mib-2 sun"
#    oidTrees        = 1.3.6.1.2.1
    snmpVersion      = SNMPv1
    securityLevel    = noauth
    securityName     = espublic
 }
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■ errorAction can be restart , ignore , or kill . If the restart option is used,

then the Sun Management Center agent tries to restart if it encounters an error

when communicating with the subagent. The other options result in the

respective behaviors.

■ startCommand is the mandatory command to start the subagent. This command

should contain %port , which is replaced by the value given in snmpPort .

■ stopCommand is the command to stop the process. %pid can be used to represent

the process ID (PID) of the subagent process.

■ pollInterval defines the time (in seconds) in which the Sun Management

Center agent polls the subagent.

■ pollHoldoff is the time (in seconds) after which the first poll is done on the

subagent after the latter is started by the Sun Management Center agent.

■ oidTrees gives the space-separated list of SNMP OIDs managed by the

subagent.

■ snmpVersion can take values SNMPv1and SNMPv2.
■ securityLevel can be priv , auth , or noauth.
■ securityName is the SNMPv1 community name or SNMPv2 security name to

use.

For more details, refer to the descriptions in the subagent-registry-d.x file.

6. Stop, then restart the agent:

Agent Exits During Startup

The Sun Management Center agent has the ability to monitor itself and restrict its

memory usage. To do this, there are some predefined limits that have been set for

the memory usage of the agent process. These limits are highly dependent on:

■ Number of modules loaded

■ Type of modules loaded

■ Type of the system being managed

On rare occasions, the default memory usage limit is exceeded during the agent

startup and when the agent stops running. This is an indication that the default

limits set for the agent memory size are not enough for your configuration.

# /opt/SUNWsymon/sbin/es-stop -a
# /opt/SUNWsymon/sbin/es-start -a
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To confirm that memory usage is the cause, look in the /var/opt/SUNWsymon/
log/agent.log file for one of the following messages:

or

If you see one of these messages during the agent startup, reconfigure the memory

usage limits on the agent host using the following procedure.

▼ To Increase Agent Memory Size

1. Become superuser on the agent host.

2. Copy the file agent-stats-d.def to /var/opt/SUNWsymon .

3. Edit the file as shown in the following example:

Excessive Virtual Memory Use

Excessive Physical Memory Use

# su

# cp /opt/SUNWsymon/modules/cfg/agent-stats-d.def /var/opt/
SUNWsymon/cfg/

# vi /var/opt/SUNWsymon/cfg/agent-stats-d.def
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4. To increase the agent memory size, increase the alarmlimit:error-gt to the
desired value in the following code segment. (The value is in Kbytes.)

5. Save the file and restart the agent.

Configuring Sun Management Center
Software to Use Different Port Addresses

This section describes how to configure Sun Management Center software when

there is potential conflict for port addresses.

▼ To Determine If a Port Is Used

● Determine if a specific port number is used in your system by typing:

The Sun Management Center server communicates with the Sun Management

Center agents and the other server components (Topology manager, Configuration

manager, Event manager, and Trap handler) using SNMP. By contrast, the server

communicates with the Sun Management Center consoles using remote method

invocation (RMI).

 procstats = {
        size = {
            statusActions(error-gt)     = abort
            statusService(abort)        = _internal
            statusCommand(abort)        = abort "Excessive Virtual Memory Use"

            alarmlimit:error-gt = 70000
            alarmlimit:warning-gt = 60000
            alarmlimit:info-gt =
        }
     .....
     }

# /bin/netstat -an|grep port_number
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Several components require the use of network ports, as shown in the following

table.

Note – The SNMP port definitions for Sun Management Center components are

found in two files: the /var/opt/SUNWsymon/cfg/domain-config.x file, which

exists in every machine running any Sun Management Center component, and the

/var/opt/SUNWsymon/cfg/server-config.x file, which exists on machines

that have the Sun Management Center server component installed.

In the domain-config.x file, there is one configuration block for each of the

SNMP-based Sun Management Center agents. In each configuration block, there is

(at least) one line that defines the port address for the corresponding agent. The

default port definition for the Sun Management Center server is in the

server-config.x file.

Setup scripts automatically configure the components by using the default port

addresses. However, if any of the default ports are being used, then you must take

action to avoid such conflicts in network port addresses.

▼ To Reconfigure Sun Management Center

Software to Use Nondefault Port Addresses

1. Run the es-setup script to create the domain-config.x and server-config.x
(server configuration setup) files.

2. Edit these files with the new port numbers.

See the next section and “To Reconfigure Sun Management Center RMI Port

Address” on page 488 for more information.

TABLE B-1 Sun Management Center Default Port Addresses

Layer Component Default Port Number

Agent Agent 161

Server Trap handler 162

Server Event manager 163

Server Topology manager 164

Server Configuration manager 165

Server Server 2099
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▼ To Reconfigure Sun Management Center SNMP

Port Addresses

1. Log in as superuser.

2. Edit the domain-config.x file and change the address port to an unused port.

This example illustrates changing the agent default port address from 161 to 1161 .

Before:

After:

3. Save the file.

Note – Hosts with Sun Management Center agents using port addresses other than

161 can be added to the administrative domain manually by using the Create

Topology Object window or can be discovered automatically by specifying the port

number in the discovery parameters. (For more information on the Create Topology

Object window, see Chapter 3. For more information on how hosts are discovered

automatically, see Chapter 4). Since you can only specify one port number in

addition to port 161, it is best to select an alternate port number and use that number

for all agent installations.

▼ To Reconfigure Sun Management Center RMI

Port Address

1. Log in as superuser.

2. Edit the /var/opt/SUNWsymon/cfg/server-config.x file.

agent = {
      snmpPort = 161

agent = {
      snmpPort = 1161
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3. Search for the block which starts with rmiReceptor .

For example:

4. Uncomment the line that reads property:rmiPort = 2099 by deleting the
pound (#) character.

5. Change the address port to a new unused port number.

For example:

This example illustrates changing the server default port address from 2099 to

1199 .

6. Save the file.

rmiReceptor = {
    [ use RECEPTORS.RMI ]

#    property:rmiPort = 2099
#    property:rmiHost = localhost

    # 0 means user authentication is disabled
    # 1 means user authentication is enabled
    # property:securityFlag = 1

    # -1 means no limit
    # 0 means make a guess at a limit (base on # of fd's)
    # >0 specifies the exact limit
#
}

property:rmiPort = 1199
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Monitoring Topology Manager and
Event Manager

There are five components in the server layer:

■ Sun Management Center server

■ Topology manager

■ Trap handler

■ Configuration manager

■ Event manager

With the exception of the server, the other four components are Sun Management

Center agents loaded with specialized modules.

You may want to monitor the Topology manager, Trap handler, Configuration

manager, and Event manager to determine their status. The Configuration manager

and the Trap handler are configured so that you do not need to perform any

maintenance procedures. In addition, the default configurations of both the

Topology manager and the Event manager work for most user environments.

However, you can modify the default configurations for specialized environments.

The default configuration for the Topology manager and the Event manager (and all

other Sun Management Center agents) is defined by the Agent Statistics module. See

“Agent Statistics Module Version 2.0” on page 578 for more information about this

module.

This module includes features that guard against errors that can bring down the

host. The default action is for the software to terminate the Topology manager

process if predefined thresholds are exceeded.
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▼ To Create a Server Component as a Monitored

Object

1. In the main console window, select Edit ➤ Create an Object.

The Create Topology Object window is displayed. By default the tab is set to Group.

For more information, see “To Create a Node” on page 30.

2. Click the Node tab.

The window changes to display settings available for nodes.

3. Click the Monitor Via button to see the pull-down menu, then select Sun
Management Center Agent - Host.

4. Type the name of the server component in the Node Label field.

5. (Optional) Enter a description of the node.

6. Enter the name of the Sun Management Center server in the Hostname field.

7. Type the port number for the server component in the Port field (FIGURE B-1).

See the table entitled “Sun Management Center Default Port Addresses” on page 487

for the default port values for each of the server components.

8. Complete this procedure with one of the following actions:

■ Click OK to create the server component object and close this window.

■ Click Apply to create the server component object without closing this window.

■ Click Cancel to cancel your request.
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FIGURE B-1 Creating a Server Component as a Monitored Object
492 Sun Management Center 3.0 Software User’s Guide • November 2000



Topology Manager

The Topology manager enables the main console window to present logical objects

in a topology view. It also provides the ability to create a logical object (such as a

group) whose status summarizes the statuses of managed objects residing on

multiple hosts.

Managed objects include networks, hosts, hardware components, and software

components. The total number of objects and the contents of these objects determine

the system resource requirement (for example, Virtual Size) for the Topology

manager. This requirement must be less than the defaults set for the Topology

manager.

If the Virtual Size of the Topology manager exceeds the default value, then the

Topology manager exits with the error message, “error excessive virtual memory

use.” To solve this error, you need to increase the default virtual size by completing

the following procedure after you have carefully evaluated the situation.

▼ To Increase the Critical Threshold for the Virtual

Size Data Property.

1. Create the Topology manager monitored object.

See “To Create a Server Component as a Monitored Object” on page 491.

2. Open the Details window by proceeding with one of the following:

■ Click the right mouse button on the Topology manager object icon and highlight

Details from the pop-up menu in the hierarchy view or the topology view.

■ Double-click the left mouse button on the Topology manager icon in the hierarchy

view or the topology view.

■ Select the Topology manager icon in the main console window, then select Tools

➤ Details.

3. In the Browser Details window, double-click on the Local Applications icon in the
hierarchy (tree) view.

4. Double-click on the Agent Statistics icon in the contents view or single click in
the expansion/compression icon next to the Agent Statistics icon in the hierarchy
view.

The Agent Statistics folders are displayed.

5. Double-click on the PA Process Statistics folder icon in either the hierarchy or the
contents view.

The monitored properties are displayed in a property table (FIGURE B-2).
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FIGURE B-2 PA Process Statistics Property Table

6. Select the Virtual Size table cell, then proceed with one of the following:

■ Click the right mouse button in the table row and select Attribute Editor from the

pop-up menu.

■ Click the Attributes button.

7. Click on the Alarms tab button.

The alarm rows are displayed (FIGURE B-3).

8. Type the desired value in the Critical Threshold (>) field.

9. Complete this procedure with one of the following actions:

■ Click OK to create a new Critical Threshold value and close this window.

■ Click Apply to create a new Critical Threshold value without closing this

window.

■ Click Cancel to cancel your request.
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FIGURE B-3 Alarms Tab for the Virtual Size Property in the Topology Manager Object
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Event Manager

The Event manager communicates with other server components through SNMP

using the default port 163. Similar to the Topology manager, the Event manager is

also loaded with the Agent Statistics module. In addition, the Event manager is

automatically loaded with a specialized Event Management module that is

displayed in the Browser Details window in the Local Applications category.

The Event Management module is responsible for the overall maintenance of the

event database. Its responsibilities include purging deleted events, renaming the

trash file, and smart delete (FIGURE B-4).

FIGURE B-4 Event Management Module Data Properties

Smart delete means that Sun Management Center software automatically deletes

closed, fixed, and open events from the event database after a set period of time. By

default, the closed or fixed events are removed from the database after seven days

and the open events are removed after 30 days. You can change these defaults with

the following procedure.

▼ To Change the Default Values for Smart Delete

in the Event Manager

1. Create the Event manager monitored object.

See “To Create a Server Component as a Monitored Object” on page 491.

2. Open the Details window by proceeding with one of the following:

■ Click the right mouse button on the Event manager icon and highlight Details

from the pop-up menu in the hierarchy view or the topology view.
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■ Double-click the left mouse button on the Event manager icon in the hierarchy

view or the topology view.

■ Select the Event manager icon in the main console window then select Tools ➤

Details.

3. In the Browser Details window, double-click on the Local Applications icon in the
hierarchy (tree) view.

4. Select the Event Management module and proceed with one of the following:

For more information, see “To Edit Module Parameters” on page 176.

■ Click the right mouse button and highlight Edit Module from the pop-up menu in

the hierarchy view or the contents view.

■ In the Details window, select Module ➤ Edit Module.

The Module Parameters Editor is displayed.

5. Type the new time values into the editable fields.

The default time values are displayed in FIGURE B-5.

6. Alternately, you may turn off “smart delete” by selecting Disabled in the
pull-down menu next to the Smart Delete Enabled Switch field.

7. Complete this procedure with one of the following actions:

■ Click OK to accept the changes you have made and close this window.

■ Click Reset to reset the Module Parameter Editor to the default parameters.

■ Click Cancel to cancel your request.
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FIGURE B-5 Module Parameter Editor for the Event Management Module
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Reading Sun Management Center Log
Files

The server and agents write to various log files in the directory,

/var/opt/SUNWsymon/log .

These files are “circular log files.” A circular log file does not grow in size after a

certain limit. As new messages are logged into the file, the oldest messages are

removed.

Use the es-run interface with the ctail and ccat commands to view these log

files. The es-run interface sets up the proper environment to run Sun Management

Center utilities. The utilities ccat and ctail display only the relevant data, after

sorting the data in chronological order. The ccat and ctail commands are similar

to the UNIX cat and tail commands, but are intended for use with Sun

Management Center circular log files.

▼ To Use ccat to Read Sun Management Center

Log Files

The ccat command reads the specified log file, sorts the messages in

chronologically ascending order, and writes to the standard output. The ccat
command takes one argument, which is the full path to the circular log file.

● Use the es-run interface with the ccat command:

▼ To Use ctail to Read Sun Management Center

Log Files

The ctail command reads the circular log file and by default writes the last 15 lines

of the file to standard output.

# /opt/SUNWsymon/sbin/es-run ccat path_to_file/filename
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The ctail command takes four arguments: filename and the -f , -l , and -n options

where:

The filename argument is the full path name to the circular log file. The filename
argument is mandatory.

-f option is used to monitor the growth of the log file. As the log file grows, the

messages appended to the file are also written to the standard output. The ctail
-f option is similar to the -f option for the UNIX tail command.

-l option is used to print the absolute line number at the beginning of each

message.

-n NumOfLines option is used to change the number of lines displayed. By default

only the last 15 lines are printed.

● Use the es-run interface with the ctail command:

Sun Management Center Server Issues

This section discusses how the main console window hangs when users are

attempting to start a new console window and connect to the Sun Management

Center server. However, existing console window connections encounter no

problems.

Hanging Main Console Window

This problem occurs because:

■ The server memory is used up - Threads that are reading from a socket can hang

when there is a large discrepancy between the read and write rates at either end

of a socket. The memory problem occurs when the Sun Management Center

server has a large amount of buffered data waiting to be sent to its clients. This

buffered data is so large that the server runs out of memory while trying to write

to the socket. Once this happens, the server does not recover.

Note – If you are monitoring the server log file, use the following command:

/opt/SUNWsymon/sbin/es-run ctail -f /var/opt/SUNWsymon/log/server.log.

You may see one or several messages that the server is out of memory.

# /opt/SUNWsymon/sbin/es-run ctail [-f, -l, -n NumOfLines] path_to_file_filename
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■ The console memory for the console process is used up - If that is the case, you may be

able to confirm this by selecting the Sun Management Center Console Messages

option under the File Menu on the main console window. The Sun Management

Center Console Messages window may display one or several messages that the

console is out of memory.

▼ To Resolve a Hanging Main Console Window
■ If the server memory is used up, increase the memory available to the server

process. The default size is 64 Mbytes.

For example, to double the default memory from 64 Mbytes to 128 Mbytes.:

Note – If your server is invoked using the es-start -A command, or by

rebooting, customize the default memory size by changing -Xmx64m to the desired

size in the /opt/SUNWsymon/classes/base/server/bin/es-server.sh file.

■ If the console memory is used up, the solution is to restart the console with a

bigger memory size.

For example, to increase the memory to 100 Mbytes:

This process allocates more memory to the console for this one session.

Note – To allocate more memory without having to re-enter the option

-- -Xmx<size> for every session, change the default memory size from -Xmx64m
to the desired size in the /opt/SUNWsymon/classes/base/console/bin/
es-console.sh file.

Adding Customized Menu Items

Sun Management Center software enables you to customize the Tools menu by

adding external, standalone applications that can be launched from the main console

window. The application must be written in Java, although non-Java applications are

# es-start -s -- -Xmx128m

# es-start -c -- -Xmx100m
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accommodated by the ExampleSystemCommand Java wrapper class that executes

another program or shell script in a separate process. The application does not

require a selected host object, and it has no further interaction with Sun

Management Center once it has been launched.

The name of the application (as specified in the console-tools.cfg file) is added

to the Tools menu in the main console window below the standard menu items

provided by the Sun Management Center software. The application that is launched

is displayed in a separate window.

The console-tools.cfg file is a plain text file that resides on the Sun

Management Center server host. The file may be modified at any time (including

while the console is running), but changes introduced by editing the files will not

take effect until the es-tool script is executed and the console is restarted. The file

consists of a series of lines, each of which describes an application; blank lines and

lines beginning with the pound sign (#) are ignored. Fields within each line are

separated by commas (,).

▼ To Customize the Tools Menu

1. Using a standard text editor, add the following line to the
/var/opt/SUNWsymon/cfg/console-tools.cfg file.

Each application implemented as a shell script or an executable binary is defined by

a line with the following format:

where:

menu label — the string that is displayed in the Tools menu. The string can be

either unlocalized or localized text. Unlocalized text can contain embedded spaces.

Localized text must be specified as a property_file:key pair, where property_file is the

name of the file containing the localizable messages for a particular locale, and key
is the identifier used to locate the string that is displayed in the Tools menu in the

property file. Note that spaces are not allowed in the key.

class — the fully qualified Java class name.

args — the list of arguments to the class.

For example, the following file shows entries for three applications to be added to

the Tools menu: Example GUI , rlogin , and ftp .

menu_label,class [args]
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Caution – Each entry must be specified on a single line, even though the text is

shown wrapped in the example.

Note – The Java wrapper class SMSystemCommand enables you to execute an

arbitrary shell command. This class takes two arguments. The first argument is the

shell command to execute:

- If a program name is specified, give a full path name.

- If there are embedded spaces, enclose the entire shell command in double quotes.

The second argument is the command to run on a Microsoft Windows client. For

example: com.sun.symon.base.client.console.SystemCommand "<shell
command>" "<windows command>"
In this case, the first argument is ignored.

Variable substitution is performed on the arguments if special variable references are

present. The allowed variables are:

$host (replaced with the currently selected agent host name)

$port (replaced with the currently selected port number)

2. Place the Java class files for the applications in the /opt/SUNWsymon/apps/
classes directory.

3. Run the es-tool update script on the Sun Management Center server host.

4. Stop the console by selecting File ➤ Exit from the menu bar on the main console
window.

5. Click the Exit button to exit the application.

# Format:
# menu_label, class arguments

Example GUI,exampleApp.ExampleGUITool

Rlogin,com.sun.symon.base.client.console.SMSystemCommand
“/usr/openwin/bin/xterm -e rlogin $ host " "start rlogin $ host "

exampleApp.ExampleSystemCommand:ftp,exampleApp.ExampleSystemCommand
"/usr/openwin/bin/xterm -e ftp $host " "start ftp $host "

# /opt/SUNWsymon/sbin/es-tool /var/opt/SUNWsymon/cfg/console-tools.cfg
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6. Restart the console for the application to be added to the Tools menu.

Note – Depending upon your sites configuration, it may also be necessary to restart

the Sun Management Center server.

SNMP MIBs for Sun Management Center
Modules

Sun Management Center software publishes the Simple Network Management

Protocol Management Information Bases (SNMP MIBs) for the modules. The MIB

file is an Abstract Syntax Notation (ASN.1) specification of the data that is modeled

(in this case, by the Sun Management Center module). These MIBs can be used as

the data definition by third party SNMP-based management stations (for example

HP OpenView and Unicenter TNG). Sun Management Center has MIBs for the

following modules:

■ file-scan.mib
■ health-monitor-mib.mib
■ kernel-reader-mib.mib
■ nfsmon-mib.mib
■ nfsstat-mib.mib
■ print-spool-mib.mib
■ process-details-mib.mib
■ process-monitor.mib
■ trap-mib.mib

The above MIBs are installed by default, in the /opt/SUNWsymon/util/cfg
directory by the Sun Management Center software during installation of the agent

layer. (Depending on your installation, your base directory may be different.)

# /opt/SUNWsymon/sbin/es-start -c
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▼ How to Use the Sun Management Center SNMP

MIBs in a Third Party Management Station

1. Preprocess the MIBs.

Some SNMP management stations can read the ASN.1 MIBs. Others require the

ASN.1 MIBs to be converted to some other format in order to be read. For example,

you may need to convert the MIB to a Guidelines for the Description of Managed

Objects (GDMO) format or use a MIB compiler to generate another intermediate

format.

2. Load the MIB.

Load the ASN.1 MIB or a preprocessed format of that MIB into the third party

management station. You are informing the third party management station about

the layout and composition of the data that is modeled by the MIB.

3. Use the MIB information to talk to the Sun Management Center agent.

Once the MIB is successfully loaded into the third party SNMP agent, you can

communicate with the Sun Management Center agent and get the data from the

MIB. However, the module must be loaded and enabled in the Sun Management

Center agent.

For example, you can start issuing the SNMP Get commands on some of the

variables in the MIB.

Note – By default, the Sun Management Center modules are enabled for SNMP Get
commands by using the SNMPv1 community ’public’ and SNMPv2 username

’public’. However, if the Sun Management Center module has different settings, then

you need to use the right community and username to communicate with the Sun

Management Center agent.

Note – Since Sun Management Center agents operate with SNMPv2usec-based

security, SNMP Set commands on the agent are involved. Refer to the SNMPv2usec

related Request For Comments (RFCs) for more information.
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▼ How to Access the Modules With Multiple

Instances

SNMPv2 uses the term ’context’ for the MIBs that can have multiple instances of the

module loaded on the agent. If you are using a SNMPv2-based third party

management station to communicate with this type of agent, then be sure you are

using the right context information. However, if you are using a SNMPv1-based

management station, then complete the following step.

● Add the context information to the SNMP community as follows:

Adding this context information enables you to access data from multiple instances

of the same module running on an agent.

Database Backup and Recovery

● If your Sun Management Center database has been inadvertently corrupted due to a

system failure (such as a file system problem), you can run the following interactive

script as superuser to restore your database:

If you are already aware that your Sun Management Center database needs to be

backed up to prevent loss of data (for example, before a hardware or operating

environment upgrade), you can run either of the following two scripts to back up

your database:

The following script will run in interactive mode and enable you to specify the

location where the database files should be saved:

If you prefer to run es-backup in silent mode (with default answers to the script’s

questions), type the following command:

community:context

# /opt/SUNWsymon/sbin/es-restore

# /opt/SUNWsymon/sbin/es-backup

# /opt/SUNWsymon/sbin/es-backup -y
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The database files will automatically be saved in the directory

/var/opt/SUNWsymon/backup.

If you need to periodically run the es-backup script with the -y option, you can

also set your own cron program for the script to be run on a routine basis.

Note – Both scripts shut down the Sun Management Center processes before

starting the restore or backup, and restart the processes once the recovery or backup

has been completed.
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APPENDIX C

Internet Protocol Routing

This appendix describes:

■ Overview of IP Addressing

■ Subnetting

■ Netmasks

Overview of IP Addressing

Internet protocol (IP) addresses are 32 bits long. Thus, there is a possibility of

approximately a total 4 billion addresses for the entire Internet. An IP address is

expressed as a series of octets separated by dots. For example, the address 11111111

00000001 00000101 00001010 is written as 127.1.5.10, or using hexadecimal notation,

7f.1.5.a0.

Because of this vast number of addresses, there was a need to organize the network

hierarchically into administrative domains. This need led to the definition of name

administrative domains and network classes. Since each site can vary in size, IP

addresses are divided into three main types or classes. A large site can reserve a

class A address and receive 224 individual addresses, while a small site can reserve a

class C address and receive 28 individual addresses.
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Network Classes

Class A uses the first octet for the network address, and the rest for host addresses

within this network. For example, a site whose network address is 129.0.0.0 would

own the 224 addresses between 129.0.0.0 and 129.255.255.255.

Class B uses two octets for the network address, and two for the host address. For

example, a site whose network address is 129.123.0.0 would own the 216 addresses

between 129.123.0.0 and 129.123.255.255.

Class C uses three octets for the network address, and one for the host address. For

example, a site whose network address is 129.123.56.0 would own the 28 addresses

between 129.123.56.0 and 129.123.56.255.

Subnetting

Subnetting is defined as dividing a network into smaller segments, or subnets,

which is imperative for Class A and B networks. Routers do not forward packets

outside a subnet if the destination address is within the same subnet. Thus, network

traffic is decreased dramatically by segmenting a large network. For example, there

is a class B network that is segmented into 255 subnets. Unless a packet destination

is a host outside the subnet, a local packet is sent to 255 hosts instead of 256,000.

Network Host

0xxxxxxx xxxxxxxx xxxxxxxx xxxxxxxx

Network Host

10xxxxxx xxxxxxxx xxxxxxxx xxxxxxxx

Network Host

110xxxxx xxxxxxxx xxxxxxxx xxxxxxxx
510 Sun Management Center 3.0 Software User’s Guide • November 2000



Netmasks

The format of the netmask is a series of 1s followed by a series of 0s. By ANDing an

IP address with a netmask, we can get the address of the subnet.

Routers use netmasks to decide whether to forward a packet to an external subnet.

For example, there is a machine with an IP address of 129.123.56.95 that is sending

an email to another machine whose IP address is 129.123.56.100. By ANDing both IP

addresses with a netmask (255.255.255.00), the result is 129.123.56.0 for both

machines. The router then concludes that both the source machine and destination

machine are in the same subnet. Therefore, the router does not forward the email to

external subnets.

On the other hand, if the destination address is 129.123.67.100, then the resulting

subnet address is 129.123.67.0. The router forwards the email to the external subnet

(129.123.67.0).

Note – Although some of these examples apply to Ethernet links, the principles still

apply regardless of the type of network.
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APPENDIX D

Sun Management Center Software -
Modules

The Sun Management Center software monitors various components of your system,

including your hardware, operating environment, local applications, and remote

systems. This section provides additional explanation for the core modules described

in Chapter 11 and presents them in their respective categories.

For more information on other modules that may be applicable to your particular

system, see the Sun Management Center web site: http://www.sun.com/
sunmanagementcenter .

This appendix describes the following modules:

■ Hardware

■ Sun StorEdge A5x00 Array

■ Sun StorEdge T3 Array

■ Operating System

■ Directory Size Monitoring Module Version 2.0

■ File Monitoring Module Version 2.0

■ IPv6 Instrumentation Module Version 1.0

■ MIB-II Instrumentation Module Version 1.0

■ Kernel Reader Module Version 1.0

■ Kernel Reader Simple Module Version 3.0

■ NFS Statistics Module Version 2.0

■ Solaris Process Details Module Version 2.0

■ NFS File Systems Module Version 2.0

■ Simple MIB-II Module Version 1.0

■ Local Applications

■ Agent Statistics Module Version 2.0

■ Data Logging Registry Module Version 2.0

■ Health Monitor Module Version 2.0

■ Logview ACL Version 1.0

■ Print Spooler Module Version 3.0

■ Process Monitoring Module Version 2.0
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■ File Scanning (System Log) Module Version 2.0

■ Remote Systems

■ MIB-II Proxy Monitoring Module Version 2.0

■ HP JetDirect Module Version 2.0

Most of these modules have default monitoring conditions that generate alarms

when system values fall outside of these conditions. You may alter these default

thresholds by creating your own alarm thresholds, as explained in Chapter 11.

Also, there are modules that utilize the Add Row operation to define what data

properties to monitor. These modules will come up with empty tables and you have

to execute an Add Row operation to activate the specifics for monitoring the

modules.

The following table lists the modules described in this appendix and provides

details on those modules that are automatically loaded and those that can be loaded

multiple times. It also points out those modules that utilize the Add Row utility.

TABLE D-1 Modules Loaded Automatically, Multiple Times, and Use Add Row
Operation

Alphabetical Listing of Core Modules Module Loads
Automatically

Module Loads
Multiple Times

Module Uses
Add Row Utility

Agent Statistics Module Version

2.0

X

Config-Reader Module1 X

Data Logging Registry Module

Version 2.0

X

Directory Size Monitoring Module

Version 2.0

X X

Dynamic Reconfiguration

Module2

File Monitoring Module Version

2.0

X X3

File Scanning (System Log)

Module Version 2.0

X X X 4

HP JetDirect Module Version 2.0 X

Health Monitor Module Version

2.0

Kernel Reader Module Version 1.0 X

Kernel Reader Simple Module 3.0

Logview ACL Module 1.0 X
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Hardware

The following modules, when loaded, are found under the hardware icon:

■ Sun StorEdge A5x00 Array

■ Sun StorEdge T3 Array

MCP Manager Module 1.0

IPv6 Instrumentation Module

Version 1.0

MIB-II Proxy Monitoring Module

Version 2.0

X

NFS File Systems Module Version

2.0

NFS Statistics Module Version 2.0

Print Spooler Module Version 3.0 X X

Process Monitoring Module

Version 2.0

X X5

Simple MIB-II Module X

Solaris Process Details Module

Version 2.0

Storage A5x00

Sun StorEdge T3

1. Refer to your platform-specific supplement for more information on the Config-Reader module.

2. Refer to your platform-specific supplement for more information on the Dynamic Reconfiguration module.

3. Each added row defines what file to monitor.

4. Each added row defines what pattern within the monitored file to match. The row needs to be added to the ta-
ble, Scan Table.

5. Each row defines what pattern to match from all the processes that are running on the agent host.

TABLE D-1 Modules Loaded Automatically, Multiple Times, and Use Add Row
Operation

Alphabetical Listing of Core Modules Module Loads
Automatically

Module Loads
Multiple Times

Module Uses
Add Row Utility
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Sun StorEdge A5x00 Array

Enables you to monitor the state of A5000, 5100, and 5200 storage devices, and

manage alarms on these devices.

TABLE D-2 Rules for Sun StorEdge A5x00

Rules Property

sunSmTreeProp tree prop

sunSmNodeName Name

timestamp_raw timestamp_raw

timestamp Name

status_change Number Of Model property/value changed.

This value changes whenever there is a difference between previous

snapshot and current snapshot.

TABLE D-3 Sun StorEdge A5x00 Sena Table

Property Description

sunSmTreeProp sunSmTreeProp

sunSmNodeName Current Name

entry_no entry number

#dataFormat instance

rowstatus The row status

box_rev Box_rev

device_count Device_count

box_id Box Id

instance Instance

logical_path Logical Path

machine Machine

name Name

node-wwn Node-wwn

physical_path Physical Path

platform Platform
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set_flg Set Flag

slot_count Slot_count

type Type

vendor_name Vendor_name

virtual_node Virtual_node

TABLE D-4 Sun StorEdge A5x00 Front Table

Property Description

sunSmTreeProp sunSmTreeProp

sunSmNodeName Current Name

entry_no entry number

instance Instance

TABLE D-5 Sun StorEdge A5x00 Rear Table

Property Description

sunSmTreeProp sunSmTreeProp

sunSmNodeName Current Name

entry_no entry number

entry number Instance

TABLE D-6 Sun StorEdge A5x00 Disk Backplane Table

Property Description

sunSmTreeProp sunSmTreeProp

sunSmNodeName Current Name

entry_no entry number

byp_a_enabled Byp_a_enabled

byp_b_enabled Byp_b_enabled

fru fru

status Status

alarmRules rpho400

TABLE D-3 Sun StorEdge A5x00 Sena Table

Property Description
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TABLE D-7 Sun StorEdge A5x00 Fan Tray Table

Property Description

sunSmTreeProp sunSmTreeProp

sunSmNodeName Current Name

entry_no entry number

fan_fail Fan_fail

fru fru

speed Speed

status Status

alarmRules rpho401

type Type

TABLE D-8 Sun StorEdge A5x00 Led Table

Property Description

sunSmTreeProp tree prop

sunSmNodeName Name

entry_no entry number

led-num Led No

state State

TABLE D-9 Sun StorEdge A5x00 Front Slot Table

Property Description

front_slotTbl Front_slot Table

sunSmTreeProp sunSmTreeProp

sunSmNodeName Current Name

entry_no entry number

connect_disk connect_disk_name

id Id

loop_status Loop_status

alarmRules rpho411

power_status power-status

alarmRules rpho414
518 Sun Management Center 3.0 Software User’s Guide • November 2000



slot-num Slot-num

status Status

temperature Temperature

temperature_status Temperature_status

alarmRules rpho407

TABLE D-10 Sun StorEdge A5x00 Rear Slot Table

Property Description

sunSmTreeProp sunSmTreeProp

sunSmNodeName Current Name

entry_no entry number

connect_disk connect_disk_name

id Id

loop_status Loop_status

alarmRules rpho412

power_status power-status

alarmRules rpho414

slot-num Slot-num

status Status

temperature Temperature

temperature_status Temperature_status

alarmRules rpho408

TABLE D-11 Sun StorEdge A5x00 Disk Table

Property Description

sunSmTreeProp sunSmTreeProp

sunSmNodeName Current Name

entry_no entry number

capacity Capacity

device_type Device Type

TABLE D-9 Sun StorEdge A5x00 Front Slot Table

Property Description
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firmware_revision firmware_revision

fru Fru

hard_address Hard Address

instance Instance

logical_path logical_path

mounted_partitions Mounted Partitions

name Name

node-wwn Node Wwn

physical_path physical_path

port-wwn Port Wwn

product_name product_name

revision revision

serial_number serial_number

status Status

alarmRules rpho406

vendor_name vendor_name

TABLE D-12 Sun StorEdge A5x00 Sena Power Supply Table

Property Description

sunSmTreeProp sunSmTreeProp

sunSmNodeName Current Name

entry_no entry number

fru Fru

AC_status AC_status

DC-current DC-current

DC-voltage DC-voltage

ps-instance Ps-instance

status Status

alarmRules rpho402

TABLE D-11 Sun StorEdge A5x00 Disk Table

Property Description
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temperature_status Temperature_status

alarmRules rpho409

type Type

TABLE D-13 Sun StorEdge A5x00 Interconnect Table

Property Description

sunSmTreeProp sunSmTreeProp

sunSmNodeName Current Name

entry_no entry number

eprom_failure Eprom_failure

fru Fru

status Status

alarmRules rpho405

TABLE D-14 Sun StorEdge A5x00 Interface_board Table

Property Description

interface_board-

entry

entry_no

sunSmTreeProp sunSmTreeProp

sunSmNodeName Current Name

entry_no entry number

fru Fru

interface_board-

instance

Ib-Instance

loop Loop

loop0_fault Loop0_fault

loop1_fault Loop1_fault

status Status

alarmRules rpho400

temperature_status temperature_status

alarmRules rpho410

TABLE D-12 Sun StorEdge A5x00 Sena Power Supply Table

Property Description
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TABLE D-15 Sun StorEdge A5x00 Loop - Gbic Table

Property Description

sunSmTreeProp sunSmTreeProp

sunSmNodeName Current Name

entry_no entry number

fru Fru

loop-instance Gbic-Instance

status Status

alarmRules rpho413

loop_configuration_s

tatus

Loop Configuration

TABLE D-16 Sun StorEdge A5x00 Rules

Rule Description

rpho414 Fibre Channel OFFLINE

rpho415 Fibre Channel CRC Error

rpho416 ASC 0x47

rpho417 drive operation marginal

rpho418 failure prediction

rpho419 NCOMPLETE DMA XFER on sbus

rpho420 Offline Timeout

rpho421 soc lilp map failed
522 Sun Management Center 3.0 Software User’s Guide • November 2000



Sun StorEdge T3 Array

Enables you to monitor the state of T300 storage devices, and manage alarms on

these devices.

TABLE D-17 Sun StorEdge T3 Module - Basic Properties Table

Property Description

sunSmTreeProp sunSmTreeProp

sunSmNodeName Current Name

t300name t300name

dataFormat instance

rowstatus Row Status

sysId id

sysVendor vendor

sysModel model

sysRevision firmware revision

sysIpAddr IP address

sysSubNet subnet mask

sysGateway gateway

sysBootMode boot mode

sysBootDelay boot delay

sysMpSupport multi-pathing support

sysHasVolumes has volumes

TABLE D-18 Sun StorEdge T3 Module - Advanced Properties Table

Property Description

t300name t300name

dataFormat instance

rowstatus Row Status

sysStripeUnitSize stripe unit size

sysCacheMode cache mode

sysCacheMirror cache mirror

sysReadAhead read ahead
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sysReconRate reconRate

sysOndgMode ondgMode

sysOndgTimeslice ondgTimeslice

sysIdleDiskTimeout idle disk timeout

sysTftpHost tftp host

sysTftpFile tftp file

sysLastRestart ast restart time

sysDate date

sysTime time

sysTimezone time zone

TABLE D-19 Sun StorEdge T3 Module - Statistical Properties Table

Property Description

t300name t300name

sysTotalRequests total requests

sysWriteRequests write requests

sysReadRequests read requests

sysTotalBlocks total blocks

sysBlocksWritten blocks written

sysBlocksRead blocks read

sysCacheWriteHits cacheWriteHits

sysCacheWriteMisse

s

cacheWriteMisses

sysCacheReadHits cacheReadHits

sysCacheReadMisses cacheReadMisses

sysCacheRmwFlushe

s

sysCacheRmwFlushes

TABLE D-18 Sun StorEdge T3 Module - Advanced Properties Table

Property Description
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sysCacheReconFlush

es

cacheReconFlushes

sysCacheStripeFlush

es

cacheStripeFlushes

clear-flag clear flag

TABLE D-20 Sun StorEdge T3 Module - Unit Table

Property Description

sunSmTreeProp sunSmTreeProp

sunSmNodeName Current Name

t300name t300name

unitId unit id

unitType unit type

unitStandby standby

unitIsControllerUnit isControllerUnit

machine machine

platform platform

TABLE D-21 Sun StorEdge T3 Module - Disk Table

Property Description

disks-entry entry_no

sunSmTreeProp sunSmTreeProp

sunSmNodeName Current Name

entry_no entry number

TABLE D-22 Sun StorEdge T3 Module - Disk (Basic Properties Table)

Property Description

sunSmTreeProp sunSmTreeProp

sunSmNodeName Current Name

t300name t300name

TABLE D-19 Sun StorEdge T3 Module - Statistical Properties Table

Property Description
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unitId unit id

fruStatus status

alarmRules rpurple203, rpurple204, rpurple205

TABLE D-23 Sun StorEdge T3 Module - Disk (Common Fru Properties)

Property Description

fruDiskRole disk role

fruDiskCapacity disk capacity

fruDiskTemp temperature

TABLE D-24 Sun StorEdge T3 Module - Advanced Properties Table

Property Description

t300name t300name

unitId unit id

fruId fru id

fruDiskPort1State port1 state

fruDiskPort2State port2 state

fruDiskStatusCode status code

fruDiskVolId disk volid

fruDiskVolIndex disk volindex

fruDiskVolName disk volname

fruDiskIsRoleData isRoleData

fruDiskIsRoleStandb

y

isRoleStandby

fruDiskIsRoleUndefi

ned

sUndefined

fruDiskIsExpendable isExpendable

TABLE D-22 Sun StorEdge T3 Module - Disk (Basic Properties Table)

Property Description
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TABLE D-25 Sun StorEdge T3 Module - Controllers

Property Description

controllers-entry entry_no

sunSmTreeProp sunSmTreeProp

sunSmNodeName Current Name

entry_no entry number

TABLE D-26 Sun StorEdge T3 Module - Controller Table

Property Description

controller-entry t300name unitId fruId

sunSmTreeProp sunSmTreeProp

sunSmNodeName Current Name

t300name t300name

unitId unit id

fruStatus status

alarmRules rpurple20, rpurple202

TABLE D-27 Sun StorEdge T3 Module - Load Common FRU Properties

Property Description

fruCtlrCpuDesc CPU type

fruCtlrRole controller role

fruCtlrPartnerId partner id

fruCtlrCtState current state

fruCtlrCacheSize cache size

fruCtlrTemp temperature

fruCtlrIsExpendable isExpendable

TABLE D-28 Sun StorEdge T3 Module - Loopcards

Property Description

loopcards-entry entry_no
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sunSmTreeProp sunSmTreeProp

sunSmNodeName Current Name

entry_no entry number

TABLE D-29 Sun StorEdge T3 Module - Loop Card Table

Property Description

loop_card-entry t300name unitId fruId

sunSmTreeProp sunSmTreeProp

sunSmNodeName Current Name

t300name t300name

unitId unit id

fruStatus status

alarmRules rpurple214 rpurple215 rpurple216

TABLE D-30 Sun StorEdge T3 Module - Load Common FRU Properties

Property Description

fruLoopMode loop mode

fruLoopCable1State cable1 state

fruLoopCable2State cable2 state

fruLoopTemp temperature

TABLE D-31 Sun StorEdge T3 Module - Power Cooling Unit Table

Property Description

sunSmTreeProp sunSmTreeProp

sunSmNodeName Current Name

t300name t300name

unitId unit id

fruStatus status

alramRules rpurple206, rpurple207, rpurple208, rpurple209, rpurple210,

rpurple211, rpurple212, rpurple213

TABLE D-28 Sun StorEdge T3 Module - Loopcards

Property Description
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TABLE D-32 Sun StorEdge T3 Module - Load Common FRU Properties

Property Description

fruPowerPowOutput output state

fruPowerPowSource input source

fruPowerPowTemp temperature

fruPowerFan1State fan1 state

fruPowerFan2State fan2 state

fruPowerBatState battery state

fruPowerBatLife battery life

fruPowerBatUsed battery used

TABLE D-33 Sun StorEdge T3 Module - Midplane Table

Property Description

sunSmTreeProp true

sunSmNodeName Current Name

t300name t300name

unitId unit id

fruStatus status

TABLE D-34 Sun StorEdge T3 Module - Volume (Basic Properties Table)

Property Description

sunSmTreeProp sunSmTreeProp

sunSmNodeName Current Name

t300name t300name

unitId unit id

volId volume id

volName volume name

volWWN volume WWN

volStatus volume status

volCacheMode cache mode
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volCacheMirror cache mirror

volCapacity volume capacity

volArrayWidth drive number

TABLE D-35 Sun StorEdge T3 Module - Statistical Properties Table

Property Description

t300name t300name

unitId unit id

volId volume id

volTotalRequests total requests

volWriteRequests write requests

volReadRequests read requests

volTotalBlocks total blocks

volBlocksWritten blocks written

volBlocksRead blocks read

volSoftErrors soft errors

volFirmErrors firm errors

volHardErrors hard errors

volCacheWriteHits cacheWriteHits

volCacheWriteMisse

s

cacheWriteMisses

volCacheReadHits cacheReadHits

volCacheReadMisses cacheReadMisses

volCacheRmwFlushe

s

cacheRmwFlushes

volCacheReconFlush

es

cacheReconFlushes

volCacheStripeFlush

es

cacheStripeFlushes

clear-flag clear flag

TABLE D-34 Sun StorEdge T3 Module - Volume (Basic Properties Table)

Property Description
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TABLE D-36 Sun StorEdge T3 Module - Ports

Property Description

ports-entry entry_no

sunSmTreeProp sunSmTreeProp

sunSmNodeName Current Name

entry_no entry number

TABLE D-37 Sun StorEdge T3 Module - Port (Basic Properties Table)

Property Description

sunSmTreeProp sunSmTreeProp

sunSmNodeName Current Name

t300name t300name

unitId unit id

portId portId

portWWN port WWN

portStatus port status

portType port type

portFruId port fruId

portSunHost port sunHost

portFibreCount fibre count

portFibreAlpaMode ALPA mode

TABLE D-38 Sun StorEdge T3 Module - Statistical Properties Table

Property Description

t300name 300name

unitId unit id

portId ortId

portTotalRequests total requests

portWriteRequests write requests

portReadRequests read requests
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portTotalBlocks total blocks

portBlocksWritten blocks written

portBlocksRead blocks read

TABLE D-39 Sun StorEdge T3 Module - Attachments Table

Property Description

attachments-entry entry_no

sunSmTreeProp sunSmTreeProp

sunSmNodeName Current Name

entry_no entry number

TABLE D-40 Sun StorEdge T3 Module - Attachments Table

Property Description

sunSmTreeProp sunSmTreeProp

sunSmNodeName Current Name

t300name t300name

unitId unit id

portId portId

attachId attach id

attachLun attach Lun

attachMode attach mode

attachVolId attach volid

attachVolName attach volname

TABLE D-41 Sun StorEdge T3 Module - Loops

Property Description

loops-entry entry_no

TABLE D-38 Sun StorEdge T3 Module - Statistical Properties Table

Property Description
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sunSmTreeProp sunSmTreeProp

sunSmNodeName Current Name

entry_no entry number

TABLE D-42 Sun StorEdge T3 Module - Loops Table

Property Description

sunSmTreeProp sunSmTreeProp

sunSmNodeName Current Name

t300name t300name

unitId unit id

loopId loop id

loopStatus loop status

loopMux loop mux

loopIsAvailable isAvailable

loopIsReserved isReserved

loopIsIsolated isIsolated

loopIsTop isTop

loopIsBottom isBottom

loopIsMiddle isMiddle

TABLE D-43 Sun StorEdge T3 Module - Rules

Ruole Description

rpurple201 Controller Error

rpurple202 Controller Error

rpurple203 Disk Error

rpurple204 Disk Error

rpurple205 Disk Error

rpurple206 PowerSupply Error

rpurple207 PowerSupply Error

rpurple208 Fan fault

TABLE D-41 Sun StorEdge T3 Module - Loops

Property Description
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Operating System

The following modules, when loaded, are found under the operating system icon:

■ Directory Size Monitoring Module Version 2.0

■ File Monitoring Module Version 2.0

■ IPv6 Instrumentation Module Version 1.0

■ Kernel Reader Module Version 1.0

■ Kernel Reader Simple Module Version 3.0

■ NFS Statistics Module Version 2.0

■ Solaris Process Details Module Version 2.0

■ NFS File Systems Module Version 2.0

■ Simple MIB-II Module Version 1.0

These modules monitor the operating system on your host.

Directory Size Monitoring Module Version 2.0

This module enables you to isolate and monitor the size of any directory and its

subdirectories on a host on which an agent is installed. The subdirectories and links

may be viewed recursively using a window accessible from the modules pop-up

menu.

rpurple209 DC error

rpurple210 Power supply unit disabled

rpurple211 Power supply off

rpurple212 Power supply error

rpurple213 Battery missing

rpurple214 Loop card missing

rpurple215 Interconnect cable missing

rpurple216 Loop card disabled

TABLE D-43 Sun StorEdge T3 Module - Rules

Ruole Description
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Note – Any number of directories may be monitored individually by loading

multiple instances of the Directory Size Monitoring module, or by adding rows for

additional directories in the properties table. See “To Define a Directory” on

page 105 for more information.

Directory Monitoring Status Table

The following table provides a brief description of the properties for Directory Size

Monitoring:

File Monitoring Module Version 2.0

This module enables you to monitor the files on a host. Any file or number of tiles

may be isolated and monitored individually by loading multiple instances of the File

Monitoring module. This module requires you to add rows for the data property

tables. For more information, see “Browser Table Operations” on page 97.

TABLE D-44 Directory Size Monitoring Properties

Property Description

Instance Name Single word or alpha-character string that is used internally within

the Sun Management Center agent to identify uniquely a particular

module or a row within a module

Directory Name Name of the directory being monitored

Directory Directory Existing Check

Directory Size (KB) Current size of the directory in Kbytes

Rate (KB/sec) Rate at which the directory is changing size in Kbytes per second
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File Monitoring Status Table

The following table lists the File Monitoring Status properties and their descriptions:

IPv6 Instrumentation Module Version 1.0

This section presents information on the IPv6 Instrumentation module, which

comprises the following groups:

■ IPv6 IP Group

■ IPv6 TCP Group

■ IPv6 UDP Group

■ IPv6 ICMP Group

TABLE D-45 File Monitoring Properties

Property Description

Name Name of the file being monitored

Description Descriptive name provided for this file when added

Filename File being monitored

Last Modified Date and time the file last changed

File Size (Bytes) Size of the file

Size Rate (Bytes) Number of bytes written per second
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IPv6 IP Group

TABLE D-46 IPv6 Group Table

Property

IPv6 Forwarding

IPv6 Default Hop

Limit

IPv6 Interface

IPv6 Route Number

TABLE D-47 IPv6 If Stats Table

Property

ipv6IfIndex

ipv6IfDescr

ipv6IfLowerLayer

ipv6IfEffectiveMtu

ipv6IfReasmMax

Size

ipv6IfIdentifier

ipv6IfIdentifier

Length

ipv6IfPhysical

Address

ipv6IfAdminStatus

ipv6IfOperStatus
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TABLE D-48 IPv6 If Stats Table

Property

ipv6IfIndex

ipv6IfStatsIn

Receives

ipv6IfStatsInHdr

Errors

ipv6IfStatsInTooBig

Errors

ipv6IfStatsInNo

Routes

ipv6IfStatsInAddr

Errors

ipv6IfStatsIn

UnknownProtos

ipv6IfStatsIn

TruncatedPkts

ipv6IfStatsIn

Discards

ipv6IfStatsIn

Delivers

ipv6IfStatsOutForw

Datagrams

ipv6IfStatsOut

Requests

ipv6IfStatsOut

Discards

ipv6IfStatsOutFrag

OKs

ipv6IfStatsOutFrag

Fails

ipv6IfStatsOutFrag

Creates

ipv6IfStatsReasm

Reqds

ipv6IfStatsReasm

OKs
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ipv6IfStatsReasm

Fails

ipv6IfStatsInMcast

Pkts

ipv6IfStatsOutMcast

Pkts

TABLE D-49 IPv6 Addr Prefix Table

Property

ipv6IfIndex

ipv6AddrPrefix

ipv6AddrPrefixLeng

th

ipv6AddrPrefixOn

LinkFlag

ipv6AddrPrefix

AutonomousFlag

TABLE D-50 IPv6 Addr Table

Property

ipv6IfIndex

ipv6AddrAddress

ipv6AddrPfxLength

ipv6AddrType

ipv6AddrAnycast

Flag

ipv6AddrStatus

TABLE D-48 IPv6 If Stats Table

Property
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TABLE D-51 IPv6 Route Table

Property

ipv6 RouteDest

ipv6RoutePfxLength

ipv6RouteIndex

ipv6RouteIfIndex

ipv6RouteNextHop

ipv6RouteType

ipv6RouteProtocol

ipv6RoutePolicy

ipv6RouteAge

ipv6RouteNextHop

RDI

ipv6RouteMetric

ipv6RouteWeight

ipv6RouteInfo

ipv6RouteValid

TABLE D-52 IPv6 Net To Media Table

Property

ipv6IfIndex

ipv6NetToMediaNet

Address

ipv6NetToMedia

PhysAddress

ipv6NetToMedia

Type
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IPv6 TCP Group

IPv6 UDP Group

ipv6IfNetToMedia

State

ipv6IfNetToMedia

LastUpdated

ipv6NetToMedia

Valid

TABLE D-53 IPv6 Conn Table

Property

tcp6ConnState

tcp6ConnLocal

Address

tcp6ConnLocalPort

tcp6ConnRem

Address

tcp6ConnRemPort

TABLE D-54 IPv6 UDP Table

Property

ipv6UdpLocal

Address

ipv6UdpLocalPort

ipv6UdpIfIndex

TABLE D-52 IPv6 Net To Media Table

Property
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IPv6 ICMP Group

TABLE D-55 IPv6 If ICMP Table

Property

ipv6IfIndex

ipv6IfIcmpMsgs

ipv6IfIcmpInErrors

ipv6IcmpInDest

Unreachs

ipv6IfIcmpInAdmin

Prohibs

ipv6IfIcmpInTime

Excds

ivp6IfIcmpInParm

Problems

ivp6IfIcmpInPktToo

Bigs

ipv6IfIcmpInEchos

ipv6IfIcmpInEcho

Replies

ipv6IfIcmpInRouter

Solicits

ipv6IcmpInRouter

Advertisements

ipv6IfIcmpIn

NeighborSolicits

ipv6IfIcmpInNeighb

orAdvertisements

ipv6IfIcmpIn

Redirects

ipv6IfIcmpInGroup

MembQueries

ipv6IfIcmpInGroup

MembResponses

ipv6IfIcmpInGroup

MembReductions
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ipv6IfIcmpOutMsgs

ipv6IfIcmpOut

Errors

ipv6IfIcmpOutDest

Unreachs

Ipv6IfIcmpOut

AdminProhibs

ipv6IfIcmpOutTime

Excds

ipv6IcmpOutParm

Problems

ipv6IcmpOutPktToo

Bigs

ipv6IfIcmpOutEchos

ipv6IfIcmpOutEcho

Replies

ipv6IfIcmpOutRoute

rSolicits

ipv6IcmpOutRouter

Advertisements

ipv6IfIcmpOut

NeighborSolicits

ipv6IfIcmpOutNeig

hborAdvertisments

ipv6IfIcmpOut

Redirects

ipv6IfIcmpOutGrou

pMembQueries

ipv6IfIcmpOutGrou

pMembResponses

ipv6IfIcmpOut

GroupMemb

Reductions

TABLE D-55 IPv6 If ICMP Table

Property
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MIB-II Instrumentation Module Version 1.0

This section presents information on the MIB-II Instrumentation module. It describes

the property tables that belong to the following MIB-II groups:

■ MIB-II System Group Table

■ MIB-II Interfaces Group Tables

■ MIB-II IP Group Table

■ MIB-II ICMP Group Table

■ MIB-II TCP Group Tables

■ MIB-II UDP Group Tables

MIB-II System Group Table

The following table provides a brief description of the properties for MIB-II System

Group:

MIB-II Interfaces Group Tables

The following tables provide a brief description of the properties for the MIB-II

Interface group:

■ MIB-II Interfaces Group Table

■ MIB-II Interface Table

TABLE D-56 MIB-II System Group Properties

Property Description

System Description MIB-II system description or the description of the host (read-

write)

System OID Object identifier or the Object ID (OID) of the software system

Time Since System Is Up Time in microseconds since the system is up

System Contact The contact name for this system

System Name The qualified host name on which the agent is running (read-

write)

System Location The physical location of the host (read-write)

System Services Sum integer value indicating the set of services primarily

offered
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MIB-II Interfaces Group Table

The following table provides a brief description of the properties for MIB-II

Interfaces Group:

MIB-II Interface Table

The following table provides a brief description of the properties for MIB-II

Interfaces:

TABLE D-57 MIB-II Interfaces Group Properties

Property Description

Number of

Interfaces

Number of interfaces to the machine, including the loopback

TABLE D-58 MIB-II Interface Properties

Property Description

IF Index Index of the interface in this table

IF Descr Description of the interface

IF Type Type of the interface

IF Largest MTU Size of the largest datagram that can be sent on the interface

IF Speed Bandwidth of the interface

IF Physical Address Physical address of the interface

IF Admin Status Desired state of the interface

IF Oper Status Operational state of the interface

IF Last Change Value of sysUpTime (that is, time when the system is up and

running) when the operational state has changed last time

IF In Octets Octets received on the interface

IF In Unicast Pkts Unicast packets received on the interface

IF In NonUnicast

Pkts

Non-unicast packets received on the interface

IF In Discards Number of packets on the interface that are chosen to be discarded

IF In Errors Number of inbound packets on the interface that contained errors

IF In Unknown

Protos

Number of packets with unsupported protocol that were received

on the interface
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MIB-II IP Group Table

The following tables provide a brief description of the properties for MIB-II IP:

■ MIB-II Group Table

■ IP Address Table

■ IP Route Table

■ IP NetToMedia Table

MIB-II Group Table

The following table provides a brief description of the properties for MIB-II IP

Group:

IF Out Octets Number of octets transmitted out on the interface

IF Out Unicast Pkts Number of unicast packets transmitted out on the interface

IF Out NonUnicast

Pkts

Number of non-unicast packets transmitted out on the interface

IF Out Discards Number of outbound packets on the interface that contained errors

IF Out Errors Number of outbound packets that could not be transmitted because

of errors

IF Out Queue

Length

Length of the output packet queue

IF Specific Reference to the MIB definitions specific to the particular media

TABLE D-59 MIB-II Group Properties

Property Description

IP Forwarding Indicates whether this entity is a gateway

IP Default TTL Default Time-to-Live inserted into the IP headers

IP In Receives Number of datagrams received

IP In Header Errors Number of input datagrams discarded because of errors in IP

headers

IP In Address Errors Number of input datagrams discarded because of errors in

destination IP address

IP Forwarded

Datagrams

Number of forwarded datagrams

TABLE D-58 MIB-II Interface Properties (Continued)

Property Description
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IP Address Table

The following table provides a brief description of the properties for IP Addresses:

IP In Unknown

Protos

Number of locally addressed datagrams that were discarded

because of unsupported protocols

IP In Discards Number of input datagrams that were discarded

IP In Delivers Number of input datagrams that were successfully delivered

IP Out Requests Number of datagrams that were supplied to IP for transmission

IP Out Discards Number of output IP datagrams that were discarded

IP Out No Routes Number of output IP datagrams that were discarded because no

route destination was found

IP Reassemble

Timeouts

Maximum time in seconds for which the received fragments were

held for reassembly

IP Reassemble

Requireds

Number of IP fragments received that required reassembly

IP Reassemble OKs Number of IP datagrams that were successfully reassembled

IP Reassemble Fails Number of failures detected by the reassembly algorithm

IP Fragmentation

OKs

Number of IP datagrams that were successfully fragmented

IP Fragmentation

Fails

Number of IP datagrams that have failed fragmentation

IP Fragmentation

Creates

Number of IP datagram fragments that were generated due to

fragmentation

TABLE D-60 IP Addresses Properties

Property Description

IPAT IP Address IP Address to which this entry’s addressing information pertains

IPAT IfIndex Index in the interface table for the corresponding interface

IPAT Net Mask Subnet mask associated with the IP address

IPAT Broadcast

Address

Value of the least significant bit in the IP broadcast address

IPAT Reassemble

Max Size

Size of the largest IP datagram which can be reassembled by this

entity

TABLE D-59 MIB-II Group Properties (Continued)

Property Description
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IP Route Table

The following table provides a brief description of the properties for IP Route:

TABLE D-61 IP Route Properties

Property Description

IP Route Destination Destination IP address of the route

IP Route IfIndex Index of the interface in the interface table through which the next

hop of this route is reached

IP Route Metric1 Primary routing metric for the route that is specific to the routing 1

protocol

IP Route Metric2 Alternate routing metric for the route that is specific to the routing 2

protocol

IP Route Metric3 Alternate routing metric for the route that is specific to the routing 3

protocol

IP Route Metric4 Alternate routing metric for the route that is specific to the routing 4

protocol

IP Route NextHop IP address of the next hop of this route

IP Route Type Type of route

IP Route Proto Routing mechanism through which this route was learned

IP Route Age Number of seconds since the route was last updated

IP Route Mask Mask to be logical and with the destination address before being

compared to the route destination

IP Route Metric5 Alternate routing metric for the route that is specific to the routing 5

protocol

IP Route Info Reference to MIB definitions specific to the routing protocol
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IP NetToMedia Table

The following table provides a brief description of the properties for IP NetToMedia:

MIB-II ICMP Group Table

The following table provides a brief description of the properties for MIB-II ICMP

Group:

TABLE D-62 IP NetToMedia Properties

Property Description

IPN2M IfIndex Index of the interface in the interface table on which this entry’s

equivalence is effective

IPN2M

PhysAddress

Media-dependent physical address

IPN2M NetAddress IP address corresponding to the physical address

IPN2M Type Type of mapping

TABLE D-63 MIB-II ICMP Group Properties

Property Description

ICMP In Messages Number of ICMP messages received

ICMP In Errors Number of ICMP messages received with errors

ICMP In Dest

Unreachs

Number of ICMP destination unreachable messages received

ICMP In Time

Exceeds

Number of ICMP time exceeded messages received

ICMP In Parameter

Problems

Number of ICMP parameter problem messages received

ICMP In Src

Quenchs

Number of ICMP source quench messages received

ICMP In Redirects Number of ICMP redirect messages received

ICMP In Echos Number of ICMP echo request messages received

ICMP In Echo Reps Number of ICMP echo reply messages received

ICMP In

Timestamps

Number of ICMP timestamp request messages received

ICMP In Timestamp

Reps

Number of ICMP timestamp reply messages received
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MIB-II TCP Group Tables

The following tables provide a brief description of the properties for MIB-II TCP:

■ MIB-II TCP Group Table

■ TCP Connections Table

ICMP In Address

Masks

Number of ICMP address mask request messages received

ICMP In Address

Mask Reps

Number of ICMP address mask reply messages received

ICMP Out Messages Number of ICMP messages that were attempted to send

ICMP Out Errors Number of ICMP messages that were not send due to problems

ICMP Out Dest

Unreachs

Number of ICMP destination unreachable messages sent

ICMP Out Time

Exceeds

Number of ICMP time exceeded messages sent

ICMP Out

Parameter Problems

Number of ICMP parameter problem messages sent

ICMP Out Src

Quenchs

Number of ICMP source quench messages sent

ICMP Out Redirects Number of ICMP redirect messages sent

ICMP Out Echos Number of ICMP echo request messages sent

ICMP Out Echo

Reps

Number of ICMP echo reply messages sent

ICMP Out

Timestamps

Number of ICMP timestamp request messages sent

ICMP Out

Timestamp Reps

Number of ICMP timestamp reply messages sent

ICMP Out Address

Masks

Number of ICMP address mask request messages sent

ICMP Out Address

Mask Reps

Number of ICMP address mask reply messages sent

TABLE D-63 MIB-II ICMP Group Properties (Continued)

Property Description
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MIB-II TCP Group Table

The following table provides a brief description of the properties for MIB-II TCP

Group:

TABLE D-64 MIB-II TCP Group Properties

Property Description

TCP Retransmission

Algorithm

Algorithm used to determine the timeout value used for

retransmitting unacknowledged octets

TCP Retransmit Min

Timeout

Minimum value permitted by TCP implementation for the

retransmission timeout

TCP Retransmit

Max Timeout

Maximum value permitted by TCP implementation for the

retransmission timeout

TCP Max

Connections

Limit on the number of TCP connections

TCP Active Opens Number of times TCP connections have transitioned to SYN-SENT

from CLOSED state

TCP Passive Opens Number of times TCP connections have transitioned to SYN-RCVD

from LISTEN state

TCP Attempt Fails Number of times TCP connections have transitioned from SYN-

SENT or SYN-RCVD to COLSED state and from SYN-RCVD to

LISTEN state

TCP Established-to-

Resets

Number of times TCP connections have transitioned from

ESTABLISHED or CLOSE-WAIT to CLOSED state

TCP Current

Established

Number of TCP connections for which the current state is

ESTABLISHED or CLOSE-WAIT

TCP In Segments Number of segments received

TCP Out Segments Number of segments sent

TCP Retransmitted

Segments

Number of segments retransmitted

TCP In Errors Number of segments received in error

TCP Out With Reset

Flag

Number of segments sent containing the RST flag
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TCP Connections Table

The following table provides a brief description of the properties for TCP

Connections:

MIB-II UDP Group Tables

The following tables provide a brief description of the properties for MIB-II UDP:

■ MIB-II UDP Group Table

■ UDP Table

MIB-II UDP Group Table

The following table provides a brief description of the properties for MIB-II UDP

Group:

TABLE D-65 TCP Connections Properties

Property Description

TcpConn State State of this TCP Connection

TcpConn Local Address Local IP address for this TCP connection

TcpConn Local Port Local port number for this TCP connection

TcpConn Remote Address Remote IP address for this TCP connection

TcpConn Remote Port Remote port number for this TCP connection

TABLE D-66 MIB-II UDP Group Properties

Property Description

UDP In Datagrams Number of UDP datagrams delivered to UDP users

UDP No Port

Datagrams

Number of received UDP datagrams for which there is no

application at the destination port

UDP In Errors Number of received UDP datagrams that could not be delivered

UDP Out Datagrams Number of UDP datagrams sent
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UDP Table

The following table provides a brief description of the properties for UDP:

Kernel Reader Module Version 1.0

The Kernel Reader module monitors kernel statistics and all kernel information

including CPU statistics, system load statistics, disk statistics, file system usage, and

so on. This section includes properties and their descriptions for all Kernel Reader

managed objects:

■ User Statistics Table

■ Interprocess Communication Tables

■ Disk Statistics Managed Objects Tables

■ I/O Error Statistics Table

■ Filesystem Usage Table

■ CPU Statistics Managed Object Tables

■ Memory Usage Statistics Table

Kernel Reader Simple Module Version 3.0
■ System Load Statistics

■ Swap Statistics Table

■ Streams Statistics Managed Objects Table

■ Software Rules Table

The Kernel Reader module generates a warning alarm if it finds any disk with an

increasing wait queue while busy.

A warning alarm occurs when the disk is over 75% busy and the average queue

length is over 10 with an increasing wait queue. The warning alarm is on until the

disk is not over 70% busy and the average queue length is no longer than 8.

Similarly, this module generates a warning alarm if 90% of swap space is in use. The

alarm remains open until the swap space in use is less than 80% of the total swap

space.

TABLE D-67 UDP Properties

Property Description

UDP Local Address The local IP address for this UDP listener

UDP Local Port The local port number for this UDP listener
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The following table provides default alarm thresholds for applicable Kernel Reader

modules:

User Statistics Table

The following table provides a brief description of the properties for User Statistics:

TABLE D-68 Kernel Reader Alarm Thresholds

Alarm Threshold Message Condition

Error If file system kpctUsed is > 98

Warning If file system kpctUsed is > 90

Error If file system inode percentage is > 90

Warning If file system inode percentage is > 80

TABLE D-69 User Statistics Properties

Property Description

Console User User currently logged in on the console

Number Of Users Number of unique users currently logged in

Number Of User Sessions Number of currently active user sessions

Primary User Login name of the primary user
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Interprocess Communication Tables

IPC Shared Memory Table

IPC Semaphores Table

The following table provides a brief description of the properties for System Load

Statistics:

TABLE D-70 IPC Shared Memory Properties

Property Description

Total Shared

Memory Segments

Total number of shared memory segments initially available for use.

Available Shared

Memory Segments

Number of currently available shared memory segments.

Shared Memory

Segments Used

Shared memory segments used as a percentage of the total units.

TABLE D-71 IPC Semaphores Properties

Property Description

Total Semaphores

Available

Total number of semaphores currently available.

Semaphores Used Semaphores used as a percentage of the total.
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System Load Statistics Table

Disk Statistics Managed Objects Tables

The following tables provide a brief description of the properties for Disk Statistics:

■ Disk Details Table

■ Disk Service Time Table

The following table provides a brief explanation of what these tables contain:

Disk Details Table

The following table provides a brief description of the properties for Disk Details:

TABLE D-72 System Load Statistics Properties

Property Description

1 Min Load Average Load average over the last 1 minute

5 Min Load Average Load average over the last 5 minutes

15 Min Load Average Load average over the last 15 minutes

TABLE D-73 Disk Statistics Parameters

Property Description

Disk Details Details that pertain to the disk

TABLE D-74 Disk Details Properties

Property Description

Disk Name Name of the disk (sd0 and so on)

Disk Alias Name of the disk (c0t0d0 and so on)

Read Operation Per Sec Read operation per sec

Writes Operation Per Sec Writes operation per sec

Operation Per Sec (read +

write)

Operation per sec (read and write)

Number Of Bytes Read Number of bytes read

Number Of Bytes Written Number of bytes written
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Disk Service Time Table

The following table provides a brief description of the properties for Disk Service

Time:

Number Of Bytes

Transferred (read + write)

Number of bytes transferred (read and write)

Average Number Of

Transactions Waiting

Average number of transactions waiting

Average Number Of

Transactions Running

Average number of transactions running

TABLE D-75 Disk Service Time Properties

Property Description

Diskname Name of the disk (sd0 and so on)

Disk Alias Name of the disk (c0t0do, etc.)

Percentage Of Time

There Is A Transaction

Waiting For Service

Percentage of time there is a transaction waiting for service

(wait queue length)

Percentage Of Time The

Disk Is Busy

Percentage of time the disk is busy (transaction running)

Average Wait Service

Time

Average wait service time

Average Run Service

Time

Average run service time

Average Service Time Average service time

Rule 404 Meta Disk Rule

TABLE D-74 Disk Details Properties (Continued)

Property Description
Appendix D Sun Management Center Software - Modules 557



I/O Error Statistics Table

Under the I/O Error Statistics Table, there are the following two tables (FIGURE D-1):

TABLE D-76 I/O Error Statistics Properties

Property Description

Device The name of the device in a descriptive format.

Software Errors The total number of software errors.

Hardware Errors The total number of hardware errors.

Transport Errors The total number of transport errors.

Total Errors Total number of errors.

TABLE D-77 Device Error Table

Property Description

Device The name of the device in descriptive format

Software Errors Total number of software errors

Hardware Errors Total number of hardware errors

Transport Errors Total number of transport errors

Total Errors Total number of errors

TABLE D-78 Tape Error Table

Property Description

Device The name of the device in descriptive format

Software Errors Total number of software errors

Hardware Errors Total number of hardware errors

Transport Errors Total number of transport errors

Total Errors Total number of errors
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FIGURE D-1 I/O Error Statistics Tables
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Filesystem Usage Table

The following table provides a brief description of the properties for Filesystem

Usage:

Note – The Find All Recent Files (>2 or >10Meg) probe commands for the UFS

Filesystem Usage and VXFS Filesystem Usage folders only find files that were

created or modified less than 24 hours ago. The Find All Files (>2 or >10Meg) probe

commands for UFS Filesystem Usage and VXFS Filesystem Usage find all files

(FIGURE D-2) regardless of the date/time they were created or modified.

For more information on the probe command, see “To Probe a Property” on

page 117.

TABLE D-79 Filesystem Usage Properties

Property Description

Index Mount point index

Mount Point Mount point for the file system

Disk Name Name of the device (/dev/dsk/... )

Size (KB) Total size of the filesystem in Kbytes

Free (KB) Available disk space in Kbytes

Free KB (Non Root) Available disk space for non-superusers in Kbytes

Percent Used Percentage of Disk Space Used

Total Inodes Total size of the filesystem in Kbytes

Available Inodes Available disk space for the file system in Kbytes

Percentage Of Inodes Used Percentage of Inodes Used
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FIGURE D-2 Probe Commands for Filesystem Usage

CPU Statistics Managed Object Tables

The following tables provide a brief description of the properties for CPU Statistics

managed objects:

■ CPU Utilization Table

■ CPU Process Table

■ CPU I/O Table

■ CPU Interrupts Table

■ CPU Syscalls Table

■ CPU Misc Table

■ CPU Regwindow Table

■ CPU Pageinfo Table

■ CPU Faults Table
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CPU Utilization Table

The following table provides a brief description of the properties for CPU

Utilization:

CPU Process Table

The following table provides a brief description of the properties for CPU processes:

TABLE D-80 CPU Usage Properties

Property Description

CPU Number CPU number

% CPU Idle Time Percentage of time spent by CPU on idle mode

% CPU User Time Percentage of time spent by CPU on user mode

% CPU Kernel Time Percentage of time spent by CPU on kernel mode

% CPU Wait Time Percentage of time spent by CPU on wait mode

% CPU Wait Time On I/O Percentage of time spent by CPU on wait mode for I/O

% CPU Wait Time On

Swap

Percentage of time spent by CPU on wait mode for swap

% CPU Wait Time On Pio Percentage of time spent by CPU on wait mode for Pio

Times Idle Thread

Scheduled

Percentage of idle time spent by CPU on threads scheduled

Rule 403 Meta CPU Rule

TABLE D-81 CPU Process Table

Property Description

Processes in Run
Queue

Processes in run queue

Processes Waiting Waiting processes

Processes Swapped Swapped processes

Total Number of CPUs Total number of CPUs
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CPU I/O Table

The following table provides a brief description of the properties for CPU I/O:

CPU Interrupts Table

The following table provides a brief description of the properties for CPU Interrupts:

TABLE D-82 CPU I/O Properties

Property Description

CPU Number Central Processing Unit (CPU) number

Physical Block Reads Number of physical block reads

Physical Block Writes Number of physical block writes

Logical Block Reads Number of logical block reads

Logical Block Writes Number of logical block writes

Raw I/O Reads Number of raw I/O reads

Raw I/O Writes Number of raw I/O writes

Bytes Read By Rdwr() Number of bytes read by Rdwr()

Bytes Written By Rdwr() Number of bytes written by Rdwr()

Terminal Input Characters Number of terminal input characters

Chars Handled In

Canonical Mode

Number of chars handled in canonical mode

Terminal Output

Characters

Number of terminal output characters

Physical Block Writes Number of physical block writes

Procs Waiting For Block

I/O

Number of processes waiting for block I/O

TABLE D-83 CPU Interrupts Properties

Property Description

CPU Number CPU number

Context Switches Number of context switches

Traps Number of traps
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CPU Syscalls Table

The following table provides a brief description of the properties for CPU system

calls:

Device Interrupts Number of device interrupts

Interrupts As Threads Number of interrupts as threads

Interrupts Blocked/

Preempted/Released

Number of interrupts blocked, pre-empted or released

TABLE D-84 CPU System Call Properties

Property Description

CPU Number CPU number

System Calls Number of system calls

Read+Readv System Calls Number of read+ready system calls

Write+Writev System Calls Number of Write+Writev system calls

Forks Number of forks

Vforks Number of Vforks

Execs Number of executables

Msg Count Number of message count

Semaphore Ops Count Number of semaphore operation count

Pathname Lookups Number of pathname lookups

Ufs_iget() Calls Number of ufs_iget() calls

Directory Blocks Read Number of directory block reads

Inodes Taken With Attached

Pages

Number of indexes taken with attached pages

Inodes Taken With No

Attached Pages

Number of indexes taken with no attached pages

Inode Table Overflows Number of Inode table overflows

File Table Overflows Number of file table overflows

Proc Table Overflows Number of process table overflows

TABLE D-83 CPU Interrupts Properties

Property Description
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CPU Misc Table

The following table provides a brief description of the properties for CPU

Miscellaneous:

CPU Regwindow Table

The following table provides a brief description of the properties for CPU

Regwindow:

TABLE D-85 CPU Miscellaneous Properties

Property Description

CPU Number CPU number

Involuntary Ctx Switches Number of involuntary context switches

Thread_create()s Number of thread_create()s

Cpu Migrations By Threads Number of CPU migrations by threads

Xcalls To Other Cpus Number of Xcalls to other CPUs

Failed Mutex Enters

(adaptive)

Number of failed mutex enters (adaptive)

Rw Reader Failures Number of read/write reader failures

Rw Write Failures Number of read/write write failures

Loadable Module Loaded Number of loadable module loaded

Loadable Module Unloaded Number of loadable module unloaded

Tries To Acquire RW Lock Number of tries to acquire read/write lock

TABLE D-86 CPU Regwindow Properties

Property Description

CPU Number CPU number

User Overflows Number of user overflows

User Underflows Number of user underflows

System Overflows Number of system overflows

System Underflows Number of system underflows

System User Overflows Number of system user overflows
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CPU Pageinfo Table

The following table provides a brief description of the properties for CPU Pageinfo:

TABLE D-87 CPU Pageinfo Properties

Property Description

CPU Number CPU number

Reclaims Number of reclaims

Reclaims From Free List Number of reclaims from free list

Pageins Number of pageins

Pages Paged In Number of pages paged in

Pageouts Number of pageouts

Pages Paged Out Number of pages paged out

Swapins Number of swap ins

Pages Swapped In Number of pages swapped in

Swapouts Number of swap outs

Pages Swapped Out Number of pages swapped out

Pages Zero Filled On Demand Number of pages zero filled on demand

Pages Freed By Daemon Number of pages fixed by daemon

Pages Examined By Pageout

Daemon

Number of pages examined by the pageout daemon

Revolutions Of The Page

Daemon Hand

Number of revolutions of the page daemon hand

Times Pager Scheduled Number of times pager scheduled
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CPU Faults Table

The following table provides a brief description of the properties for CPU Faults:

Memory Usage Statistics Table

The following table provides a brief description of the properties for Memory Usage

Statistics:

TABLE D-88 CPU Faults Properties

Property Description

CPU Number CPU number

Minor Page Faults Via hat_fault() Number of minor page faults through

hat_fault()

Minor Page Faults Via as_fault() Number of minor page faults through as_fault()

Major Page Faults Number of major page faults

Copy-on-write Faults Number of copy-on write faults

Protection Faults Number of protection faults

Faults Due To Software Locking Req Number of software locking faults

as_fault() s In Kernel addr Space Number of in kernel addr space

TABLE D-89 Memory Usage Statistics Properties

Property Description

Physical Memory Available (MB) Physical memory available in Mbytes

Physical Memory In Use (MB) Physical memory in use in Mbytes

Percent Memory Used Percentage of memory used

Physical Memory Free (MB) Physical memory free in Mbytes

Percent Memory Free Percentage of memory free
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Swap Statistics Table

The following table provides a brief description of the properties for Swap Statistics:

Streams Statistics Managed Objects Table

The following section provides the various Streams Statistics properties for the

following managed objects:

■ Stream Head Cache

■ Queue Cache

■ Streams Messages

■ Linkinfo Cache

■ Strevent Cache

■ Syncq Cache

■ Qband Cache

The following table briefly describes the managed objects:

TABLE D-90 Swap Statistics Properties

Property Description

Available KB (Anon Memory Not Reserved) Swap available. Total reserved swap

space.

Reserved KB (Anon Memory Reserved But

Not Allocated)

Swap reserved

Allocated KB (Anon Memory Not Free) Swap allocated

Used KB Swap used

Total KB (Used + Available) Swap total

Percent Swap Used Percentage of swap used

Rule 405 Meta Swap Rule

TABLE D-91 Streams Statistics Managed Objects

Properties Description

Stream Head Cache Kernel statistics for streams head cache

Queue Cache Kernel statistics for queue cache

Streams Msgs Kernel statistics for streams messages

Linkinfo Cache Kernel statistics for link information cache
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All of the preceding property tables have similar entries. These are listed in the

following table.

All of the Streams Statistics managed objects have the same properties. The

following table presents these common properties:

Software Rules Table

The following table provides a brief description of the properties for Software Rules:

NFS Statistics Module Version 2.0

This section presents property tables for NFS Statistics:

■ RPC Information Table

■ NFS Information Table

Strevent Cache Kernel statistics for streams event cache

Syncq Cache Kernel statistics for synoq cache

Qband Cache Kernel statistics for qband cache

TABLE D-92 Streams Statistics Table Properties

Property Description

The Name Of The Cache Name of the cache

Current Usage (total - avail) Cache’s current usage

Maximum Capacity Maximum capacity of the cache

Cumulative Total Of Allocations Number of total cache allocations

Number of Allocation Failures Number of allocation failures

Percent Used Percentage of cache used

TABLE D-93 Software Rules Properties

Property Description

Rule rknrd105 Software rule (refer to rule rknrd105 in Appendix E)

Rule rknrd106 Software rule (refer to rule rknrd106 in Appendix E)

TABLE D-91 Streams Statistics Managed Objects

Properties Description
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Using the NFS Statistics module, statistical information on the Remote Procedure

Calls (RPC) and Sun’s distributed computing file system (NFS) calls may be

monitored. The number of RPC and NFS calls received by the server and made by

the client are monitored and displayed in the main console window along with the

status of the transaction activity on the local host. The following tables list some of

the properties monitored by this module with both the server and the client

statistics.

RPC Information Table

The following table provides a brief description of the properties for RPC

Information:

NFS Information Table

The following table provides a brief description of the properties for NFS

Information:

TABLE D-94 RPC Server and Client Information Properties

Property Description

RPC Calls Total number of RPC calls made by the host

Bad RPC Calls Total number of calls rejected by the RPC layer

Bad RPC Calls % Percentage of rejected calls compared to the total number of calls

made (bad RPC Calls/RPC calls)

RPC Call Rate Number of RPC calls made per second

TABLE D-95 NFS Server and Client Information Properties

Property Description

NFS Calls Total number of NFS calls sent by the host

Bad NFS Calls Total number of NFS calls rejected

Bad NFS Calls % Percentage of rejected NFS calls compared to the total number of

calls sent (bad NFS calls/NFS calls)

NFS Call Rate Number of NFS calls sent per second
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NFS Statistics

Solaris Process Details Module Version 2.0

The Solaris Process Details module parameters are listed in the following table. This

table is seen when you try to load the module.

TABLE D-96 NFS Server Statistics

Property Description

Server NFS Calls Number of bad server NFS calls since the last init.

Server Bad NFS Call
%

Bad NFS calls as a percent of the total NFS calls made.

Server NFS Call Rate Rate at which server NFS calls are being made per second.

TABLE D-97 Client NFS Statistics

Property Description

NFS Calls Client NFS calls

Bad NFS Calls Number of bad client NFS calls since the last init.

Bad NFS % Bad NFS calls as a percentage of the total NFS calls made.

NFS Call Rate Rate at which client NFS calls are being made per second.

TABLE D-98 Solaris Process Details Parameters

Property Description

Module Name Name of the module (this is not editable)

Module Description Description of the module (this is not editable)

Version Version of the module (this is not editable)

Enterprise SNMP enterprise in which the module is loaded (this is not editable)

Module Type Type of the module (this is not editable)

Number of

Processes

Number of processes that is obtained by the module based on the

following selection criteria. One of the given numbers can be

selected by the user.

Selection Criteria Selection criteria by which the processes are sorted and selected. For

example, the user can select the top 10 processes using this function.
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The following section presents the Solaris Process property table.

Process Table

The following table provides a brief description of the properties for Solaris Process:

TABLE D-99 Process Properties

Property Description

PS Process ID Process ID of this process

PS Parent Process ID Process ID of the parent of this process

PS User ID Login ID of the user of this process

PS User Name Login name of the user of this process

PS Effective User ID Effective user ID of this process

PS Group ID Real group ID of this process

PS Effective Group

ID

Effective group ID of this process

PS Session ID Process ID of the session leader of this process

PS Process Group ID Process ID of the process group leader of this process

PS TTY Controlling terminal for this process

PS Start Time Starting time of this process

PS Time Cumulative execution time of this process

PS State State of this process

PS Wait Channel Address of an event for which this process is waiting

PS Scheduling Class Scheduling class of this process

PS Address Memory address of this process

PS Size Total size of this process in virtual memory

PS Priority Priority of this process

PS Nice Nice value of this process, which is used for priority computation

PS Percent CPU

Time

Percent CPU time

PS Percent Memory Percent memory

PS Command Base name of the executable file for this process

PS Command Line Full command name of this process, including the arguments
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NFS File Systems Module Version 2.0

The NFS File Systems module enables you to monitor the NFS file systems on hosts

running the Solaris 2 and Solaris 7 operating environments. The NFS File Systems

module monitors the amount of disk space occupied by mounted or unmounted file

systems: the amount of used and available space as well as the remaining total

capacity.

When loading the NFS File Systems module, you may define which file systems you

want to monitor by using pattern matching. Patterns may be used to filter which

NFS file systems are monitored by file system or mount point.

File System Usage Table

The following table provides a brief description of the properties for NFS Filesystem

Usage:

Simple MIB-II Module Version 1.0

The following tables provide a brief description of the properties for Simple MIB-II

managed objects:

■ System Group

■ Interfaces Group

■ IP Group

TABLE D-100 Filesystem Usage Properties

Property Description

NFS Filesys Name of the NFS filesystem

Size Total size of the NFS filesystem in Kbytes

Used Used disk space for the NFS file system in Kbytes

Available Available disk space for the NFS file system in Kbytes

% Used Percentage of NFS disk space used

Rate Percentage capacity change per second

Mount Point Mount point for the NFS filesystem

Entry Index Entry index of the NFS filesystem
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System Group

The following table provides a brief description of the properties for System Group.

Interfaces Group

The following tables provides a brief description of the properties for Interfaces

Group.

■ Interfaces Group

■ Interfaces Table

TABLE D-101 System Group Properties

Property Description

System Description MIB-II system description or the description of the host (read-write)

System OID Object identifier or the Object ID (OID) of the software system

Time Since Up Time in microseconds since the system is up

System Contact The contact name for this system

System Name The qualified host name on which the agent is running (read-write)

System Location The physical location of the host (read-write)

System Services Sum integer value indicating the set of services primarily offered

TABLE D-102 Interfaces Group Properties

Property Description

Number of Interfaces Number of interfaces to the machine, including the loopback

TABLE D-103 Interfaces Table

Property Description

IF Index Index of the interface in this table

IF Descr Description of the interface

IF Type Type of the interface

IF Largest MTU Size of the largest datagram that can be sent on the interface

IF Speed Bandwidth of the interface

IF Physical Address Physical address of the interface

IF Admin Status Desired state of the interface
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IP Group

The following table provides a brief description of the properties for IP Group.

■ IP Group

■ IP Route Table

IF Oper Status Operational state of the interface

IF Last Change Value of sysUpTime (that is, time when the system is up and

running) when the operational state has changed last time

IF In Octets Octets received on the interface

IF In Unicast Pkts Unicast packets received on the interface

IF In nonUnicast Pkts Non-unicast packets received on the interface

IF In Discards Number of packets on the interface that are chosen to be discarded

IF In Errors Number of inbound packets on the interface that contained errors

IF In Unknown Protos Number of packets with unsupported protocol that were received

on the interface

IF Out Octets Number of octets transmitted out on the interface

IF Out Unicast Pkts Number of unicast packets transmitted out on the interface

IF Out nonUnicast
Pkts

Number of non-unicast packets transmitted out on the interface

IF Out Discards Number of outbound packets on the interface that contained errors

IF Out Errors Number of outbound packets that could not be transmitted because

of errors

IF Out Queue Length Length of the output packet queue

IF Specific Reference to the MIB definitions specific to the particular media

TABLE D-104 IP Group

Property Description

IP Forwarding Indicates whether this entity is a gateway

TABLE D-103 Interfaces Table(Continued)

Property Description
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IP Address Table

TABLE D-105 IP Route Table

Property Description

IP Route Destination Destination IP address of the route

IP Route IfIndex Index of the interface in the interface table through which the next

hop of this route is reached

IP Route Metric1 Primary routing metric for the route that is specific to the routing 1

protocol

IP Route Metric2 Alternate routing metric for the route that is specific to the routing 2

protocol

IP Route Metric3 Alternate routing metric for the route that is specific to the routing 3

protocol

IP Route Metric4 Alternate routing metric for the route that is specific to the routing 4

protocol

IP Route NextHop IP address of the next hop of this route

IP Route Type Type of route

IP Route Proto Routing mechanism through which this route was learned

IP Route Age Number of seconds since the route was last updated

IP Route Mask Mask to be logical and with the destination address before being

compared to the route destination

IP Route Metric5 Alternate routing metric for the route that is specific to the routing 5

protocol

IP Route Info Reference to MIB definitions specific to the routing protocol

TABLE D-106 IP Address Table Properties

Property Description

IPAT IP Address IP Address Table Entry IP Address in MIB-II

IPAT IfIndex

IPAT Net Mask

IPAddTab R MaxSize
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Local & Remote Application Modules

The Sun Management Center software monitors various components of your system,

including your hardware, operating environment, local applications, and remote

systems. This section provides additional explanation for the core modules described

in Chapter 11 and presents them in their respective categories.

This appendix describes the following modules. For more information on other

modules that may be applicable to your particular system, see the previous

appendix, your supplement, or go to the Sun Management Center web site: http:/
/www.sun.com/sunmanagementcenter .

■ Local Applications

■ Agent Statistics Module Version 2.0

■ Data Logging Registry Module Version 2.0

■ Health Monitor Module Version 2.0

■ Logview ACL Version 1.0

■ Print Spooler Module Version 3.0

■ Process Monitoring Module Version 2.0

■ File Scanning (System Log) Module Version 2.0

■ Remote Systems

■ MIB-II Proxy Monitoring Module Version 2.0

■ HP JetDirect Module Version 2.0

Most of these modules have default monitoring conditions that generate alarms

when system values fall outside of these conditions. You may alter these default

thresholds by creating your own alarm thresholds, as explained in Chapter 11.

Also, there are modules that utilize the Add Row operation to define what data

properties to monitor. These modules will come up with empty tables and you have

to execute an Add Row operation to activate the specifics for monitoring the

modules.

The following table lists the modules described in this appendix alphabetically and

provides details on those modules that are automatically loaded and those that can

be loaded multiple times. It also points out those modules that utilize the Add Row

utility.

Local Applications

The following modules, when loaded, are found under the local applications icon:
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■ Agent Statistics Module Version 2.0

■ Data Logging Registry Module Version 2.0

■ Health Monitor Module Version 2.0

■ Logview ACL Version 1.0

■ Print Spooler Module Version 3.0

■ Process Monitoring Module Version 2.0

■ File Scanning (System Log) Module Version 2.0

Agent Statistics Module Version 2.0

This section presents the following information on Agent Statistics:

■ Object Statistics Table

■ Commands Executed Table

■ Transactions Performed Table

■ Sun Management Center Process Statistics Table

■ Sun Management Center Total Process Statistics Table

The Agent Statistics module monitors the health of the agent installed on a host.

This module monitors the objects, processes, and execution of processes by the

agent.

TABLE D-107 Agent Statistics Main Sections

Agent Statistics Tables Description

Object Section Displays data on the objects loaded onto the agent. Status field

displays the current status of the TOE and binary objects loaded into

and used by the agent.

Execution Section Displays data on the number of Tcl or TOE commands invoked by

the agent interpreter. Also displays data on the number of

asynchronous transactions initiated by the agent. Status field

displays a brief description of the current status of the objects listed.
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The following table provides a brief description of the Agent Statistics managed

objects:

The following lists default alarm thresholds for applicable Agent Statistics modules:

TABLE D-108 Agent Statistics Section Properties

Property Description

Object Statistics TOE Count - Number of TOE objects loaded into the agent bob

Count - Number of binary object buffers used by the agent

Commands Executed Total - Total number of commands that have been executed by the

agent

Rate (#/sec) - Number of commands executed by the agent per

second

Transactions

Performed

Total - Total number of transactions performed by the agent

Rate (#/sec) - Number of transactions performed by the agent per

second

PA Process Statistics Process statistics pertaining to the PA

PA Total Process

Statistics

Total process statistics pertaining to the PA

TABLE D-109 Agent Statistics Alarm Thresholds

Agent Statistics Condition

Error If toeCount > 6000

Warning If toeCount > 5000

Error If bobcount > 1200

Warning If bobcount > 1000

Warning If commands rate > 6000

Warning If transactions rate > 8

Error If process size > 35000

Warning If process size > 30000

Error If rss > 25000

Warning If percentage CPU time > 90

Warning If totalstats.count > 15

Error If totalstats.size > 40000

Warning If totalstats.size > 35000

Warning If totalstats.rss > 35000
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The following sections describe the property tables for Agent Statistics.

Object Statistics Table

The Objects section displays data on the Objects loaded onto the agent. The Status

field displays the current status of the TOE and binary objects loaded into and used

by the agent.

The following table provides a brief description of the properties for Object

Statistics:

Commands Executed Table

The following table provides a brief description of the properties for Commands

Executed:

Transactions Performed Table

The following table provides a brief description of the properties for Performed

Transactions:

TABLE D-110 Object Statistics Properties

Property Description

Total TOE Objects Number of TOE objects loaded into the agent

Total Bobs Number of binary object buffers used by the agent

TABLE D-111 Executed Commands Properties

Property Description

Total Commands Total number of commands that have been executed by the agent

Rate (/sec) Number of commands executed by the agent per second

TABLE D-112 Transactions Performed Properties

Property Description

Total Transactions Total number of transactions performed by the agent

Transaction Rate

(/sec)

Number of transactions performed by the agent per second
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Sun Management Center Process Statistics Table

The software monitors the Sun Management Center process statistics. The following

table provides a brief description of the properties for Sun Management Center

Process Statistics:

TABLE D-113 Sun Management Center Process Statistics Properties

Property Description

Process ID Identification number of the process

Process Unique Id Unique identification number of the process

Process Name Name of the process

Process Status Status of the process

Process State State of the process

User ID User ID of the process

Virtual Size Total size of the process

Resident Set Size Resident size of the process

Start Time Seconds Startup time of the process in seconds since January 1, 1970

Start Date Startup date of the process

Start Time Startup time of the process

CPU Time CPU time used by the process

Percent CPU Time Percentage of CPU time used by the process

Context Switches Context switches of the process

System Calls System calls made by the process

Command Line Command line of the process
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Sun Management Center Total Process Statistics Table

The software monitors the total Sun Management Center process statistics.

The following table provides a brief description of the properties for Total Sun

Management Center Process Statistics:

Data Logging Registry Module Version 2.0

The Data Logging Registry consists of the registry table.

Registry Table

The following table provides a brief description of the properties for Data Logging

Registry:

TABLE D-114 Total Sun Management Center Process Statistics Properties

Property Description

Number of Processes Number of agent and child processes

Total Virtual Size Total virtual size of agent and children

Total Res Size Total resident set size of agent and children

TABLE D-115 Data Logging Registry Properties

Property Description

Log Destination

State

State of the logged file destination.

Module Name Module name for data value (data from this module is logged in the

registry)

Instance Name Module instance name for data value.

Property Name Property name for data value

Logging Interval Logging interval for data value

File Logging File logging status.

Logging Destination The logging destination for data value.

Data Cache Data cache status

Cache Size (samples) Size of data cache
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Health Monitor Module Version 2.0

The Health Monitor module monitors the health of your host. When alarm

conditions occur, this module offers suggestions, if necessary, on how to improve the

performance of the system.

For example, this module monitors the swap space that is available, reserved,

allocated, and used. Sample alarm messages, from lowest to highest severity,

include:

■ No Worries: sufficient swap space available

■ There is lots of unused swap space

■ Not much swap left: perhaps add some more

■ Swap space shortage: add some more now

■ Dangerous swap space shortage: add more immediately

This section describes properties of the following Health Monitor module managed

objects:

■ Swap Table

■ Kernel Contention Table

■ NFS Table

■ CPU Table

■ Disk Table

■ RAM Table

■ Kernel Memory Table

■ Directory Cache Table

The Health Monitor module tracks the system properties for the above as described

in the following table:

TABLE D-116 Health Monitor Properties

Property Description

Swap Details the swap space

Kernel Contention Monitors the kernel contention (mutex) properties

NFS Provides NFS client information

CPU Provides information on the power of the CPU

Disk Presents the disc I/O information

RAM Random Access Memory (RAM) information

Kernel Memory Information on kernel memory

Directory Cache Cache of the directory
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Swap Table

The following table provides a brief description of the properties for Swap:

Kernel Contention Table

The following table provides a brief description of the properties for Kernel

Contention (mutex):

NFS Table

The following table provides a brief description of the properties for NFS client

information:

TABLE D-117 Swap Properties

Property Description

Swap Available KB Swap space value available

Swap Reserved KB Swap space value reserved

Swap Allocated KB Swap space value allocated

Swap Used KB Swap space value used

Swap Rule Rule for swap

TABLE D-118 Kernel Contention Properties

Property Description

Spins On Mutexes Spins on mutexes (lock not acquired on first try) - Sum for all

CPUs

Number Of CPUs Number of CPUs

Spins On Mutexes Rule Spins on mutexes (lock not acquired on first try) - Sum for all

CPUs

TABLE D-119 NFS Client Information Properties

Property Description

Calls Total number of RPC calls received

Badcalls Total number of calls rejected by the RPC layer

Retrans Call retransmitted due to a timeout
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CPU Table

The following table provides a brief description of the properties for the central

processing unit (CPU):

Disk Table

The following table provides a brief description of the properties for Disk:

Badxids Reply from server not corresponding to any outside call

Timeouts Call timed out while waiting for a reply from server

Newcreds Number of times authentication information was refreshed

Badverfs Calls failed due to a bad verifier in response

Timers Number of times that calculated time-outs exceed the minimum

specified timeout value for a call.

Nomem Failure to allocate memory

Can't Send Failure to send NFS/RPC rule

NFS/RPC Rule Value of the NFS/RPC rule

TABLE D-120 CPU Properties

Property Description

Processes In Run

Queue

Number of processes in run queue

Processes Waiting Number of processes blocked for resources

Processes Swapped Number of processes that can be run but swapped

CPU Power Rule CPU power rule

TABLE D-121 Disk Properties

Property Description

Disk Name Name of the disk

Disk Alias Name of the disk (for example, c0t0d0 )

Percent Disk Wait Average number of transactions waiting for service

TABLE D-119 NFS Client Information Properties (Continued)

Property Description
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RAM Table

The following table provides a brief description of the properties for random access

memory (RAM):

Kernel Memory Table

The following table provides a brief description of the properties for Kernel

Memory:

Percent Disk Busy Percent of time disk is busy

Service Time (ms) Average service time in milliseconds

Disk Rule Disk rule

TABLE D-122 RAM Properties

Property Description

Handspread Value of hand spread (one of kernel parameters) pages

Scan rate Page scan rate

Real Memory rule Real memory rule

TABLE D-123 Kernel Memory Properties

Property Description

Total Kernel Allocation

Fails

Value of kernel allocation failure

Physical Memory Free Value of free physical memory

Kernel Memory Rule Value of kernel memory rule

TABLE D-121 Disk Properties (Continued)

Property Description
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Directory Cache Table

The following table provides a brief description of the properties for Directory

Cache:

Logview ACL Version 1.0

The Logview module creates a file list that allows you to specify which user or

group can access this file in the logviewer.

Print Spooler Module Version 3.0

The Print Spooler module monitors the status of the printer daemon and print queue

on the local host as well as the printer devices installed on it.

■ Printer LPsched

■ Printer Devices Table

■ Printer Queues Table

TABLE D-124 Name Cache Statistics Properties

Property Description

Cache Hits Number of times a previously accessed page is found

Cache Misses Number of times a previously accessed page is missed

DNLC Rule DNLC (Directory Name Lookup Cache) rule

TABLE D-125 Logview Access Control Table

Property

Instance Name

File Name

User Name

Group Name
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The following table describes the print spooler managed objects:

Printer LPsched

The printer daemon section displays data on the LP Request Scheduler. The

following table provides a brief description of the properties for the Line Printer’s

Schedule (LPsched):

Printer Devices Table

The Printer Devices table lists the printers that are already added to the table (by

selecting the Add option from the pop-up menu. The pop-up menu displays when

you position the cursor in a row and click the right mouse button.)

The instance name or alias of the printer is displayed in the Name field followed by

the description of the printer displayed in the Description field, and the name of the

host on which it is installed, displayed in the Host Name field. If you are running a

console displaying data monitored by an agent on a print server host, the path name

of the printer device is displayed in the Device field. The printer state displays in the

Printer State field.

TABLE D-126 Print Spooler Properties

Property Description

Lpsched Status Status of the lpsched process

Printer Devices Table lists information about the printer devices

Printer Queues Table lists information about the printer queue

TABLE D-127 Printer LPsched Properties

Property Description

LPsched state Current status of the printer.
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The following table provides a brief description of the properties for Printer Devices:

Printer Queues Table

The Print Queues table lists the print queues on the local host and displays the

status of each queue. The following table provides a brief description of the

properties for Printer Queues:

Process Monitoring Module Version 2.0

The following section describes the Process Monitoring module parameters and their

property descriptions. This module requires you to add rows for the data property

tables. For more information, see “Browser Table Operations” on page 97.

TABLE D-128 Printer Devices Properties

Property Description

Row Status The status of the row

Printer name Name of the printer device

Description Description of the row

Host name Name of the host to which the device is attached

Device name Alphanumeric device name

Device state The state of the device

TABLE D-129 Printer Queues Properties

Property Description

Printer Queue Name Name of the printer queue

Printer Queue State Current status of the printer queue (values are “accepting” and “not

accepting”)

# of Printer Queue

Jobs

Total number of jobs in the queue

Current Printer Job Number of jobs currently spooled in the queue

Printer Queue Size Total size (in Kbytes) of the jobs currently spooled in the queue
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When a process “hit” is found, the %CPU and a count of the number of processes

that match is displayed. If you want to change the module parameters, you can edit

all the parameters except for the entry name by accessing the pop-up menu. See

“Pop-up Menu” on page 72 for more information.

Process Statistics Table

The following table provides a brief description of the properties for Process

Statistics:

Note – The first five row entries in TABLE D-130 must be entered by you when

adding a row to the process statistics table. See “To Add a Row (for the Directory

Size Monitoring, File Monitoring, File Scanning, and Process Monitoring Modules)”

on page 106 for more information.

TABLE D-130 Process Statistics Properties

Property Description

Entry Name Name of the entry (must be a unique name)

Name Pattern Pattern to match the name of the process that you want to monitor

Argv Pattern Pattern to match the arguments of the command which executes the

process

User Specification User name executing the command

Entry Description Description of the entry (mandatory field)

Monitoring State Toggle between on (row is enabled) and off (row is disabled). When

the row is disabled, all the entries are displayed as 0 (zero).

Process Command Name process

% CPU Usage Percentage CPU used by the processes. This is a time-weighted

average taken at different time intervals (not to be confused with

the value that might result after you enter the Unix ps command).

Virtual Size Total size of the processes

Resident Set Size Resident size of the processes

Process Count Number of the processes that matched the pattern
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File Scanning (System Log) Module Version 2.0

The File Scanning module scans files on a host for user-specified patterns. Multiple

instances of the File Scanning module may be loaded to scan multiple files. This

module requires you to add rows for the data property tables. For more information,

see “Browser Table Operations” on page 97.

The File Scanning module has the following managed objects:

■ File ID Table

■ File Statistics Table

■ Scan Table

The following table provides a brief description of the properties for File Scanning:

File ID Table

The following table provides a brief description of the properties for File ID:

TABLE D-131 File Scanning (System Log) Properties

Property Description

File ID Name given by you to the pattern used in the file scan

File Stats State of the pattern listed

Scan Table Name given by you to the pattern used in the file scan

TABLE D-132 File ID Properties

Property Description

Filename Full path name of the file to be scanned

Scan Mode Mode in which the file is being scanned

Start Time Time the file scan was first started
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File Statistics Table

The File Statistics table displays summary information on the file that is to be

scanned. The following table provides a brief description of the properties for File

Statistics:

Scan Table

The following table provides a brief description of the properties for Scan:

Remote Systems

The software enables you to monitor remote systems, such as HP printers equipped

with a JetDirect card.

The following modules, when loaded, are found under the local remote system icon:

TABLE D-133 File Statistics Properties

Property Description

Modification Time Date and time when the file was last modified

File Size Size of the file in bytes

Number of Lines Number of lines contained in the file

Lines Per Second Rate at which the file is changing in lines per second

TABLE D-134 Scan Table Properties

Property Description

Row Status The status of the row

Pattern Name Name given by you to the pattern used in the file scan

Pattern Description Name of the pattern entry to be displayed in the name field of the

Scan Results section

Regexp Pattern Regular expression pattern to be used when scanning the file for

entries

Pattern State State of the pattern listed (on/off). The off state indicates that the

pattern listed will not be used in the file scan

Matches Number of lines that contain the pattern
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■ MIB-II Proxy Monitoring Module Version 2.0

■ HP JetDirect Module Version 2.0

MIB-II Proxy Monitoring Module Version 2.0

The MIB-II Proxy Monitoring module monitors the MIB-II parameters for remote

systems. The various categories that monitor the MIB-II parameters on remote

systems are listed in the following sections, which list MIB-II group tables:

■ MIB-II System Group Table

■ MIB-II Interfaces Group Tables

■ MIB-II IP Group Table

■ MIB-II ICMP Group Table

■ MIB-II TCP Group Tables

■ MIB-II UDP Group Tables

For more information on the properties of these parameters, see “IPv6

Instrumentation Module Version 1.0” on page 536, which lists the properties for local

systems. The same functionality is applied on remote systems by the MIB-II Proxy

Monitoring module. For more information on the definition of MIB-II, see the

standards documentation RFC1213 (Request For Comments 1213).

HP JetDirect Module Version 2.0

Agents can monitor HP printers equipped with a JetDirect card by proxy using the

HP JetDirect module. Multiple HP printers may be monitored by loading multiple

instances of this module.

Printer Status Table

The following table provides a brief description of the properties for Printer Status:

For platform-specific information, see your supplement.

TABLE D-135 General Printer Status Properties

Property Description

Status Display LED status display

SNMP Get Status Status of SNMP Get
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APPENDIX E

Sun Management Center Software
Rules

This appendix lists the Sun Management Center rules for the following modules:

■ Kernel Reader

■ Health Monitor

A rule is an alarm check mechanism that allows for complex or special purpose logic

in determining the status of a monitored host or node.

There are two types of rules—simple and complex:

■ Simple rules are based on the rCompare rule, in which monitored properties are

compared to the rule. If the rule condition becomes true, an alarm is generated.

For example, a simple rule can be the percentage of disk space used. If the

percentage of disk space used equals or is greater than the percentage specified in

the rule, then an alarm is generated.

■ Complex rules are based on multiple conditions becoming true. For example, one

complex rule states that when a disk is over 75% busy and the average queue

length is over 10 and the wait queue is increasing, then an alert alarm is

generated.

Note – Any user-customized Solstice SyMON 1.x rules must be ported to the new

environment before the rules can be used in Sun Management Center software.
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Kernel Reader

The following table lists the Kernel Reader simple rules.

TABLE E-1 Kernel Reader Simple Rules

Property Description

avg_1min Load Averages Over The Last 1 Minute

avg_5min Load Average Over The Last 5 Minutes

avg_15min Load Average Over The Last 15 Minutes

cpu_delta Difference between the previous and current time

cpu_idle CPU idle time

cpu_kernel CPU kernel time

cpu_user CPU user time

cpu_wait CPU wait time

ipctused Percent of inodes used

kpctused Percent of Kbytes used

mem-inuse Physical Memory In Use (MBytes)

numusers Number Of Users

numsessions Number Of User Sessions

swap_used Swap Used Kbytes

wait_io CPU wait time breakdown

wait_pio CPU wait time breakdown

wait_swap CPU wait time breakdown
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The following table lists the Kernel Reader complex rules.

TABLE E-2 Kernel Reader Complex Rules

Rule ID Description Type of Alarm

rknrd100 This rule covers a transitory event and generates an alert

alarm when the disk is over 75% busy, the average queue

length is over 10, and the wait queue is increasing. Alert

alarm stays on until the disk is not over 70% busy and the

average queue length is no longer than 8.

Alert

rknrd102 This rule covers a transitory event and generates an alert

alarm if 90% of swap space is in use. Event causing the alarm

stays open until swap space in use is less than 80% of the total

swap space.

Alert

rknrd103 This rule covers a transitory event and generates an alert

alarm if swapping and paging is high for a given CPU. This

indicates that a CPU may be thrashing. Alert alarm is

generated when CPU exceeds 1 swap-out, 10 page-ins, and 10

page-outs per second. Alert alarm stays on if CPU exceeds 1

swap-out, 8 page-ins, and 8 page-outs per second.

Alert

rknrd105 File System Full error. This rule looks for a file system full

error message in the syslog (/var/adm/message ).

Alert alarm that is

closed immediately

rknrd106 No swap space error. This rule looks for a no swap space error

message in the syslog (/var/adm/message).
Alert alarm that is

closed immediately

rknrd400 This rule checks for a continuous CPU load over 6 per CPU

for four hours.

Informational

rknrd401 This rule checks for disks being busy more than 90% of the file

for x hours. The parameters field holds the last time CPU load

was below 6, and is initialized to some date in the year 2001.

Informational

rknrd402 This rule checks if available swap space drops below 10% for

x hours. The parameters field holds the last time CPU load

was below 6, and is initialized to some date in the year 2001.

Informational

rknrd403 This rule is not currently supported. Informational

rknrd404 An informational alarm is generated if the rule rknrd401 gets

triggered 4 times.

Informational

rknrd405 An informational alarm is generated if the rule rknrd402 gets

triggered 4 times.

Informational
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Health Monitor

The following table lists the Health Monitor complex rules.

TABLE E-3 Health Monitor Complex Rules

Rule ID Description Type of Alarm

rhltm000 This rule checks whether there is enough swap space. Critical, Alert,

Caution

rhltm001 Each time a CPU has to wait for a lock to become free, it

wastes CPU power; and this event is counted, since the kernel

uses mutually exclusive locks to synchronize its operation and

keep multiple CPUs from concurrently accessing critical code

and data regions.

Critical, Alert,

Caution

rhltm002 This rule is based on the observation that NFS remote

procedure call timeouts may be associated with duplicate

responses after the call is retransmitted. This indicates that the

network is okay but the server is responding slowly.

Critical, Alert,

Caution

rhltm003 Here the run queue length is divided by the number of CPUs.

This is based upon the fact that every CPU takes a job off the

run queue in each time slice.

Critical, Alert,

Caution

rhltm004 A busy or slow disk reduces system throughput and increases

user response times. This rule identifies the disks that are

loaded so that the load can be rebalanced.

Critical, Alert,

Caution

rhltm005 RAM rule based on residency time for an unreferenced page.

The virtual memory system indicates that it needs more

memory when it scans looking for idle pages to reclaim for

other uses.

Critical, Alert,

Caution

rhltm006 This rule refers to the kernel memory allocation problem. It

shows up when login attempts or network connections fail

unexpectedly. There are two possible causes. Either the kernel

has reached the extent of its address space, or the free list does

not contain any pages to allocate. It is more a sign of a

problem that may otherwise be overlooked.

Critical, Alert,

Caution

rhltm007 There is a global cache of directory path name components

called the directory name lookup cache, or Directory Name

Lookup Cache Rule (DNLC). Missing a cache means that

directory entries must be read from disk and scanned to locate

the right file.

Critical, Alert,

Caution
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Glossary

administrative
domain An arbitrary collection of hosts and networks that are monitored by the

software as a single hierarchal entity. Users may choose to divide their

enterprise into several domains, each to be managed by different users.

agent A software process, usually corresponding to a particular local managed host,

that carries out manager requests and makes local system and application

information available to remote users.

alarm An abnormal event, which may be indicative of current or impending

problems, is detected by a Sun Management Center agent. The agent passes

information about the abnormal event to the Sun Management Center server.

The server passes this information on to the user as an alarm, when the

abnormal event matches a predefined alarm threshold.

alarm
acknowledgment Sun Management Center users can acknowledge alarms, indicating that the

alarm does not represent a serious problem or that the problem is being

resolved. Acknowledged alarms take a lower priority than unacknowledged

alarms.

Attribute Editor A window which provides information about the selected object. In addition,

the Attribute Editor enables you to customize various monitoring criteria for

that object. The monitoring criteria are dependent on the type of object. There

are Attribute Editors for domains, hosts, modules, and data properties.

bus A point-to-point network component. Used by the software to represent a

network link to which many other hosts may be connected.

community A string similar to a password that is used to authenticate access to an agent’s

monitored data.

complex alarm A complex alarm is based on a set of conditions becoming true. Unlike simple

alarms, you cannot set thresholds for complex alarms.
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composite object Composite object refers to hardware with multiple instances of the Solaris

operating environment running inside a single chassis. They are “composites”

from the Sun Management Center point of view because they consist of several

parts shown inside a group or container; one object for each instance of the

Solaris operating environment, two objects representing an active and backup

“system controller,” and one object representing the hardware chassis and

related equipment such as fans and power supplies.

Console window A graphical user interface component of Sun Management Center software

based on Java technology that is used to view monitored hosts (and managed

objects) information and status and to interact with Sun Management Center

agents.

developer
environment A “demonstration” environment in which developers can test customized

modules designed to work with the Sun Management Center software. See the

Sun Management Center 3.0 Developer Environment Reference Manual for more

information.

Discovery A Sun Management Center tool available from the main console window that

is used to find hosts, routers, networks, and Simple Network Management

Protocol (SNMP) devices that can be reached from the Sun Management Center

server.

dynamic loadable
modules A Sun Management Center agent module that can be loaded or unloaded at

run time, enabling monitored properties to be displayed on the main console

window without having to restart the console or agent.

event A change in the state of a managed object.

file scanning The act of scanning a file (usually a log file) for certain patterns (regular

expressions) that may be indicative of problems or significant information. Sun

Management Center agents use file scanning to assist in the monitoring of

systems and applications when these components do not provide direct access

to status information.

graphical user
interface The graphical user interface, or GUI, is a window that provides the user with a

method of interacting with the computer and its special applications, usually

with a mouse or other selection device. The window usually includes such

things as windows, an intuitive method of manipulating directories and files,

and icons.

hierarchy view A window view that defines objects in a hierarchy or tree relationship to one

another. Objects are grouped depending on the rank of the object in the

hierarchy.

hop The number of routers a packet goes through before reaching its destination.
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instance A single word or alpha-character string that is used internally within the Sun

Management Center agent to identify uniquely a particular module or a row

within a module.

manage In Sun Management Center software, manage is defined as being able to

monitor, as well as manipulate the object. For example, management privileges

include acknowledging and closing alarms, loading and unloading modules,

changing alarm thresholds, and so on. Management privileges are similar to

read, write, and execute access.

MIB Management Information Base. A MIB is a hierarchical database schema

describing the data available from an agent. The MIB is used by Sun

Management Center agents to store monitored data that can be accessed

remotely.

module A software component that may be loaded dynamically to monitor data

resources of systems, applications and network devices.

monitor In Sun Management Center software, monitor is defined as being able to

observe an object, view alarms and properties. Monitoring privileges are

similar to read-only access.

node A node is a workstation or server.

object A particular resource (computer host, network interface, software process, and

so on) which is subject to monitoring or management by Sun Management

Center software. A managed object is one that you can manipulate. For

example, you can acknowledge and turn off an alarm condition for an object

that you can manage. A monitored object is one that you can observe but not

acknowledge or otherwise manage.

production
environment One of two environments in which Sun Management Center software is

deployed. The production environment is a “real” environment (as opposed to

a test environment) in which you manage and monitor your hardware.

remote server context A remote server context refers to a collection of Sun Management Center

agents and a particular server layer with which the remote agents are

associated.

request caching The Sun Management Center server consolidates duplicate outstanding

requests originating from multiple consoles and eliminates the execution of

redundant requests.

rule A rule is an alarm check mechanism that allows for complex or special purpose

logic in determining the status of a monitored host or node.

segment An object representing a “segment” of the network, and used as a basis for a

local network.
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seed The password for the Sun Management Center user group called esmaster .

The seed is an alpha-numeric string of up to 8 characters. (This is not

necessarily a UNIX password.) You can select your own seed, or accept the

default seed (maplesyr ) provided by the Sun Management Center software. If

you select your own seed, be sure to record it for later reference.

server The collection of programs and processes (SNMP-based trap, event, topology,

configuration, and Java server) that work on behalf of a Sun Management

Center user to help manage a particular set of networks, hosts and devices.

Usually sends requests to Sun Management Center agents, accepts collected

data from them, and passes the data to the main console window for display.

server context See “remote server context.”

simple alarm Simple alarms are based on one condition becoming true. You may set alarm

thresholds for simple alarms.

SNMP Simple Network Management Protocol. A simple protocol designed to allow

networked entities (hosts, routers, and so on) to exchange monitoring

information.

SNMPv2 usec SNMP version 2, user-based security model security standards.

Sun Management
Center superuser Sun Management Center superuser is a valid user on a server host. The

superuser decides what the agents are in the context of the server. By default,

the superuser password is used as a seed for security key generation.

Sun Management
Center user Sun Management Center users are the members of the symon group in the

/etc/group file.

topology view The topology view displays the members of the object selected in the hierarchy

view.

URL Uniform Resource Locator. An URL is a textual specification describing a

resource which is network-accessible.
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Index
A
absolute Time Editor expression, 150, 157 to 161

access control, 233, 238

ACL, 233, 238

Actions tab, 137, 421

adding

a row to a data property table, 105 to 106, 106 to

108, 113 to 115

from graph clipboard, 120 to 121

objects to administrative domains, 51 to 66

Address process property, 220

administrative domain

creating, 20

default, 16

definition, 7, 15

deleting, 19, 22 to 23

hierarchy examples, 16

home, 16 to 17, 19

initiating a discovery request, 54 to 57

listing, 80 to 81

members, 7

multiple, 15

populating, 20 to 21, 51 to 66

referencing, 19

remote, 23

security, 12, 19

set home administrative domain, 19

switching between, 80 to 81

agent

health, 168

interacting with console and server, 3 to 5

port number, 487

SNMP, 10

agent down alarm notification, 404

Agent Statistics

Configuration manager, 490

Event manager, 490

Sun Management Center server, 490

Topology manager, 490

Trap handler, 490

alarm limits, 135, 420

alarm threshold

creating, 136 to 137, 241, 420 to 421

alarms, 141, 424

accessing, 190

accessing from web interface, 408

acknowledged, 190

alert, 598

alert alarm generation, 595

attribute editor, 405

categories, 193, 411

caution, 598

complex, 9

critical, 598

determining the severity of an alarm, 189

generation, 595

red alarm icon, 189

schedule, 149

seeing, 81

sending email when alarm occurs, 140, 141, 424

setting schedule, 162 to 165

severities, 81

simple, 9, 134 to 135, 418 to 419

simple rules, 595

states, 194
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threshold, 134 to 135, 418 to 419

unacknowledged, 190

windows, 135, 420

Alarms tab button in the Details window, 206

Alarms tab in the Attribute Editor, 134 to 135, 418

to 419

Attribute Editor, 90

Actions tab, 137, 421

Alarms tab, 134 to 135, 418 to 419

definition, 131, 415

History tab, 146, 428

Info tab, 133, 418

module, 179, 183

opening, 132

Refresh tab, 144, 426

Security tab, 242

attributes

changing, 47 to 48

automatic notification of an alarm condition, 140,

141, 424

B
backup

of your database, 506

Browser Details window, 83, 84

Browser tab button in the Details window, 206

buttons

Discovery Request window, 53 to 54

Domain Manager window, 19

Hide Details, 227, 232

Show Details, 227, 232

C
changing attributes about an object, 47 to 48

changing port addresses, 486 to 489

circular log files, 499

class A, B, and C networks, 510

Class process property, 220

CLI (see command line interface), 451

command line interface, 451

basic commands, 463

command-specific parameters, 462

extended commands, 465

alarms, 468

modules, 465

object attribute, 466

topology, 470

interaction modes, 455

batch mode, 455

session mode, 455

internationalization, 475

log file, 474

operation and parameter formats, 460

output, 472

HTML, 474

plain text, 473

XML, 473

overriding parameters, 461

pre-defined parameters, 458

relationship to system structure, 452

software structure, 453

user authorization, 454

user environment, 454

using to log in, 456

Command process property, 220

CommandLine process property, 220

comparison Time Editor expression, 151 to 156, 162

to 165

complex alarms, 9

complex rule

alert alarm generation, 595

definition, 595

Config Reader, 84, 206

special instructions for Details window, 223

Configuration manager, 5, 239

agent statistic, 490

port number, 487

configuring

Details Process display, 218 to 221

legacy agent as subagent, 482 to 484

port addresses, 486 to 489

conflict with port addresses, 486 to 489

connecting objects, 44

console, 3, 10

interacting with server and agent, 3 to 5

multiple consoles, 3

copying

data property to graph, 90

groups, 46

module, 90
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objects, 45 to 46

to graph clipboard, 120 to 121

CPU thrashing, 597

CPU% process property, 220

creating

a module object, 35 to 37, 179

administrative domains, 20

alarm threshold, 136 to 137, 420 to 421

groups, 37 to 39

links between objects, 44

monitored modules, 35 to 37

nodes, 30 to 35, 40 to 41

objects with Discovery manager, 55 to 57

segments, 42 to 44

server component object, 491

critical

alarms, 598

cron Time Editor expression, 150, 157 to 161

customized menu items

adding, 501

customizing alarm actions, 141, 424

cutting objects, 49

cyclic Time Editor expression, 150, 151 to 156

D
data

displaying, 96

probing, 116 to 118

refreshing, 115

data property

Attribute Editor, 131, 415

displaying, 96

graphing, 119

monitoring, 149

probing, 117

refresh interval, 145, 426

sampling points, 147

tool tip, 72

data property table

adding row to, 105 to 106, 106 to 108, 113 to 115

database

backup and recovery, 506

Dataviews

creating, 289

context menu, 289

copy to dataview clipboard, 290

options menu, 289

definition, 287

dataviews, 287

creating, 289

deleting, 293

navigating dataviews window, 292

opening an existing, 292

saving, 294

scalar tables, 295

creating, 295

tables, types of, 295

vector tables, 297

creating, 297

default administrative domain, 16

default privileges

overriding, 247

topology manager, Sun Management Center

default security privileges, 246

deleting

administrative domains, 19, 22 to 23

discovery request, 66

events from event database, 496 to 498

objects, 50

row, 90

Details

alarms, 84

applications, 84

browser, 84

hardware, 84

Details Process display

configuring, 218 to 221

selecting columns, 218 to 220

Details window

Actions tab in the Attribute Editor, 137, 421

Alarms tab button, 206

Alarms tab in Attribute Editor, 134 to 135, 418 to

419

Browser tab button, 83, 206

disk total, 224

exiting, 85

Hardware information types, 222

History tab in the Attribute Editor, 146, 428

Info tab button, 206

Info tab in Attribute Editor, 133, 418

Info tab properties, 209

memory hardware total, 224

Modules tab button, 275
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monitoring log messages, 214

moving columns in Process display, 221

Process Statistics window, 221

Processes tab button, 217

processors total, 224

Refresh tab in the Attribute Editor, 144, 426

Solaris Process Details module, 217

sorting columns in Process display, 220

starting, 85, 207

tab buttons, 84

tape devices total, 224

Directory Name Lookup Cache, 598

Directory Size Monitoring module, 174

defining a directory, 105 to 106

list files, 116 to 118

disabling

a module, 90, 177

row, 90

discovery

checking part numbers, 58

deleting request, 66

filters, 60

methods of, 56, 58

modifying request, 65

request ID, 57

scheduling requests, 60

server context, 57

starting, 52 to 54

starting request, 66

status, 53 to 54

stopping request, 66

timeout, 57 to 58

Discovery Requests window, 53 to 54

disk

busy, 595, 597

complex rules, 595

load, 598

disks, total in Details window, 224

displaying data, 96

document type declaration, 445

Domain Manager buttons, 19

domain, See administrative domain

domain-config .x file, 487

DTD

see document type declaration, 445

Dynamic Reconfiguration

special instructions for Details window, 223

E
Edit menu, 75

editing

graph axes, 125

module, 89, 176 to 177

row, 90

EGroup process property, 219

enabling

module, 90, 178

row, 90

Entity Desc property, 209

Entity Event Destination property, 209

Entity Family property, 209

Entity Full Desc property, 209

Entity Trap Destination property, 209

esadm, 235, 236, 238, 245

esdomadm, 235, 236, 245

esmaster , 234, 235, 479 to 480

esops , 235, 245

espublic , 234, 235, 239, 240, 244, 479 to 480

EUser process property, 219

Event manager, 5, 239, 496 to 498

agent statistic, 490

port number, 487

events

deleting from event database, 496 to 498

exiting Details window, 85

F
File menu items, 75

File Monitoring module, 105

adding row to table, 106 to 108

File Scanning module, 105, 110

file system full, 597

filtering

discovery requests, 60

log messages, 212 to 213

finding specific log messages, 215

G
general group, 37
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Go menu items, 77

graph

applying template, 123

copying data property to, 90

data property, 119

editing axes, 125

historical data, 146, 428

menu items, 123 to 130

multiple data properties, 120 to 121

opening, 122

sampling points, 147

saving, 122

Group ID process property, 219

Grouping operations, 249

definition, 249

detailed procedures

creating a data property task, 264

creating a filter, 258

creating a module task, 263

creating a task, 260

creating an MCP parcel, 270

creating an MCP task, 273

creating an object group, 255

deleting a filter, 260

deleting a task, 269

deleting an MCP parcel, 272

deleting an MCP task, 274

deleting an object group, 258

editing a filter, 259

editing a module task, 264

editing an object group, 257

editing data property tables, 267

simple, scalar editable table, 267

simple, scalar noneditable
tables, 267

vector tables, 268

general procedures

creating a task, 254

creating an object group, 253

setting a schedule, 254

the state of the operation, 255

main group operations window, 251

new tools menu, 250

groups, 16

copying, 46

creating, 37 to 39

general and IP-based, 37

moving, 46

pasting, 46

security, 12

H
hand icon, 226

hardware

monitored by Sun Management Center

software, 2

pathnames displayed, 226

resources displayed, 224

views of, 224

Hardware Details window, 84

Hardware Diagnostics Suite, 84, 206

Health Monitor rules, 595

help, 79

pop-up balloon, 87

helpful hints

displaying levels of details, 88, 208

Search function is case-sensitive, 230

searching in multiple instances, 231

using tool tips, 72, 87

viewing long messages in table cells, 208

Hide Details button, 227, 232

hierarchy view, 10, 68

mouse actions, 70

history interval

schedule, 149

setting, 147, 151 to 156, 157 to 161

History tab, 146, 428

home administrative domain, 16 to 17, 19

host

Details window, 83

security, 12, 92

host down alarm notification, 404

Hostname property, 209

I
import/export utility

CLI interface, 438

defined, 431

document type declaration, 445

file format, 444
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files, 443

head information, 446

how it is used, 431

software structure, 432

starting, 434

starting import, 436

in, 209

increasing virtual size, 493 to 495

Info tab

Entity Desc property, 209

Entity Event Destination property, 209

Entity Family property, 209

Entity Full Desc property, 209

Entity Trap Destination property, 209

Hostname property, 209

IP Address property, 209

Netmask property, 209

Operating System property, 209

properties, 209

Target Hostname property, 209

Target IP Address property, 209

Info tab button in the Details window, 206

Info tab in the Attribute Editor, 133, 418

installation

default administrative domain, 16

IP Address property, 209

IP addresses within server contexts, 240

IP-based group, 37

J
Java security classes, 233

K
kernel memory allocation, 598

Kernel Reader

creating alarm, 136 to 137, 420 to 421

displaying data, 96

rules, 595

keys, 479 to 480

regenerating, 481

L
legacy agent, 482 to 484

load, 598

loading modules, 89, 171 to 175

local applications, modules relating to, 577

log files, viewing, 212, 216

log messages

filtering, 212 to 213

finding specific messages, 215

log view, 11, 84

M
main console window, 10

Management Information Base, See modules, MIB

masking of network addresses, 511

memory hardware, total in Details window, 224

Memory% process property, 220

Menu items, 74

Edit, 75

File, 75

Go, 77

graph, 123 to 130

View, 76

menu, View Columns, 218

messages, viewing, 11

MIB

SNMP, 504

modifying objects, 47 to 48

module object, creating, 179

modules

Agent Statistics, 168, 578

Attribute Editor, 179 to 183

Config Reader, 168

copying, 90

creating a monitored module, 35 to 37

Data Logging Registry, 168, 582

data properties, 415

definition, 8, 86

Details window, 83

Directory Size Monitoring, 168, 174

disabling, 90, 177, 283

displaying rules for, 283

dynamic, 8

Dynamic Reconfiguration, 168
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editing, 89, 176 to 177, 282

enabling, 90, 178, 283

File Monitoring, 169

File Scanning, 110, 169, 591

Health Monitor, 169, 583

HP JetDirect, 169, 593

icon for multi-instance, 277

in alphabetical listing, 514

Kernel Reader, 169, 553

loaded by default, 168

loading, 89, 171 to 175, 277

loading a scheduled module, 281

local applications, 577

MIB, 8

MIB-II Instrumentation, 169, 544

MIB-II Proxy Monitoring, 169, 593

monitoring, 179

multi-instance, 277

NFS File Systems, 170, 573

NFS Statistics, 170, 570

number of instances loaded, 173

operating system, 515, 534

Print Spooler, 170, 587

Process Monitoring, 111, 170, 175, 589

remote systems, 592

rules, 283

schedule, 149, 179 to 183

security, 12, 92, 179 to 183

security permissions, 182

setting schedule, 162 to 165, 278

Solaris Process Details, 170, 571

that load automatically, 514

that load multiple times, 514

unloading, 90, 179, 281

using ’Add Row’, 514

Modules tab button in the Details window, 275

monitored hardware, 2

monitored software properties, 2, 8

monitoring

data property, 149

log messages, 214

objects, methods of, 32 to 33

server components, 491

moving columns in Details Process display, 221

moving groups, 46

N
navigating

administrative domains, 80 to 81

main console window, 78

Netmask, 58

ANDing, 511

property, 209

NFS remote procedure, 598

Nice process property, 220

node, creating, 30 to 35, 40 to 41

notifying you when a host or agent is down, 404

notifying you when an alarm occurs, 140, 141, 424

O
objects

alarms, 81

copying, 44

creating automatically with Discovery

manager, 55 to 57

cutting and pasting, 49

delete, 50

Details window, 83

linking two objects, 44

modifying, 47 to 48

pasting, 44

octets in network addressing, 510

opening

Attribute Editor, 132

graphs, 122

operating system

modules relating to, 515, 534

property, 209

P
pasting

groups, 46

objects, 45 to 46, 49

permissions, security, 233

pfiles process statistic, 221

PGroup process property, 220

physical view, 11, 224

refresh details, 227

pictures of system hardware, 224
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PID process property, 219

ping  command, 56, 58

pldd process statistic, 221

pmap process statistic, 221

populating administrative domains, 20 to 21, 51 to

66

pop-up balloon help, 87

port addresses

changing, 486 to 489

within server contexts, 240

port numbers

discovery process, 58

PPID process property, 219

Print Spooler module

adding row to table, 113 to 115

printer monitoring, 170

Priority process property, 220

probe a monitored data property, 117

Process display, configuring, 218 to 221

Process Monitoring module, 105, 111, 175

process property

Address, 220

Class, 220

Command, 220

CommandLine, 220

CPU%, 220

EGroup, 219

EUser, 219

Group ID, 219

Memory%, 220

Nice, 220

PGroup, 220

PID, 219

PPID, 219

Priority, 220

Session ID, 220

Size, 220

Start time, 220

State, 220

Time, 220

UID, 219

User, 219

Wait Channel, 220

Process Statistics window, 221

processes, 84

processes view, 11

processors, total in Details window, 224

property, See data property

pstack process statistic, 221

Q
queue length, complex rules, 595

R
rCompare  rule, 9

recovery

of your database, 506

referencing administrative domains, 19

refresh data, 115

refresh interval

schedule, 149

setting, 145, 151 to 156, 157 to 161, 426

Refresh tab, 144, 426

regenerating security keys, 481

relationships, inclusive, 238

remote administrative domains, 23

remote server access, 239

remote server context, 5

remote systems, modules relating to, 592

rhltm000, 598

rhltm001, 598

rhltm002, 598

rhltm003, 598

rhltm004, 598

rhltm005, 598

rhltm006, 598

rhltm007, 598

rknrd100, 597

rknrd102, 597

rknrd103, 597

rknrd105, 597

rknrd106, 597

rknrd401, 597

rknrd402, 597

rknrd403, 597

rknrd404, 597

rknrd405, 597
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RMI port address, 488

router forwarding rule, 510

routing tables, 56, 58

row

adding, 105 to 106, 106 to 108, 113 to 115

deleting, 90

disabling, 90

editing, 90

enabling, 90

rule, 5, 9

complex, 595

CPU power, 598

Directory Name Lookup Cache, 598

disk busy, 597

disk loaded, 598

Health Monitor, 595, 598

kernel memory allocation, 598

Kernel Reader, 595, 596 to 597

no swap space error, 597

run queue length, 598

simple, 595

Solstice SyMON 1.x software, 595

Sun Management Center 2.1 software, 595

swap space, 597, 598

time for an unreferenced page, 598

user-customized, 595

run queue length, 598

running UNIX commands on data, 116 to 118

S
same server context, 5

sampling points for data property, 147

saving graph, 122

scalar dataviews tables, 295

creating, 295

schedule, 149, 151 to 156, 157 to 161, 162 to 165, 179

to 183

scheduling discovery requests, 60

search pattern, 214

Search window in Details Logical view, 230

searching for specific log messages, 215

Secure Socket Layer, 317

security, 12

access control (ACL) categories, 233, 234

accessing on a module, 242

adding user-defined group, 244

adding users, 241

deleting users, 245

granting administrator privileges, 245

specifying ACL, 238

using key functions, 241

administrative domains, 19

default privileges

default privileges, 246

esmaster
private, 234

espublic
public, 234

for a module, 179 to 183

functions

admin, 237

general, 237

operator, 237

host, 92

layers in Sun Management Center software, 233

module, 92

permissions, 233

remote, 23

Sun Management Center users, 234

tab, 242

security keys, 479 to 480

regenerating, 481

seed for security key, 480

segment creation, 42 to 44

selecting columns in Details Process display, 218 to

220

server

access, 239

context, 239

context limitations, 241

interacting with console and agent, 3 to 5

interaction with agents, 5

interacts with multiple consoles, 5

port number, 487

remote access, 239

server component as monitored object, 491

server context, 23

discovery process, 57

limitations, 241

server-config .x file, 487

Session ID process property, 220

setting
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alarm schedule, 162 to 165

history interval, 151 to 156

refresh interval, 145, 157 to 161, 426

schedules, 149

Show Details button, 227, 232

simple alarms thresholds, 9

simple rules

alarm generation, 595

monitored properties, 595

Size process property, 220

Smart delete, 496 to 498

SMsystemCommand, 503

SNMP, 10

MIBs for Sun Management Center Modules, 504

SNMP port

definitions, 487

SNMP subagents, 482 to 484

software properties monitored by Sun

Management Center software, 2, 8

Solaris Process Details module, 217

sorting columns in Details Process display, 220

Start time process property, 220

starting

Details window, 85, 207

discovery, 52 to 54, 66

State process property, 220

statistics

Detail Process Statistics window, 221

pfiles, 221

pldd, 221

pmap, 221

pstack, 221

stopping discovery request, 66

subagent, 482 to 484

subnets, 510

Sun Management Center

component layers, 2

Java security classes, 233

monitoring, 32 to 33

remote access, 239

rules, 595

security layers, 233

server

context limitations, 241

server access, 239

server agent statistic, 490

server context, 239

user functions, 237

user security, 234

swap space, 597, 598

error, 597

in use, 597

switching between administrative domains, 80 to

81

syslog , 597

T
tape devices, total in Details window, 224

Target Hostname property, 209

Target IP Address property, 209

text pattern includes UNIX regular

expressions, 214

Time Editor, 149, 150

combining expressions, 150 to 165

Time process property, 220

timeout, discovery process, 57 to 58

tool tip, 72, 87

Tools Menu

customizing, 501

Topology manager, 5, 239

agent statistic, 490

exiting, 493 to 495

function, 493

port number, 487

system resource requirement, 493

Virtual Size limit, 493

topology view, 10, 68

mouse actions, 72

Trap handler, 5, 239

agent statistic, 490

port number, 487

U
UID process property, 219

UNIX regular expressions in text patterns, 214

unloading a module, 90, 179

User process property, 219

users, 234
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default functions, 237

esmaster , 234

espublic
public, 234

V
var/adm/message , 597

vector dataviews tables, 297

creating, 297

view

hierarchy, 10

of administrative domain, 68

topology, 10

View Columns pull-down menu, 218

View menu items, 76

viewing

error messages, 11

log files, 212, 216

virtual size, increasing, 493 to 495

W
Wait Channel process property, 220

web interface

alarm categories, 411

alarms attribute editor, 405

alarms status summary, 407

attribute editor, 316

Actions tab, 421

Alarms tab, 418

History tab, 428

Info tab, 418

Refresh tab, 426

creating an alarm, 420

defining alarm action script, 424

details, 306

Browser tab, 307

displaying, 306

filtering alarms, 311

Info tab, 307

loading modules, 313

Log tab, 314

displaying attribute editor, 416

down alarm notification, 404

email notification for critical alarm, 424

login screen, 303

main console, 304

main console screen, 304

modifying alarms, 423

module data properties, 415

setting a history interval, 429

setting a refresh interval, 426

starting, 302

viewing alarm information, 408
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